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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.
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Passport ID, go to: 
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Or click the New users - please register link on the HP Passport login page.
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Support

You can visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.
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• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
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Welcome to This Guide

This guide explains how to configure and work with an IT model that 
enables you to build a topology of your system. You populate the model 
with configuration items and their relationships, and then use the model to 
measure and manage critical business processes. 

This chapter includes:

 ➤  How This Guide Is Organized on page 13

 ➤  Who Should Read This Guide on page 14

 ➤  Getting More Information on page 15

How This Guide Is Organized

The guide contains the following chapters:

 Part I Modeling

Describes how to model your business environment by defining views and 
by building TQL queries that retrieve the required information from the 
CMDB; describes how to create Topology reports based on a specific Report 
query and how to view and modify the definitions of configuration item 
types (CITs) defined in the UCMDB and the relationships that define the 
connections between them.
13
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 Part II Settings

Describes how to manage definitions, resources, and tools that enable you 
to discover IT infrastructure resources, how to define schedules for tasks that 
are activated on a periodic basis, how to configure settings to meet your 
organization's specifications, and how to enable specific recipients to 
automatically receive a specified report, via email, at regularly defined 
intervals.

 Part III Application

Describes how to compare the hierarchies of two compound CIs or of two 
snapshots (taken at different times) of a view; describes the various reports 
listing CIs and relationships, their attribute values, changes, and other 
statistics.

 Part IV Users and Permissions

Describes how to set up users and roles and grant permissions to roles to use 
components of the application; describes how to apply permissions to users 
and user groups to enable access to specific resources and resource instances 
in your business environment.

 Part V View Explorer

Explains how View Explorer presents the elements of the IT universe model 
in HP Universal CMDB through the medium of views. 

 Part VI Topology Map

Explains Topology Map concepts and describes how to work with the 
Topology Map that shows the CIs and relationships defined in a view. 

Who Should Read This Guide

This guide is intended for the following users of HP Universal CMDB:

➤ HP Universal CMDB administrators

➤ HP Universal CMDB platform administrators
14
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➤ HP Universal CMDB application administrators

➤ HP Universal CMDB data collector administrators

Readers of this guide should be knowledgeable about enterprise system 
administration, have familiarity with ITIL concepts, and be knowledgeable 
about HP Universal CMDB.

Getting More Information

For a complete list of all online documentation included with HP Universal 
CMDB, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the HP Universal CMDB Deployment Guide PDF.
15
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Part I

Modeling





1
Configuration Management Database 
(CMDB)

This chapter provides information on CMDB.

This chapter includes:

Concepts

 ➤  CMDB Overview on page 20

 ➤  Configuration Items (CI) on page 21

 ➤  Nodes and Relationships on page 21

Reference

 ➤  CMDB Log Files on page 21

 ➤  Log Severity Levels on page 30

 ➤  CMDB Configuration Parameters on page 31
Concepts
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Chapter 1 • Configuration Management Database (CMDB)
CMDB Overview

The CMDB is the central repository for the configuration information that is 
gathered from the Discovery and Dependency Mapping (DDM) process and 
the various third-party applications and tools.

The CMDB contains all the configuration items (CIs) and relationships 
created in HP Universal CMDB, whether created automatically from the 
DDM process or inserted manually. The CIs and relationships together 
represent a model of all the components of the IT Universe in which your 
business functions. The CMDB stores and handles the infrastructure data 
collected and updated by the DDM process. For more information about the 
DDM process, see Discovery and Dependency Mapping Guide.

The IT Universe model can be very large, containing millions of CIs. To 
facilitate their management, you work with the CIs in a view that provides a 
subset of the overall components in the IT Universe world.

You use factory views or views defined in View Manager or the Modeling 
Studio to display and manage the CIs and relationships in the CMDB. The 
views enable you to focus on specific IT areas and are available via View 
Explorer. An example of a view is shown in the following figure:

The CMDB also contains the TQL query definitions that are used to query 
and retrieve data from the CMDB, for presentation in the views; and the 
configuration item type (CIT) model, a repository for the CI types used to 
define the CIs and relationships. For information on TQL queries, see 
“Topology Query Language” on page 341.
20
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Configuration Items (CI)

A configuration item (CI) is a component of the CMDB that represents a 
physical or logical entity in the system, for example, hardware, software, 
services, business processes, and customers. The CIs are part of the 
IT Universe model in the CMDB, where they are organized into a 
hierarchical format based on the interdependencies in your organization’s 
IT environment. The interdependencies in HP Universal CMDB are called 
relationships.

Each CI belongs to a configuration item type (CIT). The CIT defines a 
category of CIs used in HP Universal CMDB. The CITs provide templates for 
creating the CIs and associated properties in each category. You view and 
manage the CIs in the CMDB using views. Each view shines a spotlight on 
part of the IT Universe model.

Nodes and Relationships

Nodes are the components from which TQL queries are built in Enrichment 
Manager, View Manager, Correlation Manager, Topology Report Manager, 
and Query Manager.

Relationships are connections defined between CIs. Relationships are 
defined one at a time for each pair of nodes in a TQL query.

Reference

CMDB Log Files

CMDB log files enable you to perform basic troubleshooting of CMDB 
runtime problems. Additionally, by tracking CMDB behavior in the log files, 
you can examine the effects of changes made in the system. CMDB is 
composed of subsystems and each subsystem records to several log files. 

Log files are located in the <HP Universal CMDB root 
directory>\UCMDBServer\j2f\log folders.
21
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This section includes the following topics:

➤ “CMDB Server Parameters” on page 22

➤ “CI Type Model Log” on page 24

➤ “CMDB Notification Log” on page 25

➤ “CMDB Model Audit Short Log” on page 26

➤ “History Database Log” on page 27

➤ “CMDB Enrichment Log” on page 27

➤ “CMDB Plug-in Log” on page 28

➤ “CMDB Dal Log” on page 28

➤ “CMDB Operation Statistics Log” on page 29

CMDB Server Parameters
This section contains definitions for CMDB server parameter log files. For 
details on changing log levels, see “Changing Log Levels” on page 30.

This section includes the following topics:

➤ “Lifecycle Log” on page 23

➤ “General CMDB Log” on page 23

➤ “Quota Log” on page 24
22
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Lifecycle Log

The log name is cmdb.info.log. 

General CMDB Log

The log name is cmdb.log.

Log File Description

Purpose CMDB server lifecycle: 

➤ all server tasks

➤ customer loading and unloading 

➤ startup and shutdown of Task manager

Contains information about any application that does not 
start up correctly.

Information 
Level

All lifecycle details.

Error Level Startup errors of CMDB subsystems, primarily in the data 
access layer.

Debug Level Not applicable

Basic 
Troubleshooting

➤ If the CMDB client receives an exception that the customer 
does not exist, check that the customer is properly loaded. 

➤ If the CMDB client receives an exception that it cannot find 
CMDB in a JNDI lookup, check that the CMDB server is 
bound in the JNDI tree.

➤ If the HA Controller does not load the CMDB customers, 
check that the CMDB server is registered in the HA 
controller.

Log File Description

Purpose Errors of all CMDB subsystems and CMDB CITs that do not 
have their own log file.

Information 
Level

Information from the CMDB server not directed to any 
specific log.

Error Level All errors in the CMDB server.
23
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Quota Log

The log name is cmdb.quota.log.

CI Type Model Log
The log name is cmdb.classmodel.log.

Debug Level Debug information in the CMDB server that is not directed to 
a specific log.

Basic 
Troubleshooting

CMDB server errors during CMDB deployment.

Log File Description

Purpose Quota names, quota values, and current quota levels. 

Information 
Level

Quota names and values set in the server and customer levels 
during a customer load.

Error Level CMDB operations that fail because they exceed quota limits.

Debug Level A count collector runs every n minutes and gathers current 
counts for all quotas. Collected counts are logged.

Basic 
Troubleshooting

If operations fail because of quota limits, check the count 
growth and quota values.

Log File Description

Purpose CI Type Model errors and debug messages.

Information 
Level

When a CI Type Model is loaded, incorrect definitions are 
logged as informational messages. An example of an incorrect 
definition is duplicate attributes.

Error Level Not available.

Log File Description
24
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CMDB Notification Log
The log name is cmdb.notification.log.

Debug Level Every CI Type update includes the following:

➤ original CIT in XML format

➤ new CIT in XML format

➤ differences between the CITs 

If the CI Type Model update is rejected, the reason is logged.

Basic 
Troubleshooting

Compares the differences that the server finds between the 
original CIT and the new CIT. This is useful to understand the 
following scenarios:

➤ a CIT in a package failed 

➤ an action in the CIT browser applet failed

➤ an action in the CIT browser applet succeeded when it 
should have failed

Log File Description

Purpose Notification messages from the time of the component’s 
creation in CMDB until the client’s listener receives a message.

Most components receive configuration changes from CMDB 
in push mode, by the notification mechanism, rather than in 
pull mode.

Information 
Level

➤ startup and shutdown of publishers

➤ register and unregister remote and internal listeners

Error Level ➤ errors when messages are published

➤ errors when messages are received 

Debug Level ➤ unique message ID 

➤ number of changes that a message includes as well as more 
details according to the type of the message (for example, 
the TQL result version) 

➤ JMS header properties

Log File Description
25
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CMDB Model Audit Short Log
The log name is cmdb.model.audit.short.log.

Basic 
Troubleshooting

If an application does not receive a notification, check the 
following:

➤ a listener is registered with the appropriate notification 
filter

➤ a message is published with data that matches this filter

➤ a message is received by the listener (use the unique 
message ID to verify)

Log File Description

Purpose Information about a CI Type operation: type of operation, 
data received as input, and what happened to the data in each 
CIT. 

Also contains information about the caller application, 
execution times, and persistency time.

Information 
Level

Operation details

Error Level Not available.

Debug Level Not available.

Basic 
Troubleshooting

If there are no changes when there should be, check the 
following:

➤ the operation exists

➤ the input is correct 

➤ what happened to the data. There may have been a false 
update. 

This is especially useful when running DDM to trace the 
input. 

Log File Description
26
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History Database Log
The log name is cmdb.history.log.

CMDB Enrichment Log
The log name is cmdb.enrichment.log.

Log File Description

Purpose ➤ Records which CITs are found by the History database when 
the database is initialized from an existing topology. 

➤ Records what is to be saved in the History database.

➤ Tracks events saved in the History database.

➤ Records when the History database was purged.

Information 
Level

➤ When the last purge was carried out.

➤ Information about initialization of the History database.

Error Level Lists errors that occur when event information is inserted in 
the History database.

Debug Level ➤ Details about CITs inserted during initialization of the 
History database.

➤ Details about changes in the TQL results saved in the 
History database.

Log File Description

Purpose Enrichment definitions: adding, updating, removing, and 
calculating. 

Calculation results such as how many CIs were added, how 
many relationships were removed, and so forth. 

Supplies the reason for a calculation failure. Failure in a model 
update, however, is not included since it is an asynchronous 
execution.

Information 
Level

➤ Add, update, and remove enrichment definitions.

➤ Add, update, and remove CIs or relationships to or from a 
model.

Error Level Calculation failure.
27
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CMDB Plug-in Log
The log name is cmdb.plugins.log.

CMDB Dal Log
The log name is cmdb.dal.log.

Debug Level Traces the enrichment calculation process.

Basic 
Troubleshooting

➤ If no calculation was carried out, check the definition of 
add enrichment.

➤ If there are no results, check the finish calculate entry.

Log File Description

Purpose Plug-in input and output notification.

Information 
Level

Lifecycle of publisher.

Error Level ➤ no customer name exists in the customer ID 

➤ publisher failure 

Debug Level Receive or send a change.

Basic 
Troubleshooting

If notification did not reach the destination, check that the 
plug-in received the input. 

Log File Description

Purpose Information about activity that occurred in the data access 
layer, the layer that works with CMDB.

Information 
Level

Not available.

Error Level ➤ connection pool errors

➤ database errors

➤ command execution errors

Log File Description
28
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CMDB Operation Statistics Log
The log name is cmdb.operation.statistics.log.

Debug Level ➤ all DAL commands executed

➤ all SQL commands executed

Basic 
Troubleshooting

If you suspect that CMDB actions are taking too long, check 
the time spent on queries and updates in the DAL logs and 
operation logs.

Exception details and ID are entered into the log. The 
exception ID appears in the exception itself.

Log File Description

Purpose Statistics for all operations performed in the past 15 minutes 
including worst operation instances.

Information 
Level

Statistics per operation including operation class name, caller 
application, and customer ID.

Default of 10 worst operation instances.

Error Level Disables the statistics feature.

Debug Level Not available.

Basic 
Troubleshooting

Check when there is a performance slow down.

Log File Description
29
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Log Severity Levels

Each log is set so that the information it records corresponds to a certain 
severity threshold. Because the various logs are used to keep track of 
different information, each is pre-set to an appropriate default level. For 
details on changing the log level, see “Changing Log Levels” below.

Typical log levels are listed below from narrowest to widest scope:

➤ Error. The log records only events that adversely affect the immediate 
functioning of HP Universal CMDB. When a malfunction occurs, you can 
check if Error messages were logged and inspect their content to trace the 
source of the failure.

➤ Warning. The log’s scope includes, in addition to Error-level events, 
problems for which HP Universal CMDB is currently able to compensate 
and incidents that should be noted to prevent possible future malfunctions.

➤ Info. The log records all activity. Most of the information is normally 
routine and of little use and the log file quickly fills up.

➤ Debug. This level is used by HP Software Support when troubleshooting 
problems.

Note: The names of the different log levels may vary slightly on different 
servers and for different procedures. For example, Info may be referred to as 
Always logged or Flow.

Changing Log Levels
If requested by HP Software Support, you may have to change the severity 
threshold level in a log, for example, to a debug level.

To change the severity threshold level:

 1 Open the log properties file in a text editor. Log file properties are defined in 
files in the following directory: <HP Universal CMDB root 
directory>\UCMDBServer\j2f\conf\core\Tools\log4j.
30
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 2 Locate the loglevel parameter. For example,

 3 Change the level to the required level. For example, 

 4 Save the file.

CMDB Configuration Parameters

This section describes the parameters needed for configuring the CMDB. By 
changing the values of CMDB parameters, the administrator can change the 
runtime behavior of CMDB.

This section includes the following topics:

➤ “Overview” on page 32

➤ “Aging Parameters” on page 33

➤ “Configuration Item Type Parameters” on page 34

➤ “Configuration Item Type Setting Parameters” on page 36

➤ “Data Model Parameters” on page 36

➤ “General Server Parameters” on page 37

➤ “History Database Parameters” on page 40

➤ “History Database Purging Parameters” on page 42

➤ “Monitoring Parameters” on page 43

➤ “Notification Parameters” on page 44

➤ “Other Parameters” on page 45

➤ “Plug-in Parameters” on page 48

➤ “Quota Parameters” on page 48

➤ “System TQL Parameters” on page 51

loglevel=ERROR

loglevel=DEBUG
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Overview

Note: Changed parameters may impact the entire system and not just the 
CMDB. Parameters that can be changed by users are marked Y in the Change 
Value? (Y/N) column of each table. All other parameters should be changed 
by HP Software Support only.

To modify a parameter, select Admin > Settings > Infrastructure Settings, 
choose Foundations, select cmdb and locate the parameter in the 
appropriate table. Click the Edit button and modify the parameter with the 
required value. 
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Aging Parameters 
This section describes the aging parameters: 

 

Parameter Name Parameter 
Description

Type Value Description Change 
Value? 
(Y/N)

model.aging.is.agi
ng.enabled

Defines whether the 
aging mechanism is 
enabled.

Boolean ➤ true. Aging is 
enabled. The 
scheduler runs and 
marks candidates 
(objects/links) for 
deletion.

➤ false. Aging is 
disabled. The 
scheduler does not 
run but the dates 
when candidates 
must be deleted and 
the actual deletion 
are set. This is the 
default. 

Y

model.aging.sched
uler.hour.of.first.ru
n

The time when the 
aging parameter 
runs after startup.

integer Default: 2:00 AM N

model.aging.sched
uler.interval.in.ho
urs 

The interval in 
hours between aging 
parameter runs.

integer Default: 24 hours N

model.aging.time.
unit=days
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Configuration Item Type Parameters
This section describes the CIT parameters: 

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)

dal.classmodel.dao.type Defines the 
storage type of the 
CI Type Model.

string ➤ jdbc. Storage in 
the database.

➤ xml. Storage in 
an XML file.

N

dal.classmodel.filesystem.
file.name

Defines the 
relative directory 
path where a CI 
Type is saved 
when the storage 
type is xml.

string The path is relative 
to the HP Universal 
CMDB home 
directory. 

dal.classmodel.deployme
nt.dao.type

Defines the 
storage type of a 
CI Type definition 
for initial 
deployment.

string xml. CMDB reads 
from the XML files 
and deploys the CI 
Type in CMDB.

N

dal.classmodel.deployme
nt.file.name

Defines the 
relative directory 
path to the CI 
Type XML files. 
These files are 
needed for CI 
Type deployment.

string All XML files must 
have the suffix 
_deployment.xml. 

N

dal.classmodel.db.name Defines the name 
of the schema for 
CMDB 
management. 
CMDB 
management 
includes two 
tables: ID gen and 
CMDB versions. 

string Relevant for 
Microsoft SQL 
Servers only. 

Y
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dal.classmodel.host.name The IP address of 
the CMDB 
management 
database host.

string Y

dal.classmodel.user.name User name to log 
into the CMDB 
management 
database. 

string In Oracle, it is also 
the schema name.

Y

dal.classmodel.password Password to log 
into the CMDB 
management 
database.

string Y

dal.classmodel.server The same as 
dal.classmodel.hos
t.name. 

string Defined for DB 
context only. DB 
context is the name 
of a parameter in 
the connection 
pool.

Y

dal.classmodel.sid The sid of a CI 
Type Model.

string Relevant for Oracle 
database.

Y

dal.classmodel.port Defines a TCP port 
of database host.

integer Y

dal.classmodel.db.type The type of 
CMDB.

string ➤ ORACLE Server

➤ SQL Server

Y

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)
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Configuration Item Type Setting Parameters
This section describes the CI Type settings parameters:

 

Data Model Parameters
This section describes the data model parameters: 

 

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)

classmodel.persistenc
y.file=/cmdb/classmo
del/persistency/class
model.xml

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)

dal.datamodel.
dao.type

Defines the type 
of continuous 
storage of a data 
model.

string ➤ jdbc. Continuous 
storage in the 
database.

➤ mock.  

N

dal.datamodel.
db.name

Defines the name 
of the schema.

string Relevant for Microsoft 
SQL Servers only.

Y

dal.datamodel.
host.name

The IP address of 
the CMDB 
database host.

Note: CMDB 
database includes 
CI Type Model 
and data model 
database.

string Y

dal.datamodel.
user.name

User name to log 
into the CMDB 
database. 

string In Oracle, it also denotes 
the schema name.

Y

dal.datamodel.
password

Password to log 
into the CMDB 
database.

string Y
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General Server Parameters
This section describes the general server parameters: 

 

dal.datamodel.s
erver

The same as 
dal.datamodel.host
.name. 

string Defined for DB context 
only. DB context is the 
name of a parameter in 
the connection pool.

Y

dal.datamodel.s
id

If the CMDB 
database is Oracle, 
this parameter 
defines the sid of 
the CI Type 
Model.

string Y

dal.datamodel.
port

The TCP port of 
the database host.

integer Y

dal.datamodel.
db.type

The type of CMDB 
database.

string ➤ ORACLE Server

➤ SQL Server

Y

Parameter Name Parameter Description Type Value Description Change 
Value? 
(Y/N)

server.sync.sessio
n.timeout

The default time-out for 
executing synchronous 
CMDB operations. 

Does not affect 
asynchronous 
operations.

integer ➤ Value is in seconds. 

➤ If the CMDB 
operation runs longer 
than the defined 
value, a request time-
out exception is sent 
to the client.

N

upgrade.enabled Defines whether CMDB 
should perform an 
upgrade on startup.

Boolean ➤ true. Perform an 
upgrade.

➤ false. Do not perform 
an upgrade.

N

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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upgrade.file=/cm
db/upgrade.dat

The file containing the 
date of the last upgrade 
for each customer.

/cmdb/upgrade.dat

task.threads.pool
.size.process

For internal HP use only. integer 20

task.threads.pool
.size.modeltopol
ogy

The number of threads 
dedicated to the CMDB 
model topology.

integer 10

task.threads.pool
.size.tqlcalculator

The number of threads 
dedicated to the TQL 
calculator.

integer 15

task.threads.pool
.size.tqlresultrep
ository

The number of threads 
dedicated to the TQL 
result repository.

integer 8

task.threads.pool
.size.modelquery

The number of threads 
dedicated to the CMDB 
model query.

integer 20

task.threads.pool
.size.tqlnotificati
on

The number of threads 
dedicated to TQL 
notification.

integer 8

task.threads.pool
.size.tqlresultsutil
s

The number of threads 
dedicated to TQL results 
utilities.

integer 20

task.threads.pool
.size.tqlpatternsc
ache

The number of threads 
dedicated to the TQL 
query cache.

integer 6

task.threads.pool
.size.tqlpatterns
manager

The number of threads 
dedicated to the TQL 
query manager.

integer 2

task.threads.pool
.size.plugins

The number of threads 
dedicated to plug-ins

integer 1

Parameter Name Parameter Description Type Value Description Change 
Value? 
(Y/N)
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task.threads.pool
.size.raw.event

The number of threads 
dedicated to raw events.

integer 1

task.threads.pool
.size.enrichment
admin

The number of threads 
dedicated to enrichment 
administration.

integer 1

task.threads.pool
.size.enrichment
definition

The number of threads 
dedicated to enrichment 
definitions.

integer 4

task.threads.pool
.size.enrichment
calculation

The number of threads 
dedicated to the 
enrichment calculation.

integer 4

task.threads.pool
.size.classmodel

The number of threads 
dedicated to the CIT 
model.

integer 1

task.threads.pool
.size.deployment

The number of threads 
dedicated to 
deployment.

integer 1

task.threads.pool
.size.modelupdat
e

The number of threads 
dedicated to updating 
the CMDB model.

integer 1

task.threads.pool
.size.tqlresultrep
ositorycache

The number of threads 
dedicated to the TQL 
results repository cache.

integer 1

task.threads.pool
.size.tqlscheduler

The number of threads 
dedicated to the TQL 
scheduler.

integer 1

Parameter Name Parameter Description Type Value Description Change 
Value? 
(Y/N)
39



Chapter 1 • Configuration Management Database (CMDB)
History Database Parameters
This section describes the History database parameters: 

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

dal.history.db.nam
e

Defines the 
name of the 
History schema.

string Relevant for Microsoft 
SQL Servers only. 

Y

dal.history.host.na
me

The IP address 
of the database 
host.

string Y

dal.history.user.na
me

User name to 
log into History 
database. 

string In Oracle, it also 
denotes the schema 
name.

Y

dal.history.passwor
d

Password to log 
into the data 
model database.

string Y

dal.history.server Defined for DB 
context only. 
DB context is 
the name of a 
parameter in 
the connection 
pool.

string The value must be the 
same as 
dal.history.host.name. 

Y

dal.history.sid If the CI Type 
database is 
Oracle, this 
parameter 
defines the SID 
of the CI Type.

string Y

dal.history.port The TCP port of 
the database 
host.

integer Y

dal.history.db.type The type of 
History 
database.

string ➤ ORACLE Server

➤ SQL Server 

Y
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dal.history.data.tab
lespace.name

This parameter 
is relevant for 
the Oracle 
database only. 
The DBA can 
define the 
tablespace for 
the History 
data.

cmdbhistorydata

dal.history.index.ta
blespace.name

This parameter 
is relevant for 
the Oracle 
database only. 
The DBA can 
define the 
tablespace for 
indexes.

cmdbhistoryindex

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
41



Chapter 1 • Configuration Management Database (CMDB)
History Database Purging Parameters
This section describes the History database purging parameters: 

 

Parameter 
Name

Parameter 
Description

Type Value Description Change Value? 
(Y/N)

history.purging.
days.to.save.bac
k

The minimum 
number of days 
to keep update 
and last create 
changes in the 
CMDB before 
purging those 
changes from 
the History 
database. 

Note: The last 
change of an 
attribute is not 
purged until a 
newer one 
overrides it. 

integer For example, if the value is 
90, changes that occur 
today remain in the 
History database for at 
least 90 days.

Y

history.purging.
scheduler.interv
al.in.hours

The interval of 
time between 
purges of the 
History 
database.

integer Value is in hours.

For example, if the value is 
24, the History database is 
purged every 24 hours.

Y

history.purging.
scheduler.hour.
of.first.run

The hour of the 
day, using a 24 
hour format, to 
begin purging. 
Purging is 
generally 
performed 
during the 
night hours.

integer For example, if the value is 
01, purging begins at 01:00 
every day.

Y
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Monitoring Parameters
This section describes the monitoring parameters: 

 

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)

monitor.scheduler.lo
ad.customer.number

Defines the number 
of customers to be 
monitored.

integer If the value is -1, no 
customer is 
monitored. 

Values other than -1 
define the number 
of monitored 
customers.

N

monitor.performance
.warning

The minimum 
threshold to define 
CMDB performance 
as Warning.

The maximum 
threshold to define 
CMDB performance 
as Good.

long Value is in 
milliseconds.

N

monitor.performance
.error

The minimum 
threshold to define 
CMDB performance 
as Error. 

The maximum 
threshold to define 
CMDB performance 
as Warning.

long Value is in 
milliseconds.

N

monitor.scheduler.ti
mer.time

The interval of time 
to run a performance 
check.

long Value is in 
milliseconds.

N

monitor.scheduler.de
lay.time

The delay between 
system startup and 
the first performance 
check run.

long Value is in 
milliseconds.

N
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Notification Parameters
This section describes the notification parameters: 

 

task.threads.pool.size
.monitorQuery

The number of 
threads dedicated to 
the pool size monitor 
query.

1

task.threads.pool.size
.monitorCollector

The number of 
threads dedicated to 
the pool size monitor 
collector.

1

task.threads.pool.size
.customer.load

1

Parameter Name Parameter Description Type Value 
Description

Change 
Value? 
(Y/N)

notification.number.of.
publish.tasks

Number of single-
threaded tasks that 
publish CMDB changes 
to internal listeners.

integer N

notification.jms.connection.
factory

The JMS connection 
used for receiving 
notification.

  N

notification.topic.jndi.name The JNDI name of the 
topic selected for 
notification.

  N

Parameter Name Parameter 
Description

Type Value Description Change 
Value? (Y/N)
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Other Parameters
This section describes other data parameters: 

notification.sessions.
applications=DASHBOARD=3
;MAM_Viewing_system=3;
MAM_=10;CmdbExt=3;
AdaptersFramework=3;
MAM_AutoDiscovery=3;
sap=2;siebel=2;MAM_
Correlation_system=3

Defines a number of 
topic sessions for JMS 
subscribers per caller 
application.

string Definitions 
are 
separated by 
a semicolon 
(;).

N

notification.queue.size.max Maximum number of 
messages that can 
accumulate in the 
internal queue when 
the JMS server is down. 

integer N

notification.queue.flush.
interval

Interval of time to send 
any JMS messages 
accumulated in the 
queue.

integer Value is in 
seconds.

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

dal.datamodel.da
ta.tablespace.na
me

The tablespace name 
for the data model. 

string Relevant for Oracle 
database only.

Y

dal.datamodel.in
dex.tablespace.n
ame

The tablespace name 
for indexes.

string Relevant for Oracle 
database only.

Y

dal.in.clause.thre
shold

The maximum 
number of values in 
a SQL IN clause.

integer N

Parameter Name Parameter Description Type Value 
Description

Change 
Value? 
(Y/N)
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dal.num.of.in.ch
unks

The maximum 
number of chunks 
to be performed by 
an SQL IN clause.

integer For example: an SQL 
WHERE clause 
generates n number 
of values. If 
(dal.in.clause.
threshold * dal.num.of.
in.chunks) > n, a 
temporary table is 
used. If, however, n is 
larger, several SQL 
statements are 
executed with the 
SQL IN clause. 

N

dal.use.dirty.read Defines whether the 
database queries use 
dirty read. 

Boolean Relevant only for 
certain queries.

➤ true. Queries use 
dirty read.

➤ false. Queries do 
not use dirty read.

N

dal.update.class.
model.enabled

Defines whether CI 
Type Model updates 
are permitted. This 
parameter is 
currently used for 
consolidated tables 
in HP Software-as-a-
Service. 

Boolean ➤ false. Tables are 
consolidated and 
an update of CI 
Type Model is not 
allowed.

➤ true. Tables are not 
consolidated and 
an update of CI 
Type Model is 
allowed.

N

dal.use.memory.i
nstead.temp.tabl
e.low.threshold=

 

dal.use.memory.i
nstead.temp.tabl
e.high.threshold
=

 

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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dal.datamodel.m
ax.name.length.
allow

Maximum length of 
table and column 
names in database.

integer N

dal.classmodel.u
se.idgen

Defines whether to 
use the HP sequence 
ID generator for the 
database.

Boolean ➤ true. Use ID 
generator.

➤ false. Do not use 
ID generator.

N

dal.datamodel.cr
eatetime.attribut
e.name

Name of the 
attribute with the 
creation time of the 
CI or relationship.

string N

dal.datamodel.u
pdatetime.attrib
ute.name

Name of the 
attribute with the 
last update time of 
the CI or 
relationship.

string N

dal.handle.statist
ics.on.startup=tr
ue

dal.statistics.start
up.percentage.th
reshold=5

dal.statistics.start
up.aging.thresho
ld.hours=36

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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Plug-in Parameters
This section describes the plug-in parameters: 

 

Quota Parameters
This section describes the quota parameters:

 

Parameter Name Parameter Description Type Value Description Change Value? 
(Y/N)

plugins.raw.event.
qualifiers

The list of attribute 
qualifiers relevant for 
raw events. If an 
attribute has one of the 
qualifiers in the list, this 
qualifier is sent as a raw 
event to the 
HP Universal CMDB 
server, to the event 
system.

string Names of attribute 
qualifiers must be 
separated by a 
semicolon (;). 

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

quota.name.custome
r.model.objects

The maximum 
number of CIs in a 
CIT. Every customer 
in HP Software-as-a-
Service mode has a 
maximum number.

integer For example, if 
the value is 100 
and the CIT 
already includes 
100 CIs, no 
additional CIs 
can be added.

N

quota.name.custome
r.tql.active

The maximum 
number of active 
TQLs that can be 
run concurrently.

integer When the quota 
limit is reached, 
no further TQLs 
can be added.

N
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quota.name.server.m
odel.objects

The maximum 
number of CIs that 
the CMDB server 
can hold in a CIT for 
all customers 
combined.

integer ➤ In 
HP Universal 
CMDB, the 
value must be 
the same as 
quota.name.cu
stomer.model.o
bjects. 

➤ In 
HP Software-
as-a-Service, 
the value must 
be greater than 
quota.name.cu
stomer.model.o
bjects. 

N

quota.name.server.tq
l.active

The maximum 
number of active 
TQLs that can run in 
the entire CMDB 
Server. 

integer ➤ In 
HP Universal 
CMDB, the 
value must be 
the same as 
quota.name.cu
stomer.tql.activ
e. 

➤ In 
HP Software-
as-a-Service, 
the value must 
be greater than 
quota.name.cu
stomer.tql.activ
e. 

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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quota.scheduler.inter
val.sec

The frequency in 
which the actual 
customer and server 
counts are checked 
against their defined 
quota value.

integer Value is in 
seconds.

N

quota.statistics.enabl
ed

Defines if quota 
counts should be 
returned to the Self-
Alert Monitor. This 
is relevant for 
HP Business 
Availability Center.

Boolean ➤ false. Do not 
return the 
quota count. 
This value is 
relevant for 
HP Universal 
CMDB.

➤ true. Return 
the quota 
count to the 
Self-Alert 
Monitor. This 
value is 
relevant for 
HP Business 
Availability 
Center.

N

quota.check.enabled Defines whether to 
enforce quota 
checking.

Boolean ➤ true. Perform 
quota 
checking.

➤ false. Do not 
perform quota 
checking.

N

quota.loader.name Defines where to 
load quota values.

string settings. Read 
from the 
HP Universal 
CMDB 
configuration 
file. 

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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System TQL Parameters
This section describes the threshold parameters that determine whether or 
not node conditions are stored in the system TQL. 

 

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

System TQL Cache 
Clean Frequency

Defines the 
frequency in which 
the system TQLs 
that are not used, 
and their results, are 
removed from the 
system.

integer The value is 
measured in 
hours.

N

System TQL Enabled Defines whether the 
system TQL 
component is 
enabled or not. 

Boolean ➤ true. System 
TQL is 
enabled.

➤ false. System 
TQL is not 
enabled.

N

System TQL’s Life 
Time

Defines the time 
after which a system 
TQL's results are 
deleted from the 
system if not used.

integer The value is in 
hours.

N

System TQL's Max 
Result Size 

Defines the 
maximum number 
of CIs returned for 
the node condition 
for the results to be 
held in the system 
TQL.

integer If the number 
exceeds the 
maximum, the 
node condition 
results are not 
held in the 
system TQL.

N
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System TQL's Min DB 
Query Time 

The minimum 
amount of time it 
takes for the 
database to calculate 
the node condition 
results above which 
a system TQL can be 
created to hold the 
results.

integer For example, if 
calculation time 
is less than 10 
seconds, then the 
node condition 
results are not 
stored in the 
system TQL.

The value is 
measured in 
milliseconds.

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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IT Universe Manager

This chapter provides information on IT Universe Manager.

This chapter includes:

Concepts

 ➤  IT Universe Manager Overview on page 54

 ➤  Working with Views in IT Universe Manager on page 55

 ➤  View Tree Structure on page 57

 ➤  Working with CIs on page 58

 ➤  Working with Relationships on page 62

Tasks

 ➤  Create CIs and Relationships in the CMDB on page 66

 ➤  Check Status of Application Discovery (Rediscover a View) on page 67

Reference

 ➤  IT Universe Manager User Interface on page 70
Concepts
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IT Universe Manager Overview

IT Universe Manager enables you to manage the content of your IT Universe 
model. The following tasks represent the basic functionality of the 
application:

➤ Creating CIs without creating relationships. You can define new CIs that are 
added to the CMDB individually, so that no new relationships are created. 
For details, see “Creating a Non-Related CI” on page 58.

➤ Creating CIs with relationships for them. You can define new CIs and attach 
them to existing CIs, so defining a new CI and a new relationship in the 
CMDB. For details, see “Creating a Related CI” on page 58.

➤ Adding existing CIs and creating relationships for them. You can attach CIs 
to an existing CI, so creating new relationships for existing CIs. For details, 
see “Attaching Existing CIs” on page 64.

➤ Deleting CIs. You can delete CIs from the CMDB. For details, see “Deleting 
CIs” on page 59.

Populating the IT Universe Model
The IT Universe model in the CMDB contains the CIs and relationships 
produced by the CI-generating tools that operate within HP Universal 
CMDB. Most CIs and relationships originate from one of the following 
sources:

➤ Discovery and Dependency Mapping (DDM). Automatically creates CIs and 
relationships based on the discovered IT resources and topology in your 
company’s infrastructure. For details, see “Discovery and Dependency 
Mapping – Overview” in Discovery and Dependency Mapping Guide.

➤ IT Universe Manager. Enables you to manually create CIs and relationships 
that represent logical and physical elements of the business. For details, see 
“Working with CIs” on page 58.

➤ Enrichment Manager. Enables you to add CIs and relationships to the 
CMDB by receiving data from the attributes of Enrichment nodes as defined 
in the Enrichment TQL query. For details, see “Enrichment Manager” on 
page 315.
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Working with Views in IT Universe Manager

In IT Universe Manager, you analyze data at the view level. Views are subsets 
of the IT Universe, containing only those CIs relating to a specific area of 
interest. All views are based on a pattern which determines the content of 
the view. 

➤ Pattern views and template based views are built from a TQL (Topology 
Query Language) query that defines the structure of the view. The view 
displays only those CIs and relationships that satisfy the query definition. 
You build pattern views and template based views in View Manager, while 
TQL queries are defined in Query Manager.

➤ Perspective based views are built manually, by selecting a group of CIs and 
applying a perspective to them. The perspective is a pattern used to define 
which related CIs are included in the view. You build perspective based 
views in the Modeling Studio.

For information on the different view types and how they function, see 
“View Formats” on page 150.

Note: You must have Change permissions for a view to edit a view. If you do 
not have the necessary permissions, contact your HP Universal CMDB 
Administrator.

CIs created by DDM are automatically added to each view where the CIs 
(and their relationships) fit the TQL definition for the view. When you open 
a view in View Explorer, the TQL query for the view queries the CMDB for 
CIs that match the defined pattern. If there are no matches (for example, in 
the case of a view for a DDM process where the process has not yet run) then 
the view remains empty.

When you define a new CI while working in any view in IT Universe 
Manager, the CI (and any associated relationship) is created in the CMDB. 
The CI is added to your current view only if it meets the view’s TQL 
specifications.
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If the created CI and relationship do not meet the TQL requirements, then 
the CI and relationship are created in the CMDB but are not visible in the 
view. Similarly, if you attach an existing CI to a CI in the view, and the new 
pattern does not meet the TQL requirements, then the attached CIs do not 
appear in the view, but the relationship is still created.

View Lifecycle
If you do not access a view from View Explorer for a specified period of time, 
the view is cleared out, to save memory in the system. It is not deleted from 
the CMDB; the view can be retrieved by clicking on it. The default time 
period for clearing out unused views is one hour. You can set the time period 
using the MAM Server configuration parameter Views Usage Untouched 
Time Before Empty View in Infrastructure Settings Manager. After changing 
the parameter’s value, you must execute the JMX command: Core 
manager\reloadSystemParamaters() for the change to take effect.

You can also modify the frequency with which the system checks whether a 
view has been accessed. The default frequency is for the system to check 
every 15 minutes. To change this value, select the Views Usage Check Time 
Interval parameter in Infrastructure Settings Manager. After you change the 
value, restart the server service for the change to take effect.

For details regarding Infrastructure Settings Manager, see “Infrastructure 
Settings Manager User Interface” on page 460.

Note: Views defined as persistent are not cleared out and always remain in 
the memory.
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View Tree Structure

Views are organized in a hierarchical tree format in the left pane of 
IT Universe Manager, which is known as View Explorer (it is also called CI 
Selector). The view name appears in the View box above the tree and acts as 
the containing folder for the CIs in the view. 

The first level of the View Explorer tree consists of the nodes for the root 
CIs. A root CI is the starting point for a view subtree. A view may contain 
any number of subtrees. Under the root CIs come the branch CIs, expanding 
down to the leaf CIs as the last nodes at the ends of each branch.

The CIs at each level in a subtree are considered to be attached to the CI on 
the branch directly above. This attachment generally depicts a dependent 
relationship, so that the higher branch (closer to the root CI) represents a 
component of your business that depends on the CIs on the next branch 
down (closer to the leaf CIs) in the business process. For example, an 
application depends on the servers running the application.

The attachment between a higher node and lower node is referred to as a 
parent-child relationship. The parent CI may have many attached child CIs, 
and the child CIs pass operational status to the parent.  

The tree topology is determined by the folding rules defined for the view. In 
a pattern view, these are defined for the specific view. In a template based or 
a perspective based view, the folding rules are defined as part of the template 
or perspective. For details on defining folding rules, see Add Rule in 
“Context Menu Options” on page 357.
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Working with CIs

In IT Universe Manager, you can create related and non-related CIs, delete 
CIs, edit the CI properties, and remove out-of-date CIs using the Aging 
Mechanism.

This section includes the following topics:

➤ “Creating a Non-Related CI” on page 58

➤ “Creating a Related CI” on page 58

➤ “Deleting CIs” on page 59

➤ “CI Properties” on page 60

➤ “Removing Out of Date CIs Using the Aging Mechanism” on page 61

Creating a Non-Related CI
You can define a new CI in IT Universe Manager by clicking the New CI 
button in the toolbar. The New CI dialog box opens, which enables you to 
define the properties for the new CI. The CI is created in the CMDB. For 
details, see “New CI Dialog Box” on page 94. 

Note: The CI is added to the view only if it meets the specifications of the 
pattern, template, or perspective of the view. 

A CI created in this way is added as an independent entity without any 
relationship to any other existing CI in the CMDB. 

Creating a Related CI
You can define a new CI to be added as a parent, child, or sibling of an 
existing CI. 

To define a new related CI:

 1 Select the CI in your view to which you want to attach the new CI.

 2 Click the New Related CI button in the toolbar.
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 3 In the New CI dialog box, define the properties and relationship for the CI. 
For details, see “New CI Dialog Box” on page 94.

The CI and relationship are created in the CMDB.

Note: The CI and relationship are added to the view only if they meet the 
specifications of the pattern, template, or perspective of the view. 

Deleting CIs
You can delete a CI by selecting Delete from CMDB from the context menu 
in IT Universe Manager. The CI is deleted from the CMDB and from all 
views. If the CI has children, they are not automatically deleted when you 
delete the parent CI. If you delete a CI without first deleting the relationship 
between the CI and any child CIs that appear with the parent CI in a view, 
the child CIs are removed from the view.

If the child CIs do not appear in any other view, they remain in the CMDB 
without appearing in a view. The child CIs might appear in the future in 
views where they meet the pattern requirements.

One exception to this rule is when the relationship between a child and 
parent CI is a Container link; in that case, when the parent CI is deleted, the 
contained CI is also removed from the CMDB. For example, if a host CI is 
the container for a child CPU CI, then when the host CI is deleted, the CPU 
is also removed from the CMDB.

When you delete a CI that was created by the DDM process, the CI is 
restored the next time that DDM runs (if the CI is still valid), and it 
reappears in all relevant views.
59



Chapter 2 • IT Universe Manager
CI Properties
In IT Universe Manager, you can edit the properties of a CI. The CI 
properties are divided into several categories which appear in the New CI 
dialog box:

➤ The general properties of a CI are common to all CIs. Some general 
properties are defined automatically during CI creation; others can only be 
defined manually in the New CI dialog box. 

➤ CIT-specific properties are created as part of the CIT definition in the CI 
Type Manager. The values for the CIT-specific properties are taken from the 
CIs discovered during DDM. The values can also be entered manually, when 
you manually create CIs to represent entities in your infrastructure. For 
details, see “CI Type Manager” on page 225.

➤ Key properties can be general or CIT-specific properties, which must be 
assigned a value to create an instance of the CI type.

You can access the Configuration Item Properties dialog box to view the CI 
properties from IT Universe Manager by right-clicking the CI and selecting 
Properties from the context menu or by clicking the Properties tab in the 
Advanced pane. You can edit the CI properties as well if you have the 
necessary permissions for editing CIs. For details on CI properties, see 
“Configuration Item Properties Dialog Box” on page 74.

The CIT-specific properties are displayed in the Specific Properties section of 
the Configuration Item Properties dialog box when you sort the properties 
using the Categorized button. Some properties for the automatically created 
CIs can be edited; however, if the CI is configured to Allow CI Update (in the 
General Properties), then DDM may override your changes when it updates 
the CI. A description of the selected property can be found in the 
Description area at the bottom of the Configuration Item Properties dialog 
box.

Some of the CIT-specific properties for DDM CIs are set by default to be 
monitored for changes. When one of these properties has been modified, 
information on the change can be viewed in a change report. For more 
information, see “Change Report” on page 585.
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Removing Out of Date CIs Using the Aging Mechanism
If a CI or relationship is not updated or refreshed over a period of time (for 
example, a CI is not rediscovered by DDM and no manual update occurs), 
an aging mechanism deletes the CI from the CMDB.

When the aging mechanism is enabled, the CI is marked for deletion if the 
CI has not been accessed for a specified period of time (by default, 14 days). 
The Last Access Time parameter is used to make the calculations. By default, 
the CI is deleted 28 days after the last access time. These default values are 
set per CIT and can be changed in the CI Type Manager.  

The aging mechanism for the CMDB is enabled or disabled from 
Infrastructure Settings Manager: Select Admin > Settings > Infrastructure 
Settings Manager, choose Foundations, select CMDB, and locate the Is 
Aging Enabled entry in the Aging Settings table. Change the value to true 
or false, as required.

When the aging mechanism is enabled for the CMDB in Infrastructure 
Settings, you can enable or disable aging and automatic deletion for 
individual CIs by setting the value of the Enable Aging field in the 
Configuration Item Properties dialog box. If the aging mechanism is 
disabled for the CMDB, the Enable Aging setting is ignored and no CIs are 
deleted.

Note: The default setting of the aging mechanism is disabled.
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Working with Relationships

Many of the relationships between CIs in the CMDB are created 
automatically, for example, by DDM. In addition, you can create 
relationships manually in IT Universe Manager, Enrichment Manager, 
Correlation Manager, Query Manager, Topology Report Manager, or View 
Manager.  

This section includes the following topics:

➤ “Creating Relationships” on page 62

➤ “Creating Hierarchical Relationships” on page 63

➤ “Attaching Existing CIs” on page 64

➤ “Adding Folding Rules to Relationships” on page 65

➤ “Deleting Relationships” on page 65

Creating Relationships
You can create relationships by right-clicking a CI or multiple CIs in the 
View Explorer pane or the Topology Map and selecting Relate to CI from the 
context menu. In the Topology Map, you can define a relationship between 
two CIs in the view by drawing a line between the two, using the Create 
Relationship button from the toolbar. Either of these actions opens the 
Insert Relationship dialog box. For details, see “Insert Relationship Dialog 
Box” on page 81.
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You can create as many relationships as necessary between a CI in the 
CMDB and other CIs. Each new relationship exists as its own entity in the 
CMDB, and has its own properties that can be edited in IT Universe 
Manager (as described in “Configuration Item Properties Dialog Box” on 
page 74). You can also create more than one relationship between the same 
two CIs, when each relationship is based on a different relationship type. In 
the following example, host7 has both a Backbone and a Talk relationship 
with host8.

Creating Hierarchical Relationships
By attaching one CI to another in IT Universe Manager  you create a 
hierarchical relationship (parent-child) between them, so that one CI is 
influenced by the other. 
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Certain relationships defined in this way are restricted to the relationship 
type Depends On (if the relationship is between two non-monitoring CIs), 
or the relationship type Monitored By (if the child CI in the relationship is a 
monitor type CI); however, other relationship types are used between 
specific types of CIs. For example, if a relationship is defined between two 
Host CIs, there are several possible relationship types. 

 

Note: When you attach a child CI to a parent CI, you are creating that 
relationship in the CMDB. The child therefore impacts on the parent CI in 
every view where the relationship exists, and is displayed in every view 
where the child and relationship match the TQL. 

Attaching Existing CIs
You can attach existing CIs using the Insert Relationship dialog box. The 
dialog box has two modes:

➤ Selecting the CIs that you want to attach.

➤ Defining the relationship between the original CI and the CIs to attach. For 
information on relationships, see “Working with Relationships” on page 62.
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When selecting the CIs to attach, you can select multiple CIs from a view to 
attach to the original CI. However, all CIs that you want to attach in one 
operation must have the same relationship type. For example, you cannot 
attach a CI that uses the relationship Depends On in the same operation as a 
CI that uses the relationship Monitored By.

You cannot create an identical relationship between the same CIs twice 
within a view. For example, if parent CI Italy depends on child CI Rome, 
Rome appears under the CI Italy in the view. If you then again attach Rome 
to Italy with a Depends On relationship, Rome still appears once only under 
that parent CI. 

Adding Folding Rules to Relationships
After setting the node and relationship definitions of a view, you can add 
folding rules to selected relationships in View Manager. This enables you to 
define the organizational structure of CIs in the Topology Map by displaying 
selected CIs at different levels. When no folding rules are defined, the 
Topology Map displays all CIs included in the query results on one level by 
default. For example, if the query results include hosts and networks, both 
CI types are displayed on the same level in the Topology Map.

Note: The maximum number of CIs that can be displayed in a single layer is 
900. If a view contains a layer with more than 900 CIs, the view is not 
displayed in the Topology Map until the folding rules are changed.

For details on adding folding rules, see Add Rule in “Context Menu 
Options” on page 357.

Deleting Relationships
The Topology Map shows only the relationships for the CIs that are part of 
the current view; however, the same relationships may also be part of other 
views. When you delete a relationship in IT Universe Manager, it is deleted 
from the CMDB and from all views.
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When a relationship is deleted, the CI on the other end of the relationship 
may remain in the view, if it still matches the pattern of the view.  In a 
perspective based view, you can remove the CI completely from the view 
(without deleting it from the CMDB), by deleting it from the view in the 
View Editor in the Modeling Studio.

When you delete a relationship that was created by the DDM process, the 
relationship is restored the next time that DDM runs (if the relationship is 
still valid), and it reappears in all relevant pattern views.

It can take a few minutes to delete subtrees, or multiple CIs and 
relationships, from a view.

Tasks

Create CIs and Relationships in the CMDB

This task describes how to create related and non-related CIs, as well as 
relationships between CIs, in the CMDB.

This task includes the following steps:

➤ “Define a New Non-related CI” on page 66

➤ “Define a New Related CI” on page 66

➤ “Attach Existing CIs” on page 67

 1 Define a New Non-related CI
Click the New CI button in the toolbar. In the New CI dialog box, select a CI 
type from the tree and define the properties for the new CI. For details, see 
“New CI Dialog Box” on page 94.

 2 Define a New Related CI
Click the New Related CI button in the toolbar. In the New CI dialog box, 
select a CI type from the tree and define the properties for the new CI. On 
the Relationship page of the dialog box, select the type of relationship and 
define its properties. For details, see “New CI Dialog Box” on page 94.
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 3 Attach Existing CIs
Select a CI in a view. Right-click the CI and select Relate to CI. In the Insert 
Relationship dialog box, select a target CI. On the Relationship page of the 
dialog box, select the type of relationship and define its properties. For 
details, see “Insert Relationship Dialog Box” on page 81.

Check Status of Application Discovery (Rediscover a 
View)

You, the application owner or administrator, need to be kept informed of 
any problems to your application. So, for example, you need to know that 
discovery is working correctly and that its current configuration can 
connect to the application database. This section explains how to run the 
rediscovery procedure that enables you to check the current status of the 
discovery of an application.

Note: 

➤ Set up and configuration is performed by the UCMDB administrator. For 
details, see “Prerequisites” on page 68.

➤ Rediscovery is performed by the application owner/administrator. For 
details, see “Access the View” on page 69.

➤ You do not need any knowledge of Discovery and Dependency Mapping 
(DDM) to run this procedure.

➤ By default, you can run the rediscovery procedure on views that include 
less than 10,000 CIs. For details on changing this number, see 
“Important Information” on page 79.
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This task includes the following steps:

➤ “Prerequisites” on page 68

➤ “Access the View” on page 69

➤ “View Results in the View” on page 69

➤ “Schedule the Rediscovery” on page 69

 1 Prerequisites

Note: This step is performed by the UCMDB administrator.

 a In DDM, create a module that contains the jobs that must discover the 
application. For details, see “Run Discovery – Advanced Mode Workflow” 
in Discovery and Dependency Mapping Guide. 

 b Activate the module and all the jobs. The jobs must remain activated.

 c Verify that the module has run without errors. For details, see “Manage 
Errors” and “Discovery Status Pane” in Discovery and Dependency Mapping 
Guide. 

 d Correct any errors in the application and confirm that DDM finds no 
errors during the next run. 

Important: The application owner cannot rediscover a view if DDM is 
reporting errors. You must set an error-free baseline.

 e In View Manager, define a view that includes the application CI or CIs to 
be rediscovered. These are the CIs that are created when you activate the 
jobs that discover the application. For details, see “View Manager 
Overview” on page 150. 

 f Notify the application owner of the name of the view. 
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 2 Access the View

Note: This step is performed by the application owner/administrator.

In IT Universe Manager, access the view that includes the application CIs to 
be rediscovered. For details, see “Search for CIs in Search Mode” on 
page 671. 

 3 View Results in the View

 a You need to check the complete application. You click the Rediscover 
View Content button in the CI Selector toolbar. The Show Discovery 
Status and Changes of View dialog box is displayed. The dialog box 
displays information about which jobs and trigger CIs discovered the CIs 
in the view, on the last occasion that DDM ran the discovery for the jobs. 
For details, see “Discovery and Changes Summary Dialog Box” on 
page 79.

To run the discovery, click the Rerun Discovery button. To view 
information about the jobs and trigger CIs, use the links to drill down. 
For details, see “Managing Problems With Error Reporting” in Discovery 
and Dependency Mapping Guide.

 b You need to check specific components of your application. You select 
the component’s CI in the Topology Map pane and display the Discovery 
tab in the Advanced pane. For details, see “Discovery and Changes 
Summary Dialog Box” on page 79.

To rediscover several CIs, press CTRL, select the CIs and display the 
Discovery tab.

To run the discovery, click the Rerun Discovery button.

 4 Schedule the Rediscovery
You can schedule how often the rediscovery procedure should run. In the 
Job Definition window, choose the Run Discovery on View action. For 
details, see “Job Scheduler Window” on page 503.

Reference
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IT Universe Manager User Interface

This section describes:

 ➤  Add Background Image Dialog Box on page 71

 ➤  CI/Relationship History Dialog Box on page 72

 ➤  Configuration Item Properties Dialog Box on page 74

 ➤  Discovery and Changes Summary Dialog Box on page 79

 ➤  Get Related CIs Report on page 80

 ➤  Insert Relationship Dialog Box on page 81

 ➤  IT Universe Manager Window on page 86

 ➤  New CI Dialog Box on page 94

 ➤  Related CIs in View/Database Map on page 99
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Add Background Image Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to add an image as a background to a view as a 
navigational aid.

To access: In IT Universe Manager, select Layout > Add 
Background Image from the toolbar.

Important 
Information

You can add an image file (of .gif type) as the background 
image of a view. This can be used as a navigational aid, for 
example, for global networks containing different networks 
in different countries. 

You can add additional background images to the existing 
list by inserting image files (of .gif type) to the following 
location: 

<HP Universal CMDB root directory>\UCMDBServer\j2f
\AppServer\webapps\site.war\images\gui\mam_images
\gui\images\backgrounds.

Tip: Before copying this URL to a browser, copy to a text 
editor and remove the break markups (<br />).

Note: This option is only active when Manual Layout is 
selected as the layout for the view.

GUI Element (A–Z) Description

Background 
Image

Displays the selected image.

File Name Contains a list of the available image files. Select the file 
name of the image you want to appear in the view and click 
OK. To remove an image from a view, select None in the File 
Name list and click OK. Select Layout > Save Layout to save 
your changes.
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CI/Relationship History Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a list of attributes in which changes have 
occurred as well as the differences between two 
configuration files.

To access: 

➤ In IT Universe Manager, right-click the selected CI or 
relationship in View Explorer or the Topology Map and 
select CI History from the context menu.

➤ In Discovery and Dependency Mapping, in the 
Discovered by [Module or Job Name] CIs dialog box, 
right-click a CI and choose CI History. 

GUI Element (A–Z) Description

Click Refresh to refresh the data in the table.

View the difference between two configuration files. 
Select two CIs of type configfile and click the Show 
difference button to open the Visualdiff report, which 
displays a comparison of the two files. Text added to the 
second file appears highlighted in yellow. Text removed 
from the first file appears highlighted in red. Differences 
between the files appear highlighted in green. 
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Choose the export format for the table data. The available 
options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. In 
Solaris, you can specify the list separator in the 
application that opens the CSV file.

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

Attribute The name of the attribute.

Change Date The date when the last change occurred.

Filter by Filter the data in the table by one or more of the 
following filters:

➤ Time Range. Select the time period for which the CI 
history is displayed.

➤ Change Type. Select the type of changes displayed in 
the table.

➤ Attribute. Select the attribute types displayed in the 
table.

GUI Element (A–Z) Description
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Configuration Item Properties Dialog Box

Modified By Indicates the cause of the change. For example, the field 
can contain the name of a user or a DDM job.

New Value The new value of the attribute.

Old Value The previous value of the attribute.

Description Enables you to view and edit basic information for an 
existing CI or relationship.

To access: Select Admin > Modeling > IT Universe Manager 
and use one of the following:

➤ Select a CI in the topology map or View Explorer. In the 
Advanced Pane, select the Properties tab and click Edit. 

➤ Right-click a CI in View Explorer or the Topology map 
and select Properties.

Important 
Information

The Configuration Item Properties dialog box contains two 
types of properties: 

➤ General properties, which include general information 
about the CI or relationship. These properties are 
common to all CITs and are documented below.

➤ CIT-specific properties, which include properties specific 
to that CI. These properties vary according to the type of 
CI or relationship and are not documented .

When you sort the properties by category, the CIT-specific 
properties appear at the top of the list and the general 
properties appear at the bottom.

You can view a description of the selected property in the 
Description Area at the bottom of the dialog box. Click the 
Show/Hide Description Area button to display the 
Description Area.

Mandatory fields are denoted by an asterisk.

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Click to display the properties by category.

Click to display the properties alphabetically.

Toggles between showing and hiding the description area at 
the bottom of the Properties window.

Click Expand to expand the properties tree when the 
properties are displayed by category.

Click Collapse to collapse the properties tree when the 
properties are displayed by category.
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Choose the export format for the table data. The available 
options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the Control 
Panel, and on the Numbers tab ensure that the comma is 
defined as the List Separator value. In Solaris, you can 
specify the list separator in the application that opens 
the CSV file.

➤ XML. The table data is formatted as an XML file that can 
be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

Actual Deletion 
Period

The number of days after which the CI or relationship is 
deleted.

Allow CI Update When selected, this option allows the DDM process to 
automatically update the CI or relationship properties with 
information that it discovers. If you change the value of a 
property supplied by the DDM process, the value is 
overridden by the discovered value.

When this option is cleared, the CI or relationship 
properties are not overridden by the DDM process.

Apply Click Apply to save the changes made to the CI or 
relationship properties.

GUI Element (A–Z) Description
76



Chapter 2 • IT Universe Manager
City The name of the city. The list is automatically updated 
when you select a country (or state, when applicable). Select 
an option from the list.

Note: This field does not appear for relationships.

CI Type The type of the CI or relationship (read-only value). For 
information about CITs in HP Universal CMDB, see “CI 
Type Manager” on page 225.

Country The country in which the CI is located. Select an option 
from the list. 

Note: This field does not appear for relationships.

Created By The user name of the administrator who manually created 
the CI or relationship, where applicable (read-only value).

Create Time The date and time when the CI or relationship was created.

Deletion 
Candidate Period

The number of days after which the CI or relationship 
becomes a candidate for deletion.

Description A brief description of the CI or relationship.

Display Label The name of the CI or relationship as it appears in View 
Explorer.

Edit In the Properties tab of the Advanced pane, you can view a 
CI’s properties but you cannot edit them. Click Edit to open 
the Configuration Item Properties dialog box where you can 
edit the properties.

Enable Aging Enables the aging mechanism for this CI or relationship. It 
is selected by default for DDM CIs. This field is only 
displayed for certain CIs. For details, see “Removing Out of 
Date CIs Using the Aging Mechanism” on page 61.

ID The internal ID of the CI or relationship in the CMDB (read-
only value).

GUI Element (A–Z) Description
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Context Menu

Last Access Time The time that the CI or relationship was last accessed, 
whether when being updated or being discovered by DDM. 
This field is only displayed for certain CIs.

This parameter is used by the aging mechanism – for details, 
see “Removing Out of Date CIs Using the Aging 
Mechanism” on page 61.

Name The name of the CI or relationship.

Note Enables you to enter other information about the CI or 
relationship.

Origin An ID for the source that automatically created the CI or 
relationship, or the application where the CI or relationship 
was created (read-only value).

Reset Click the Reset button to restore the original property 
settings of the CI or relationship.

State The name of the state – when applicable for the selected 
country. The list is automatically updated when you select a 
country. Select an option from the list.

Note: This field does not appear for relationships.

Updated by The user name of the administrator who updated the CI or 
relationship properties.

Update Time The date and time when the CI or relationship properties 
were last updated.

User Label Enables you to define a display label for the CI or 
relationship. If no value is entered, the CI name appears as 
the default label.

Menu Item Description

Copy Property Name Copies the name of the selected property to the memory.

Copy Property Value Copies the value of the selected property to the memory.

GUI Element (A–Z) Description
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Discovery and Changes Summary Dialog Box

Description Enables you to find recent changes, for example, to an 
application, by rediscovering the CIs and jobs in a view. 

To access: In IT Universe Manager:

➤ To rediscover all CIs of a view, click the Show 
Discovery and Changes Summary button  in the CI 
Selector toolbar. The Discovery and Changes Summary 
dialog box is displayed.

➤ To rediscover one CI or several CIs in a view, select the 
CI and display the Discovery tab.

To rediscover CIs, you can also select Operations > 
Rediscover View Content.

Important 
Information

By default, you can run the rediscovery procedure on 
views that include less than 10,000 CIs. 

To increase the number of CIs that you can rediscover in 
a view:
1  Access the Infrastructure Settings Manager (Settings > 

Infrastructure Settings Manager).

2  Select the Foundations context, choose 
MamAutoDiscovery from the list, and locate the Max 
CIs in view supported to rediscover entry in the 
MamAutoDiscovery - General table. 

3  Click the Edit button and change the number.

4  Restart the server for the change to take effect.

For details on working with the Infrastructure Settings 
Manager, see Chapter 13, “Infrastructure Settings 
Manager.”

Included in Tasks “Check Status of Application Discovery (Rediscover a 
View)” on page 67

Useful Links “Discovery Status Pane” in Discovery and Dependency 
Mapping Guide
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Get Related CIs Report

GUI Element (A-Z) Description

Click to refresh the status of the selected CIs.

This button is disabled when there is no data to be 
reloaded.

Click to rerun the discovery.

Discovery Progress 
Status on View

For details, see “Discovery Status Pane” in Discovery and 
Dependency Mapping Guide.

History Changes on 
View

For details, see “CI/Relationship History Dialog Box” on 
page 72.

Description Enables you to view the CIs related to a specified CI in a 
tree format.

To access: In IT Universe Manager, click Generate Related 
CIs Report  from the toolbar.

Important 
Information

➤ For information about limitations on the size of reports 
produced in .pdf format, see “Troubleshooting and 
Limitations” in Reference Information. 

➤ For details on how to work with reports, see “Working 
in Reports - Overview” in Reference Information.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Insert Relationship Dialog Box

GUI Element (A–Z) Description

<Related CIs data> The report data consists of the CIs related to the selected 
CI, arranged in tree format with the selected CI as the 
root. The child CIs are arranged by CIT.

Generate Click the Generate button to generate the data for the 
selected period.

Description Enables you to attach CIs to the CI you selected in View 
Explorer.

To access: In IT Universe Manager, right-click a CI in the 
Topology Map or View Explorer, and select Relate to CI from 
the context menu.

Important 
Information

To create a relationship between two CIs, select the source 
CI in View Explorer or the Topology Map and then select 
Relate to CI from the context menu. On the first page of the 
dialog box (the CI Selection page), you select the target 
CI(s). Then click Relationship, to select the relationship type 
on the second page of the dialog box.

You can also create a relationship between two CIs 
graphically by clicking the Create Relationship button  
in the toolbar and drawing a line between the two CIs. In 
this case, a smaller version of the Insert Relationship dialog 
box opens, which contains the following tabs:

➤ Select Relationship. Displays a tree with the available 
relationship types. Select the required relationship.

Note: You can double-click the relationship you select to 
save using the default properties.

➤ Relationship Definition. Displays the properties of the 
selected relationship. You can edit the properties as 
described in “Define Relationship Properties Pane” on 
page 83.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Relationship Page

Included in Tasks “Create CIs and Relationships in the CMDB” on page 66

Useful Links “View Explorer” on page 676

GUI Element (A–Z) Description

Click to add the selected CIs in the left pane to the Target 
CIs pane.

Click to remove selected CIs from the Target CIs pane (this 
does not delete the CIs from the CMDB).

Select target CIs Select a view to display in the view tree and select CIs to 
move to the Target CIs pane.

The Select target CIs pane follows the standard View 
Explorer functionality. For details, see “View Explorer” on 
page 676. 

Source CI The CI you selected as the source CI.

Target CIs Displays the CIs you have selected as target CIs for the 
relationship.

Description Enables you to define the relationship to be created between 
the original CI and the CIs selected in the CI Selection page 
of the dialog box.

To access: Click the Relationship button from the Insert 
Relationship dialog box.

Important 
Information

When defining multiple relationships, you can define 
different descriptions and property values for each 
relationship: Skip the property definitions here and edit 
each relationship individually after it is created.
82



Chapter 2 • IT Universe Manager
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Select Relationship Pane

Define Relationship Properties Pane

GUI Element (A–Z) Description

Direction Select the direction of the relationship.

For some relationship types (for example, Container link, or 
between a group CI and a monitor CI), only one direction is 
valid. 

Relationship Define the type of relationship created between the original 
CI and the CIs being attached. Select an option from the 
list. For most relationships, only the Depends On option or 
the Monitored By option is available, depending on the 
type of CIs for which you are creating a relationship.

Source CI Displays the name of the CI on the first end of the 
relationship. This is the CI that you selected in the view.

Target CI Displays the name of the CI on the second end of the 
relationship, that is attached to the original CI.

GUI Element (A–Z) Description

Actual Deletion 
Period

The period after which the relationship is deleted when the 
aging mechanism is enabled.

Allow CI Update When the value is set to true, the DDM process 
automatically updates the relationship.

Created By The user name of the administrator who manually created 
the relationship, where applicable.

Create Time The date and time when the relationship was created.

Deletion 
Candidate Period

The number of days after which the relationship becomes a 
candidate for deletion.

Description A detailed description of the relationship.
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Destination 
Network Address

Defined only for route links. Indicates the destination 
network address to which this route is configured.

Enable Aging (Only displayed for certain CIs.) When the value is set to 
true, the aging mechanism is enabled for this relationship. It 
is selected by default for DDM CIs. For details, see 
“Removing Out of Date CIs Using the Aging Mechanism” 
on page 61.

Last Access Time The time that the relationship was last accessed, whether 
when being updated or being discovered by DDM. This field 
is displayed only for certain CIs.

Must When the value is set to true, the child CI is dominant when 
the percentage rule is used to calculate status for the parent 
CI. If the CI has low status, the parent must take the child 
CI status, if necessary overriding the percentage rule 
calculation. This is useful to give emphasis to an important 
CI. For example, you might want to define Must for a 
database CI, so that status is critical all the way up the 
subtree if the database falls, regardless of the status of the 
other CIs in the subtree.

The must status defined for a relationship applies for that 
relationship only – it is not used in any other relationships 
of the child CI. 

Name A brief description of the relationship. If no value is entered, 
the relationship type is used in place of the name.

Note Enables you to enter other information about the 
relationship.

Origin An ID for the source that automatically created the 
relationship, or the application where the relationship was 
created.

Updated By The user name of the administrator who updated the CI 
properties.

Update Time The date and time when the relationship properties were 
last updated.

GUI Element (A–Z) Description
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User Label Enables you to define a display label for the relationship. If 
no value is entered, the relationship name appears as the 
default label.

Weight When a weight value is entered, the child CI is given more 
weight in percentage calculations, when percentage rule is 
used to calculate status for the parent CI. For example, if a 
child CI is given a weight of 3, then it has three times more 
impact on the parent status calculation than its unweighted 
siblings.

The weight defined for a relationship applies for that 
relationship only – it is not used in any other relationships 
the child CI may have. 

GUI Element (A–Z) Description
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IT Universe Manager Window

Description Enables you to define and manage the CIs and 
relationships in your views.

The IT Universe Manager window contains the following 
panes:

➤ View Explorer (CI Selector). Displays the CIs of a 
selected view. You can select the view from a 
drop–down list. For details, see “View Explorer” on 
page 676.

➤ Topology Map. Displays the CIs of a selected view in 
Map mode or Text mode.

➤ Advanced Pane. Displays properties, history, and 
discovery data for the selected CI or view.

To access: Select Admin > Modeling > IT Universe 
Manager.

Important 
Information

When working in a view in IT Universe Manager, you can 
create new CIs, modify existing CIs, or delete CIs. All of 
these actions have a direct effect on the entire IT Universe 
model. For example, if you delete a CI in your view, that 
CI is deleted from the IT Universe model and no longer 
appears in any view.

Useful Links ➤ “Save Snapshot Dialog Box” on page 539

➤ “Set View Parameters/Set View Element Parameters 
Dialog Box” on page 183
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Topology Map

Description Displays the CIs of the currently selected view in 
graphical or table format. By default, the CIs are 
displayed in graphical format.

➤ Select the Map Mode tab to display the CIs in 
graphical format.

➤ Select the Text Mode tab to display the CIs in tabular 
format.

To access: Select Admin > Modeling > IT Universe 
Manager.

Important 
Information

When you select a CI in View Explorer or the Topology 
Map, the Configuration Items drop-down in the Main 
Menu becomes active. The options available under that 
drop-down are the same as those available by right-
clicking the CI.

You can customize the Topology Map context menu to 
include other commands (for example, ping, run a 
program, open a URL) from within CI Type Manager. For 
details, see “Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard” on 
page 245.

Note: For grouped CIs and the relationships between 
them, not all of the context menu options are active. 
Grouped CIs appear in parentheses in View Explorer and 
in the Topology Map. You can double-click a link to a 
grouped CI to open the Link Map, which displays the 
individual CIs and relationships. Right-click a CI or 
relationship in the Link Map to display the regular 
context menu. For details about grouping CIs, see 
“Node/Relationship Grouping Dialog Box” on page 179.
87



Chapter 2 • IT Universe Manager
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Select the topology map mode from the Show window in 
the toolbar. 

Note: You can also select the modes from the Operations 
drop-down in the Main Menu. 

The following modes are available:

➤ View Results. Displays an entire layer within a view.

➤ Related in View. Displays the interdependencies of the 
selected CI within the current view.

➤ Related in DB. Displays the interdependencies of the 
selected CI within the entire CMDB.

Specify the CIT you want displayed in the table. The table 
also includes the children of the selected CIT.

Note: This option is displayed in Text mode only.
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Choose the export format for the table data. The available 
options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. In Solaris, 
you can specify the list separator in the application 
that opens the CSV file.

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

Note: This option is displayed in Text mode only.

<Main Menu> For details, see “Main Menu” on page 713.

<Node> The nodes in the topology map represent CIs.

Hold the pointer over a node to display its tooltip which 
describes the type of the CI.

<Relationship> The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, 
which describes the type of the relationship.

Note: When you select a calculated relationship, the 
Delete  button in the toolbar is disabled. 

GUI Element (A–Z) Description
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<Toolbar> For details, see “Toolbar Options” on page 717Note: 
When accessing the Topology map via direct links, the 
toolbar includes options from the Related CIs Map. For 
details, see “Related CIs in View/Database Map” on 
page 99.

<CI type attributes> The columns appearing in Text mode represent the CIT 
attributes of the selected CIs.

Map Mode Click the Map Mode tab to display the selected layer of 
CIs in topology map format.

Text Mode Click the Text Mode tab to display the attribute 
properties of the CIs in the selected layer in table format.

For details on some of the toolbar icons in Text Mode, see 
“Element Instances Dialog Box” on page 394.

GUI Element (A–Z) Description
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IT Universe Manager Context Menu

The IT Universe Manager window includes the following elements (listed 
alphabetically) available by right-clicking a CI or relationship in the View 
Explorer pane or Topology Map:

Menu Item Description

Actions Select one of the following options:

➤ Add CI to Discovery Job. Displays the Add CI to 
Discovery Job dialog box, which enables you to 
manually invoke a DDM job for the selected CI. You 
can use this option to discover additional information 
about the CI through one of the available DDM jobs.

➤ Remove CI from Discovery Job. Displays the Remove 
CI from Discovery Job dialog box, which enables you 
to manually remove a CI from the DDM job.

➤ Open Credentials Information. Displays the Protocol 
Parameters dialog box, which enables you to enter 
credentials for the selected CI. This option is only 
relevant for CIs that require credentials to be viewed. 
For details, see “Domain Credential References” in 
Discovery and Dependency Mapping Guide.

➤ Show Discovery status. Opens the Discovery Status 
dialog box for the selected CI.

CI/Relationship 
History

Displays the CI History dialog box. For details, see 
“CI/Relationship History Dialog Box” on page 72.

Delete from CMDB Enables you to delete the selected CI or relationship from 
the view and from the CMDB.

Note: When you delete a parent CI, the selected CI and 
its children are removed from the view, but only the 
selected CI is removed from the database.

Generate Direct Link 
to CI

Enables you to create a direct link to the selected CI using 
the Direct Links Wizard. For details, see “Direct Link 
Dialog Box” on page 440.
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Get Related CIs The following options are available:

➤ From View. Opens the Related CIs in View Map.

➤ From Database without Filter. Opens the Related CIs in 
Database without Filter Map.

➤ From Database with Filter. Opens a dialog box that 
displays the number of related CIs by type. Select the 
CI type you want to display in the Related CIs Map 
and click OK.

➤ Reveal From Database without Filter. Adds to the 
existing map the immediate neighbors of the selected 
CI in the CMDB. This option is only active within the 
Related in DB mode of the Topology Map.

➤ Reveal From Database with Filter. Opens a dialog box 
which displays the number of related CIs by type. 
Select the CI type you want to display in the Topology 
Map results. Adds to the existing map the immediate 
neighbors of the selected CI that match the CI type 
selected. This option is only active within the Related 
in DB mode of the Topology Map.

➤ Reveal from View. Adds to the existing map the 
immediate neighbors of the selected CI in the view. 
This option is only active within the Related in View 
mode of the Topology Map.

Label Select one of the following options:

➤ Edit Label. Opens the Edit Label dialog box which 
enables you to edit the name of the CI.

➤ Reset Label. Resets the CI name to its default value 
from the CMDB.

Note Select one of the following options:

➤ Add Note. Opens an editing box where you can add a 
note to the CI.

➤ Delete Note. Deletes all text saved in a note for the 
selected CI.

Open Appears only for configuration file CIs. Opens the 
configuration file in a popup window.

Menu Item Description
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Advanced Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Properties Displays the Properties page for the selected CI or 
relationship. For details, see “Configuration Item 
Properties Dialog Box” on page 74.

Relate to CI Opens the Insert Relationship dialog box. For details, see 
“Insert Relationship Dialog Box” on page 81.

Show Compound 
Path

Appears only for compound relationships. Displays the 
Link Map for the selected relationship, which shows the 
CIs involved in the compound relationship.

Show Differences Appears only for configuration file CIs. When two such 
CIs are selected, the option is active. Displays the 
differences between the two configuration files in a 
popup window. For details, see “CI/Relationship History 
Dialog Box” on page 72.

Straighten Straightens the relationship between two nodes. This 
option is only available for relationships that have angles.

View Sublayer Displays a popup window showing the CIs in the layer 
beneath the selected CI.

Note: This option is only active for CIs with children.

GUI Element (A–Z) Description

Discovery tab Displays the DDM run status for the selected CIs. For 
details, see “Discovery and Changes Summary Dialog 
Box” on page 79 and “Discovery Status Pane” in Discovery 
and Dependency Mapping Guide.

Menu Item Description
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New CI Dialog Box

History tab  Displays the history for the selected CI. For details, see 
“CI/Relationship History Dialog Box” on page 72.  

Properties tab Displays the selected CI’s properties (the same properties 
that appear in the Configuration Item Properties dialog 
box). You can view the properties in the properties tab, 
but you must open the dialog box to edit the properties. 
For details, see “Configuration Item Properties Dialog 
Box” on page 74.

Description Enables you to define a new CI.

To access: In IT Universe Manager, click the New CI icon  
in the toolbar to create a non-related CI. Select a CI in the 
topology map and click the New Related CI icon  to 
create a related CI.

Important 
Information

To define a new CI, select the CI type from the tree at the 
top of the dialog box. The CI types in the tree that are 
available to be instantiated appear in black. The CI types in 
faded text cannot be instantiated.

Edit the properties in the Define new CI properties area. The 
table below includes the properties which are common to 
all CIs. In addition, there are other properties specific to 
each CI.

If you are creating a related CI, click the Relationship button 
to go to the relationship mode of the dialog box. Select a 
relationship and edit its properties.

Included in Tasks “Create CIs and Relationships in the CMDB” on page 66

Useful Links “View Explorer” on page 676

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Actual Deletion 
Period

The period after which the CI is deleted when the aging 
mechanism is enabled.

Allow CI Update When the value is set to true, this option enables the DDM 
process to automatically update the CI properties with 
information that it discovers. If you change the value of a 
property supplied by the DDM process, the value is 
overridden by the discovered value.

When the value is set to false, the CI properties are not 
overridden by the DDM process.

City The name of the city. The list is automatically updated 
when you select a country (or state, when applicable). Select 
an option from the list.

Country The country in which the CI is located. Select an option 
from the list. 

Created By The user name of the administrator who manually created 
the CI, where applicable.

Create Time The date and time when the CI was created.

Deletion 
Candidate Period

The period after which the CI becomes a candidate for 
deletion when the aging mechanism is enabled.

Description A description of the CI.

Display Label The label that appears for the CI in the topology map.

Enable Aging When the value is set to true, the aging mechanism is 
enabled for this CI. It is selected by default for DDM CIs. For 
details, see “Removing Out of Date CIs Using the Aging 
Mechanism” on page 61.

Default value: false.

Note: This field is only displayed for certain CIs.
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Last Access Time The time that the CI was last accessed, whether when being 
updated or being discovered by DDM. This field is displayed 
only for certain CIs.

This parameter is used by the aging mechanism. For details, 
see “Removing Out of Date CIs Using the Aging 
Mechanism” on page 61.

Name The name of the CI.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the CI, or 
the application where the CI was created.

Relationship For a related CI, click Relationship to go to the relationship 
mode of the dialog box.

State The name of the state – when applicable for the selected 
country. The list is automatically updated when you select a 
country. Select an option from the list.

Select CI Type Enables you to select the CI type from the tree for the new 
CI. The CI types that are available for the selected CI or view 
appear active in the CI type tree. The other CI types appear 
in faded text and cannot be selected.

To limit the CI type tree to CI types from the current view, 
select CI Types from the current view on the right. To 
display all CI types in the tree, select All CI Types.

Updated By The user name of the administrator who updated the CI 
properties.

Update Time The date and time when the CI properties were last updated.

User Label Enables you to define a display label for the CI. If no value is 
entered, the CI name appears as the default label.

GUI Element (A–Z) Description
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Relationship Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define the relationship between the new CI 
and the CI selected in the view, as well as the properties of 
the relationship.

To access: Click the Relationship button from the New 
Related CI dialog box.

GUI Element (A–Z) Description

Allow CI Update When the value is set to true, the DDM process 
automatically updates the relationship.

CI Definition Click CI Definition to return to the CI properties mode of 
the dialog box.

Created By The user name of the administrator who manually created 
the relationship, where applicable.

Create Time The date and time when the relationship was created.

Description A description of the relationship.

Direction Select the relationship direction from the drop-down box.

Enable Aging Enables the aging mechanism for the CI being created. It is 
selected by default for DDM CIs.

Last Access Time The time that the CI was last accessed, whether when being 
updated or being discovered by DDM. This field is only 
displayed for certain CIs.
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Must When the value is set to true, the child CI is dominant 
when the percentage rule is used to calculate status for the 
parent CI. If the CI has low status, the parent must take the 
child CI status, overriding the percentage rule calculation if 
necessary. This is useful to give emphasis to an important 
CI. For example, you might want to define Must for a 
database CI, so that status is critical all the way up the 
subtree if the database falls, regardless of the status of the 
other CIs in the subtree.

The Must status defined for a relationship applies to that 
relationship only – it is not used in any other relationships 
of the child CI.

Name The name of the CI.

Network Address Defined only for route links. Indicates the destination 
network address to which this route is configured.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the 
relationship, or the application where the relationship was 
created.

Relationship Enables you to define the type of relationship that is created 
between the two CIs. For most relationships, only the 
Depends On option is available.

Source CI The name of the CI on the first side of the relationship. This 
is the CI that you selected in the view.

Target CI The name of the CI on the second side of the relationship. 
This is the new CI that you are creating.

Updated By The user name of the administrator who updated the 
relationship properties.

Update Time The date and time when the CI properties were last updated.

GUI Element (A–Z) Description
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Related CIs in View/Database Map

User Label Enables you to define a display label for the relationship.

Weight When a weight value is entered, the child CI is given more 
weight in percentage calculations, when the percentage rule 
is used to calculate status for the parent CI. For example, if a 
child CI is given a weight of 3, then it has three times more 
impact on the parent status calculation than its unweighted 
siblings.

The weight defined for a relationship applies to that 
relationship only – it is not used in any other relationships 
of the child CI.

Description Enables you to view the CIs related to a specified CI in the 
view or the CMDB in map or table format.

To access: In IT Universe Manager, right-click the required 
CI and select Get Related CIs > From View or From 
Database with Filter or From Database without Filter.

Important 
Information

When you select From View, the Related CIs Map displays 
related CIs in the current view. When you select From 
Database without Filter, the Related CIs Map displays 
related CIs in the CMDB. When you select From Database 
with Filter, you first select the CI types you want to see in 
the map, which then displays related CIs of those types in 
the CMDB.

The related CIs can be viewed in map mode or in text 
mode. The text mode format of the map includes the 
icons found in the Element Instances dialog box. For 
details, see “Element Instances Dialog Box” on page 394.

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Click Place in Center to place the map in the center of the 
window.

Click Fit to Window to fit the map to the size of the 
window.

Click Export Map to Image to save the map to a file.

Click Print... to open the Print Preview dialog box, which 
enables you to preview or print the map.

Click Layout Properties to open the Layout Properties 
dialog box which enables you to modify the layout.

Click CI Properties to open the Configuration Item 
Properties dialog box.

Click CI History to open the CI History dialog box for the 
selected CI.

Select a different CI in the map and click Reveal from 
Database without Filter to add the related CIs in the 
CMDB for the new CI to the existing map.

Note: This option is only available from the Related CIs 
from Database map.

Select a different CI in the map and click Reveal from 
Database with Filter to select the CI types you want to see 
in the map and add the related CIs in the CMDB for the 
new CI to the existing map.

Note: This option is only available from the Related CIs 
from Database map.

Select a different CI in the map and click Reveal from 
View to add the related CIs in the view for the new CI to 
the existing map.

Note: This option is only available from the Related CIs 
from View map.
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Select a different CI in the map and click Refocus on CI 
without Filter to redraw the Related CIs map with the 
new CI as the focus without using a CI type filter.

Note: This option is only available from the Related CIs 
from Database map.

Select a different CI in the map and click Refocus on CI 
with Filter to select the CI types to appear in the Related 
CIs map and redraw the map with the new CI as the 
focus.

Note: This option is only available from the Related CIs 
from Database map.

Select a different CI in the map and click Refocus on CI 
from View to redraw the Related CIs map with the new CI 
as the focus.

Note: This option is only available from the Related CIs 
from View map.

Click Reset Focus to restore the focus of the Related CIs 
map to the original state.

Click Delete to delete the selected CI or relationship.

Click New Related CI to open the New Related CI dialog 
box, which enables you to define a new related CI. For 
details, see “New CI Dialog Box” on page 94.

Click Relate to CI to open the Insert Relationship dialog 
box, which enables you to create a relationship between 
two CIs. For details, see “Insert Relationship Dialog Box” 
on page 81.

Click Add CI to Discovery Job to display the Add CI to 
Discovery Job dialog box, which enables you to manually 
invoke a DDM job for the selected CI. You can use this 
option to discover additional information about the CI 
through one of the available DDM jobs.

GUI Element (A–Z) Description
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Context Menu

The Related CIs Map includes the following elements (listed alphabetically) 
available by right-clicking a CI or relationship in the map:

Click Remove CI from Discovery Job to display the 
Remove CI from Discovery Job dialog box, which enables 
you to manually remove a CI from the DDM job.

<Layout box> Select the map layout from the drop-down list.

<Mode box> Select the map mode from the drop-down list.

Map Select Map to view the related CIs in map mode.

Text Select Text to view the related CIs in text mode.

Menu Item Description

<IT Universe 
Manager context 
menu options>

The following context menu options from the main 
IT Universe Manager window are also available in the 
Related CIs Map:

➤ Properties

➤ CI History

➤ Delete

➤ Insert Relationship

For details, see “IT Universe Manager Window” on 
page 86.

Get Related CIs > 
Refocus on CI 
without Filter

Select a different CI in the map and select Get Related CIs 
> Refocus on CI without Filter to redraw the Related CIs 
map with the new CI as the focus.

Note: This option is only available from the Related CIs 
from Database map.

GUI Element (A–Z) Description
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Get Related CIs > 
Refocus on CI with 
Filter

Select a different CI in the map and select Get Related CIs 
> Refocus on CI with Filter to select the CI types to appear 
in the Related CIs map and redraw the map with the new 
CI as the focus.

Note: This option is only available from the Related CIs 
from Database map.

Get Related CIs > 
Refocus on CI from 
View

Select a different CI in the map and select Get Related CIs 
> Refocus on CI from View to redraw the Related CIs map 
with the new CI as the focus.

Note: This option is only available from the Related CIs 
from View map.

Get Related CIs > 
Reset Focus

Select Reset Focus to restore the focus of the Related CIs 
map to the original state.

New Related CI Opens the New Related CI dialog box, which enables you 
to define a new related CI. For details, see “New CI Dialog 
Box” on page 94.

Menu Item Description
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3
Modeling Studio

This chapter provides information on the Modeling Studio.

This chapter includes:

Concepts

 ➤  Modeling Studio – Overview on page 106

 ➤  Business CI Models on page 106

 ➤  Building a Perspective Based View on page 108

 ➤  Revealed CIs and Watchpoints on page 110

Tasks

 ➤  Build a Business CI Model on page 114

 ➤  Build a View Based on a Model on page 116

 ➤  Build a View Based on a Collection of CIs on page 116

Reference

 ➤  Modeling Studio User Interface on page 117
Concepts
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Modeling Studio – Overview

The Modeling Studio enables you to create perspective based views, which 
comprise a subset of the IT universe, containing only those CIs relating to a 
specific area of interest. Perspective based views are composed of a selection 
of CIs and a viewing perspective. A perspective is a template which is 
applied to the CI selection, similar to the pattern in a pattern view. For 
example, a perspective could comprise a host containing an IP. In that case, 
the view would include all the hosts in the CI selection along with their 
contained IPs. 

The most basic perspective is known as the Content Only perspective and 
consists of only the node itself. If you apply the Content Only perspective to 
a CI collection, the resulting view contains only the selected CIs themselves.

The views created in the Modeling Studio can be viewed in the topology 
map in IT Universe Manager, like all other views. They also appear in the 
view tree in the Views pane of View Manager, but do not appear in the 
editing pane when selected. All editing of perspective based views occurs in 
the Modeling Studio.

Business CI Models

The collection of CIs which compose the view content can be selected in 
two ways. You can select CIs from the CI Selector and drag them onto the 
editing pane. In this case, you can build a view by applying a perspective to 
the collection and the collection cannot be reused in another view without 
repeating the selection process. The other way to select the CIs to appear in 
the view is by creating a model.

A model is a reusable collection of CI instances that define a business entity, 
such as a business service or line of business. By creating a model, you are 
building a CI collection that can be reused with other perspectives to create 
different views. Any changes you subsequently make to the model are 
reflected in all the views based on that model.
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Building a Model
You build a model by first selecting a business CI to serve as its basis. The 
available business CIs include group, application, business service, business 
unit, and line of business. Then, you can add CIs to your model in the 
following ways:

➤ Manually, by dragging CIs from the CI Selector into the Model Editor

➤ Revealing related CIs using a reveal path and selecting the ones to add to the 
model

➤ Defining a watchpoint for a selected CI and automatically adding CIs to the 
model

You can also begin building a model by dragging CIs onto the empty canvas 
and selecting Create a new model.

The model you create is a CI itself and the CIs in your model are related to 
the model by Contains relationships. You must save your model before 
applying a perspective to it to build a view.

Important: The changes you make in a model affect the entire universe, not 
just the views based on that model. Thus, if you delete a CI from a model, 
you are deleting the relationship that existed between the CIs from the 
CMDB.
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Building a Perspective Based View

A perspective based view is composed of a perspective applied to a model or 
a collection of CIs. The perspective is a special type of template which is 
designed to be applied to a subset of the IT Universe model. Perspectives are 
defined in View Manager, but perspective based views are built in the 
Modeling Studio.

The Content pane of the View Editor displays the models or CIs you have 
selected to serve as the basis of your view. The Perspective pane displays the 
selected perspective. The Preview pane displays the resulting view based 
upon your content and perspective selections. When you make a change in 
the content or perspective selections, the view is updated accordingly in the 
Preview pane. For details, see “View Editor” on page 142.

This section includes the following topics:

➤ “Content” on page 108

➤ “Perspectives” on page 109

➤ “Including and Excluding Child CIs” on page 109

Content
The content in a perspective based view can be selected in two ways:

➤ You can add individual CIs to the view manually, using the CI Selector. The 
CIs in the collection are independent of each other. In this case, the 
collection of CIs is not defined as a model and cannot be reused in another 
view.

➤ You can add one or more models to the view, using the CI Selector. 
Alternatively, you can start by working with a model in the Model Editor 
and select Generate View from Model to build a view based on that model. 
In this case, the identical content can be used to build another view by 
selecting the same models.

You can select both individual CIs and models to form the content of a 
perspective based view, however in that case, the models are treated as 
ordinary CIs. The models themselves are included in the view without their 
hierarchy of child CIs. 
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Perspectives
The perspective you select for your view determines which CIs are included 
in the view. A perspective is a reusable pattern, similar to a template. The 
difference between a perspective and a regular template is that the 
perspective includes one or more nodes designated as contact nodes. A 
contact node is a node in the pattern which is used to apply the pattern to 
specific content.

For example, in the following perspective, a host is designated as the contact 
node and it has an IP related to it by a contained relationship.

When this perspective is applied to a CI collection, all the hosts in the 
collection appear in the resulting view, along with the IPs contained in 
them. The hosts that do not contain IPs, as well as CIs of any other type 
from the collection, do not appear in the view.

A perspective can have several contact nodes, but every disconnected graph 
within a perspective must have at least one contact node.

If you make a change to a perspective, all views based on that perspective are 
affected.

Including and Excluding Child CIs
When adding CIs that have children to a view, the CI and its children are 
only included in the view if the pattern of the perspective includes children 
for the selected CI type. In that case, children are included for all CIs of that 
type. After creating a view, you can hide specific CIs from the view by 
selecting the CI in the View Results pane and selecting Hide CI from View 
from the context menu or clicking the Hide CI from View button in the 
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toolbar. This option is only available for CIs that were added to the view via 
the perspective and were not part of the original content on which the view 
was based. Thus, if the view was based on a collection of CIs, the CIs in that 
collection cannot be hidden from the view. If the view was based on a 
model, the model cannot be hidden from the view, but the CIs contained in 
the model can be hidden.

Revealed CIs and Watchpoints

The Modeling Studio provides two advanced methods of adding CIs to an 
existing model: revealing related CIs and defining watchpoints.

This section includes the following topics:

➤ “Revealing CIs” on page 110

➤ “Watchpoints” on page 113

Revealing CIs
One approach to building a model is to add CIs related to the CIs in the 
model. The Modeling Studio provides a tool to help you reveal those CIs. 
The process of revealing related CIs involves constructing a reveal path, 
which is a chain of CI types that are related to each other. The first item in 
your reveal path is the CI type of the CI from which you started to reveal 
CIs. The Modeling Studio locates all of its related CIs and lists their CI types. 
By selecting one of those types, you build the next step of your path. All the 
related CIs of that type appear in the lower pane of the dialog box. You can 
select the ones you want to include in your model. The process is repeated 
to build the following step of the path.
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For example, if you begin to reveal CIs from a CI of type Windows, the 
Modeling Studio may reveal related CIs of types Interface, Network, and IP. 
If you select Network, the related CIs of type Network appear in the lower 
pane and can be added to the model by dragging them into the CIs Basket 
or clicking the CIs Basket icon:
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Click Next to build the next step of the path using Network as your 
selection. The Modeling Studio reveals related CIs of type Windows, Unix, 
and IP. Unix is selected and the Unix CIs appear in the lower pane and can 
be added to the model by dragging the selected ones into the CIs Basket 
pane:
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Click Next to build the next step of the path using Unix as your selection:

In this case, a reveal path of Windows > Network > Unix was constructed. At 
each step, you have the option of adding any of the revealed related CIs to 
your model. For details on revealing CIs, see “Reveal CIs Dialog Box” on 
page 139.

It is also possible to construct a reveal path without revealing CIs. For 
details, see “Create/Edit/Save Reveal Path Dialog Box” on page 123.

Watchpoints
Another method of locating related CIs to add to the model is by defining a 
watchpoint for a selected CI in the model. A watchpoint is a mechanism 
which is triggered when a new related CI of a specified type is created. Every 
watchpoint is defined in connection with a reveal path. If a new related CI 
of any CI type included in the path is created, the watchpoint is triggered 
and an indicator appears next to the model. For details on defining a 
watchpoint, see “New Watchpoint Dialog Box” on page 135.
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Note: You must save a new model before defining watchpoints for its CIs.

All the related CIs detected by the watchpoint are displayed in the 
Watchpoints Updates dialog box. The dialog box enables you to select the 
ones to add to your model and the ones to suppress, or exclude from your 
model. For details, see “Watchpoints Updates Dialog Box” on page 147.

You also have the option to include the detected CIs in your model 
automatically by selecting the check box in the New Watchpoint dialog box. 
In this case, all CIs detected by the watchpoint are added to the model. 

A watchpoint can also be used to detect CIs included in the model which are 
no longer related to the model. If such CIs are found along the reveal path 
connected to the watchpoint, they also appear in the Watchpoints Updates 
dialog box. You can accept the suggestion to remove the CIs from your 
model, or you can suppress the suggestion, thereby keeping the CIs in your 
model.

Note: Although a watchpoint is defined for an individual CI, the 
watchpoint results display related CIs of the CI types included in the reveal 
path for all CIs in the model.

Tasks

Build a Business CI Model 

This task describes how to build a business CI model which can serve as the 
basis for a view.

This task includes the following steps:

➤ “Create the New Model” on page 115

➤ “Add CIs to the Model Manually” on page 115
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➤ “Reveal CIs” on page 115

➤ “Define Watchpoints for CIs in the Model” on page 115

 1 Create the New Model
In the Modeling Studio, click the New  button and select New Model to 
open the New Model dialog box. Select a CI type and enter the values for its 
properties. For details, see “New Model Dialog Box” on page 134.

 2 Add CIs to the Model Manually
In the CI Selector, search for the CIs you want to include in your model. 
Select them and drag them into the model. 

Tip: You can select more than one CI by holding the CTRL key while selecting 
CIs.

 3 Reveal CIs
Select a CI in the model and reveal its related CIs along a reveal path. Add 
selected CIs from among the revealed CIs to your model. When you are 
done, save the model. For details, see “Reveal CIs Dialog Box” on page 139.

 4 Define Watchpoints for CIs in the Model
Right-click a CI in the model and select Watchpoint > Add Watchpoint. The 
New Watchpoint dialog box opens. Select a reveal path and click OK. A 
small icon appears next to the CI indicating that a watchpoint is defined for 
it. For details, see “New Watchpoint Dialog Box” on page 135.
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Build a View Based on a Model 

This task describes how to build a view in the Modeling Studio based on a 
model and a perspective.

This task includes the following steps:

➤ “Open the Model” on page 116

➤ “Select a Perspective” on page 116

➤ “Save the View” on page 116

 1 Open the Model
In the Modeling Studio, click the Open  button and select Open Model to 
open the relevant model. For details, see “Open Model Dialog Box” on 
page 136.

 2 Select a Perspective
In the Model Editor, right-click the model and select Generate View for 
selected model. The Creating New View dialog box opens. Select a 
perspective to apply to the model. For details, see “Creating New View 
Dialog Box” on page 124.

 3 Save the View
The View Editor opens with your new view. Rename the view and save it in 
the correct folder. For details, see “View Editor” on page 142.

Build a View Based on a Collection of CIs

This task describes how to build a view in the Modeling Studio based on a 
collection of CIs and a perspective.

This task includes the following steps:

➤ “Create the New View” on page 117

➤ “Add CIs to the View” on page 117
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➤ “Select a Perspective and Save the View” on page 117

 1 Create the New View
In the Modeling Studio, click the New  button and select New View to 
open the View Editor. For details, see “View Editor” on page 142.

 2 Add CIs to the View
In the CI Selector, search for the CIs you want to include in your view. Select 
them and drag them into the view. For details on the CI Selector, see “View 
Explorer” on page 676.

Tip: You can select more than one CI by holding the CTRL key while selecting 
CIs.

 3 Select a Perspective and Save the View
In the Perspective pane, select a perspective to apply to your CI collection. 
Rename the view and save it in the correct folder. For details, see “View 
Editor” on page 142.

Reference

Modeling Studio User Interface

This section describes:

 ➤  Choose Operation for Selected Item Dialog Box on page 118

 ➤  CI Conditional Search Dialog Box on page 120

 ➤  Conditions of Related CIs Dialog Box on page 121

 ➤  Create/Edit/Save Reveal Path Dialog Box on page 123

 ➤  Creating New View Dialog Box on page 124

 ➤  Hidden CIs Dialog Box on page 124
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 ➤  Manage CI Watchpoints Dialog Box on page 125

 ➤  Model Editor on page 126

 ➤  Modeling Studio on page 133

 ➤  New Model Dialog Box on page 134

 ➤  New Watchpoint Dialog Box on page 135

 ➤  Open Model Dialog Box on page 136

 ➤  Open Saved Reveal Path Dialog Box on page 137

 ➤  Open View Dialog Box on page 138

 ➤  Reveal CIs Dialog Box on page 139

 ➤  Software Elements Search Dialog Box on page 141

 ➤  View Editor on page 142

 ➤  View Properties Dialog Box on page 146

 ➤  Watchpoints Updates Dialog Box on page 147

Choose Operation for Selected Item Dialog Box

Description Enables you to create models and views from selected 
CIs.

To access: In the Modeling Studio, drag CIs from the CI 
Selector onto the empty canvas.

Important 
Information

You can drag individual CIs or multiple CIs onto the 
canvas. You can select ordinary CIs and/or models to 
drag onto the canvas. Use the CTRL key while selecting 
CIs to select multiple CIs.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Create a new model Select to build a model comprising the CIs in your 
selection. If the CIs you dragged onto the canvas include 
at least one CI that has no valid links to any of the model 
CI types, this option is disabled.

Create a new view Select to build a view based on the CI collection formed 
by your selection.

Edit the model of the 
selected CI

Select to edit the selected model in the Model Editor.

Note: This option only appears when a single model is 
dragged onto the canvas.
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CI Conditional Search Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to search for CIs by attribute conditions, by 
related CIs and by attribute conditions of related CIs.

To access: In the CI Selector in the Modeling Studio, click 
Advanced Search in Search mode and select CI 
Conditional Search.

GUI Element (A-Z) Description

Click to add an attribute condition.

Click to delete a selected row.

Click to move a selected row up.

Click to move a selected row down.

Click to display the attribute conditions in a popup 
window.

Attribute Name Select an attribute from the drop-down list.

CI Name Enter a CI name for which to search.

CI Type Enter the CI type for which to search.

Operator Select an operator from the drop-down list.

Related CI Name Enter the name of a related CI for the search.

Related CI Type Click the ellipsis button  to select a CI type from the 
tree for a search by related CI.

Relationship Type Click the ellipsis button  to select a relationship from 
the tree for a search by related CI.

Search by CI 
conditions

Select to run a search for CIs with the specified 
conditions.
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Conditions of Related CIs Dialog Box

Search by Related CI 
conditions

Select to run a search for CIs related to CIs with the 
specified conditions.

Search by Related CI 
criteria

Select to run a search for CIs related to the specified CIs 
or CI types.

Value Enter a value for the attribute condition.

Description Enables you to define conditions for the CI types in a 
reveal path.

To access: Click the Add Condition or Edit Condition 
buttons from the Conditions column of the Reveal CIs 
dialog box.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Add the attribute condition you have defined.

Delete an attribute condition.

Move a selected row up.

Move a selected row down.

View the condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Select an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances dialog box.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three hosts: Host1 is 
assigned the value A, Host2 is assigned the value B and 
Host3 is not assigned a value. You create a query to 
retrieve all hosts that are equal to A and select NOT; the 
results of your query only include Host2 because Host3 is 
not assigned a value.

Operator Select the required operator. For details, see “Attribute 
Operator Definitions” on page 364.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.
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Create/Edit/Save Reveal Path Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define a new reveal path or edit an 
existing path.

To access: To define a new reveal path, click the Reveal 
 button from the Model Editor, and select Create 

Reveal Path. 

To edit an existing reveal path, select a path from the 
Open Saved Reveal Path dialog box and click Edit.

To save a reveal path, click Save Path from the Reveal CIs 
dialog box.

GUI Element (A-Z) Description

Description Enter a description of the path.

Name Enter the name of the path.

Preview Opens the Reveal CIs dialog box displaying the related 
CIs in the path.

Note: This button does not appear in the Save Reveal 
Path dialog box.

Reveal Path Build the path by clicking the  icon to open a dialog 
box with a CI type tree. Select the CI type for the next 
item in the path.

When you hold the pointer over a reveal path item, the 
following options are available:

➤ Delete. Deletes the item from the reveal path.

➤ Add condition. Opens the Conditions of Related CIs 
dialog box, which enables you to set conditions for 
the reveal path item.

➤ Refine Node Type. Opens a CI type tree, which enables 
you to change the CI type of the reveal path item.
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Creating New View Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Hidden CIs Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select a perspective to create a view from a 
model.

To access: In the Modeling Studio, right-click a model in 
the Model Editor, View Editor, or CI Selector and select 
Generate view for selected Model or click the Generate 
view for selected model icon  from the Model Editor.

Included in Tasks “Build a View Based on a Model” on page 116

GUI Element (A-Z) Description

<Perspective list> Select a perspective from the list to apply to your model.

Description Displays a description of the perspective.

Description Enables you to restore hidden CIs to a view.

To access: From the View Editor, click the Show Hidden 
CIs icon from the toolbar of the View Results pane.

GUI Element (A-Z) Description

<check box> Select the check boxes for the CIs you want to restore.

CI Type The CI type of the excluded CI.

Name The name of the excluded CI.

Restore Click Restore to include the selected CIs in the view.
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Manage CI Watchpoints Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Select All Click Select All to select all the CIs in the list for 
inclusion in the view.

Unselect All Click Unselect All to clear the check boxes of all the CIs 
in the list.

Description Enables you to add or remove watchpoints for a CI in a 
model.

To access: From within a model in the Model Editor, click 
the Watchpoint  button and select Manage CI 
Watchpoints or right-click a CI in the model and select 
Watchpoint > Manage CI Watchpoints.

GUI Element (A-Z) Description

Add Click to open the New Watchpoint dialog box which 
enables you to add a new watchpoint.

Remove Click to delete the selected watchpoint.

Automated A check mark indicates that the new CIs found by the 
watchpoint are to be added to the view automatically.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint Name The name of the reveal path associated with the 
watchpoint.

Watchpoint Path Displays the reveal path for the watchpoint.

GUI Element (A-Z) Description
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Model Editor

Content Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create and edit models.

To access: In the Modeling Studio, click the New button 
 and select New Model to create a new model or click 

the Open button  and select Open Model to edit an 
existing model.

Important 
Information

The Model Editor contains the following panes:

➤ Content pane. Lists the CIs and models contained in 
the model.

➤ Information pane. Displays the properties, related CIs 
and watchpoints for the selected CI or model.

You can drag CIs from the CI Selector into the Content 
pane of an existing model to add them to the model. 
However, you cannot drag in a CI that is already included 
in the model.

You can drag CIs from the CI Selector into the Related CIs 
tab of the Information pane provided that the selected 
source and target CI can be related by one of the triplets 
that includes an Impacted By (Potentially) relationship.

GUI Element (A-Z) Description

Select Text Mode to display the CIs in a list. Select Map 
Mode to display the CIs as icons in a diagram.

Click CI Properties to open the Configuration Item 
Properties dialog box for the selected CI.

Click Open selected model in a new tab to open the 
selected model in a separate Model Editor tab.

Click New Model to open the New Model dialog box 
which enables you to define a new model within the 
existing model.
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Click Generate view for selected model to create a view 
based on the current model. The Creating New View 
dialog box opens, which enables you to select a 
perspective to apply.

Click to remove a selected CI from the model (it remains 
in the CMDB).

Click Expand All to expand the model hierarchy.

Click Collapse All to collapse the model hierarchy.

Click Reveal for the following options:

➤ Start Revealing. Opens the Reveal CIs dialog box. For 
details, see Reveal CIs dialog box.

➤ Create Reveal Path. Opens the Create Reveal Path 
dialog box. For details, see Create Reveal Path dialog 
box.

➤ Open Reveal Path. Opens the Open Saved Reveal Path 
dialog box. For details, see Open Saved Reveal Path 
dialog box.

Click Watchpoint for the following options:

➤ Watchpoints Updates. Display the watchpoint results 
and select CIs to add to the model. For details, see 
Watchpoints Updates dialog box.

➤ Add Watchpoint. Define a new watchpoint for the 
selected CI. For details, see New Watchpoint dialog 
box.

➤ Manage CI Watchpoints. Add new watchpoints to the 
CI or remove existing ones. For details, see Manage CI 
Watchpoints dialog box.

GUI Element (A-Z) Description
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Click Grouping to group CIs in a group model under a 
model. Select one of the following options:

➤ Insert New Group. Create a new empty group. After 
creating the group, you can drag CIs into it from the 
CI Selector, the related CIs tab, or from the model 
itself.

➤ Join to Group. Select a CI or several CIs in the model 
and join them to an existing group or form a new 
group.

➤ Ungroup. Select a group and ungroup it. Its CIs remain 
directly under the main model.

Click Find to toggle between displaying and hiding the 
Find box and arrow controls.

Note: This button only appears in Text mode.

Click to refresh the map and optimize the map layout.

Note: This button only appears in Map mode.

Click Fit to Window to resize the map to fit the size of the 
window.

Note: This button only appears in Map mode.

Select the functionality of the cursor from the Mode 
drop-down. The following options are available:

➤ Select

➤ Drag Map

➤ Zoom

Note: This feature only appears in Map mode.

Select a CI and click Show External Relationships to 
display the related CIs for that CI.

Note: This button only appears in Map mode.

Click Hide External Relationships to hide the related CIs.

Note: This button only appears in Map mode.

Indicates that watchpoints are defined for the current CI.

GUI Element (A-Z) Description
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Context Menu Options

Indicates that the watchpoints have detected new CIs 
related to the current model. Click it to open the 
Watchpoints Updates dialog box.

CI Type column Displays the type of each CI in the model.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the model.

Find Next Click to go to the next occurrence of the selected search 
phrase in the model.

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the model.

Highlight Click to highlight all occurrences of the search phrase in 
the model.

Name column Displays the name of each CI in the model.

Menu Item Description

Fit to Window Resizes the map to fit the size of the window.

Note: This option only appears in Map mode.

Generate view for 
selected model

Select to create a view based on the current model. The 
Creating New View dialog box opens which enables you 
to select a perspective to apply.

Grouping Click Grouping to group CIs in a group model under a 
model. Select one of the following options:

➤ Insert New Group. Create a new empty group. After 
creating the group, you can drag CIs into it from the 
CI Selector, the related CIs tab, or from the model 
itself.

➤ Join to Group. Select a CI or several CIs in the model 
and join them to an existing group or form a new 
group.

➤ Ungroup. Select a group and ungroup it. Its CIs 
remain directly under the main model.

GUI Element (A-Z) Description
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Hide External 
Relationships

Hides the related CIs from the map.

Note: This option only appears in Map mode.

Insert New Model Opens the New Model dialog box which enables you to 
create a new model within the existing model.

Open selected model 
in a new tab

Opens the selected model in a separate Model Editor tab.

Properties Opens the Configuration Item Properties dialog box for 
the selected CI.

Refresh Layout Refreshes the map and optimizes the map layout.

Note: This option only appears in Map mode.

Reveal The following options are available:

➤ Start Revealing. Opens the Reveal CIs dialog box. For 
details, see Reveal CIs dialog box.

➤ Open Reveal Path. Opens the Open Saved Reveal Path 
dialog box. For details, see Open Saved Reveal Path 
dialog box.

Remove Selected 
CI(s) from the Model

Deletes the selected CIs from the model (it remains in 
the CMDB).

Select Select the functionality of the cursor. The following 
options are available:

➤ Select

➤ Drap Map

➤ Zoom

Note: This option only appears in Map mode.

Show External 
Relationships

Displays the related CIs for the selected CI.

Note: This option only appears in Map mode.

Menu Item Description
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Information Pane - Properties Tab

Information Pane - Related CIs Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Watchpoint The following options are available:

➤ Watchpoints Updates. Display the watchpoint results 
and select CIs to add to the model. For details, see 
Watchpoints Updates dialog box.

➤ Add Watchpoint. Define a new watchpoint for the 
selected CI. For details, see New Watchpoint dialog 
box.

➤ Manage CI Watchpoints. Add new watchpoints to the 
CI or remove existing ones. For details, see Manage CI 
Watchpoints dialog box.

Zoom Select the size of the map from the list of percents.

Note: This option only appears in Map mode.

Description Displays the properties of the selected CI.

This pane is identical to the Properties tab of the 
Information pane in IT Universe Manager. For details, see 
“Configuration Item Properties Dialog Box” on page 74. 

Description Displays the CIs related to the model by depends on 
relationships.

GUI Element (A-Z) Description

Click to delete the relationship to the selected CI.

Click Invert Direction to switch the direction of the 
relationship for the selected CI.

Menu Item Description
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Information Pane - Watchpoints Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

<CI list> Lists the name and CI type of the CIs related to the 
model by depends on relationships, as well as the 
direction of the relationship.

Filter by Select a field by which to filter the results and enter the 
value in the by box.

Description Displays the watchpoints defined for the selected CI.

GUI Element (A-Z) Description

Click to open the Manage CI Watchpoints dialog box, 
which enables you to edit the watchpoint.

Automated Indicates whether the new CIs found by the watchpoint 
are automatically added to the view.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint Name The name of the reveal path associated with the 
watchpoint.

Watchpoint Path Displays the reveal path of the watchpoint.

GUI Element (A-Z) Description
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Modeling Studio 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create and edit models and views.

The Modeling Studio window contains the following 
panes:

➤ CI Selector. Enables you to browse views or search for 
CIs. For details, see “View Explorer” on page 676.

➤ Editor pane. Displays the CIs of a selected view or 
model.

➤ Information Pane. Displays properties, watchpoints, 
and related CIs for the selected CI.

To access: Select Admin > Modeling > Modeling Studio.

Important 
Information

The Editor pane is a blank canvas before any views or 
models are opened. When you open a view, the View 
Editor appears there. When you open a model, the Model 
Editor appears there. Multiple views and models can be 
open at the same time, each within a separate tab.

Useful Links Model Editor, View Editor

GUI Element (A-Z) Description

Click the click the New button to select one of the 
following options:

➤ New Model. To create a new model.

➤ New View. To create a new view.

Click the Open button to select one of the following 
options:

➤ Open Model. To open an existing model.

➤ Open View. To open an existing view.

Click Save to save the changes to your view or model.

For views, a dialog box opens which enables you to 
rename your view and save it in the appropriate folder.
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New Model Dialog Box

Click Undo to reverse the last change you made.

Click Redo to repeat the last action you took.

Click Maximize Workspace to toggle between the regular 
display and a full-screen display of the editor.

<Menu> The following drop-downs are available:

➤ Resource. Enables you to create a new view or model, 
open an existing view or model, and save a view or 
model.

➤ Edit. Enables you to undo or redo an action.

➤ Tools. Includes the options from the right-click menu 
in the Editor.

➤ View. Enables you to select the panes to display.

Description Enables you to define a reusable model containing a 
collection of CIs.

To access: Click the New  button and select New 
Model or drag a CI from the tree in the CI Selector onto 
the editing pane and select Create a new model.

Included in Tasks “Build a Business CI Model” on page 114

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

New Watchpoint Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Define new CI 
Properties

Enter the values for the CI properties. You must enter 
values for key properties and required properties. The key 
properties are marked with a key symbol  and the 
required properties are marked with an asterisk.

Select CI Type Select a CI type from the list to serve as the basis for your 
model.

Description Enables you to define a watchpoint for a CI in a model.

To access: From within a model in the Model Editor, click 
the Watchpoint  button and select Add Watchpoint or 
right-click a CI in the model and select Watchpoint > Add 
Watchpoint.

Important 
Information

If no reveal paths are found for the selected CI, no 
watchpoints can be defined.

You cannot define watchpoints for CIs in a new model 
until you save the model.

Included in Tasks “Build a Business CI Model” on page 114

GUI Element (A-Z) Description

Add Revealed CIs 
automatically

Select to automatically add all revealed CIs from the 
selected path to the model.
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Open Model Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Select Watchpoint 
reveal path

Select a reveal path from the drop-down list.

Show reveal paths 
for CI type

Select a CI type from the drop-down list. All reveal paths 
beginning with that CI type appear in the list in the 
lower drop-down box.

Description Enables you to open an existing reusable model 
containing a collection of CIs in the Editor pane.

To access: Click the Open  button in the Modeling 
Studio and select Open Model.

Included in Tasks “Build a View Based on a Model” on page 116

GUI Element (A-Z) Description

Click CI Properties to open the Configuration Item 
Properties dialog box for the selected model.

Click Remove model to delete the selected model.

CI Type column Displays the CI types of the existing models.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the list of models.

Find Next Click to go to the next occurrence of the selected search 
phrase in the list of models.

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the list of models.

Name column Displays the names of the existing models.

GUI Element (A-Z) Description
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Open Saved Reveal Path Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Pending Watchpoint 
Updates

A blue triangle indicator  appears in the Pending 
Watchpoint Updates column if a watchpoint defined for 
a selected model has found new CIs.

Show only models 
with content

When the check box is selected, only models containing 
CIs appear in the list.

Description Enables you to open an existing path.

To access: From within a model in the Model Editor, click 
the Reveal  button and select Open Reveal Path or 
right-click a CI in the model and select Reveal > Open 
Reveal Path.

Important 
Information

After selecting the reveal path you want to use, click 
Execute. If CIs are found on the selected path, the Reveal 
CIs dialog box opens for that path. If no CIs are found, a 
message appears stating that no CIs were found on the 
path.

GUI Element (A-Z) Description

Description column Displays the descriptions of the existing paths.

Edit Opens the Edit Reveal Path dialog box which enables you 
to edit the selected path.

Execute Opens the Reveal CIs dialog box for the selected reveal 
path.

Find Enter a path name or a portion of a path name in the 
Find box to locate a path in the list.

Find Next Click to go to the next occurrence of the selected search 
phrase in the list of paths.

GUI Element (A-Z) Description
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Open View Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the list of paths.

Highlight Click to highlight all occurrences of the search phrase in 
the list of paths.

Name column Displays the names of the existing paths.

Remove Deletes the selected path.

Show reveal paths 
for CI type

Select a CI type from the drop-down list. All paths 
beginning with the selected CI appear in the table below.

Description Enables you to open an existing view in the Editor pane.

To access: Click the Open  button in the Modeling 
Studio and select Open View.

GUI Element (A-Z) Description

Click Expand Tree to expand the view tree.

Click Collapse Tree to collapse the view tree.

Click Refresh to refresh the view tree.

Click Delete to delete the view.

Click Disconnect view from perspective to detach a 
perspective based view from its template. It becomes a 
pattern view and is no longer affected by changes made 
to the perspective.

Go directly to IT Universe Manager for the current view.

GUI Element (A-Z) Description
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Reveal CIs Dialog Box

Click to go to the next occurrence of the selected search 
phrase in the list of views.

Click to go to the previous occurrence of the selected 
search phrase in the list of views.

<View tree> Displays the existing views in a tree format.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the list of views.

Description Enables you to search for CIs related to the CIs in a 
model and add them to the model.

To access: In the Model Editor of the Modeling Studio, 
select a CI, click the Reveal  button, and select Start 
Revealing or right-click a CI in the model and select 
Reveal > Start Revealing.

Important 
Information

The upper pane displays the CI types of the CIs related to 
the selected CI. The lower pane displays the CIs of the 
type selected in the upper pane.

The first step in the reveal path is the CI type of the CI 
you began with. When you select a CI type from the list 
in the upper pane, that CI type becomes the second step 
in the path. Click Next to display the CI types available 
for the next step of the path. 

The number at the top of the box in parentheses 
indicates the length of the constructed path thus far.

Included in Tasks “Build a Business CI Model” on page 114

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to delete a selected item from the CIs basket.

Click to add a selected CI from the lower pane to the CIs 
basket.

Click to go to the next occurrence of the selected search 
phrase in the list of CIs.

Click to go to the previous occurrence of the selected 
search phrase in the list of CIs.

<Lower pane> Displays a list of related CIs of the type selected in the 
upper pane.

CI count Indicates how many related CIs of each type were found.

CIs Basket Displays the related CIs you selected to include in the 
model.

CI Type Displays a list of CI types of the CIs related to the selected 
CI. 

Conditions A check mark indicates that conditions were defined for 
the selected CI type. Click the Conditions column for the 
CI type you want to select and click the Add Condition or 
Edit Condition button to open the Conditions of Related 
CIs dialog box. This enables you to define and edit 
conditions for the CI type.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the list of CIs.

Finish Click Finish when you have finished adding CIs to the CI 
basket.

Next Click Next to display the CI types available for the next 
step of the path.
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Software Elements Search Dialog Box

Reveal Path Displays the reveal path being constructed.

Clicking the blue arrows in the path  displays a drop-
down list of the CI types available for the next step of the 
path.

Clicking the CI types in the path displays the following 
options:

➤ Jump to page. Refreshes the table with the available CI 
types for the selected step of the path.

➤ Edit Condition. Opens the Conditions of Related CIs 
dialog box.

➤ Delete Selected Item(s). Deletes the selected CI type 
from the reveal path (the path ends at the previous CI 
type).

Save Path Opens the Save Reveal Path dialog box which enables 
you to save the path. This option is only active when a 
unique reveal path has been constructed.

Description Enables you to search for hosts by the applications 
running on them and for applications by the host on 
which they are running.

To access: In the CI Selector in the Modeling Studio, click 
Advanced Search in Search mode and select Software 
Elements Search.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

View Editor

GUI Element (A-Z) Description

Host Name Enter the name of the host for which you are searching.

Search for Select Software Element or Host.

Note: To search for a specific software element running 
on a specific host, enter a host name, select the required 
software element and search for it.

Software Element Select a software element from the drop-down list.

Description Enables you to create and edit views.

To access: In the Modeling Studio, click the New button 
 and select New View to create a new view or drag CIs 

from the CI Selector onto the blank canvas and select 
Create new view with selected CIs. Click the Open 
button  and select Open View to edit an existing view.

Important 
Information

The View Editor contains the following panes:

➤ Content pane. Drag CIs and/or models onto this pane 
to include them in your view.

➤ Perspective pane. Select a perspective to apply to the 
content to build a view.

➤ View Results pane. Displays a topology map with a 
preview of the current view.

Included in Tasks “Build a View Based on a Model” on page 116, “Build a 
View Based on a Collection of CIs” on page 116
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Content Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Go directly to IT Universe Manager for the current view.

Click Edit View Properties to open the View Properties 
dialog box which enables you to set properties for the 
view.

Click CI Properties to open the Configuration Item 
Properties dialog box for the selected CI.

Click Open selected model in a new tab to open the 
selected model in a separate Model Editor tab.

Click Generate view for selected model to create a view 
based on the selected model. The Creating New View 
dialog box opens which enables you to select a 
perspective to apply.

Click to remove a selected CI from the view.

Click Find to toggle between displaying and hiding the 
Find box and arrow controls.

CI Type column Displays the type of each CI in the view.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the view

Find Next Click to go to the next occurrence of the selected search 
phrase in the view.

Find Previous Click to go to the previous occurrence of the selected 
search phrase in the view.

Highlight Click to highlight all occurrences of the search phrase in 
the view.

Name column Displays the name of each CI in the view.
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Context Menu Options

Perspective Pane

Menu Item Description

Generate view for 
selected model

Select to create a view based on the selected model. The 
Creating New View dialog box opens which enables you 
to select a perspective to apply.

Open selected model 
in a new tab

Opens the selected model in a separate Model Editor tab.

Properties Opens the Configuration Item Properties dialog box for 
the selected CI.

Remove Selected 
CI(s) from the View

Deletes the selected CI or model from the view.

GUI Element (A-Z) Description

Apply Over Model 
Hierarchy

For views based on models, select the Apply Over Model 
Hierarchy check box to include the model hierarchy in 
the view and apply the perspective to the CIs included in 
the model as well as to the model itself. Clear the check 
box to exclude the model hierarchy from the view and 
apply the perspective to the model itself only. In this 
case, the model is treated as an ordinary CI.

Note: This option is disabled for a view based on a 
collection of CIs or on a model and a collection of CIs.

Description Displays a description of the selected perspective.

Name Click the ellipsis button to select a perspective from the 
drop-down list.
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View Results Pane

GUI Element (A-Z) Description

Click Hide CI from View to hide the selected CI from the 
view. This option is only relevant for CIs that were added 
to the view via the perspective. You cannot hide CIs from 
the original view content from the view.

Note: Hidden CIs can be restored from the Hidden CIs 
dialog box.

Click Show Hidden CIs to open the Hidden CIs dialog 
box which enables you to restore CIs that were hidden 
from the view manually.

Click Show tree view to toggle between displaying and 
hiding a tree layout of the view on the left side of the 
pane.

Click Expand preview display to display the preview in a 
separate window.

<Topology Map> The topology map in the View Results pane follows the 
layout of the topology map in IT Universe Manager. For 
details, see “Topology Map” on page 87.

<Tree View> The tree view on the left of the View Results pane 
displays the CIs of the view in tree format. This enables 
you to easily see the structure of the view and its 
different layers.
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Context Menu Options

View Properties Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Menu Item Description

Hide CI from View Click to hide the selected CI from the view. This option 
is only relevant for CIs that were added to the view via 
the perspective. You cannot hide CIs from the original 
view content from the view. In the case of a view based 
on a model, the model cannot be hidden but its CIs can.

Note: Hidden CIs can be restored from the Hidden CIs 
dialog box.

Properties Opens the Configuration Item Properties dialog box for 
the selected CI.

Description Enables you to set properties for a view.

To access: From within the View Editor, click the Edit 
View Properties  button.

Important 
Information

The properties set in the perspective definition are the 
default properties that appear selected in the View 
Properties dialog box.

GUI Element (A-Z) Description

Description Enter a description of the view (optional field).

Merge Identical 
Instances

When the check box is selected, identical instances that 
appear on the same layer in this view are automatically 
merged into one symbol in the editing pane. This helps 
you remove redundant information and sharpen the 
view’s focus. For details, see “Merge Identical Instances” 
on page 158.
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Watchpoints Updates Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Persistent View Defines whether you want the selected view to always 
remain in the system memory. You should use this 
option only for views that are used frequently.

View Name The name of the view.

Description Displays the changes found in related CIs by a 
watchpoint defined for a model.

To access: From within a model in the Model Editor, click 
the Watchpoint  button and select Watchpoints 
Updates or right-click a CI in the model and select 
Watchpoint > Watchpoints Updates.

Important 
Information

The Watchpoints Updates dialog box indicates any 
changes found involving the CIs related to the model via 
the associated reveal path. If a new related CI is found 
which is not included in the model, the suggested update 
is an added CI. If a CI in the model is found to no longer 
be related via the path, the suggested update is a removed 
CI.

This option is only enabled when watchpoints are 
defined for the model and CIs have been found.

GUI Element (A-Z) Description

Accept Select the check boxes for the CIs you want to add to 
your model or remove from your model.

Accept All Click Accept All to apply all the suggested changes to 
your model.

CI The names of the CIs found by the watchpoint.

GUI Element (A-Z) Description
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CI Type The types of the CIs found by the watchpoint.

Clear All Click Clear All to clear the check boxes for all the found 
CIs.

Restore Select the check boxes for the CIs in the Suppressed CIs 
pane that you want to consider for inclusion in your 
model.

Show/Hide 
Suppressions

Toggle between hiding and displaying the Suppressed CIs 
pane of the dialog box.

Suggested Update Indicates whether the suggested change is an added CI or 
a removed CI.

Suppress Select the check boxes for the CIs you want to exclude 
from your model or leave in your model.

Suppress All Click Suppress All to decline all the suggested changes to 
your model.

GUI Element (A-Z) Description
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View Manager

This chapter provides information on View Manager.

This chapter includes:

Concepts

 ➤  View Manager Overview on page 150

 ➤  View Formats on page 150

 ➤  Templates and Perspectives on page 151

 ➤  Predefined Folders and Views on page 152

 ➤  Building a Business View on page 153

 ➤  Link Nodes to Application CI on page 154

 ➤  Grouping By Attribute Properties on page 157

 ➤  Merge Identical Instances on page 158

Tasks

 ➤  Create a Parameterized Template on page 159

 ➤  Create a Perspective on page 161

 ➤  Create a Template Based View on page 162

 ➤  Create a Pattern View on page 164

Reference

 ➤  View Manager User Interface on page 165

Troubleshooting and Limitations on page 195
Concepts
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View Manager Overview

View Manager is a tool for creating and managing views. You can create 
your own views, or work with the out-of-the-box (factory) views provided 
with your HP Universal CMDB installation.

The IT universe model in the configuration management database can be 
very large, holding thousands of configuration items (CIs). A view enables 
you to build a subset of the overall IT universe model, containing only those 
CIs relating to a specific area of interest. You can define your own views to 
display only the information that is relevant to your organization’s business 
needs.

HP Universal CMDB supports three view formats, pattern views, template 
based views, and perspective based views, which are populated through 
different processes. For details, see “View Formats” on page 150.

View Formats

HP Universal CMDB supports three view formats, by which to populate your 
view:

➤ Pattern views are built from a Topology Query Language (TQL) query that 
defines the structure of the view. You can create the TQL query as you build 
the view from within View Manager or based on an existing query. The view 
displays only those CIs and relationships that satisfy the query definition. 
When the view is displayed or refreshed, View Manager queries the CMDB 
for all elements that fit the query, and automatically updates the view with 
those elements.

➤ Template based views are based on a TQL query, to which a template is then 
applied. The template is a reusable view that includes parameters, folding 
rules, and other settings, which are saved as part of the template. This 
enables you to build multiple views with the same settings without having 
to re-enter the setting information. The view displays only those CIs and 
relationships that satisfy the query definition and the conditions of the 
template. For details on templates, see “Templates and Perspectives” on 
page 151.
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➤ Perspective based views are built by selecting a collection of individual CIs 
and applying a special type of template, known as a perspective, to it. 
Instance views, which no longer exist, are replaced by perspective based 
views. Perspective based views cannot be viewed or edited in View Manager. 
When you select a perspective based view in View Manager, you are given 
the option to open the view in Modeling Studio, where you can edit it. For 
details, see “Modeling Studio – Overview” on page 106.

You can also create new views by selecting Save As from the context menu 
for an existing view and editing the view contents. You then follow the 
wizard to save the new view with a unique name.

Templates and Perspectives

The templates and perspectives which are used to build template based and 
perspective based views, respectively, are also defined and edited in View 
Manager. You can create a template using the New Template wizard. For 
details, see “New Template/Template Properties/Save As Template Wizard” 
on page 171. To create a perspective, use the New Perspective wizard. For 
details, see “New Perspective/Perspective Properties/Save As Perspective 
Wizard” on page 168.

Templates allow you to save the folding rules, relationship rules and 
parameters you have set in your definition. This makes it easier to build 
more views with the same settings. Any changes made to a template affect 
all existing views based on that template.

The templates you create in View Manager appear the same as pattern views 
in the editing pane. The same functionality applies to both pattern views 
and templates. The difference is that templates are reusable and they do not 
appear in the view list in IT Universe Manager. 

Perspectives are a type of template designed to be applied to a specific 
collection of CIs. You create and edit perspectives in View Manager, but you 
can only apply them to content to build a view in the Modeling Studio. 
Perspective based views appear in the views tree in View Manager, but you 
must go to the Modeling Studio to edit them. For details, see “Building a 
Perspective Based View” on page 108.
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In summary, the tree in the Views pane of View Manager can include five 
distinct entities: 

➤ pattern views

➤ templates

➤ template based views

➤ perspectives

➤ perspective based views

The first four are created and edited in View Manager. Perspective based 
views are created and edited in the Modeling Studio.

You can filter the tree to select the types of views or templates to display. For 
details, see “View Manager Window” on page 184.

Predefined Folders and Views

The file folder system in View Manager includes predefined folders and 
views, as described in the following sections:

➤ “Predefined Folders” on page 152

➤ “Factory Views” on page 152

➤ “Predefined Perspectives” on page 153

Predefined Folders
View Manager contains a hierarchical file folder system to help you organize 
your views and templates, displayed in the Views pane. Predefined folders 
are provided for the out-of-the-box views; you can modify these folders, or 
add additional folders according to your organization’s requirements.

Factory Views
Your HP Universal CMDB installation includes out-of-the-box pattern views, 
templates, and perspectives. These views provide a quick start for working 
with the CMDB.
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The out-of-the-box views are initially empty. As soon as CIs are added to the 
CMDB by one of the CI generators, the TQL query built into each pattern 
view is able to identify the CIs that meet the pattern requirements, and add 
them to the view.

Views for CIs are created when a discovery process is run; the out-of-the-box 
views that are provided correspond to the relevant Discovery and 
Dependency Mapping (DDM) packages. For example, the Oracle view (Root 
> Database > Oracle > Oracle) is populated with CIs that are created when 
Discovery and Dependency Mapping activates the Database - Oracle 
module. For details on running DDM, see “Run Discovery – Advanced Mode 
Workflow” in Discovery and Dependency Mapping Guide.

Some of the out-of-the-box views are considered basic to the system and 
cannot be deleted from the folders. 

Predefined Perspectives
HP Universal CMDB also provides out-of-the-box perspectives. One example 
is the Content Only perspective, which includes only the elements of the 
view content itself, without any additional CIs. 

Building a Business View

You can define your own views in View Manager to model your business 
environment. These views should provide the business users with logical 
representations of your company’s structure, processes, and goals.

To meet these requirements, you generally build multiple views representing 
different aspects of your business; for example, you could build business 
views that revolve around any of the following:

➤ Company structure, so that data is organized by the geographical location of 
branches, or by data centers.

➤ Business processes, so that data is organized by line of business, or by 
applications.

➤ Business goals, so that data is organized by sales, or by key customers.
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The views you create depend on the particular demands of your 
organization and the actual hierarchical structure of the views should reflect 
those demands.

The usual hierarchical format of a view is as follows:

➤ Top level. The highest levels of the view, consisting of the root CI and the 
branches below it, are normally built from logical Business CI types such as 
Location, Line of Business, Customer, Application, and so on.

➤ Intermediate level. The intermediate branches of the view normally consist 
of System CI types, representing actual hardware and software and/or 
monitoring group CI types, representing groups containing monitors.

➤ Bottom level. The lowest level of the view, consisting of leaf CIs at the ends 
of the subtrees, is built from the Monitor CI types. 

Note: The bottom level is only relevant when a monitoring solution such as 
HP Business Availability Center is connected and modeled in the CMDB. 

Link Nodes to Application CI

HP Universal CMDB enables you to define a node in a view to be linked to 
all the instances of that CIT in your IT universe. You can use this feature, for 
example, to show which hosts are serving a specific business service or to 
create Correlation rules that reflect problems at the business level.

When you select Add to Applications from the context menu for a node in 
View Manager, a new CI of type application is created. All instances of the 
selected node in any corresponding view are then linked to the new CI with 
Contains links. This CI is actually a model of type application which can be 
viewed in the Modeling Studio. The CIs in the model appear in read-only 
format. For details on models, see “Business CI Models” on page 106.
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If you make a change to the existing nodes of a view, such as selecting 
another node to be linked to the application CI or removing the link from a 
node to the application CI, the recalculation is performed immediately. 
However, if you add a node to the view, the recalculation is performed at the 
next scheduled update.

This functionality can be applied to any CI type except for: IT Universe, 
Business, Application, and all extended CI types (from running CMDB 
federation functionality).  

This section includes the following topics:

➤ “Linking a Node to an Application CI” on page 155

➤ “Removing the Link between a Node and the Application CI” on page 157

Linking a Node to an Application CI
To link a node to an application CI, select a node in the TQL in the editing 
pane of View Manager. Right-click the node and select Add to Applications. 
A dialog box opens with a default name for the new application CI, which is 
the name of the view from which you defined it followed by "_Application." 
You can accept the default name or assign it a name of your choice. The new 
CI is connected by Contains links to all the instances of the node.

A small black briefcase icon appears to the right of the node. The creation of 
the application CI and the links occurs when you save the view.

If you select a different node and repeat the process, the dialog box does not 
open (only one application CI is created per view), but Contains links are 
created between that CI and the instances of the second node.
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Example

In a view called Oracle, you select a host and click Add to Applications from 
the context menu. A new CI of type application named Oracle_Application 
is created and all the hosts queried in this TQL are linked to the 
Oracle_Application CI by Contains links.
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Removing the Link between a Node and the 
Application CI
To remove the link between a node and the application CI, right-click the 
node you selected as Add to Applications, and select Remove from 
Applications. The briefcase icon disappears and the relationships to the 
application CI are removed. If there are no remaining nodes in the view 
selected for linking to the application CI, the application CI itself is deleted. 
The change takes effect when you save the view. When you delete a view, 
the application CI created from within the view is also deleted.

Grouping By Attribute Properties

When grouping CIs in View Manager by attribute using Node Grouping, 
you can group CIs of different types in the Topology Map by using a regular 
expression as described in “Node/Relationship Grouping Dialog Box” on 
page 179. Enter the expression in the Mask to group by field in the 
Advanced Attribute Properties page of the dialog box. For details about 
regular expressions, see “Regular Expression Examples” in Reference 
Information.

Nested Groups
You can create nested groups (a node group inside another node group) to 
help fine-tune the TQL results that are displayed in the Topology Map.

For example, after grouping host nodes by their CIT, you can use their 
operation state attribute to create more focused groups.
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Merge Identical Instances

When defining a view, you can have identical instances that appear on the 
same layer in the view automatically merged into one symbol on the editing 
pane. This helps you remove redundant information and sharpen the view’s 
focus.

For example, if you want to discover and display hosts that are connected to 
other hosts in a server-client relationship, you can create the following TQL:

However, if both the server and the client are installed on the same host, 
one host appears twice.
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To overcome the redundant host display, you define that identical instances 
should be merged by selecting Merge Identical Instances on the Advanced 
Properties page of the New View wizard:

Tasks

Create a Parameterized Template 

This task describes how to define a new parameterized template.

This task includes the following steps:

➤ “Define a Template” on page 160

➤ “Define the Base TQL” on page 160

➤ “Set the Advanced Properties” on page 160

➤ “Add Nodes and Relationships to a TQL Query” on page 160

➤ “Add Folding Rules to Relationships” on page 160

➤ “Set Permissions” on page 161
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 1 Define a Template
You define a new template using the New Template wizard. Enter the 
template name and description on the General Attributes page of the 
wizard. For details, see “Template General Attributes Page” on page 172.

Note: The template is created in the same folder as the view currently 
selected in the views tree.

 2 Define the Base TQL
The TQL is assigned the same name as the template. For details, see 
“Template Base TQL Page” on page 172.

 3 Set the Advanced Properties
On the Advanced Properties page of the wizard, enter the viewing options 
for the template. For details, see “Advanced Properties Page” on page 173.

 4 Add Nodes and Relationships to a TQL Query
Add the nodes and relationships that define the query. For details on how to 
add nodes and relationships to a TQL query, see “Add Nodes and 
Relationships to a TQL Query” on page 348.

Note: You must add at least one node in order to save your template.

 5 Add Folding Rules to Relationships
You can add folding rules to selected relationships by right-clicking the 
relationship you want and selecting Add Rule. For details, see Add Rule in 
“Context Menu Options” on page 357.
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 6 Set Permissions
Apply viewing and editing permissions to users and user groups for that 
template. You set permissions in Admin > Settings > Users and Roles. For 
details, see “Users and Roles User Interface” on page 641.

Create a Perspective 

This task describes how to define a new perspective.

This task includes the following steps:

➤ “Define a Perspective” on page 161

➤ “Define the Base TQL” on page 161

➤ “Set the Advanced Properties” on page 162

➤ “Select a Contact Node” on page 162

➤ “Add Nodes and Relationships to a TQL Query” on page 162

➤ “Add Folding Rules to Relationships” on page 162

➤ “Set Permissions” on page 162

 1 Define a Perspective
You define a new perspective using the New Perspective wizard. Enter the 
perspective name and description on the General Attributes page of the 
wizard. For details, see “Perspective General Attributes Page” on page 168.

Note: The perspective is created in the same folder as the view currently 
selected in the views tree.

 2 Define the Base TQL
The TQL is assigned the same name as the perspective. For details, see 
“Perspective Base TQL Page” on page 169.
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 3 Set the Advanced Properties
On the Advanced Properties page of the wizard, enter the viewing options 
for the perspective. For details, see “Advanced Properties Page” on page 170.

 4 Select a Contact Node
On the Contact Node page of the wizard, select a CI type from the tree to 
serve as a contact node of your perspective. For details, see “Contact Node 
Page” on page 169.

 5 Add Nodes and Relationships to a TQL Query
Add the nodes and relationships that define the query. For details on how to 
add nodes and relationships to a TQL query, see “Add Nodes and 
Relationships to a TQL Query” on page 348.

 6 Add Folding Rules to Relationships
You can add folding rules to selected relationships by right-clicking the 
relationship you want and selecting Add Rule. For details, see Add Rule in 
“Context Menu Options” on page 357.

 7 Set Permissions
Apply viewing and editing permissions to users and user groups for that 
template. You set permissions in Admin > Settings > Users and Roles. For 
details, see “Users and Roles User Interface” on page 641.

Create a Template Based View

This task describes how to define a new template based view.

This task includes the following steps:

➤ “Prerequisites” on page 163

➤ “Define a New Template Based View” on page 163

➤ “Select a Template” on page 163

➤ “Set the Advanced Properties” on page 163
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➤ “Set Parameters” on page 163

➤ “Set Permissions” on page 164

 1 Prerequisites
If you want to base your view on a new template, create the template first. 
For details, see “New Template/Template Properties/Save As Template 
Wizard” on page 171.

 2 Define a New Template Based View
You define a new template based view using the New View wizard. Select 
Template Based as the view type on the General Attributes page of the 
wizard. For details, see “View General Attributes Page” on page 175.

Note: The view is created in the same folder as the view currently selected in 
the views tree.

 3 Select a Template
On the Available Templates page of the wizard, select a template on which 
to base your view. For details, see “Available Templates Page” on page 175.

 4 Set the Advanced Properties
On the Advanced Properties page of the wizard, enter the viewing options 
for the view. For details, see “Advanced Properties Page” on page 177.

 5 Set Parameters
On the Set Parameters page, enter the parameter values for the view. A 
separate wizard page appears for each item in the template for which 
parameterized values were defined. For details, see “Set Parameters Page” on 
page 178.
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 6 Set Permissions
Apply viewing and editing permissions to users and user groups for that 
view. You set permissions in Admin > Settings > Users and Roles. For details, 
see “Users and Roles User Interface” on page 641.

Create a Pattern View

This task describes how to create a pattern view and define its TQL query.

This task includes the following steps:

➤ “Define a Pattern View” on page 164

➤ “Define the Base TQL” on page 164

➤ “Set the Advanced Properties” on page 165

➤ “Add Nodes and Relationships to a TQL Query” on page 165

➤ “Add Folding Rules to Relationships” on page 165

➤ “Define Multiple Relationship Rules” on page 165

 1 Define a Pattern View
You define a new pattern view using the New View wizard. Select Pattern as 
the view type on the General Attributes page of the wizard. For details, see 
“View General Attributes Page” on page 175.

Note: The view is created in the same folder as the view currently selected in 
the views tree.

 2 Define the Base TQL
If you are basing your view on a new TQL, the TQL is assigned the same 
name as the view. If you are basing your view on an existing TQL, select it 
from the drop-down list. For details, see “View Base TQL Page” on page 176.
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 3 Set the Advanced Properties
On the Advanced Properties page of the wizard, enter the viewing options 
for the view. For details, see “Advanced Properties Page” on page 177.

 4 Add Nodes and Relationships to a TQL Query
Add the nodes and relationships that define the query. For details on how to 
add nodes and relationships to a TQL query, see “Add Nodes and 
Relationships to a TQL Query” on page 348.

Note: You must add at least one node in order to save your view.

 5 Add Folding Rules to Relationships
You can add folding rules to selected relationships by right-clicking the 
relationship you want and selecting Add Rule. For details, see Add Rule in 
“Context Menu Options” on page 357.

 6 Define Multiple Relationship Rules
You can define multiple relationship rules to define the structure between 
CITs in a view using the Relationship Folding Rules dialog box. For details, 
see “Relationship Folding Rules Dialog Box” on page 182.

Reference

View Manager User Interface

This section describes:

 ➤  Add/Edit Relationship Folding Rule Dialog Box on page 166

 ➤  List of Dependent Views Dialog Box on page 167

 ➤  New Perspective/Perspective Properties/Save As Perspective Wizard 
on page 168

 ➤  New Template/Template Properties/Save As Template Wizard on page 171

 ➤  New View/View Properties/Save As View Wizard on page 174
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 ➤  Node/Relationship Grouping Dialog Box on page 179

 ➤  Relationship Folding Rules Dialog Box on page 182

 ➤  Set View Parameters/Set View Element Parameters Dialog Box on page 183

 ➤  View Manager Window on page 184

Add/Edit Relationship Folding Rule Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to add a new relationship folding rule or 
edit an existing relationship folding rule.

To access: In View Manager, click Add or Edit from the 
Relationship Folding Rules dialog box.

Important 
Information

You can define sibling and child rules for the same 
relationship between two CITs. However, you cannot 
define parent and child rules for the same relationship, 
or left sibling and right sibling rules.

Included in Tasks “Create a Pattern View” on page 164

Useful Links “Relationship Folding Rules Dialog Box” on page 182

GUI Element (A-Z) Description

Node 1 Select the required Node1 node in the Node1 list.

Node 2 Select the required Node2 node in the Node2 list.

Relationship From the Relationship list, select an available 
relationship connecting the Node1 node to the Node2 
node. (Enabled only after you define both CITs.)

Rule From the Rule list, select a folding rule: Parent, Right 
Sibling, Left Sibling, or Child. For details, see “Adding 
Folding Rules to Relationships” on page 65.
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List of Dependent Views Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to disconnect a view from a template or 
perspective that has changed, delete the view, or reapply 
the template or perspective.

To access: In View Manager, when saving a template or 
perspective with a change, the List of Dependent Views 
dialog box automatically opens.

GUI Element (A-Z) Description

Invalid Dependent 
Views

For each dependent view listed, select one of the 
following options:

➤ Disconnect. Disconnects the view from the template 
or perspective. The view becomes an independent 
pattern view.

➤ Delete. Deletes the view from the CMDB.

Valid Dependent 
Views

For each dependent view listed, select one of the 
following options:

➤ Reapply. Applies the changed template or perspective 
to the view and saves the view.

➤ Disconnect. Disconnects the view from the template 
or perspective. The view becomes an independent 
pattern view.
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New Perspective/Perspective Properties/Save As 
Perspective Wizard

Perspective General Attributes Page

Description Enables you to define a new perspective or edit the 
properties of an existing perspective.

To access: In View Manager, click the downward arrow next 
to the New button  and select New Perspective, or select 
New > New Perspective from the context menu in the 
Views pane. 

Click the Properties button  or select Properties from the 
context menu to edit the properties of an existing 
perspective.

Select Save As from the context menu or select Resources > 
Save As to save an existing perspective with a different 
name.

Important 
Information

TQL queries should only be created by administrators with 
an advanced knowledge of the TQL system.

For more information on perspectives, see “Building a 
Perspective Based View” on page 108.

Included in Tasks “Create a Perspective” on page 161

Wizard Map The New Perspective/Perspective Properties/Save As 
Perspective wizard contains:

Perspective General Attributes Page > Contact Node Page > 
Perspective Base TQL Page > Advanced Properties Page

Description Enables you to define the general attributes of the new 
perspective.

Important 
Information

For more information on perspectives, see “Building a 
Perspective Based View” on page 108.

Wizard Map The New Perspective/Perspective Properties/Save As 
Perspective Wizard contains:

Perspective General Attributes Page > Contact Node Page 
> Perspective Base TQL Page > Advanced Properties Page 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Contact Node Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Perspective Base TQL Page

GUI Element (A-Z) Description

Perspective 
Description

Enter a description of the new perspective.

Perspective Name Enter a name for the new perspective.

Description Enables you to select a contact node for a perspective.

Important 
Information

A perspective based view must have at least one contact 
node.

For more information on perspectives, see “Building a 
Perspective Based View” on page 108.

Wizard Map The New Perspective/Perspective Properties/Save As 
Perspective Wizard contains:

Perspective General Attributes Page > Contact Node Page > 
Perspective Base TQL Page > Advanced Properties Page

GUI Element (A-Z) Description

<CI Type tree> Select a CI type from the tree to serve as the contact node of 
the perspective.

Description Enables you to define the base TQL for the new perspective.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Advanced Properties Page

Important 
Information

For more information on perspectives, see “Building a 
Perspective Based View” on page 108.

Wizard Map The New Perspective/Perspective Properties/Save As 
Perspective Wizard contains:

Perspective General Attributes Page > Contact Node Page > 
Perspective Base TQL Page > Advanced Properties Page

GUI Element (A-Z) Description

Base TQL 
Description

A description of the query. 

Base TQL Name The query is defined by default with the same name as the 
perspective. 

Base TQL Priority From the TQL Priority list, select a priority level for the new 
query (Low, Medium, High, Express). This setting 
determines how often the query should be rerun 
automatically by the system to include updated information 
from the CMDB.

Description Enables you to enter advanced properties for the 
perspective.

Important 
Information

For more information on perspectives, see “Building a 
Perspective Based View” on page 108.

Wizard Map The New Perspective/Perspective Properties/Save As 
Perspective Wizard contains:

Perspective General Attributes Page > Contact Node Page > 
Perspective Base TQL Page > Advanced Properties Page 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

New Template/Template Properties/Save As Template 
Wizard

GUI Element (A-Z) Description

Merge Identical 
Instances

When the check box is selected, identical instances that 
appear on the same layer in this perspective are 
automatically merged into one symbol in the editing pane. 
This helps you remove redundant information and sharpen 
the perspective’s focus. For details, see “Merge Identical 
Instances” on page 158.

Persistent View Defines whether you want the selected perspective to always 
remain in the system memory. You should use this option 
only for perspectives that are used frequently.

Track Changes Select to be notified when CIs are added or removed. The 
changes are tracked in the system by creating daily 
snapshots of the perspective.

Description Enables you to define a new template or edit the properties 
of an existing template.

To access: In View Manager, click the downward arrow next 
to the New button  and select New Template, or select 
New > New Template from the context menu in the Views 
pane. 

Click the Properties button  or select Properties from the 
context menu to edit the properties of an existing template.

Select Save As from the context menu or select Resources > 
Save As to save an existing template with a different name.

Important 
Information

TQL queries should only be created by administrators with 
an advanced knowledge of the TQL system.
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Template General Attributes Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Template Base TQL Page

Included in Tasks “Create a Parameterized Template” on page 159

Wizard Map The New Template/Template Properties/Save As Template 
wizard contains:

Template General Attributes Page > Template Base TQL Page 
> Advanced Properties Page

Description Enables you to define the general attributes of the new 
template.

Wizard Map The New Template/Template Properties/Save As Template 
Wizard contains:

Template General Attributes Page > Template Base TQL 
Page > Advanced Properties Page

GUI Element (A-Z) Description

Template 
Description

Enter a description of the new template.

Template Name Enter a name for the new template.

Description Enables you to define the base TQL for the new template.

Wizard Map The New Template/Template Properties/Save As Template 
Wizard contains:

Template General Attributes Page > Template Base TQL 
Page > Advanced Properties Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Advanced Properties Page

GUI Element (A-Z) Description

Base TQL 
Description

A description of the query. 

Base TQL Name The query is defined by default with the same name as the 
template. 

Base TQL Priority From the TQL Priority list, select a priority level for the new 
query (Low, Medium, High, Express). This setting 
determines how often the query should be rerun 
automatically by the system to include updated information 
from the CMDB.

Description Enables you to enter advanced properties for the template.

Wizard Map The New Template/Template Properties/Save As Template 
Wizard contains:

Template General Attributes Page > Template Base TQL Page 
> Advanced Properties Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

New View/View Properties/Save As View Wizard

GUI Element (A-Z) Description

Merge Identical 
Instances

When the check box is selected, identical instances that 
appear on the same layer in this template are automatically 
merged into one symbol in the editing pane. This helps you 
remove redundant information and sharpen the template’s 
focus. For details, see “Merge Identical Instances” on 
page 158.

Persistent View Defines whether you want the selected template to always 
remain in the system memory. You should use this option 
only for templates that are used frequently.

Track Changes Select to be notified when CIs are added or removed. The 
changes are tracked in the system by creating daily 
snapshots of the template.

Description Enables you to define a new view or edit the properties of an 
existing view.

To access: In View Manager, click the New button  or 
select New > New View from the context menu in the Views 
pane to create a new view. 

Click the Properties button  or select Properties from the 
context menu to edit the properties of an existing view. 

Select Save As from the context menu or select Resources > 
Save As to save an existing view with a different name.

Important 
Information

TQL queries should only be created by administrators with 
an advanced knowledge of the TQL system.
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View General Attributes Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Available Templates Page

Included in Tasks “Create a Template Based View” on page 162, “Create a 
Pattern View” on page 164

Wizard Map The New View/View Properties/Save As View wizard 
contains:

View General Attributes Page > (Available Templates Page) > 
(View Base TQL Page) > Advanced Properties Page > (Set 
Parameters Page)

Description Enables you to define the general attributes of the new view.

Wizard Map The New View/View Properties/Save As View Wizard 
contains:

View General Attributes Page > (Available Templates Page) 
> (View Base TQL Page) > Advanced Properties Page > (Set 
Parameters Page)

GUI Element (A-Z) Description

View Description Enter a description of the new view.

View Name Enter a name for the new view.

View Type Select Pattern to create a pattern view.

Select Template Based to create a template based view.

Description Enables you to select a template for a template based view.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

View Base TQL Page

Important 
Information

This wizard page only appears if Template Based was 
selected as the view type in the previous step.

Wizard Map The New View/View Properties/Save As View Wizard 
contains:

View General Attributes Page > (Available Templates Page) 
> (View Base TQL Page) > Advanced Properties Page > (Set 
Parameters Page)

GUI Element (A-Z) Description

Base TQL Name Displays the name of the TQL on which the selected 
template is based.

Template 
Description

A description of the selected template.

Template Name Select a template from the drop-down list.

Description Enables you to define the base TQL for the new view.

Important 
Information

This wizard page only appears if Pattern was selected as the 
view type in the previous step.

Wizard Map The New View/View Properties/Save As View Wizard 
contains:

View General Attributes Page > (Available Templates Page) > 
(View Base TQL Page) > Advanced Properties Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Advanced Properties Page

GUI Element (A-Z) Description

Base the view on a 
new TQL

Select to base your view on a new TQL.

Base the view on 
an existing TQL

Select to base your view on an existing TQL.

Base TQL 
Description

A description of the query. 

Base TQL Name If you are basing your view on an existing TQL, select the 
TQL query from the drop–down list. Only queries of type 
view appear in the list. If the query you want does not 
appear in the list, go to Query Manager and save it as a type 
view query. For details, see “Query Manager User Interface” 
on page 303.

If you are basing your view on a new TQL, the query is 
defined by default with the same name as the view. 

Base TQL Priority From the TQL Priority list, select a priority level for the new 
query (Low, Medium, High, Express). This setting 
determines how often the query should be rerun 
automatically by the system to include updated information 
from the CMDB.

Save a new TQL 
based on the 
current definition

Select to save a new TQL based on your view definition.

Note: This field only appears in the Save As View wizard.

Description Enables you to enter advanced properties for the view.

Wizard Map The New View/View Properties/Save As View Wizard 
contains:

View General Attributes Page > (Available Templates Page) > 
(View Base TQL Page) > Advanced Properties Page > (Set 
Parameters Page)
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Set Parameters Page

GUI Element (A-Z) Description

Ad Hoc View When the check box is selected, the view is defined as an 
Ad-hoc view. An Ad-hoc view is not updated automatically 
as changes occur in the system. The view is updated only 
when you schedule an update using the Scheduler.

For details, see “Scheduler User Interface” on page 496.

Merge Identical 
Instances

When the check box is selected, identical instances that 
appear on the same layer in this view are automatically 
merged into one symbol in the editing pane. This helps you 
remove redundant information and sharpen the view’s 
focus. For details, see “Merge Identical Instances” on 
page 158.

Persistent View Defines whether you want the selected view to always 
remain in the system memory. You should use this option 
only for views that are used frequently.

Track Changes Select to be notified when CIs are added or removed. The 
changes are tracked in the system by creating daily 
snapshots of the view.

Description Enables you to enter parameterized attribute values for the 
view.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Node/Relationship Grouping Dialog Box

Important 
Information

This wizard page only appears if Template Based was 
selected as the view type.

A separate page appears for each CI or relationship that has 
parameterized attribute values in the selected template.

Wizard Map The New View/View Properties/Save As View Wizard 
contains:

View General Attributes Page > (Available Templates Page) > 
(View Base TQL Page) > Advanced Properties Page > (Set 
Parameters Page)

GUI Element (A-Z) Description

Attribute The name of each attribute with a parameterized value.

Operator The operator defined for each attribute.

Value Click the field to open an editing dialog box, which enables 
you to set the parameterized value of the attribute.

Description Enables you to define a new grouping of CIs or to edit an 
existing grouping.

To access: In View Manager, select Node Grouping or 
Relationship Grouping from the context menu in the 
editing pane.

Important 
Information

You select and enter the information for the CI 
groupings in the fields at the bottom of the dialog box. 
The groupings you define are displayed in the table at 
the center of the dialog box.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to add a grouping to the table based on the 
information entered.

Deletes the selected CI group.

Moves selected row up.

Moves selected row down.

Attribute name If you are grouping by attribute, select the appropriate 
Attribute name.

You can right-click this field to select Advanced 
Properties, which opens the Advanced Attribute 
Properties dialog box.

Group By Select the criteria by which to group the CIs. The 
following options are available:

➤ Configuration Item Type. Groups CIs in the Topology 
Map by their CI type.

➤ TQL Node. Groups all CIs of the same CI type that 
fulfill the node grouping criteria. By default, these CIs 
appear in the Topology Map under a folder containing 
the name of the selected TQL node and an 
automatically added identification number.

➤ Attribute. Groups CIs of multiple CI types in the 
Topology Map, according to the attribute selected 
from the list. A CI can be a member of multiple 
groups.

Group label Enter the label of the group.

Note: This field is optional.

Minimum in group Enter the minimum number of matching CIs required to 
create the group. By default there must be at least one CI 
in the group.

Note: This field is optional.
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Advanced Attribute Properties

GUI Element (A-Z) Description

Attribute Name The name of the selected attribute.

Group List Define the specific groups of the selected attribute to be 
created. For example, to display two groups of IP 
addresses that end between 0 and 100, enter 0-50, 51-
100. Any IPs that fall outside this group are placed 
automatically into the Others group.

Mask to group by Enter a regular expression, as follows:

➤ In the first field, enter the regular expression pattern. 
This is the structure of the selected attribute.

➤ In the second field, enter the group number. This is 
the part of the regular expression pattern on which to 
focus when creating the group.

For details, see “Grouping By Attribute Properties” on 
page 157.
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Relationship Folding Rules Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define multiple relationship rules.

To access: In View Manager, select Relationship Folding 
Rules from the context menu in the Views pane.

Important 
Information

As an alternative to adding folding rules, you can choose 
to define multiple relationship rules. 

You define relationship rules to define the structure 
between CITs in a view. This is in contrast to folding rules 
where you define the structure of two nodes connected to 
a specific relationship. For example, if one of the view’s 
nodes is a host, you can specify different relationships for 
Windows, UNIX, router, and so on. By assigning different 
folding rules to different CITs, views can encompass and 
represent additional query data.

Note: If both folding and relationship rules are defined, 
the definitions for the folding rules override the 
definitions for relationship rules.

Included in Tasks “Create a Pattern View” on page 164

Useful Links “Add/Edit Relationship Folding Rule Dialog Box” on 
page 166

GUI Element (A-Z) Description

Opens the Add Rule dialog box where you can add a rule. 
For details, see “Add/Edit Relationship Folding Rule 
Dialog Box” on page 166.

Opens the Edit Rule dialog box where you can edit the 
selected rule. “Add/Edit Relationship Folding Rule Dialog 
Box” on page 166.

Deletes the selected rule.

Moves selected row up.
182



Chapter 4 • View Manager
Set View Parameters/Set View Element Parameters 
Dialog Box

Moves selected row down.

Relationship The type of relationship.

Rule The relevant folding rule.

Source The source node of the relationship.

Target The target node of the relationship.

Description Enables you to edit the predefined parameters of 
conditions of nodes in a view.

To access: In View Manager, right-click a view in the 
Views pane and select Set View Parameters from the 
context menu or right-click a node in the editing pane 
and select Set View Element Parameters from the context 
menu.

Note: This menu option is only available if a 
parameterized value has been set for an attribute of a 
node in the view.

Important 
Information

When you select Set View Element Parameters from the 
right-click menu for a node in the editing pane, the 
dialog box displays only the conditions for the selected 
node. When you select Set View Parameters from the 
right-click menu in the Views pane, the dialog box 
displays any conditions that are defined for all nodes in 
the view.

Included in Tasks “Create a Template Based View” on page 162

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

View Manager Window

Views Pane

GUI Element (A-Z) Description

Display Name The name of each attribute with a parameterized value.

Operator The operator defined for each attribute.

Value Click the field to open an editing dialog box, which 
enables you to change the parameterized value of the 
attribute.

Description Enables you to create, edit, and save a view.

The View Manager window contains the following panes:

➤ Views pane. Displays a hierarchical tree structure of 
the views that you defined.

➤ Editing pane. Displays the currently selected view, 
which consists of nodes and the relationships between 
them.

➤ CI Type Selector. Displays a hierarchical tree structure 
of the available CI types.

➤ Information Pane. Displays properties, conditions, and 
cardinality for the selected node or relationship.

To access: Select Admin > Modeling > View Manager.

Description Enables you to select a view to edit.

Important 
Information

The Views Pane contains a hierarchical file folder system 
to help you organize your views, displayed in the Views 
pane. Predefined folders are provided for the 
out-of-the-box views; you can modify these folders, or 
add additional folders according to your organization’s 
requirements.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Create a new folder.

Click to define a new view. For details, see “New 
View/View Properties/Save As View Wizard” on page 174.

Click the downward arrow to select the New Template 
wizard or the New Perspective wizard.

Click Filter Tree to filter the types of views and templates 
that appear in the tree.

Delete the selected folder or view.

Click to refresh the data content of the hierarchical tree 
structure that may have been modified by other users.

Save the view to the CMDB.

Opens the View Properties, Template Properties, or 
Perspective Properties wizard for the selected view, 
template, or perspective.

Generate a preview of the existing views in the CMDB 
that match the pattern of the current view.

Click Show View Results in IT Universe to go directly to 
IT Universe Manager for the current view.

Note: This feature is not relevant for templates or 
perspectives.

Click Expand All to expand all folders in the tree.

Click Collapse All to collapse all folders in the tree.

Denotes a view folder. Double-click the icon to expand 
the folder.

Denotes a pattern view.
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Context Menu Options

The View Manager Window includes the following elements (listed 
alphabetically) available by right-clicking a folder or view in the Views pane:

Denotes a perspective based view. When you select a 
perspective based view in the view tree, a dialog box 
opens with the following options:

➤ Open in Modeling Studio. Opens the view in the 
Modeling Studio, where it can be edited.

➤ Delete. Deletes the view from the CMDB.

➤ Disconnect view from perspective. Disconnects the 
view from the perspective, turning it into a regular 
pattern view, which can be edited in View Manager.

Denotes a template based view.

Denotes a template.

Denotes a perspective.

Root Denotes the top level folder, containing all other view 
folders.

Menu Item Description

Activate/Deactivate 
View

If the view is active, you can select Deactivate View to 
make it inactive. If the view is inactive, you can select 
Activate View to activate it. When you deactivate a view, 
a red X appears on it. Inactive views are not recalculated 
and cannot be selected in IT Universe Manager.

Note: This option is only available for pattern views.

Delete Deletes a selected folder or view.

GUI Element (A-Z) Description
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Disconnect View 
from Template

Select Disconnect View from Template to detach a 
template based view from its template. It becomes a 
pattern view and is no longer affected by changes made 
to the template.

Note: This option only appears for template based views.

Export Displays a standard Save As dialog box, enabling you to 
save the view as an XML script.

Import Opens the Import dialog box which enables you to 
import XML files containing views.

New View The following options are available:

➤ New View wizard, which enables you to define a new 
view. For details, see “New View/View Properties/Save 
As View Wizard” on page 174.

➤ New Template wizard, which enables you to define a 
new template. For details, see “New 
Template/Template Properties/Save As Template 
Wizard” on page 171.

➤ New Perspective wizard, which enables you to define a 
new perspective. For details, see “New 
Perspective/Perspective Properties/Save As Perspective 
Wizard” on page 168.

New Folder Creates a new view folder.

Preview Generates a preview of the existing views in the CMDB 
that match the pattern of the current view.

Properties Opens the View Properties, Template Properties, or 
Perspective Properties wizard for the selected view, 
template, or perspective.

Relationship Folding 
Rules

Displays the Relationship Folding Rules dialog box which 
enables you to define multiple relationship rules. For 
details, see “Relationship Folding Rules Dialog Box” on 
page 182.

Rename Folder Enables you to rename the view folder.

Menu Item Description
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Editing Pane

Save As Opens the Save As View wizard which enables you to save 
the view to the CMDB after you have modified it. For 
details, see “New View/View Properties/Save As View 
Wizard” on page 174.

Note: If you exit View Manager without saving, a 
confirmation dialog box is displayed, requesting that you 
save your view.

Set View Parameters Appears if at least one node in the view has a 
parameterized node condition. Displays the Set View 
Parameters dialog box where you can edit the parameter 
of each condition. For details, see “Set View 
Parameters/Set View Element Parameters Dialog Box” on 
page 183.

Show View Results in 
IT Universe

Takes you to IT Universe Manager and opens the selected 
view.

Note: This option does not appear for templates or 
perspectives.

Description Displays the selected view, which consists of nodes and 
the relationships between them.

➤ When you select a folder in the Views pane, the 
editing pane is empty.

➤ When you select a view in the Views pane, the editing 
pane displays the selected view. The name of the view 
appears at the top of the pane.

Important 
Information

After defining a view in the editing pane, you save it by 
clicking the Save button in the Views pane or by 
selecting Save from the context menu in the Views 
pane.

Useful Links For information on defining a TQL query, see “Add 
Nodes and Relationships to a TQL Query” on page 348.

Menu Item Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Context menu 
options>

For details, see “Context Menu Options” on page 357.

<Main menu> For details, see “Main Menu” on page 713.

<Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between two 
nodes.

<Toolbar> For details, see “Toolbar Options” on page 717. 

<Tooltip> Hold the cursor over a node or relationship to view its 
tooltip.

The tooltips contain the following information:

➤ Element name. The name of the node.

➤ CI Type. The CIT of the CI as defined in the CI Type 
Manager. For details, see “CI Type Manager User 
Interface” on page 236.

➤ Visible. Indicates whether the selected node is visible 
in the Topology map.

➤ Cardinality. Relevant for nodes with relationships. 
Defines how many nodes you expect to have at the 
other end of the relationship. For example, in a 
relationship between host and IP, if the cardinality is 
1:3, the TQL retrieves only the hosts that are 
connected 1 to 3 IPs.

➤ Folding Rule. Relevant for relationships. Indicates the 
folding rule defined for the relationship.

➤ Condition. Appears only if a condition has been 
defined for the node or relationship.
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CI Type Selector

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a hierarchical tree structure of the CI Types 
found in the CMDB. For more details, see “CI Type 
Manager User Interface” on page 236.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

To create or modify a TQL query, click and drag nodes to 
the Editing pane and define the relationship between 
them. Your changes are saved to the CMDB. For details, 
see “Add Nodes and Relationships to a TQL Query” in 
Model Management.

Important 
Information

The CI Type Selector is part of the following managers: 
View Manager, Enrichment Manager, Query Manager, 
Correlation Manager, Topology Report Manager, and 
Trigger TQL Editor. 

Included in Tasks ➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Define a TQL Query” on page 346

➤ “Create a Pattern View” on page 164

➤ “Define a Report Rule – Scenario” on page 264

GUI Element (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

Click Expand All to expand all subtrees within the CI 
type tree.
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Context Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Click Collapse All to collapse the subtrees within the CI 
type tree.

<Search window> Enter the name or part of a name of a CI type for which 
to search.

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” in Model Management.

GUI Element (A-Z) Description
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Information Pane

Description Displays the properties, conditions, and cardinality for 
the selected node and relationship.

Important 
Information

The Information pane appears in the lower part of the 
window in the following managers and user interfaces: 
View Manager, Correlation Manager, Query Manager, 
Topology Report Manager, Enrichment Manager, 
Discovery Input TQL Editor, and Discovery Trigger TQL 
Editor.

A small green indicator  appears next to the tabs in 
which a change occurred.

Included in Tasks ➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Define a TQL Query” on page 346

➤ “Create a Pattern View” on page 164

➤ “Define a Report Rule – Scenario” on page 264
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current manager. You can select a tab from the list.

Affected Nodes Displays which node is affected by the changes that occur in 
the selected trigger node. If required, you can click Edit to 
open and modify the Affected Nodes dialog box. For details, 
see “Affected Nodes Dialog Box” on page 206.

Note: This tab appears only in Correlation Manager.

Attributes Displays the attribute conditions defined for the node or the 
relationship. For details, see “Attribute Tab” on page 403.

Cardinality Cardinality defines how many nodes you expect to have at 
the other end of a relationship. For example, in a 
relationship between host and IP, if the cardinality is 1:3, the 
TQL retrieves only those hosts that are connected to 
between one and three IPs. For details, see “Cardinality Tab” 
on page 405.

Details Displays the following information:

➤ CI Type. The CIT of the selected node/relationship.

➤ Visible. A green check indicates that the selected 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Enrichment Rules Displays the Enrichment rule defined for the selected node 
or relationship. If the Enrichment rule is used to update the 
attributes of a CI, click Edit to open the Node/Relationship 
Definition dialog box and edit the rule if required. For 
details, see “Node/Relationship Definition Dialog Box” on 
page 336.

Note: This tab appears only in Enrichment Manager.

Folding Rule Displays the folding rule defined for the selected 
relationship. For details about folding rules, see “Adding 
Folding Rules to Relationships” on page 65.

Note: This tab appears only when a relationship is selected 
in View Manager.

Grouping Displays the different CI groupings for the selected node, as 
defined in the Grouping dialog box.

Note: This tab appears only in View Manager.

Node Definition Displays the attributes to be included in the report for the 
selected node. If required, you can click Edit to open and 
modify the Report Node definition dialog box. For details, 
see “Report Node Definition Dialog Box” on page 294.

Note: This tab appears only in Topology Report Manager.

Qualifiers Displays the qualifier conditions defined for the node or the 
relationship. For details, see “Qualifier Tab” on page 408.

Rule Displays the report folding rule defined for the selected 
relationship. For details about folding rules, see “Editing 
Pane” on page 288.

Note: This tab appears only when a relationship is selected 
in Topology Report Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL results. For details, see 
“Identity Tab” on page 410.

GUI Element (A-Z) Description
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Troubleshooting and Limitations

If a known folder does not appear in the Views pane in View Manager, or if a 
folder appears which should not be there, execute the following JMX 
command to refresh the folders:

MAM / Service=MAM New Folders Services / refresh()
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5
Correlation Manager

This chapter provides information on Correlation Manager.

This chapter includes:

Concepts

 ➤  Correlation Manager Overview on page 197

Tasks

 ➤  Define a Correlation Rule – Workflow on page 199

Reference

 ➤  Correlation Manager User Interface on page 205
Concepts

Correlation Manager Overview

Correlation Manager enables you to define the interdependencies between 
components in your IT infrastructure to simulate how infrastructure 
changes (for example, a new software installation or upgrade) can impact 
your system.

By creating Correlation rules based on TQL queries, you can determine the 
true origin of a problem and its business impact. Each Correlation rule you 
define is attached to a specific Correlation TQL query. For more information 
about TQL queries, see “Topology Query Language” on page 341.
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You define Correlation rules to specify a causal relationship between two or 
more Correlation nodes. Define one node as the trigger, or the node that 
represents the changes you want to make to the system, and another node 
as the one that is affected. After the causal relationship is established, 
Correlation Manager enables you to determine the effect of the changes 
occurring in root cause nodes.

You then run the Correlation rules in the Topology View tab (go to 
Applications > Topology View) to simulate how the changes impact your 
system and discover the root causes of the changes (for details, see “Run 
Correlation Dialog Box” on page 536). This enables you to evaluate and 
handle accordingly, the possible implications of any action, update, new 
deployment, or a failure of the service delivery.

A simulated change in an affected CI can alter the CI’s map status, which is 
manifested through an addition of a status icon to the CI’s symbol. The 
Topology Map displays the statuses of the trigger CIs as well as all statuses of 
the CIs that are affected by it. Each color represents a different status.

For details about the status icons and the colors that represent them, see 
“Correlation Rules Window” on page 535.

You can then generate a report displaying the following:

➤ CIs in the system that are impacted by the changes.

➤ Trigger CIs (the CIs that represent the changes you want to make to the 
system).

➤ CIs that belong to a specific business service. For details, see “Link Nodes to 
Application CI” on page 154.

Tasks
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Define a Correlation Rule – Workflow

This section describes how to define a Correlation rule whereby a change in 
CPU usage affects the Host node to which it is connected.

Note: To retrieve the required Correlation results, you must follow each step 
in this task.

This task includes the following steps:

➤ “Create an Enumeration Definition” on page 200

➤ “Define a State — Optional” on page 202

➤ “Create a Correlation TQL Query” on page 203

➤ “Define a Correlation Rule” on page 203
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 1 Create an Enumeration Definition

Note: This step is optional. You can use the default Enumeration definitions 
that appear in the System Type Manager.

To retrieve Correlation results, you must create a Correlation rule in the 
Correlation Manager. A Correlation rule is based on a state that exists in the 
State Manager. For details, see “State Manager” on page 507. 

A state is based on an Enumeration definition. Enumerations are designed to 
be used as severity value lists by states. You can either base a state on an 
existing Enumeration definition in the State Manager or, if required, create 
one by clicking the New Enumeration button. For details on creating 
Enumeration definitions, see “Create/Update List/Enumeration Definition 
Dialog Box” on page 259.

Note: Alternatively, you can create an Enumeration definition in the System 
Type Manager. For details, see “System Type Manager” on page 228. The 
Enumeration definition you create appears in the State Manager.
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Example of an Enumeration Definition

Select Admin > Settings > State Manager to open the State Manager. In the 
bottom-right corner, click the New Enumeration button to open the Create 
Enumeration Definition dialog box.

The following Enumeration definition creates a severity list that represents 
CPU usage of 10%, 20%, and 50%.
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 2 Define a State — Optional

Note: You can use the default states that appear in the State Manager or 
define another one if required.

When you create a Correlation Rule, you select the state on which the 
Correlation condition is based. The State Manager contains two default 
states — Change and Operation. Each one is based on its own severity list. 
You can use a default state, or if required, create one based on a severity list 
(Enumeration definition) that is more relevant to your needs.

To define a new state, select Admin > Settings > State Manager to open the 
State Manager. For details on defining a new state, see “State Manager Dialog 
Box” on page 509.

Example of a New State

A new state called cpu_usage is defined in the State Manager. Its Type 
Definition is based on the Enumeration definition called cpu_usage defined 
in the previous task.
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 3 Create a Correlation TQL Query
To create a Correlation TQL query, you need to create a Correlation TQL and 
then add the TQL nodes and relationships that define the query. 

Select Admin > Modeling > Correlation Manager to open the Correlation 
Manager. For details about how to create a Correlation TQL query, see “New 
Correlation Rule/Correlation Rule Properties/Save As Correlation Rule 
Wizard” on page 219. For details about how to add nodes and relationships 
to a query, see “Add Nodes and Relationships to a TQL Query” on page 348.

Example of a Correlation TQL Query

In this Correlation TQL query, a CPU and a Host node are linked by a 
Container Link relationship. The TQL results must comply with the 
direction of the arrows.

Note: A Correlation TQL query is subject to certain validation restrictions. 
For details, see “Troubleshooting and Limitations” on page 427.

 4 Define a Correlation Rule
When you define a Correlation rule, you must specify the required causal 
relationship between the nodes. Define one node as the trigger, or the node 
that represents the changes you want to make to the system, and another 
node as the one that is affected.
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Right-click the node you want to define as the trigger node and select Define 
Affected to open the Affected Nodes dialog box. In the Affected Nodes 
dialog box, select the node you want the trigger node to affect. Then click 
the Add button to open the Correlation Definition dialog box to set 
conditions for defining affected nodes. For details about how to define a 
Correlation rule, see “Correlation Definition Dialog Box” on page 207. 

Example of a Correlation Rule

The Conditions area in the Correlation Definition dialog box defines the 
conditions under which the simulated change in the system is triggered. 
The Affected Severity area defines the severity of the Correlation impact on 
the affected node.

The Correlation rule in this example states that when the CPU usage of the 
Host node to which the CPU node is connected does not equal 10%, the 
Host node is automatically assigned the 50% load status, which in this case, 
is the color red according to the severity list.
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In the resulting TQL query, an upward arrow appears next to the node 
defined as the trigger node and a downward arrow appears next to the node 
defined as the affected node.

Note: To retrieve the Correlation results, you must run the Correlation rule 
in the Topology View tab. For details, see “Retrieve Correlation Results – 
Scenario” on page 524.

Reference

Correlation Manager User Interface

This section describes:

 ➤  Affected Nodes Dialog Box on page 206

 ➤  Correlation Definition Dialog Box on page 207

 ➤  Correlation Manager Window on page 209

 ➤  Details Dialog Box on page 218

 ➤  New Correlation Rule/Correlation Rule Properties/Save As Correlation Rule 
Wizard on page 219
205



Chapter 5 • Correlation Manager
Affected Nodes Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Define which node in the TQL query is the trigger 
Correlation node and which nodes are affected by the 
changes that occurred in the system.

To access: Right-click the node or relationship that 
functions as a trigger and select Define Affected. The 
Affected Nodes dialog box opens to display the nodes in 
the TQL.

Included in Tasks “Define a Correlation Rule – Workflow” on page 199.

Important 
Information

Before creating the TQL, you must know which node in 
the TQL query is the trigger Correlation node and which 
are affected by the changes beforehand. The definition is 
performed here.

GUI Element (A-Z) Description

Affected Nodes pane Contains a list of the Correlation nodes in the 
Correlation rule. Select the nodes to be affected by the 
trigger node.
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Correlation Definition Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description ➤ In the Conditions area, set conditions for defining 
affected nodes. When this condition is met, the 
simulated change in the system is triggered.

For example, you can define a Correlation condition 
that states that the operational state of the node is 
other than Normal. When the operational state of the 
node instance changes and is no longer Normal, the 
condition is met and the simulated changes in the 
system are triggered.

➤ In the Scope area, define how many instances of the 
trigger node should fulfill the conditions for triggering 
the changes in the system.

You can apply the trigger conditions not only to one of 
the instances of a trigger node, but also to a certain 
percentage of the trigger instances, or to all of them. 

For example, you can define that impact is calculated 
when at least 10% of the system’s hosts are down.

➤ In the Affected Severity area, define the severity of the 
Correlation impact.

To access: Click Add in the Details dialog box.

Included in Tasks “Define a Correlation Rule – Workflow” on page 199

GUI Element (A-Z) Description

All All instances should fulfill the conditions.

Any One instance or more should fulfill the conditions.

Description A description of the Correlation rule you are defining.

Fixed severity Define a fixed severity level for every system change 
generated. Then, select the required severity level from 
the list.
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Function Select Function (displayed when you selected the All and 
Range options in the Scope area) to define a severity level 
for the system changes, as a function of the severity levels 
of all the trigger node instances that are included in the 
range. From the list, select either Average or Max.

For example, if you select Average, the severity level of 
the system changes is the average severity of all the 
trigger instances.

Operator Select the required operator. For a list of the operators you 
can use for defining an attribute condition, see “Attribute 
Operator Definitions” on page 364.

Range A certain percentage of all instances should fulfill the 
conditions. For example, if you enter a range of 50% to 
100%, the changes are triggered when 50% or more of 
the instances meet the conditions.

Severity relative to 
trigger severity (%)

Select Severity relative to trigger severity (%) (displayed 
when you selected the Any option in the Scope area) to 
define a severity level for each system change that is 
relative (as a percentage) to the severity of the trigger 
event.

Enter the percentage in the box provided.

State Choose the required state. The states that appear in the 
list are the states that are defined in the State Manager. 
For details, see “State Manager” on page 507.

Value Comparison Select the required attribute.

GUI Element (A-Z) Description
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Correlation Manager Window

Correlation Rules Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

 

Description Define Correlation rules.

To access: Select Admin > Modeling > Correlation 
Manager.

Important 
Information

When selecting nodes to function as Correlation triggers, 
they must comply with certain restrictions. For details, 
see “Troubleshooting and Limitations” on page 427.

Included in Tasks “Define a Correlation Rule – Workflow” on page 199

Useful Links “Correlation Manager Overview” on page 197

Description Displays a hierarchical tree structure of predefined 
folders and Correlation rules. Each Correlation rule is 
associated with a TQL query.

You can create your own query, or work with the 
default queries provided with your HP Universal 
CMDB installation.

The predefined folders are provided for the default 
queries; you can modify these folders, or add 
additional folders according to your organization’s 
requirements.

GUI Element (A-Z) Description

Create a new folder.

Creates a Correlation rule. Opens the New Correlation 
Rule Wizard.

Deletes the selected folder or Correlation rule.

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.
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The following elements are available by right-clicking a folder or Correlation 
rule:

 

(Enabled only when a new Correlation rule is created or 
when changes are made to an existing one.) Saves the 
Correlation rule to the CMDB.

Opens the Correlation Rule Wizard. Enables you to 
change the description of the rule.

Generates  a preview of the results of the selected 
Correlation rule.

Represents a folder.

Represents a Correlation rule.

GUI Element (A-Z) Description

Delete Delete the selected folder or Correlation rule.

Export Displays a standard Save As dialog box, enabling you to 
save the Correlation rule as an XML script. This option 
can be used to move a Correlation rule from one 
workstation to another, provided the related TQL query is 
also relocated.

Import Imports XML files that contain saved Correlation rules to 
the Correlation Manager.

New Creates a Correlation rule. Opens the New Correlation 
Rule Wizard.

New Folder Creates a new folder.

Preview Generates  a preview of the results of the selected 
Correlation rule.

Properties Opens the Correlation Rule Properties Wizard. Enables 
you to change the description of the rule.

Rename Folder Rename the folder.

GUI Element (A-Z) Description
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Editing Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Save (Enabled only when a new Correlation rule is created or 
when changes are made to an existing one.) Saves the 
Correlation rule to the CMDB.

Save As Displays the Save As Correlation Rule wizard, enabling 
you to create new Correlation rules based on an existing 
query.

Description Displays the selected Correlation rule, which consists of 
nodes that are defined in the TQL query and the 
relationships between them.

➤ When you select a folder in the Correlation Rules pane, 
the editing pane is empty. 

➤ When you select a Correlation rule in the Correlation 
Rules pane, the editing pane displays the selected rule, 
which consists of TQL nodes that are defined in the 
TQL query and the relationships between them.

Useful Links  “Add Nodes and Relationships to a TQL Query” on 
page 348

Important 
Information

When selecting nodes to function as Correlation triggers, 
they must comply with certain restrictions. For details, 
see “Troubleshooting and Limitations” on page 427.

GUI Element (A-Z) Description

Indicates a trigger node. Located to the right of the trigger 
node's icon. 

Indicates an affected node. Located to the right of the 
affected node’s icon.

Indicates nodes that are both affected and trigger nodes.

GUI Element (A-Z) Description
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<Context menu 
options>

For details, see “Context Menu Options” on page 357.

<Main Menu> For details, see “Main Menu” on page 713.

<Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between two 
nodes.

<Toolbar> For details, see “Toolbar Options” on page 717.

<Tooltip> Hold the cursor over a node or relationship to view its 
tooltip.

The tooltips contain the following information:

➤ Element name. The name of the node.

➤ CI Type. The CIT of the node as defined in the CI Type 
Manager. For details, see “CI Type Manager” on 
page 225.

➤ Definitions of the selected nodes and relationships. 
The attribute conditions, as described in 
“Node/Relationship Properties Dialog Box” on 
page 401.

➤ Names of the trigger and the affected nodes. This is 
only relevant if the node over which the cursor is 
hovering is the trigger node.

Define Affected Displays the Affected Nodes dialog box.

GUI Element (A-Z) Description
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CI Type Selector

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a hierarchical tree structure of the CI Types 
found in the CMDB. For more details, see “CI Type 
Manager User Interface” on page 236.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

To create or modify a TQL query, click and drag nodes to 
the Editing pane and define the relationship between 
them. Your changes are saved to the CMDB. For details, 
see “Add Nodes and Relationships to a TQL Query” in 
Model Management.

Important 
Information

The CI Type Selector is part of the following managers: 
View Manager, Enrichment Manager, Query Manager, 
Correlation Manager, Topology Report Manager, and 
Trigger TQL Editor. 

Included in Tasks ➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Define a TQL Query” on page 346

➤ “Create a Pattern View” on page 164

➤ “Define a Report Rule – Scenario” on page 264

GUI Element (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

Click Expand All to expand all subtrees within the CI 
type tree.
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Context Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Information Pane

Click Collapse All to collapse the subtrees within the CI 
type tree.

<Search window> Enter the name or part of a name of a CI type for which 
to search.

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” in Model Management.

Description Displays the properties, conditions, and cardinality for 
the selected node and relationship.

GUI Element (A-Z) Description
214



Chapter 5 • Correlation Manager
Important 
Information

The Information pane appears in the lower part of the 
window in the following managers and user interfaces: 
View Manager, Correlation Manager, Query Manager, 
Topology Report Manager, Enrichment Manager, 
Discovery Input TQL Editor, and Discovery Trigger TQL 
Editor.

A small green indicator  appears next to the tabs in 
which a change occurred.

Included in Tasks ➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Define a TQL Query” on page 346

➤ “Create a Pattern View” on page 164

➤ “Define a Report Rule – Scenario” on page 264
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current manager. You can select a tab from the list.

Affected Nodes Displays which node is affected by the changes that occur in 
the selected trigger node. If required, you can click Edit to 
open and modify the Affected Nodes dialog box. For details, 
see “Affected Nodes Dialog Box” on page 206.

Note: This tab appears only in Correlation Manager.

Attributes Displays the attribute conditions defined for the node or the 
relationship. For details, see “Attribute Tab” on page 403.

Cardinality Cardinality defines how many nodes you expect to have at 
the other end of a relationship. For example, in a 
relationship between host and IP, if the cardinality is 1:3, the 
TQL retrieves only those hosts that are connected to 
between one and three IPs. For details, see “Cardinality Tab” 
on page 405.

Details Displays the following information:

➤ CI Type. The CIT of the selected node/relationship.

➤ Visible. A green check indicates that the selected 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Enrichment Rules Displays the Enrichment rule defined for the selected node 
or relationship. If the Enrichment rule is used to update the 
attributes of a CI, click Edit to open the Node/Relationship 
Definition dialog box and edit the rule if required. For 
details, see “Node/Relationship Definition Dialog Box” on 
page 336.

Note: This tab appears only in Enrichment Manager.

Folding Rule Displays the folding rule defined for the selected 
relationship. For details about folding rules, see “Adding 
Folding Rules to Relationships” on page 65.

Note: This tab appears only when a relationship is selected 
in View Manager.

Grouping Displays the different CI groupings for the selected node, as 
defined in the Grouping dialog box.

Note: This tab appears only in View Manager.

Node Definition Displays the attributes to be included in the report for the 
selected node. If required, you can click Edit to open and 
modify the Report Node definition dialog box. For details, 
see “Report Node Definition Dialog Box” on page 294.

Note: This tab appears only in Topology Report Manager.

Qualifiers Displays the qualifier conditions defined for the node or the 
relationship. For details, see “Qualifier Tab” on page 408.

Rule Displays the report folding rule defined for the selected 
relationship. For details about folding rules, see “Editing 
Pane” on page 288.

Note: This tab appears only when a relationship is selected 
in Topology Report Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL results. For details, see 
“Identity Tab” on page 410.

GUI Element (A-Z) Description
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Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the new Correlation rule you created in the 
Correlation Definition dialog box.

To access: Click Next in the Affected Nodes dialog box.

Included in Tasks “Define a Correlation Rule – Workflow” on page 199

GUI Element (A-Z) Description

Description The description of the new Correlation rule.

State The category you chose from the State list in the 
Correlation Definition dialog box.
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New Correlation Rule/Correlation Rule Properties/Save 
As Correlation Rule Wizard

Description Creates or modifies a Correlation rule.

To access: 

➤ To create a Correlation rule, right-click anywhere in 
the Correlation Rules pane and click New or click the 
New  button.

➤ To modify a Correlation rule, right-click a Correlation 
rule in the Correlation Rules pane and select 
Properties.

➤ To create a new Correlation rule based on an existing 
query, right-click a Correlation rule in the Correlation 
Rules pane and select Save As.

Important 
Information

➤ Any major changes made to the TQL query after 
creating a Correlation rule causes the system to delete 
the rule. These changes include deleting a root cause 
or affected node or changing the Min and Max 
relationship definitions (for details, see “Cardinality 
Tab” on page 405).

➤ Minor changes, such as adding a node to the TQL, do 
not cause the deletion of the rule.

➤ The Correlation TQL that serves as the basis of the 
Correlation rule, is subject to certain validation 
restrictions. For details, see “Troubleshooting and 
Limitations” on page 427. If the TQL is not valid, it 
cannot be used for the creation of a Correlation rule.

Included in Tasks “Define a Correlation Rule – Workflow” on page 199

Wizard Map The New Correlation Rule/Correlation Rule 
Properties/Save As Correlation Rule Wizard contains:

Rule General Attributes Page > Rule Base TQL Page > Rule 
Groups Page
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Rule General Attributes Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to enter a unique name and description for 
the Correlation rule.

Included in Tasks “Define a Correlation Rule – Workflow” on page 199

Important 
Information

➤ The Correlation TQL that serves as the basis of the 
Correlation rule, is subject to certain validation 
restrictions. For details, see “Troubleshooting and 
Limitations” on page 427. If the TQL is not valid, it 
cannot be used for the creation of a Correlation rule.

➤ For important information on the effects of making 
changes to the TQL after creating it, see “New 
Correlation Rule/Correlation Rule Properties/Save As 
Correlation Rule Wizard” on page 219.

➤ By default, this wizard is set to display a Welcome 
page. You can choose not to display the Welcome page 
by changing the user preferences. For details, see “User 
Preferences Dialog Box” on page 426.

Useful Links “Topology Query Language” on page 341

Wizard Map The New Correlation Rule/Correlation Rule 
Properties/Save As Correlation Rule Wizard contains:

Rule General Attributes Page > Rule Base TQL Page > 
Rule Groups Page

GUI Element (A-Z) Description

Description (Optional) Enter a description of the rule.

Rule Name Enter a unique name for the Correlation rule. 

The rule name cannot contain any of the following 
characters: \ / : " < > | % ?

Note: If the Correlation rule name is either empty, 
contains a name used by another Correlation rule, or uses 
invalid charcters, the Next and Finish buttons are 
disabled.
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Rule Base TQL Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define the properties of the TQL on which 
the Correlation rule is based.

Included in Tasks “Define a Correlation Rule – Workflow” on page 199

Important 
Information

➤ The Correlation TQL that serves as the basis of the 
Correlation rule, is subject to certain validation 
restrictions. For details, see “Troubleshooting and 
Limitations” on page 427. If the TQL is not valid, it 
cannot be used for the creation of a Correlation rule.

➤ For important information on the effects of making 
changes to the TQL after creating it, see “New 
Correlation Rule/Correlation Rule Properties/Save As 
Correlation Rule Wizard” on page 219.

Useful Links “Topology Query Language” on page 341

Wizard Map The New Correlation Rule/Correlation Rule 
Properties/Save As Correlation Rule Wizard contains:

Rule General Attributes Page > Rule Base TQL Page > 
Rule Groups Page

GUI Element (A-Z) Description

Base the Correlation 
rule on a new TQL

Select this check box if you want to base the Correlation 
rule on a new TQL query. The TQL results are based on 
the attributes defined for the new TQL query.

Base the Correlation 
rule on an existing 
TQL

Select this check box if you want to base the Correlation 
rule on an existing TQL query. Select the required 
Correlation TQL query from the drop-down list.

Base TQL Description (Optional) Enter a description of the TQL query.
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Rule Groups Page

Base TQL Name Enter a unique name for the Correlation TQL query.

If you selected the Base the Correlation rule on an 
existing TQL option, select the Correlation TQL query on 
which you want to base the rule.

Base TQL Priority Select a priority level for the new TQL query (Low, 
Medium, High, Express). This setting determines how 
often the query is rerun automatically by the system to 
include updated information from the CMDB.

Description Enables you to define where you can run Correlation 
rules.

Included in Tasks “Define a Correlation Rule – Workflow” on page 199

Important 
Information

➤ The Correlation TQL that serves as the basis of the 
Correlation rule, is subject to certain validation 
restrictions. For details, see “Troubleshooting and 
Limitations” on page 427. If the TQL is not valid, it 
cannot be used for the creation of a Correlation rule.

➤ For important information on the effects of making 
changes to the TQL after creating it, see “New 
Correlation Rule/Correlation Rule Properties/Save As 
Correlation Rule Wizard” on page 219.

➤ By default, this wizard is set to display a Completion 
page after clicking Next in this page. You can choose 
not to display the Completion page by changing the 
user preferences. For details, see “User Preferences 
Dialog Box” on page 426.

Useful Links “Topology Query Language” on page 341

Wizard Map The New Correlation Rule/Correlation Rule 
Properties/Save As Correlation Rule Wizard contains:

Rule General Attributes Page > Rule Base TQL Page > Rule 
Groups Page

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Others Currently not supported. 

UCMDB Enables you to run a Correlation rule in the Topology 
View Application tab. For details, see “Topology View 
Overview” on page 524.
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6
CI Type Manager

This chapter provides information on CI Type Manager.

Note to HP Software-as-a-Service customers: The data in CI Type Manager 
can be viewed but not edited.

This chapter includes:

Concepts

 ➤  CI Types Overview on page 226

 ➤  CI Type Attributes on page 227

 ➤  CI Type Relationships on page 228

 ➤  System Type Manager on page 228

Tasks

 ➤  Create a CI Type on page 229

 ➤  Create a Relationship Type on page 230

 ➤  Create a Calculated Relationship Type on page 232

 ➤  Create List and Enumeration Definitions on page 233

 ➤  Enumeration Definition – Workflow on page 234

Reference

 ➤  View Descriptions for CI Types and Relationships on page 236

 ➤  CI Type Manager User Interface on page 236
Concepts
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CI Types Overview

A configuration item (CI) can represent hardware, software, services, 
business processes, or any component of your IT infrastructure. CIs with 
similar properties are grouped under a CI type (CIT). Each CIT provides a 
template for creating a CI and its associated properties. 

Every CI must belong to a CI type. The following are the main categories of 
CITs:

➤ Business. CITs that correspond to the logical elements of your business, such 
as processes and organizational groups.

➤ IT Process. CITs that correspond to changes that occur in your IT 
infrastructure.

➤ Monitor. CITs that handle incoming metrics collected from your business 
universe.

➤ System. CITs that correspond to the physical elements (hardware and 
software) installed in your business environment.

The CITs are arranged in a tree structure under these categories in the CI 
Types pane. You can browse the CI Type model by expanding the tree in the 
CI Types pane. The CIT selected in the left pane is displayed in the topology 
map along with all the potential valid relationships to other CITs.

You can also define new CITs to match your business needs. For details on 
defining new CITs, see “Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard” on page 245.
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CI Type Attributes

Every CI type has attributes which define it such as name, description, and 
default value. The CITs grouped under other CITs in the CI Type tree inherit 
attributes from the higher-level CITs. 

When you define a new CI type, you first select a Base Configuration Item 
Type from a list of existing CITs. Your new CIT inherits the attributes of the 
existing CIT. You can then set the attributes for the new CIT. You edit the 
attributes of an existing CIT by selecting a CIT from the tree in the CI Types 
pane and selecting the Attributes tab of the topology map. For details on 
CIT attributes, see “Attributes Page” on page 247.

Every CIT must have at least one key attribute. A key attribute is an attribute 
that is used as an identifier of the CIT. When you define an instance of a 
CIT, the CIT’s key attributes are mandatory fields for CIs of that type. You 
can assign as many key attributes as you want to a given CIT. If you do not 
assign a key attribute when defining a new CIT, the CIT is created, but it 
remains abstract, that is, you are unable to create instances of it (you are 
prompted to include the ABSTRACT_CLASS qualifier on the Qualifier page 
of the wizard).

Entity names in HP Universal CMDB for CMDB-based applications follow 
the conventions described below: 

➤ CIT attributes values. All primitive types are supported: long, double, float, 
string, and so on.

➤ CIT attributes values-type string. All special characters are supported. The 
maximum length is 4000 characters.

➤ CIT names and attributes names. The following are permitted: a-z, A-Z, and 
underscore (_). The length is limited to 200 characters. The CIT name must 
be in English.

➤ CIT attribute length. The total length of all the attributes in one CIT cannot 
exceed 8K due to a Microsoft SQL Server limitation.
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CI Type Relationships

A relationship defines the link between two CIs. Relationships represent the 
dependencies and connections between the entities in your IT environment. 
When you select relationships or calculated relationships in the drop-down 
box in the CI Types pane, the topology map displays all the valid instances 
of CITs linked by the selected relationship. For details about calculated 
relationships, see “Using Calculated Relationships” on page 433.

The same attributes defined for CITs are also defined for relationships. You 
can also assign key attributes for relationships but it is not required. For 
details on defining new relationship types, see “Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard” on page 245.

System Type Manager

System Type Manager enables you to create a predefined list whose values 
define an attribute type. For more details on System Type Manager, see 
“System Type Manager Dialog Box” on page 262.

You can create the following attribute types:

➤ List. Enables you to create a predefined list of values, for example, Location.

➤ Enumeration. Enables you to create a predefined list of values, as well as 
assign each value a color. Enumerations are designed to be used as severity 
value lists by states. For details, see “State Manager” on page 507. 

Severity lists are used for:

➤ Retrieving Correlation results in Topology View Application. For details, see 
“Topology View Application” on page 523.

➤ Creating a Correlation rule. For details, see “Correlation Manager” on 
page 197. 

You can use both List and Enumeration values for:

➤ Editing the attributes of a CIT. For details, see “Create a CI Type” on 
page 229.
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➤ Defining an attribute condition for a TQL node or relationship. For details, 
see “Node/Relationship Properties Dialog Box” on page 401.

Tasks

Create a CI Type

This task describes the process you follow to create a CIT using the Create CI 
Type wizard.

This task includes the following steps:

➤ “Prerequisites” on page 229

➤ “Define the CI Type” on page 229

➤ “Set the CI Type Attributes” on page 229

➤ “Assign Qualifiers to the CI Type” on page 230

➤ “Assign an Icon to the CI Type” on page 230

➤ “Customize the CI Type Menu” on page 230

➤ “Define the CI Type Default Label” on page 230

 1 Prerequisites
From the CI Type Manager, select CI Types from the list box in the CI Types 
pane. Then select New to start the Create CI Type Wizard.

 2 Define the CI Type
Enter the name, description and base configuration item type for the new CI 
type. For details, see “Details Page” on page 246.

 3 Set the CI Type Attributes
Edit the attributes of the new CI type and define key attributes for it. For 
details, see “Attributes Page” on page 247.
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Note: List and Enumeration definitions are created in the System Type 
Manager. If required, you can create additional List and Enumeration 
definitions. For details, see “Create List and Enumeration Definitions” on 
page 233.

 4 Assign Qualifiers to the CI Type
Assign qualifiers to the definition of the new CI type. For details, see 
“Qualifiers Page” on page 249.

 5 Assign an Icon to the CI Type
Select an icon to assign to the new CI type. For details, see “Icon Page” on 
page 252.

 6 Customize the CI Type Menu
Select the menu items and commands to appear in the shortcut menu for 
the new CI type. For details, see “Attached Menu Page” on page 254.

 7 Define the CI Type Default Label
Define the attributes to appear in the CI type label. For details, see “Default 
Label Page” on page 257.

Create a Relationship Type

This task describes the process you follow to create a relationship type using 
the Create Relationship wizard.

This task includes the following steps:

➤ “Prerequisites” on page 231

➤ “Define the Relationship” on page 231

➤ “Set the CI Type Attributes” on page 231
230



Chapter 6 • CI Type Manager
➤ “Assign Qualifiers to the Relationship” on page 231

➤ “Customize the Relationship Menu” on page 231

➤ “Define the Relationship Default Label” on page 232

 1 Prerequisites
From the CI Type Manager, select Relationships from the list box in the CI 
Types pane. Then select New to start the Create Relationship Wizard.

 2 Define the Relationship
Enter the name, description and base CI type for the new relationship. For 
details, see “Details Page” on page 246.

 3 Set the CI Type Attributes
Edit the attributes of the new relationship and define key attributes for it. 
For details, see “Attributes Page” on page 247.

Note: List and Enumeration definitions are created in the System Type 
Manager. If required, you can create additional List and Enumeration 
definitions. For details, see “Create List and Enumeration Definitions” on 
page 233.

 4 Assign Qualifiers to the Relationship
Assign qualifiers to the definition of the new relationship. For details, see 
“Qualifiers Page” on page 249.

 5 Customize the Relationship Menu
Select the menu items and commands to appear in the shortcut menu for 
the new relationship. For details, see “Attached Menu Page” on page 254.
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 6 Define the Relationship Default Label
Define the attributes to appear in the relationship label. For details, see 
“Default Label Page” on page 257.

Create a Calculated Relationship Type

This task describes the process you follow to create a calculated relationship 
type using the Create Calculated Relationship wizard.

This task includes the following steps:

➤ “Prerequisites” on page 232

➤ “Define the Calculated Relationship” on page 232

➤ “Assign Qualifiers to the Relationship” on page 232

➤ “Add Required Triplets” on page 232

 1 Prerequisites
From the CI Type Manager, select Calculated Relationships from the list box 
in the CI Types pane. Then select New to start the Create Calculated 
Relationship Wizard.

 2 Define the Calculated Relationship
Enter the name, description and base CI type for the new calculated 
relationship. For details, see “Details Page” on page 246.

 3 Assign Qualifiers to the Relationship
Assign qualifiers to the definition of the new relationship. For details, see 
“Qualifiers Page” on page 249.

 4 Add Required Triplets
Add the required triplets. For details, see see “Triplets Page” on page 251.
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Create List and Enumeration Definitions

This section describes the tasks for creating List and Enumeration 
definitions.

This task includes the following steps:

➤ “Create a List Definition” on page 233

➤ “Create an Enumeration Definition” on page 233

 1 Create a List Definition
You can create a List definition of predefined values. For example, a List 
definition called Location might contain:

➤ New York

➤ Boston

➤ Baltimore

For details, see “Create/Update List/Enumeration Definition Dialog Box” on 
page 259.

 2 Create an Enumeration Definition
You can create an Enumeration definition, which enables you to assign a 
color for each value on the list. For details, see “Create/Update 
List/Enumeration Definition Dialog Box” on page 259. For an example of an 
Enumeration definition, see “Enumeration Definition – Workflow” on 
page 234.
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Enumeration Definition – Workflow

The following steps describe how to create an Enumeration definition.

Note: To retrieve the required results, you must follow each step in this task.

To create an Enumeration definition:

 1 Select Admin > Modeling > CI Type Manager.

 2 In the left pane, click the System Type Manager  button to open the System 
Type Manager dialog box.

 3 Click the Add button to open the Create List/Enumeration Definition dialog 
box.

Note: Alternatively, you can select Admin > Settings > State Manager and 
then click the New Enumeration button to open the Create 
List/Enumeration Definition dialog box.

 4 Select Enumeration.

 5 In the Name box, enter the required name. 

 6 (Optional) In the Display Name box, enter the required display name.

This example describes how to create the following severity list:

 7 Click the Add  button to create a new row.

 8 In the Value box, enter Normal.

Key Value Severity Represented

0 Green Normal

1 Orange Major

2 Red Critical
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 9 In the Key box, enter 0.

 10 In the Color section, select Green.

 11 Click the Add  button to create another row.

 12 In the Value box, enter Major.

 13 In the Key box, enter 1.

 14 In the Color section, select Orange.

 15 Click the Add  button to create another row.

 16 In the Value box, enter Critical.

 17 In the Key box, enter 2.

 18 In the Color section, select Red.

The following image shows the Enumeration Definition section after the 
changes:

 19 Click OK to save your changes.

Reference
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View Descriptions for CI Types and Relationships

You can view a complete list of available CI types in tree format in the left 
pane of CI Type Manager. You can search incrementally for a specific CI type 
as described in “CI Type Manager” on page 240. To see a description for a 
particular CI type, select it from the tree and hold the pointer over the icon 
which corresponds to it in the Topology Map. A tooltip containing a 
description of the CI type is displayed.

For relationships, select Relationships in the left pane and search 
incrementally by the first letter of the relationship. Select the relationship 
you want and hold the pointer over its icon in the Topology Map to display 
a tooltip containing a description of the relationship.

You can also view a list of relationships in “Relationship Definitions” in 
Reference Information.

CI Type Manager User Interface

This section describes:

 ➤  Add/Edit Attribute Dialog Box on page 237

 ➤  Add/Remove Relationship Dialog Box on page 240

 ➤  CI Type Manager on page 240

 ➤  Create Configuration Item Type/Relationship/Calculated Relationship 
Wizard on page 245

 ➤  Create/Update List/Enumeration Definition Dialog Box on page 259

 ➤  System Type Manager Dialog Box on page 262
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Add/Edit Attribute Dialog Box

Details Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define a new attribute to add to a CIT or to 
edit an existing attribute of a CIT.

To access: In the CIT Manager, select the Attributes tab, 
then click the Add  button, or select an attribute and 
click the Edit button or double-click the attribute.

Important 
Information

In Edit mode, fields that cannot be changed are disabled.

GUI Element (A-Z) Description

Attribute Name Enter a unique name for the new attribute. The name can 
contain all characters except the following: " \ / [ ] : | < > + = 
; , ? *

Note: The attribute name is not case sensitive.

Attribute Type Select one of the following options:

➤ Primitive. Choose from one of the following field types: 
boolean, bytes, date, double, float, integer, integer_list, long, 
string, string_list, xml.

➤ Enumeration/List. Contains a list of Enumerations and 
Lists defined in the System Type Manager. For details, see 
“System Type Manager” on page 228.

This option enables you to define an attribute with a 
predefined value. For example, a location attribute might 
be defined by a location list containing the following 
values: Singapore, Paris, New York. 

Default Value Enter or select a default value for the attribute. The options 
for the Default Value field vary depending on the attribute 
type you selected. 

Note: If you select the integer_list or string_list Primitive 
attribute type, you can enter multiple values.
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Description Enter a description for the new attribute.

Note: This field is optional.

Display Name Enter a name for the new attribute to identify it in 
HP Universal CMDB.

Note: This field is optional.

Value Size Enter a value for the maximum physical size of the new 
attribute. (Enabled for bytes and string only).

GUI Element (A-Z) Description
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Advanced Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Advanced tab 
options>

You can set the following optional parameters:

➤ Visible. Select to display this attribute in the Properties 
tab in IT Universe Manager.

➤ Editable. Select to enable future editing of the attribute. 
Only attributes that are marked as Editable (or ones that 
have values) are displayed in the Properties tab in 
IT Universe Manager.

➤ Comparable. Select to enable this attribute to be used for 
comparing compound CIs.

➤ Required. Select to define this attribute as a required one, 
if its value is required for the creation of the CIT.

➤ Index. Select to accelerate the attribute retrieval 
performance. This option is recommended for attributes 
that are used frequently in search conditions. For 
example, IP address is usually an index attribute of a host.

➤ Change Monitored. Select to define attributes whose 
values are being marked as Change Monitored in CI Type 
Manager. For every change in an attribute defined as 
Change Monitored, you are notified by a Change event in 
the Topology View.

➤ Upper Case. When this option is selected, the attribute 
value appears in upper case.

➤ Lower Case. When this option is selected, the attribute 
value appears in lower case.

➤ Static. Select to define this attribute as static.

➤ Asset Data. Select to display the attribute value in the 
Asset Report.

➤ Password. When this option is selected, the attribute 
value appears as asterisks (a hidden value).

➤ Unique. When this option is selected, different instances 
of this CI type must have unique values.
239



Chapter 6 • CI Type Manager
Add/Remove Relationship Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

CI Type Manager

Description Enables you to add or remove default or new 
relationships between CITs, which define their physical 
or logical connections.

To access: In the CIT Manager, right-click a CIT or two 
CITs and select Add/Remove Relationship from the 
context menu.

Important 
Information

When adding a relationship between two CITs, select 
the two CITs to be linked by holding down CTRL and 
clicking the CIT names. Then right-click one of them 
to display the context menu and select Add/Remove 
Relationship.

GUI Element (A-Z) Description

<node1 to node2> Select the relationships to add in the direction of the 
first node to the second.

<node2 to node1> Select the relationships to add in the direction of the 
second node to the first.

Relationship Name A list of the possible relationships.

Description Enables you to view the information in the CI Type model, 
which contains the definitions of all configuration item 
types (CITs) defined in the system and the relationships that 
define the connections between them. Each CIT has its own 
attributes, as well as the attributes inherited from its parent 
CIT.

To access: Select Admin > Modeling > CI Type Manager.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click the New button to open the Create Configuration 
Item Type Wizard which enables you to define a new CI 
type. For details, see “Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard” on 
page 245.

Click Delete to delete the selected CI type or relationship.

Click to refresh the data content of the hierarchical tree 
structure that may have been modified by other users.

Click the Save button to save changes made to a CI type.

Enables you to import CITs from an external file.

Enables you to export a CIT as an XML file. Use this option 
to move CITs from one server to another.

<CI 
Type/Relationship 
Box>

Select one of the following options:

➤ CI Types. Display the CI types in the CIT model.

➤ Relationships. Display the relationships in the CIT model.

➤ Calculated Relationships. Display the calculated 
relationships in the CIT model.

<Main Menu> For details, see “Main Menu” on page 713.

<Toolbar> For details, see “Toolbar Options” on page 717.
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CI Types Pane A hierarchical tree structure of the CI Type model containing 
the inheritance relationships among CITs, and displaying 
the number of instances of each CIT in the UCMDB. All CITs 
included in the CI Type model are classified as either a CIT 
or a relationship. You can drill down and view the 
relationships and neighbors of the selected CIT in the 
topology map. You can search in the list of CITs or 
relationships using the Incremental Search by entering the 
first letter of the CIT or relationship repeatedly until you 
reach the required selection. You can also search for a CIT or 
relationship by entering its full name.

Note: Each CI type is represented by a unique icon. (If an 
icon has not been defined for the CIT, it takes the icon of its 
parent.)

GUI Element (A-Z) Description
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Main Window The following tabs are available:

➤ Dependencies. Displays the CI Type model in a topology 
map, including the CITs and the relationships between 
them. The name of the selected CI type or relationship 
appears in the border at the top of the pane. When you 
point to a CIT, a tooltip displays the display name of the 
CIT and its description.

➤ Details. Enables you to edit the basic information about 
the CI type selected in the left pane. For details, see 
“Details Page” on page 246.

➤ Attributes. Enables you to edit the attributes of the 
selected CIT. For details, see “Attributes Page” on 
page 247.

➤ Qualifiers. Enables you to assign qualifiers to the selected 
CIT. For details, see “Qualifiers Page” on page 249.

➤ Triplets. Enables you to create a calculated relationship. 
For details, see “Triplets Page” on page 251. This page 
appears only for calculated relationships.

➤ Icon. Enables you to assign an icon to the selected CIT. 
For details, see “Icon Page” on page 252. This tab does not 
appear for relationships.

➤ Attached Menu. Enables you to customize the shortcut 
menu of a CI by adding menu items and commands (for 
example, ping, run a program, open a URL). The 
customized menu is displayed when you right-click a CI 
instance in IT Universe Manager. For details, see 
“Attached Menu Page” on page 254.

➤ Default Label. Enables you to define attributes that appear 
in the CIT label. You can include more than one attribute 
by using the function buttons. For details, see “Default 
Label Page” on page 257.

GUI Element (A-Z) Description
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Context Menu
CI Type Manager includes the following context menu options available by 
right clicking a CI type in the CI Types pane or the Dependencies map:

GUI Element (A-Z) Description

Add/Remove 
Relationship

Opens the Add/Remove Relationship dialog box, which 
enables you to add or remove relationships from CITs. For 
details, see “Add/Remove Relationship Dialog Box” on 
page 240.

Delete Deletes the selected CI type. This option is only available for 
CI types that have no children and no instances.

Export Enables you to export a CIT as an XML file. Use this option 
to move CITs from one server to another.

New Opens the Create Configuration Item Type Wizard which 
enables you to define a new CI type. For details, see “Create 
Configuration Item Type/Relationship/Calculated 
Relationship Wizard” on page 245.

Show CIT 
Instances

Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” on page 394.
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Create Configuration Item Type/Relationship/Calculated 
Relationship Wizard

The Create Configuration Item Type wizard includes the following pages:

➤ “Details Page” on page 246

➤ “Attributes Page” on page 247

➤ “Qualifiers Page” on page 249

➤ “Triplets Page” on page 251

➤ “Icon Page” on page 252

➤ “Attached Menu Page” on page 254

➤ “Default Label Page” on page 257

Description Enables you to define a new configuration item type or 
relationship.

To access: 

➤ Click a CI type or relationship in the topology map or CI 
Types pane of the CIT Manager and select New from the 
context menu.

➤ Click the New button  in the CI types pane.

Wizard Map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page
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Details Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to enter basic information about the new CI 
type you are defining.

Important 
Information

For general information about the Create Configuration 
Item Type Wizard, see “Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard” on 
page 245.

Wizard Map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page

GUI Element (A-Z) Description

Base CI Type Select a base CIT for the CIT you are creating. The new CIT 
inherits the base CIT’s attributes.

Note: This field only appears in the Create CI Type Wizard. 
It is not relevant when editing an existing CIT in the Details 
tab of CI Type Manager.

Description A description for the new CIT.

Note: This field is optional.

Display Name The name of the CIT as it appears in the HP Universal CMDB 
interface.

Name The unique name of the new CIT. The name can contain all 
characters except the following: " \ / [ ] : | < > + = ; , ? *

Note: The name field is case sensitive, but you cannot use 
the same name with different cases for two different CITs.
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Attributes Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to edit the attributes of the CIT.

Wizard Map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page

GUI Element (A-Z) Description

To define an attribute as a key attribute, click in the left 
column beside the attribute name. A key icon appears in the 
cell. A key attribute is an attribute that must be defined for 
CIs of that CI type.

To remove the key attribute definition, click in the left 
column again. The key icon disappears.

For more information on key attributes, see “CI Type 
Attributes” on page 227.

Denotes a static attribute. A static attribute takes the same 
value for all the CIs of that type. If it is changed, all the CIs 
of that type are affected and automatically display the new 
value. A static attribute cannot be defined as a key attribute.

Note: You cannot define an attribute as static from within 
the CIT Manager. It is done by deploying the relevant 
package. Static attributes are for internal use only.

Click the Add button to define a new attribute. For details, 
see “Add/Edit Attribute Dialog Box” on page 237.

Select a row and click the Edit button to open the Edit 
Attribute dialog box. For details, see “Add/Edit Attribute 
Dialog Box” on page 237.

Note: If you modify an attribute belonging to a CIT’s parent, 
the text turns light blue. If you modify an attribute 
belonging to the CIT itself, the text turns dark blue.
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Click the Delete button to delete a selected attribute. This 
option is only active for newly defined attributes.

Click the Reset button to reset the attribute settings after 
editing a pre-existing attribute.

Click Select Columns to select the columns to appear using 
the Select Columns dialog box.

<Attributes> Displays all attributes associated with the new CIT. 
Attributes appearing in black are ones that the new CIT 
inherits from the base CIT. Attributes appearing in blue are 
ones that are private to this CIT and its descendants. 
Attributes appearing in light blue are inherited ones that 
have been modified for the new CIT.

Asset Data Select to display the attribute value in the Asset Report. For 
details see “Asset Report User Interface” on page 577.

Note: When this qualifier is selected for a given attribute, 
the attribute appears as a visible column in the Element 
Instances dialog box. For details, see “Element Instances 
Dialog Box” on page 394.

Change 
Monitored

Select to define attributes whose values are being marked as 
Change Monitored in CI Type Manager. 

Note: When this qualifier is selected for a given attribute, 
the attribute appears as a visible column in the Element 
Instances dialog box. For details, see “Element Instances 
Dialog Box” on page 394.

Comparable Select to enable this attribute to be used for comparing 
compound CIs. For details, see “Compare CIs User Interface” 
on page 569.

Note: When this qualifier is selected for a given attribute, 
the attribute appears as a visible column in the Element 
Instances dialog box. For details, see “Element Instances 
Dialog Box” on page 394.

Default Value The default value for the attribute. This value appears when 
the new CIT is defined and there is no runtime value for the 
attribute.

GUI Element (A-Z) Description
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Qualifiers Page

Description A description of the attribute.

Display Name The attribute name that appears in the HP Universal CMDB 
interface.

Editable Select to enable future editing of the attribute.

Only attributes that are marked as Editable (or ones that 
have values) are displayed in the Properties tab in 
IT Universe Manager.

Index Select to accelerate the attribute retrieval performance. 

This option is recommended for attributes that are used 
frequently in search conditions. For example, IP address is 
usually an index attribute of a host. 

Lower Case Select to keep the attribute value in lower case.

Name The actual name of the attribute (compare to Display Name).

Required Select to define this attribute as a required one, if its value is 
required for the creation of the CIT.

Type The type of the attribute.

Visible Select to display this attribute in the Properties tab in 
IT Universe Manager.

Description Enables you to assign qualifiers to a CIT definition.

Important 
Information

Qualifiers enable you to define added attribute definitions 
to the CIT. In the Qualifiers list, select the required qualifiers 
using the Add buttons to move your selections to the 
Configuration Item Type Qualifiers list. You can make 
multiple selections by holding down the CTRL key.

Wizard Map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click this button to move all qualifiers to the Configuration 
Item Type Qualifiers list.

Select the qualifier and click this button to add the qualifier 
to the Configuration Item Type Qualifiers list. Select 
multiple qualifiers by holding down the CTRL key.

To remove a qualifier from the CIT definition, select the 
qualifier from the Configuration Item Type Qualifiers list 
and click this button.

Click this button to remove all qualifiers from the 
Configuration Item Type Qualifiers list

To define a new, custom qualifier, enter the qualifier name 
in the window and click Insert. The qualifier appears in the 
Configuration Item Type Qualifiers list.

<Configuration 
Item Type 
Qualifiers>

The list of qualifiers that define attributes of the new CIT. 
For example, you can use a qualifier to define a CIT as 
abstract, which means that you cannot create instances from 
it.

<Qualifiers> For a list of the available qualifier options, see “Qualifier 
Tab” on page 408. 
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Triplets Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a calculated relationship.

Each row on the Triplets page represents one of the allowed 
steps in the path leading from the source CI to the target CI 
in the topology map.

Note: This step of the wizard is relevant only for calculated 
relationships.

Important 
Information

➤ For details about calculated relationships, see “Using 
Calculated Relationships” on page 433.

➤ For general information about the Create Configuration 
Item Type Wizard, see “Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard” on 
page 245.

Useful Links “Using Calculated Relationships” on page 625

Wizard Map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page

GUI Element (A-Z) Description

Click to define the allowed steps in a path in the topology 
graph leading from the source CI to the target CI in the 
calculated relationship. Opens the Add Triplet dialog box. 
For details, see “Add Triplet Dialog Box” on page 390.

Select a row and click the Edit button to edit the triplet. 
Opens the Edit Triplet dialog box. For details, see “Add 
Triplet Dialog Box” on page 390.

Click the Delete button to delete a selected triplet.

Relationship The required relationship connecting the two nodes.
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Icon Page

Relationship 
Direction

The required relationship direction.

➤  Indicates the direction of the physical relationship.

➤  Indicates the direction opposite to the physical 
relationship.

Source The required source node.

Target The required target node.

Description Enables you to select an icon to assign to the new CI Type.

Note: This step of the wizard is not relevant for 
relationships.

Important 
Information

Each CIT is displayed with a default icon. However, you can 
attach different icons to the same CIT when certain 
conditions apply. For example, you can associate different 
icons with the same CIT when one of its attribute values 
changes.

Wizard Map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to add a row.

Note: Only active if Change the Configuration Item Type 
icon according to its attribute value is selected.

Click to remove a row.

Note: Only active if Change the Configuration Item Type 
icon according to its attribute value is selected.

Attribute Name Select an attribute to determine the icon assigned to the CIT.

Change the 
Configuration 
Item Type icon 
according to its 
attribute value

Enables you to assign an icon for each attribute value. For 
example, you could define two values for the City attribute: 
if City=London, one icon is displayed. If City=Beijing, another 
icon is displayed.

Note: If you change the icon of a CIT that appears in an 
existing view, the CIT's icon is not updated in the view.

Configuration 
Item Type Main 
Icon

Select the group to which the CIT belongs.

Icon Select an icon to associate with the value you entered in the 
Value column.

Value Enter a value corresponding to the attribute you selected. 
You can add a new line for each value you enter.
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Attached Menu Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to customize the shortcut menu of a CI by 
adding menu items and commands (for example, ping, run 
a program, open a URL). The customized menu is displayed 
when you right-click a CI instance in IT Universe Manager.

Important 
Information

If a CIT does not have a method defined specifically for it, 
the CIT inherits all the menus from its parent CIT or the 
nearest ancestor that does have a method defined for it.

If you create or modify a menu, the change occurs only in 
the specific CIT that is being edited.

Wizard Map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page

GUI Element (A-Z) Description

Select a menu item from the tree and click the button. A 
new entry appears under the selected item.

Click to remove a menu item.

Click to move a selected menu item up in the menu.

Click to move a selected menu item down in the menu.

<Tree> Hierarchical tree containing the default menu items.

Caution: It is not recommended to edit the definitions of the 
default menu items.
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Command To connect to a specific location on the World Wide Web, 
select URL, and enter the exact Internet address, for 
example, http://www.hp.com/go/software. (Available only if 
you select the URL command type option.)

Note: If you use a variable in the Command field, use the 
format command name %1 and define the CIT attributes as 
described in Parameters. The parameter values replace %1 
according to their order in the list. For example, %1 is 
replaced by the first parameter in the list, %2 is replaced by 
the second parameter in the list, and so on.

Description Enter a description for the method. (This is for internal use 
only and does not appear in the menu.)

Existing Method Select to choose a command from a list of defined methods 
inherited from the IT Universe CIT and all its ancestors.

Icon Select the icon to appear next to the menu option in the 
context menu.

Note: This field is optional.

Menu Item Name Enter a name for the new menu item as it should appear in 
the menu.

Method Enables you to add a command to the menu.

Note: To create a method and not override the existing 
method, it is recommended to create a new menu item and 
place the new method there. 

Method Name Enter a name for the command.

New Method Select to add an action (for example, ping) to the menu 
item.

Parameters To add attributes to the command or URL, click the Add 
Parameter button and select the attribute from the list.

To delete an existing entry, select it and click the Remove 
Parameter button.

Note: Parameters are not relevant when Inner Process is 
selected.

GUI Element (A-Z) Description
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Require user 
confirmation?

Select the check box for users to confirm access to a menu 
item before the item is displayed.

Separator To place a separator between two menu items:

Click OK to place a separator underneath the selected menu 
option. 

Shortcut Press any key combination to create a shortcut for the menu 
item, for example, CTRL+H. 

Note: This field is optional.

Sub-Menu Select to create a sub-menu under the selected menu option.

Type Choose a command type:

➤ URL. Opens a web page to the specified URL. Enter the 
URL of a Web page for the command to open in the URL 
box.

➤ Inner Process. Triggers an internal HP Universal CMDB 
action. Select an action from the drop-down list of 
actions. 

➤ Execute. Triggers an executable action. Enter an 
executable command in the Executable box.

GUI Element (A-Z) Description
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Default Label Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define attributes that appear in the CIT label. 
You can include more than one attribute by using the 
function buttons.

The final step of the Create Configuration Item Type 
Wizard. 

Important 
Information

The label appears as the title under a CI of the new CI Type. 
The label definition can be customized to include different 
attribute values. For example, if the function label of the 
host CIT is composed of hostname and network, the 
displayed label is: server1 10.0.65.0.

Labels can also be created using regular expressions.

Wizard Map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page

GUI Element (A-Z) Description

Selects the attributes to appear in the Format box. Use the 
following function buttons to display multiple attributes in 
the label.

Adds parentheses to the formatted text (use in conjunction 
with the other functions).

And Places an AND operator between two attributes in the 
formatted text. For example, 
network_netaddr&network_domain displays the network 
address and the domain of a node.

Attribute Name Displays the available options of attributes to be included in 
the CIT label.

Clear Click to clear the Format window.
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Format Displays the attributes that you select to appear in the CIT 
label.

For example, to label a host by its host name and operating 
system, choose the host_hostname and host_os attributes. 
The CIT label is host1 UNIX.

You can define conditions using AND and OR combinations.

Note: To delete an attribute from the Format box, highlight 
it and press the DELETE key.

Or Places an OR operator between two attributes in the 
formatted text.

RegExp Adds a regular expression (using regular expression syntax) 
to the label definition. The structure of the entry is (v1, v2, 
v3), where v1 represents the selected attribute, v2 represents 
the regular expression itself (which divides the value into 
groups), and v3 represents the number of the selected group.

For example, if the selected attribute is a name, consisting of 
a first name, a space, and a surname, the regular expression 
would be (name, (\S*)(\s*)(\S*), 3), which indicates that the 
surname can be used for the name attribute in the default 
label.

For examples of how to use regular expression syntax, see 
“Regular Expression Examples” in Reference Information.

Undo Click to undo the last change in the Format window.

GUI Element (A-Z) Description
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Create/Update List/Enumeration Definition Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define a new List or Enumeration definition. 
The List or Enumeration definition you have created 
appears in the System Type Manager dialog box, where you 
can edit it if required (for details, see “System Type Manager 
Dialog Box” on page 262).

To access: Click the Add button in the System Type 
Manager dialog box.

Important 
Information

You can access the Create/Update Enumeration Definition 
dialog box from the State Manager as well. For details, see 
“State Manager” on page 507.

Included in Tasks “Create List and Enumeration Definitions” on page 233

GUI Element (A-Z) Description

Display Name Enter the name you want to appear in the list of System 
Type Definitions. If you leave this field empty, the entry in 
the Name field is used.

Enumeration Enables you to create a predefined list of values, as well as 
assign each value a color. For details, see “Enumeration 
Definition Area” on page 261.

List Enables you to create a predefined list of values. For details, 
see “List Definition Area” on page 260.

Name Enter a unique name for the definition.
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List Definition Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Create a predefined list of values. For example, a 
Location attribute might be defined by a location list 
containing the following values:

➤ New York

➤ Boston

➤ Baltimore

To access: Select List in the Create List/Enumeration 
Definition dialog box.

GUI Element (A-Z) Description

Add a List definition. Double-click inside the row and 
either select a date from the calendar that appears (if 
you chose the type Date) or type the required value.

Delete a List definition.

Type Choose one of following field types:

➤ Date

➤ Double

➤ Integer

➤ Long

➤ String
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Enumeration Definition Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a list from a predefined list of 
values (similar to List), with capabilities such as 
assigning a color for every value. Enumerations are 
designed to be used as severity value lists by states. You 
can use Enumerations for lists that require key values. 

To access: Select Enumeration in the Create 
List/Enumeration Definition dialog box.

Useful Links “Enumeration Definition – Workflow” on page 234

GUI Element (A-Z) Description

Add an Enumeration definition.

Remove an Enumeration definition.

Color Select a color that indicates the severity level.

Key Type a number to create an enumeration that describes 
a severity list for a category.

Assign key values according to the following rules:

➤ The list of key values must always begin with zero 
(0). (Zero represents the Normal state.) Otherwise, it 
does not appear in the State Manager (for details, see 
“State Manager” on page 507).

➤ The list must always be numbered consecutively.

For an example of an Enumeration definition, see 
“Enumeration Definition – Workflow” on page 234.

Value Type a value, either a string or a number, for example, 
Red or my value. The value appears in the tooltip for 
the CI in IT Universe Manager.
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System Type Manager Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the attribute types you defined in the Create 
List/Enumeration Definition dialog box.

To access: Select CI Types > System Type Manager.

Included in Tasks “Create List and Enumeration Definitions” on 
page 233

Useful Links “Enumeration Definition – Workflow” on page 234

GUI Element (A-Z) Description

Create a predefined list whose values define an attribute 
type. You can create a definition for the following attribute 
types:

➤ List definition.

➤ Enumeration definition.

For a description of these attribute types, see “Create/Update 
List/Enumeration Definition Dialog Box” on page 259.

Delete an existing definition. Select the system type 
definition you want to delete and click the Delete button.

Enables you to edit an existing definition. For details, see 
“Create/Update List/Enumeration Definition Dialog Box” on 
page 259.

<System Type 
Definitions>

The list of Enumeration and List definitions created in the 
System Type Manager.
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Topology Report Manager

This chapter provides information on Topology Report Manager.

This chapter includes:

Concepts

 ➤  Topology Report Manager Overview on page 264

Tasks

 ➤  Define a Report Rule – Scenario on page 264

 ➤  Compare a CI Configuration to a Gold Master Template on page 274

Reference

 ➤  Topology Report Manager User Interface on page 274

Troubleshooting and Limitations on page 299
Concepts
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Topology Report Manager Overview

Topology Report Manager enables you to define the following reports:

➤ Topology reports. Contains information about selected Report nodes in the 
managed world. Each report is based on a specific Report TQL query, which 
is created especially for it. (If required, you can define multiple reports for 
each query.) For more information about TQL queries, see “Topology Query 
Language” on page 341. Topology Report Manager enables you to define 
exactly which information appears in each report, including the order in 
which nodes are listed and their placement relative to other nodes, and how 
the information within each report is sorted. For details, see “Topology 
Report Manager Window” on page 285.

➤ Gold Master reports. Compares the configuration of a Gold Master CI to 
other CIs of the same CI type. Select the CI you want to use as the Gold 
Master CI, and then the CIs whose configuration you want to compare to 
the Gold Master template. You can choose the CIs from existing views or 
from the CMDB. The report that is generated specifies which of the selected 
CIs are configured differently. For details, see “Gold Master Report Pane” on 
page 279.

Tasks

Define a Report Rule – Scenario

This scenario describes how to create a Report TQL definition whose query 
results retrieve hosts that run on a Windows operating system. Then, by 
changing a report’s parameterized values, you can generate a report from 
that same TQL query displaying hosts that run on a Linux operating system.

Note: To retrieve the required query results, you must follow each step in 
this scenario.
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This task includes the following steps:

➤ “Create a Report TQL Query” on page 265

➤ “Set TQL Node Definitions” on page 266

➤ “Define the Column Content of the Selected Node” on page 267

➤ “Sort the Column Information” on page 268

➤ “Set the Node Order” on page 269

➤ “Refine the Report Layout” on page 270

➤ “View a Topology Report Displaying Hosts that Run on a Windows 
Operating System” on page 272

➤ “View a Topology Report Displaying Hosts that Run on a Linux Operating 
System” on page 273

 1 Create a Report TQL Query
To create a Report TQL query, you need to define a Report rule and then add 
the TQL nodes and relationships that define the query. 

Select Admin > Modeling > Topology Report Manager to open Topology 
Report Manager. For details about how to create a Report TQL query, see 
“New Report/Report Properties/Save As Report Wizard” on page 281. For 
details about how to add nodes and relationships to a query, see “Add Nodes 
and Relationships to a TQL Query”.
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Example of a Report TQL Query

In this Report TQL query, a Network and a Host node are linked by a 
Member relationship and the Host node is linked to an IP node by a 
Contained relationship. The TQL results must comply with the direction of 
the arrows.

Note: A TQL query is subject to certain validation restrictions. For details, 
see “Troubleshooting and Limitations” on page 427.

 2 Set TQL Node Definitions
You can set attribute definitions for the nodes and relationships you added 
to the TQL query. In the editing pane, right-click the required node, and 
select Node Properties to open the Node Properties dialog box. Then click 
the Attribute tab. For details on how to define node and relationship 
definitions, see “Node/Relationship Properties Dialog Box” on page 401.

Example of a TQL Node Definition

In Topology Report Manager, the attribute condition of the Host node are 
defined in the Attribute tab in the Node Properties dialog box to retrieve 
only hosts that run on a Windows operating system.
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To do this, in the Attribute tab, select the following:

➤ Attribute name — Host Operating System

➤ Operator — Like ignore case

➤ Parameterized Value

➤ Value — %windows%

When the Parameterized Value equals %windows%, all hosts that run on a 
Windows operating system are displayed in the query results.

 3 Define the Column Content of the Selected Node
Define which nodes to include in the report, and which attributes and 
functions to display for each node. In the editing pane, right-click the 
required node, and select Report Node Definition to open the Report Node 
Definition dialog box. Click the Add Attributes button to select the required 
attributes. For details, see “Report Node Definition Dialog Box” on page 294.

Example of Nodes to Be Included in a Report

➤ The attributes Network Address and Network Class are selected for the 
Network node.

➤ The attributes Host DNS Name and Host Operating System are selected for 
the Host node.
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➤ The attributes IP Network Address, IP Network Mask, and Last Access Time 
are selected for the IP node.

 4 Sort the Column Information
Determine the order of the information displayed for each node, and the 
method by which the data is sorted in each column. In the editing pane, 
right-click the appropriate node and select Report Node Definition to open 
the Report Node Definition dialog box. Then click Sort to open the 
Attribute Column dialog box to define the order in which the node’s 
attributes appear in the Topology report. For details, see “Attribute Columns 
Dialog Box” on page 277.

Example of the Order in Which the Node Information is Displayed in a 
Report

In the Attribute Columns dialog box, the attributes for the Network node 
are defined to appear in the Topology report in the following order:
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In the Attribute Columns dialog box, the attributes for the Host node are 
defined to appear in the Topology report in the following order:

In the Attribute Columns dialog box, the attributes for the IP node are 
defined to appear in the Topology report in the following order:

 5 Set the Node Order
Determine the order of the nodes in the report. Right-click any node from 
the query and select Node Order to open the Set Node Order dialog box. 
The Set Node Order dialog box displays a row for each node that is included 
in the report. Use the up and down arrows to move the nodes to the 
required location in the report. For details, see “Set Node Order Dialog Box” 
on page 296.
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Example of How the Order of the Nodes is Displayed in a Report

Use the up and down arrows to move the Network node to the beginning of 
the list and the IP node to the bottom. The Network node is the parent 
node, so it should appear at the beginning of the report. The data of the 
Host node is displayed next, followed by the IP node. 

 6 Refine the Report Layout
You can display nodes dependent on other nodes either aligned underneath 
or indented underneath the parent node a generated report. Displaying 
nodes indented beneath one another enables you to better distinguish 
between parent nodes and their children. 

The editing pane enables you to define how nodes are displayed in a 
generated report in relation to one another. For details about the editing 
pane, see “Topology Report Manager Window” on page 285.
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Example of How Nodes are Displayed in Relation to One Another

➤ In this report, the IP CI is defined as the child of the Host CI, and the Host 
CI is defined as the child of the Network CI. As a result, the IP CI is indented 
underneath the Host CI and the Host CI is indented under the Network CI 
in the generated report.

➤ In this report, the IP, Host, and Network CIs are defined as siblings, so all the 
CIs are displayed aligned with one another.
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 7 View a Topology Report Displaying Hosts that Run on a 
Windows Operating System
In the Reports pane, right-click the Report TQL query definition and select 
Generate.

This report displays an instance of a host CI that runs on a Windows 2003 
operating system.
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 8 View a Topology Report Displaying Hosts that Run on a Linux 
Operating System
In the Reports pane, right-click the Report TQL query and select Set Report 
Parameters to open the Set Report Parameters wizard. Click %windows%, 
and in the Editing window that opens, enter %linux%. Save the new 
definition. Then right-click the Hosts report definition and select Generate.

This report displays an instance of a host CI that runs on a Linux operating 
system.
273



Chapter 7 • Topology Report Manager
Compare a CI Configuration to a Gold Master Template

This task describes how to create a Gold Master report definition and then 
generate a Gold Master report.

This task includes the following steps:

➤ “Create a Gold Master Report Definition” on page 274

➤ “Generate a Gold Master Report” on page 274

 1 Create a Gold Master Report Definition
Define a Gold Master report that compares the configuration of a Gold 
Master CI to other CIs of the same CI type, or a child of the CI type. Select 
the CI you want to use as the Gold Master CI and then the CIs whose 
configuration you want to compare to the Gold Master template. You can 
select the CIs from existing views or from the CMDB. For details, see “Gold 
Master Report Pane” on page 279.

 2 Generate a Gold Master Report
Generate a report that specifies which of the selected CIs are configured 
differently. For details, see “Gold Master Report Pane” on page 279.

Reference

Topology Report Manager User Interface

This section describes:

 ➤  Add Attributes Dialog Box on page 275

 ➤  Add/Edit Function Dialog Box on page 276

 ➤  Attribute Columns Dialog Box on page 277

 ➤  Edit Attribute Dialog Box on page 278

 ➤  Filter CITs Dialog Box on page 278

 ➤  Gold Master Report Pane on page 279

 ➤  New Report/Report Properties/Save As Report Wizard on page 281
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 ➤  Topology Report Manager Window on page 285

 ➤  Report Node Definition Dialog Box on page 294

 ➤  Set Node Order Dialog Box on page 296

 ➤  Set Report Parameters Wizard on page 297

 ➤  Set View-specific Report Dialog Box on page 298

Add Attributes Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define the content of the selected Report 
node’s columns.

To access: Click the Add Attributes  button in the 
Report Node Definition dialog box.

Included in Tasks “Define a Report Rule – Scenario” on page 264

Important 
Information

Attributes that have already been selected in the Report 
Node Definition dialog box do not appear on the list.

GUI Element (A-Z) Description

<Click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

<Right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

Add Select the check box of the attributes you want to appear 
in the report. The selected attributes appear in the Report 
Node Definition dialog box. Each attribute you add 
represents a column in the report.

Attribute The name of the attribute.

Column Title The column title, by default, takes the same name as the 
selected attribute. You can change the title of the column 
in the Edit Attribute dialog box.
275



Chapter 7 • Topology Report Manager
Add/Edit Function Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define which of the node’s functions and 
parameters you want to include in the report.

To access: Click the Add Function  button in the 
Report Node Definition dialog box.

Included in Tasks “Define a Report Rule – Scenario” on page 264

GUI Element (A-Z) Description

Attribute Define the necessary parameters.

Function From the Function list, select the function you want to 
use to calculate the results on these columns. 

Following are the available options:

➤ average. The average value of all the attributes of the 
connected nodes.

➤ count. Calculate the number of node instances 
connected to the selected node.

➤ max. The maximum value of all the attributes of the 
connected nodes.

➤ min. The minimum value of all the attributes of the 
connected nodes.

➤ sum. The sum of all the attributes of the connected 
nodes.

Related The node on which you want to perform the function.

Title The name of the function attribute displayed in the 
report.
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Attribute Columns Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Determine the order of the information displayed for 
each Report node, and the method by which the data is 
sorted in each column.

To access: Click the Sort  button in the Report Node 
Definition dialog box.

Included in Tasks “Define a Report Rule – Scenario” on page 264

GUI Element (A-Z) Description

Ascending Sort the information in ascending order.

Descending Sort the information in descending order.

Sort Items by Select the primary sort column from the Sort Item by list.

Then by Define up to three secondary sort columns from the Then 
by lists.
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Edit Attribute Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Filter CITs Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Modify the name of the column title.

To access: Select the required attribute in the Report Node 
Definition dialog box and click the Edit/Attribute 
Function  button.

Included in Tasks “Define a Report Rule – Scenario” on page 264

GUI Element (A-Z) Description

Attribute Displays the node’s selected attribute. This box cannot be 
edited.

Column Title Modify the column title as required. The name that 
appears in the Column Title box is, by default, the same 
name as the attribute. The modified column title appears 
in the Field column in the Report Node Definition dialog 
box.

Description Enables you to exclude the CI types you do not want to 
appear in the Gold Master report.

To access: Click the Filter CI Types  button in the Gold 
Master Report pane.

GUI Element (A-Z) Description

<List of CI types> The CI types you select are excluded from the report.
278



Chapter 7 • Topology Report Manager
Gold Master Report Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Define a Gold Master report definition that compares the 
configuration of a Gold Master CI to other CIs of the 
same CI type or a child of the CI type. You choose the 
CI you want to use as the Gold Master CI and then the 
CIs whose configuration you want to compare to the 
Gold Master template. You can choose the CIs from 
existing views or from the CMDB. The report that is 
generated specifies which of the selected CIs are 
configured differently.

To access: 

1  Select Admin > Modeling > Topology Report Manager.

2  Right-click anywhere in the Reports pane and click 
New or click the New  button to open the New 
Report Wizard.

3  Define the report and select Gold Master.

Important 
Information

➤ You can also define a schedule that generates and 
saves Gold Master reports on a periodic basis. For 
details, see “Scheduler” on page 493.

➤ The CIs appear in this report under the following 
circumstances:

➤ Their attributes are marked as Comparable in the 
Add Attribute dialog box in the CI Type Manager.

➤ The CIs have descendants that are defined as 
Comparable.

For details, see “Add/Edit Attribute Dialog Box” on 
page 237.

GUI Element (A-Z) Description

Determines which CI types are not included in the Gold 
Master report. Opens the Filter CITs dialog box.

Generates a Gold Master report. For details, see “Gold 
Master Report” on page 551.
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Compared CIs Pane

Master CI Pane

Left Pane

Moves the required CIs back and forth between the left 
pane and the Master CIs pane and the Compared CIs 
panes.

Include Similar Items Select this check box if you want to include the compared 
CIs whose configuration is identical to that of the Gold 
Master CI.

Description Contains the CIs that you want to compare to the Gold 
Master CI.

Important 
Information

You can select multiple CIs.

Description Contains the CI you want to use as a Gold Master CI.

Description The left pane contains the following tabs:

➤ Browse. Select the required CI from different levels of 
the view hierarchy. For details, see “Browse Tab” on 
page 574.

➤ Search. Search for a specific CI in existing views or in 
the entire CMDB. For details, see “Search Tab” on 
page 574.

GUI Element (A-Z) Description
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New Report/Report Properties/Save As Report Wizard

Report General Attributes Page

Description Create or modify a Topology or Gold Master report 
definition.

To access: 

➤ To create a Topology or Gold Master report definition, 
right-click anywhere in the Reports pane and click 
New or click the New  button.

➤ To modify a Topology or Gold Master report definition, 
right-click a report definition in the Reports pane and 
select Properties. 

➤ To create a new report based on an existing query, 
right-click a report definition in the Reports pane and 
select Save As.

Included in Tasks “Define a Report Rule – Scenario” on page 264

Wizard Map The New Report/Report Properties/Save As Report Wizard 
contains:

Report General Attributes Page > Report Titles Page > 
Report Base TQL Page

Description Enables you to enter a unique name and description for a 
Topology or Gold Master report.

Included in Tasks “Define a Report Rule – Scenario” on page 264

Important 
Information

By default, this wizard is set to display a Welcome page. 
You can choose not to display the Welcome page by 
changing the user preferences. For details, see “User 
Preferences Dialog Box” on page 426.

Useful Links “Topology Query Language” on page 341

Wizard Map The New Report/Report Properties/Save As Report Wizard 
contains:

Report General Attributes Page > Report Titles Page > 
Report Base TQL Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Report Titles Page

GUI Element (A-Z) Description

Report Description (Optional) Enter a description of the report.

Report Name Enter a unique name for the Topology or Gold Master 
report.

The report name cannot contain any of the following 
characters: \ / : " < > | % ?

Note: If the Report name is either empty, contains a 
name used by another report, or uses invalid characters, 
the Next and Finish buttons are disabled.

Report Type Select one of the following options:

➤ Gold Master. Create a Gold Master report. For details 
on how to define a Gold Master report, see “Gold 
Master Report Pane” on page 279.

➤ Topology. Create a Topology report. For details, see 
“Topology Report” on page 591.

Description Enables you to define the report titles.

Included in Tasks “Define a Report Rule – Scenario” on page 264

Important 
Information

This page is relevant to Topology reports only.

Useful Links “Topology Query Language” on page 341

Wizard Map The New Report/Report Properties/Save As Report Wizard 
contains:

Report General Attributes Page > Report Titles Page > 
Report Base TQL Page
282



Chapter 7 • Topology Report Manager
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Report Base TQL Page

GUI Element (A-Z) Description

Report Subtitle Enter the subtitle of the Topology report. This title 
appears underneath the title at the head of the report.

Report Title Enter the title of the Topology report. This title appears at 
the head of the report.

Description Enables you to define the properties of the TQL on which 
the Topology report is based.

Included in Tasks “Define a Report Rule – Scenario” on page 264

Important 
Information

➤ This page is relevant to Topology reports only.

➤ By default, this wizard is set to display a Completion 
page after clicking Next in this page. You can choose 
not to display the Completion page by changing the 
user preferences. For details, see “User Preferences 
Dialog Box” on page 426.

Useful Links “Topology Query Language” on page 341

Wizard Map The New Report/Report Properties/Save As Report Wizard 
contains:

Report General Attributes Page > Report Titles Page > 
Report Base TQL Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Base the report on a 
new TQL

Select this check box if you want to base the Topology 
report on a new TQL query. The report that is generated 
displays the results of the attributes defined for the new 
TQL.

Base the report on an 
existing TQL

Select this check box if you want to base the Topology 
report on an existing TQL query. Select the required 
Report TQL query from the drop-down list.

Base TQL Description (Optional) Enter a description of the TQL query.

Base TQL Name Enter a unique name for the Report TQL query.

If you selected the Base the report on an existing TQL 
option, select the Report TQL query on which you want 
to base the Topology report.

Base TQL Priority Select a priority level for the new TQL query (Low, 
Medium, High, Express). This setting determines how 
often the query is rerun automatically by the system to 
include updated information from the CMDB.
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Topology Report Manager Window

Reports Pane

Description Topology Report Manager enables you to:

➤ Define Topology reports about specific Report nodes. 
Each report is based on a specific Report TQL query, 
which is created especially for it. You can define 
exactly what information appears in each report, 
including the order in which Report nodes are listed 
and their placement relative to other Report nodes, 
and how the information within each report is sorted.

➤ Define a report that compares the configuration of a 
Gold Master CI to other CIs of the same CI type or a 
child of the CI type. For details, see “Gold Master 
Report Pane” on page 279.

To access: Select Admin > Modeling > Topology Report 
Manager.

Important 
Information

You can also define a schedule that creates Topology 
reports based on a specific Report query, on a periodic 
basis. For details, see “Scheduler” on page 493.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Compare a CI Configuration to a Gold Master 
Template” on page 274

Description Displays a hierarchical tree structure of predefined folders 
containing report definitions. Each report is associated 
with a TQL query.

You can create your own TQL query, or work with the 
default queries provided with your HP Universal CMDB 
installation.

The predefined folders are provided for the default 
queries. You can modify these folders, or add additional 
folders according to your organization’s requirements.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Create a new folder.

Create a TQL Report or Gold Master report definition. 
Opens the New Report wizard.

Delete the selected folder or report.

Refresh the data content of the hierarchical tree structure 
that may have been modified by other users.

(Enabled only when a report is created or when changes 
are made to an existing one.) Save the Gold Master or 
Topology report to the CMDB.

Open the New Report Properties wizard. Enables you to 
change the description and activation state of the report.

Generates  a preview of the results of the selected Report 
TQL.

Represents a folder.

Represents a Gold Master report definition.

Represents a Topology report definition.
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The following elements are available by right-clicking a folder or report:

GUI Element (A-Z) Description

Delete Delete the selected folder or report definition from the 
CMDB.

Export Displays a standard Save As dialog box, enabling you to 
save the report as an XML script. This option can be used 
to move a report from one workstation to another, 
provided the related TQL Report query is also relocated.

Note: Only relevant for Topology reports and not Gold 
Master reports.

Import Import XML files that contain saved Report queries to 
Topology Report Manager.

New Create a TQL Report or Gold Master report definition. 
Opens the New Report Wizard.

New Folder Create a new folder.

Properties Open the Report Properties wizard. Enables you to 
change the description and activation state of the report.

Rename Folder Rename the folder.

Preview Generates  a preview of the results of the selected Report 
TQL.

Save (Enabled only when a new TQL Report or Gold Master 
report definition is created or when changes are made to 
an existing one.) Save the TQL Report or Gold Master 
report definition to the CMDB.

Save As Displays the Save As dialog box, enabling you to define a 
new name and description for a TQL Report or Gold 
Master report definition. This option can be used for 
creating a new report based on an existing one.
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Editing Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Set Report 
Parameters

Enables you to generate a report using values different 
than the ones you defined in the Attribute tab in the 
Node/Relationship dialog box. Opens the Set Report 
Parameters wizard.

Note: This option only appears if you defined a 
parameterized value in the Attribute tab in the 
Node/Relationship Properties dialog box.

Set View-specific 
report

(Optional) Enables you to generate a report of the 
selected Report TQL query based on a certain view rather 
than the entire CMDB. Select the view on which you 
want to base the report.

Description Create and define Report nodes and relationships.

➤ When you select a folder in the Reports pane, the 
editing pane is empty.

➤ When you select a report in the Reports pane, the 
editing pane displays the TQL Report query, which 
consists of TQL nodes that are defined in the TQL 
query and the relationships between them, or the Gold 
Master report.

Useful Links “Add Nodes and Relationships to a TQL Query” on 
page 348

GUI Element (A-Z) Description

<Context menu> options For details, see “Context Menu Options” on 
page 357.

<Main Menu> For details, see “Main Menu” on page 713.

<Node> A component from which TQL queries are built.

GUI Element (A-Z) Description
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The following elements are available by right-clicking a relationship. These 
options define how nodes are displayed in a generated report in relation to 
one another.

<Relationship> The entity that defines the relationship between 
two nodes.

<Toolbar> For details, see “Toolbar Options” on page 717.

<Tooltips> Hold the cursor over a node or relationship to 
view its tooltip.

The tooltips contain the following information:

➤ Node Report Order: The order in which the 
Report node appears in the report.

➤ Node Report Label: A title for the selected 
Report node definition. For details, see Report 
Node Definition dialog box.

➤ Column Title: The title of each column for that 
node. For details, see Edit Attribute dialog box.

GUI Element (A-Z) Description

Add Relationship 
Folding Rule

Enables you to define how nodes are displayed in a 
generated report in relation to one another. 

You can use one of the following options:

Child. Define one Report node as a child of the Report 
node to which it is linked. In the report, the child Report 
nodes are displayed indented beneath the parent nodes.

None. Does not define any rules for this relationship. In 
the Topology report, the Report nodes appear in different 
tables.

Sibling. Define one Report node as a sibling of the Report 
node to which it is linked. In the report, the two Report 
nodes appear aligned with one another.

SonGrid. Groups all the leaf instances in a table under 
their parent’s node. This option applies to leaf nodes 
only.

GUI Element (A-Z) Description
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CI Type Selector

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a hierarchical tree structure of the CI Types 
found in the CMDB. For more details, see “CI Type 
Manager User Interface” on page 236.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

To create or modify a TQL query, click and drag nodes to 
the Editing pane and define the relationship between 
them. Your changes are saved to the CMDB. For details, 
see “Add Nodes and Relationships to a TQL Query” in 
Model Management.

Important 
Information

The CI Type Selector is part of the following managers: 
View Manager, Enrichment Manager, Query Manager, 
Correlation Manager, Topology Report Manager, and 
Trigger TQL Editor. 

Included in Tasks ➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Define a TQL Query” on page 346

➤ “Create a Pattern View” on page 164

➤ “Define a Report Rule – Scenario” on page 264

GUI Element (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

Click Expand All to expand all subtrees within the CI 
type tree.
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Context Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Information Pane

Click Collapse All to collapse the subtrees within the CI 
type tree.

<Search window> Enter the name or part of a name of a CI type for which 
to search.

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” in Model Management.

Description Displays the properties, conditions, and cardinality for 
the selected node and relationship.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

The Information pane appears in the lower part of the 
window in the following managers and user interfaces: 
View Manager, Correlation Manager, Query Manager, 
Topology Report Manager, Enrichment Manager, 
Discovery Input TQL Editor, and Discovery Trigger TQL 
Editor.

A small green indicator  appears next to the tabs in 
which a change occurred.

Included in Tasks ➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Define a TQL Query” on page 346

➤ “Create a Pattern View” on page 164

➤ “Define a Report Rule – Scenario” on page 264

GUI Element (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current manager. You can select a tab from the list.

Affected Nodes Displays which node is affected by the changes that occur in 
the selected trigger node. If required, you can click Edit to 
open and modify the Affected Nodes dialog box. For details, 
see “Affected Nodes Dialog Box” on page 206.

Note: This tab appears only in Correlation Manager.

Attributes Displays the attribute conditions defined for the node or the 
relationship. For details, see “Attribute Tab” on page 403.

Cardinality Cardinality defines how many nodes you expect to have at 
the other end of a relationship. For example, in a 
relationship between host and IP, if the cardinality is 1:3, the 
TQL retrieves only those hosts that are connected to 
between one and three IPs. For details, see “Cardinality Tab” 
on page 405.
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Details Displays the following information:

➤ CI Type. The CIT of the selected node/relationship.

➤ Visible. A green check indicates that the selected 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.

Enrichment Rules Displays the Enrichment rule defined for the selected node 
or relationship. If the Enrichment rule is used to update the 
attributes of a CI, click Edit to open the Node/Relationship 
Definition dialog box and edit the rule if required. For 
details, see “Node/Relationship Definition Dialog Box” on 
page 336.

Note: This tab appears only in Enrichment Manager.

Folding Rule Displays the folding rule defined for the selected 
relationship. For details about folding rules, see “Adding 
Folding Rules to Relationships” on page 65.

Note: This tab appears only when a relationship is selected 
in View Manager.

Grouping Displays the different CI groupings for the selected node, as 
defined in the Grouping dialog box.

Note: This tab appears only in View Manager.

Node Definition Displays the attributes to be included in the report for the 
selected node. If required, you can click Edit to open and 
modify the Report Node definition dialog box. For details, 
see “Report Node Definition Dialog Box” on page 294.

Note: This tab appears only in Topology Report Manager.

Qualifiers Displays the qualifier conditions defined for the node or the 
relationship. For details, see “Qualifier Tab” on page 408.

GUI Element (A-Z) Description
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Report Node Definition Dialog Box

Rule Displays the report folding rule defined for the selected 
relationship. For details about folding rules, see “Editing 
Pane” on page 288.

Note: This tab appears only when a relationship is selected 
in Topology Report Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL results. For details, see 
“Identity Tab” on page 410.

Description Displays the node attributes that are included in the 
report, that is, the report’s columns. Each row in the table 
represents a column that appears in the report.

You select the required attributes from the Add Attributes 
dialog box.

To access: Right-click a node and select Report Node 
Definition.

Included in Tasks “Define a Report Rule – Scenario” on page 264

Important 
Information

Only defined nodes are included in the final report. 
However, other nodes are included in the report 
calculations, since they are part of the TQL that the 
report reflects, and they can influence the data that is 
displayed in it. For example, in a Report TQL, which 
consists of a linked Host and IP, the IP has an attribute 
condition that states that only IPs that are in a critical 
state are included in the query results. Consequently, the 
report includes only hosts that are connected to IPs in a 
critical state, even if the IPs themselves are not included 
in the report.

Note: The nodes to be included in the reports must be 
connected to each other through the TQL scenario. You 
cannot define nodes that are not linked to at least one 
other node that is included in the report.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Select the attributes you want to appear in the report 
template. Opens the Add Attributes dialog box.

Define the function you want to perform on the Report 
node. Opens the Add Function dialog box.

Modify the attributes, functions and parameters, defined 
for each Report node.

Enables you to:

➤ Modify the name of the column title for that attribute. 
Select an attribute that displays attribute in the 
Function column. Opens the Add/Edit Attribute dialog 
box.

➤ Modify the functions and parameters you defined for 
the selected report node. Select an attribute that 
displays the parameters included for each node and 
the function (such as sum or max) performed on them 
in the Function and Parameter columns. Opens the 
Add/Edit Function dialog box.

Delete the selected report node definition. A column for 
the node definition you deleted does not appear in the 
report.

Use the up and down arrows to determine the order of 
each node included in the report.

Define the sort order of the information reported for each 
Report node. Opens the Attribute Columns dialog box.

<Click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

<Right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.
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Set Node Order Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Field Displays the nodes that are included in the report, that is, 
the report’s columns.

The title of the column as displayed in the Field box is 
the way the column title appears in the report template. 
By default, column titles take the same name as the 
selected attribute. You can change the title of the column 
in the Edit Attribute dialog box.

Parameters Displays the parameters you defined for the Report node. 
For details, see the Add/Edit Function dialog box.

Title A title for the selected Report node definition.

Type Displays the functions you defined for the Report node. 
For details, see the Add/Edit Function dialog box.

Description Determine the order in which the Report nodes appear in 
the report.

To access: Right-click any node displayed in the editing 
pane and select Node Order to open the Set Node Order 
dialog box.

The Set Node Order dialog box displays a row for each 
node that is included in the report.

Included in Tasks “Define a Report Rule – Scenario” on page 264

GUI Element (A-Z) Description

Use the up and down arrows to determine the order of 
each node included in the report.

Nodes The list of nodes contained in the selected Report query.

GUI Element (A-Z) Description
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Set Report Parameters Wizard

Set Parameters on <node>

Description Displays all the parameterized values defined for the 
nodes in the TQL as configured in the Attribute tab in the 
Node/Relationship dialog box.

Enables you to modify the value and then generate a 
report based on the changed value.

To access: In the Reports pane, right-click a Report 
definition whose report was defined with parameterized 
values from the Attribute tab in the Node/Relationship 
dialog box.

Important 
Information

➤ Changing the value in the Set Report Parameters 
wizard changes what is displayed in the generated 
report and not the TQL query results.

➤ This dialog box is available only if you defined 
parameterized values in the Attribute tab in the 
Node/Relationship dialog box.

Included in Tasks “Define a Report Rule – Scenario” on page 264

Useful Links “Topology Report” on page 591

Wizard Map The Set Report Parameters Wizard contains:

Set Parameters on <node> > Set Parameterized Values 
Summary Page

Description Enables you to modify the parameterized value and then 
generate a report based on the changed value.

Wizard Map The Set Report Parameters Wizard contains:

Set Parameters on <node> > Set Parameterized Values 
Summary Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Set Parameterized Values Summary Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Set View-specific Report Dialog Box

GUI Element (A-Z) Description

Attribute name The attribute used in the attribute condition.

Operator The operator used in the attribute condition. 

Value The value of the attribute.

Description Displays all the parameterized values defined for all the 
TQL’s nodes as configured in the Attribute tab in the 
Node/Relationship dialog box.

Wizard Map The Set Report Parameters Wizard contains:

Set Parameters on <node> > Set Parameterized Values 
Summary Page

GUI Element (A-Z) Description

<Parameterized 
values>

Displays all the parameterized values defined for the 
TQL’s nodes.

Description Enables you to generate a report of the selected Report 
TQL query based on a specific view rather than the entire 
CMDB.

To access: In the Reports pane, right-click a Report 
definition and select View-Specific Report.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Troubleshooting and Limitations

You cannot create a new report if the report’s name contains more than 16 
Japanese characters. For details, see “New Report/Report Properties/Save As 
Report Wizard” on page 281.

Included in Tasks “Define a Report Rule – Scenario” on page 264

Useful Links “Topology Report” on page 591

GUI Element (A-Z) Description

Click to open the Select View dialog box. Select the view 
on which you want to base the report.

View Opens the View tree. Select the view on which you want 
to base the report.
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8
Query Manager

This chapter provides information on Query Manager.

This chapter includes:

Concepts

 ➤  Query Manager Overview on page 301

Tasks

 ➤  Create a TQL Query on page 303

Reference

 ➤  Query Manager User Interface on page 303
Concepts

Query Manager Overview

Query Manager enables you to create TQL queries that can be used in other 
managers.

It is recommended to use the relevant managers (Correlation Manager, 
Enrichment Manager, View Manager, Topology Report Manager, Trigger TQL 
Editor) to create your TQL queries, rather than Query Manager. All TQL 
queries that are created in the other managers automatically appear in 
Query Manager.

You can use the Save As option in Query Manager to change the type of a 
TQL, so you do not have to recreate it. For details, see “Queries Pane” on 
page 307. Then, to see the query results in the Topology Map, you can 
create, in View Manager, a view based on the TQL query created in Query 
Manager.
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Once you create and save a TQL query of the types View, Correlation, 
Enrichment, and Report, you cannot edit it. To edit a TQL of these types, 
you can go to the relevant manager, for example, the View Manager, and 
create a new view based on the TQL query that you created in Query 
Manager. Then you can edit the TQL query which was created in Query 
Manager, in the View Manager. Any changes you make to the query in the 
View Manager appear in the TQL query in Query Manager. You can only edit 
queries of the types Integration or Discovery in Query Manager.

You can display the retrieved data of the view’s TQLs in a topology map 
where you can monitor the data. For details, see “Topology View 
Application” on page 523. The TQL resides in the system’s memory and 
generates updated results automatically. For more information about 
Topology Query Language, see “Topology Query Language” on page 341.

Tasks
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Create a TQL Query

To create a TQL query, you need to create a TQL and then add the TQL 
nodes and relationships that define the query. 

Select Admin > Modeling > Query Manager to open Query Manager. For 
details about how to create a TQL query, see “New Query/Save Query 
As/Query Properties Dialog Box” on page 303.

For details about how to add nodes and relationships to a query, see “Add 
Nodes and Relationships to a TQL Query” on page 348.

Reference

Query Manager User Interface

This section describes:

 ➤  New Query/Save Query As/Query Properties Dialog Box on page 303

 ➤  Query Manager Window on page 306

New Query/Save Query As/Query Properties Dialog Box
O

Description Create or modify a TQL query.

To access: 

➤ Right-click anywhere in the Queries pane and click 
New or click the New  button.

or

➤ Right-click a TQL query and select Properties.

Important 
Information

TQL queries are subject to certain validation restrictions. 
For details, see “Troubleshooting and Limitations” on 
page 427. 

If the TQL is not valid, you cannot save it.

Included in Tasks “Create a TQL Query” on page 303
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Persistent (Optional) Define whether the selected TQL should 
always remain in the system memory. Use this option 
only for frequently used TQLs.

Query Description (Optional) Enter a description of the TQL query.

Query Name Enter a unique name for the TQL query.

Query Priority Select a priority level for the new TQL query (Low, 
Medium, High, or Express). This setting determines how 
often the query should be rerun automatically by the 
system to include updated information from the CMDB.

Note: If you are creating a TQL of the type Enrichment, 
you can choose a priority of either Low or Medium only.
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Query Type You can create a TQL query of the following types:

➤ View. Creates queries for pattern views whose results 
are displayed in IT Universe. For details, see “View 
Manager” on page 149.

Note: Perspectives cannot be deleted from the Query 
Manager.

➤ Correlation. Creates queries containing Correlation 
nodes, defined using the Correlation Manager. For 
details, see “Correlation Manager” on page 197.

➤ Enrichment. Creates queries containing Enrichment 
nodes and relationships. For details, see “Enrichment 
Manager” on page 315.

➤ Report. Creates queries whose results are compiled into 
reports using Topology Report Manager. For details, see 
“Topology Report Manager” on page 263.

➤ Discovery. Creates queries for use by the Discovery and 
Dependency Mapping (DDM) system. For details, see, 
“Trigger TQL Editor Window” in Discovery and 
Dependency Mapping Guide.

➤ Integration. Creates queries for use with the CMDB 
API. For details, see “The HP Universal CMDB Web 
Service API” on page 15 in Reference Information.

Note: Discovery TQLs should be created only by users 
who are thoroughly familiar with the DDM patterns used 
by the DDM system. For details, contact HP Software 
Support. 

GUI Element (A-Z) Description
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Query Manager Window

Description Enables you to query the CMDB by defining TQL queries 
or to change the type of an existing TQL.

To access: Click Admin > Modeling > Query Manager.

Important 
Information

➤ It is recommended to use the relevant Managers 
(Correlation Manager, Enrichment Manager, View 
Manager, Topology Report Manager, Trigger TQL 
Editor) to create your TQL queries, rather than Query 
Manager. All TQLs that are created in the other 
managers automatically appear in Query Manager. You 
can use the Save As option in Query Manager to 
change the type of TQL, so you do not have to recreate 
it. For details, see “Queries Pane” on page 307.

➤ Once you create and save a TQL query of the types 
View, Correlation, Enrichment, and Report, you 
cannot edit it. To edit a TQL of these types, you can go 
to the relevant manager, for example, the View 
Manager, and create a new view based on the TQL 
query that you created in Query Manager. You can 
then can edit the TQL query (which was created in 
Query Manager) in the View Manager. Any changes 
you make to the query in the View Manager appear in 
the TQL query in Query Manager. 

You can only edit queries of the Integration or 
Discovery types in Query Manager.

➤ For TQL queries to be valid, they must comply with 
the restrictions described in “Troubleshooting and 
Limitations” on page 427.

Useful Links “Topology Query Language (TQL) Overview” on page 342
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Queries Pane
 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a hierarchical tree structure of predefined folders 
and TQL queries.

You can create your own query, or work with the default 
queries provided with your HP Universal CMDB 
installation.

Predefined folders are provided for the out-of-the-box 
queries; you can modify these folders, or add additional 
folders according to your organization’s requirements.

GUI Element (A-Z) Description

Creates a new folder.

Enables you to create a TQL query of the types View, 
Correlation, Enrichment, Report, Discovery, or 
Integration. You can only edit queries of the types 
Integration or Discovery in Query Manager. Opens the 
New Query dialog box.

Deletes the selected folder or TQL query.

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.

(Enabled only when a TQL query is created or when 
changes are made to an existing one.) Save the TQL query 
to the CMDB.

Opens the Query Properties dialog box. For a description, 
see “Properties” below.

Generates  a preview of the results of the selected TQL 
query.

Represents a folder.

Represents a TQL query of the type Integration.
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The following elements are available by right-clicking a folder or a TQL 
query:

Represents a TQL query of the type (pattern) View.

Represents a TQL query of the type Template.

Represents a TQL query of the type Perspective.

Represents a TQL query of the type Correlation.

Represents a TQL query of the type Enrichment.

Represents a TQL query of the type Report.

Represents a TQL query of the type Discovery.

GUI Element (A-Z) Description

Delete Delete the selected folder or TQL query.

Export Displays a standard Save As dialog box, enabling you to 
save the TQL query in XML script format. This option 
can be used to move TQL queries from one workstation 
to another.

Import Imports XML files that contain saved TQL queries to 
Query Manager.

New Create a TQL query. For details, see “New Query/Save 
Query As/Query Properties Dialog Box” on page 303.

New Folder Create a new folder.

Preview Generates  a preview of the results of the selected TQL 
query.

Properties Opens the TQL Properties dialog box. Enables you to 
change the priority and description of the selected TQL 
query, and define whether the TQL should always remain 
in the system memory (Persistent).

GUI Element (A-Z) Description
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Editing Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Rename Folder Rename the folder.

Save (Enabled only when a new TQL is created or when 
changes are made to an existing TQL) Save the query to 
the CMDB after you have defined the specific attribute 
conditions of the nodes and relationships in the query.

Note: If you exit the Query Manager without saving, a 
confirmation dialog box is displayed, requesting that you 
save your query.

Save As Opens the Save Query As dialog box, enabling you to 
create a query by copying an existing one.

You can change the type of the query. For a description of 
the available query types, see “Query Type” on page 305.

Description Displays the currently selected TQL.

➤ When you select a folder in the Queries pane, the 
editing pane is empty.

➤ When you select a TQL query in the Queries pane, the 
editing pane displays the selected query, which 
consists of TQL nodes that are defined in the TQL 
query and the relationships between them.

Useful Links “Add Nodes and Relationships to a TQL Query” on 
page 348.

GUI Element (A-Z) Description

<Context menu> options For details, see “Context Menu Options” on 
page 357.

<Main Menu> For details, see “Main Menu” on page 713.

<Node> A component from which TQL queries are built.

GUI Element (A-Z) Description
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CI Type Selector

<Relationship> The entity that defines the relationship between 
two nodes.

<toolbar> For details, see “Toolbar Options” on page 717.

<tooltips> Hold the cursor over a node or relationship to 
view its tooltip.

The tooltips contain the following information:

➤ Element name. The name of the node.

➤ CI Type. The CIT of the node as defined in the 
CI Type Manager. For details, see “CI Type 
Manager” on page 225.

➤ Definitions of the selected nodes and 
relationships. The attribute conditions, as 
described in “Node/Relationship Properties 
Dialog Box” on page 401.

Description Displays a hierarchical tree structure of the CI Types 
found in the CMDB. For more details, see “CI Type 
Manager User Interface” on page 236.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

To create or modify a TQL query, click and drag nodes to 
the Editing pane and define the relationship between 
them. Your changes are saved to the CMDB. For details, 
see “Add Nodes and Relationships to a TQL Query” in 
Model Management.

Important 
Information

The CI Type Selector is part of the following managers: 
View Manager, Enrichment Manager, Query Manager, 
Correlation Manager, Topology Report Manager, and 
Trigger TQL Editor. 

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks ➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Define a TQL Query” on page 346

➤ “Create a Pattern View” on page 164

➤ “Define a Report Rule – Scenario” on page 264

GUI Element (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

Click Expand All to expand all subtrees within the CI 
type tree.

Click Collapse All to collapse the subtrees within the CI 
type tree.

<Search window> Enter the name or part of a name of a CI type for which 
to search.
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Context Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Information Pane

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” in Model Management.

Description Displays the properties, conditions, and cardinality for 
the selected node and relationship.

Important 
Information

The Information pane appears in the lower part of the 
window in the following managers and user interfaces: 
View Manager, Correlation Manager, Query Manager, 
Topology Report Manager, Enrichment Manager, 
Discovery Input TQL Editor, and Discovery Trigger TQL 
Editor.

A small green indicator  appears next to the tabs in 
which a change occurred.

Included in Tasks ➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Define a TQL Query” on page 346

➤ “Create a Pattern View” on page 164

➤ “Define a Report Rule – Scenario” on page 264
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current manager. You can select a tab from the list.

Affected Nodes Displays which node is affected by the changes that occur in 
the selected trigger node. If required, you can click Edit to 
open and modify the Affected Nodes dialog box. For details, 
see “Affected Nodes Dialog Box” on page 206.

Note: This tab appears only in Correlation Manager.

Attributes Displays the attribute conditions defined for the node or the 
relationship. For details, see “Attribute Tab” on page 403.

Cardinality Cardinality defines how many nodes you expect to have at 
the other end of a relationship. For example, in a 
relationship between host and IP, if the cardinality is 1:3, the 
TQL retrieves only those hosts that are connected to 
between one and three IPs. For details, see “Cardinality Tab” 
on page 405.

Details Displays the following information:

➤ CI Type. The CIT of the selected node/relationship.

➤ Visible. A green check indicates that the selected 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Enrichment Rules Displays the Enrichment rule defined for the selected node 
or relationship. If the Enrichment rule is used to update the 
attributes of a CI, click Edit to open the Node/Relationship 
Definition dialog box and edit the rule if required. For 
details, see “Node/Relationship Definition Dialog Box” on 
page 336.

Note: This tab appears only in Enrichment Manager.

Folding Rule Displays the folding rule defined for the selected 
relationship. For details about folding rules, see “Adding 
Folding Rules to Relationships” on page 65.

Note: This tab appears only when a relationship is selected 
in View Manager.

Grouping Displays the different CI groupings for the selected node, as 
defined in the Grouping dialog box.

Note: This tab appears only in View Manager.

Node Definition Displays the attributes to be included in the report for the 
selected node. If required, you can click Edit to open and 
modify the Report Node definition dialog box. For details, 
see “Report Node Definition Dialog Box” on page 294.

Note: This tab appears only in Topology Report Manager.

Qualifiers Displays the qualifier conditions defined for the node or the 
relationship. For details, see “Qualifier Tab” on page 408.

Rule Displays the report folding rule defined for the selected 
relationship. For details about folding rules, see “Editing 
Pane” on page 288.

Note: This tab appears only when a relationship is selected 
in Topology Report Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL results. For details, see 
“Identity Tab” on page 410.

GUI Element (A-Z) Description
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Enrichment Manager

This chapter provides information on Enrichment Manager.

This chapter includes:

Concepts

 ➤  Enrichment Manager Overview on page 315

Tasks

 ➤  Define an Enrichment Rule – Scenario on page 318

Reference

 ➤  Enrichment Manager User Interface on page 321
Concepts

Enrichment Manager Overview

Enrichment rules can be used for several purposes:

➤ Adding new CIs and relationships to the CMDB.

➤ Deleting specific CI instances from the CMDB.

➤ Updating the attribute values of specific CI instances in the CMDB.

Enrichment nodes and relationships differ from other nodes and 
relationships in that they are conceptual deductions that represent real 
relationships and CIs that cannot be discovered automatically by the 
discovery process.
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Enrichment nodes and relationships are created as part of a TQL, whose 
other TQL nodes are regular ones, meaning TQL nodes that already exist in 
the CMDB. For more information about TQL queries, see “Topology Query 
Language” on page 341.

The following example displays a regular Host node linked to an IBM 
Websphere MQ Enrichment node by an Enrichment Container link 
relationship.

By placing an Enrichment node within a TQL query context, the query 
receives data from its attributes, and uses it to insert new information into 
the CMDB.
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When you create Enrichment rules, the following results can occur:

➤ The CMDB is enlarged. Add Enrichment nodes and relationships that are 
currently not included in the CMDB.

The following Enrichment rule example displays a regular Windows node 
(that already exists in the CMDB) connected to a File Enrichment node by 
an Enrichment Container link relationship.

This Enrichment rule states that for every Windows CI instance that is 
found in the CMDB, a new File CI instance is created, and linked to the 
Windows CI with a Container link relationship.

➤ Specific CI instances are deleted from the CMDB. For an example, see 
“Define an Enrichment Rule – Scenario” on page 318.

➤ The values of CI attributes are updated. Use an Enrichment rule to update 
the attributes of a CI that already exists in the CMDB.

The following Enrichment rule example illustrates that a regular File System 
node (that already exists in the CMDB) has been updated with an 
Enrichment rule.

This Enrichment rule states that every File System CI found in the CMDB is 
updated with the attribute value defined in the Enrichment rule.

Tasks
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Define an Enrichment Rule – Scenario

This task describes how to create an Enrichment rule where, for every 
instance in the CMDB in which an IP CI is connected to two identical Host 
CIs, but one Host CI is identified by its IP address and the other host is 
identified by its lowest MAC address, the Host CI that is identified by its IP 
address is deleted from the CMDB.

Note: To reach the required result, you must implement each one of the 
following steps.

This task includes the following steps:

➤ “Create an Enrichment TQL Query” on page 318

➤ “Define the Host Node that Is Identified by its Lowest MAC Address” on 
page 320

➤ “Define the Host Node that is Identified by its IP Address” on page 320

➤ “Define the Enrichment Rule” on page 321

 1 Create an Enrichment TQL Query
To create an Enrichment TQL query, you need to define an Enrichment rule 
and then add the regular TQL nodes and relationships that define the query.

Note: You can add Enrichment nodes and relationships only after at least 
one regular node has been added to the query. In this task then, you must 
first add regular nodes and relationships.

Select Admin > Modeling > Enrichment Manager. For details about how to 
create an Enrichment TQL query, see “New Enrichment Rule/Enrichment 
Rule Properties/Save As Enrichment Rule Wizard” on page 332. For details 
about how to add nodes and relationships to a query, see “Add Nodes and 
Relationships to a TQL Query” on page 348.
318



Chapter 9 • Enrichment Manager
Example of an Enrichment TQL Query

A new Enrichment TQL query called doubleHosts1 (located under the 
Network folder) is created in the Enrichment Manager.

The doubleHosts1 Enrichment rule is displayed in the Enrichment Rules 
pane.

a

In this Enrichment TQL query, an IP node is linked to two Host nodes by a 
Contained relationship. The TQL results must comply with the direction of 
the arrows.
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Note: A TQL query is subject to certain validation restrictions. For details, 
see “Troubleshooting and Limitations” on page 427.

 2 Define the Host Node that Is Identified by its Lowest MAC 
Address
At the top of the Enrichment Manager window, select TQL mode. In the 
editing pane, right-click the required Host node, select Node Properties to 
open the Node Properties dialog box. Then define an attribute condition in 
the Attribute tab. For details on how to define an attribute condition, see 
“Attribute Tab” on page 403.

Example of an Attribute Condition Definition that Identifies the Host 
by its Lowest Mac Address

In the Attribute tab, this attribute condition definition identifies the 
required Host by its lowest MAC address.

➤ Attribute name — Host is Complete

➤ Operator — Equal

➤ Value — True

 3 Define the Host Node that is Identified by its IP Address
At the top of the Enrichment Manager window, select TQL mode. In the 
editing pane, right-click the required Host node, and select Node Properties 
to open the Node Properties dialog box. Then define two attribute 
conditions in the Attribute tab. For details on how to define an attribute 
condition, see “Attribute Tab” on page 403.

Example of an Attribute Condition that Enables a Host to Be 
Identified by its IP Address

This attribute condition is the first attribute condition you need to define in 
the Attribute tab to enable the Host node to be identified by its IP address.

➤ Attribute name — Host is Complete

➤ Operator — Equal
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➤ Value — False

This is the second attribute condition you need to define in the Attribute tab 
to enable the Host node to be identified by its IP address.

➤ Attribute name — Host is Complete

➤ Operator — Is null

➤ Value — Value cannot be changed

 4 Define the Enrichment Rule
Define the Enrichment rule that deletes all instances of the Host node that 
are identified by their IP address. From the Enrichment Manager window 
toolbar, select Enrichment mode. In the Enrichment Rules pane, select the 
doubleHosts1 Enrichment rule. Then right-click the Host node that is 
identified by its IP address and select Delete Relationship/Node Item.

Example of a Host Node Containing a Removed Indicator

The Host node now has a removed indicator to denote that all host 
instances that have identical attribute and cardinality settings are removed 
from the CMDB. The Enrichment query now looks like this.

Reference

Enrichment Manager User Interface

This section describes:

 ➤  Enrichment Manager Window on page 322

 ➤  New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule 
Wizard on page 332
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 ➤  Node/Relationship Definition Dialog Box on page 336

 ➤  Node Definition – Advanced Attribute Dialog Box on page 338

Enrichment Manager Window

Enrichment Rules Pane

Description Define Enrichment rules. These rules, which are based 
on a specific TQL query, can be used for several 
purposes:

➤ Adding new CIs and relationships to the CMDB.

➤ Deleting specific CI instances from the CMDB.

➤ Updating the attribute values of specific CI instances 
in the CMDB.

To access: Select Admin > Modeling > Enrichment 
Manager.

Important 
Information

Enrichment Manager has two modes in which you can 
work. Always check the Enrichment/TQL mode list in 
the toolbar to verify the currently selected mode.

Included in Tasks “Define an Enrichment Rule – Scenario” on page 318

Description Displays a hierarchical tree structure of predefined folders 
and Enrichment rules. Each Enrichment rule is associated 
with a TQL query.

You can create your own query, or work with the out-of-
the-box (factory) queries provided with your 
HP Universal CMDB installation.

The default folders are provided for the out-of-the-box 
queries. You can modify these folders, or add additional 
folders according to your organization’s requirements.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

The following elements are available by right-clicking a folder or 
Enrichment rule:

GUI Element (A-Z) Description

Creates a new folder.

Creates an Enrichment rule. Opens the New Enrichment 
Rule/Properties wizard.

Deletes the selected folder or Enrichment rule.

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.

(Enabled only when an Enrichment rule is created or 
when changes are made to an existing one.) Saves the 
Enrichment rule to the CMDB.

Opens the New Enrichment Rule/Properties wizard. 
Enables you to change the description and the activation 
state of the Enrichment rule.

Generates  a preview of the results of the selected 
Enrichment rule.

Represents a folder.

Represents an Enrichment rule.

GUI Element (A-Z) Description

Delete Deletes the selected folder or Enrichment rule.

Export Displays a standard Save As dialog box, enabling you to 
save the Enrichment rule as an XML script. This option 
can be used to move an Enrichment rule from one 
workstation to another, provided the related TQL query is 
also relocated.
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Import Imports XML files that contain saved Enrichment queries 
to the Enrichment Manager.

New Creates an Enrichment rule. Opens the New Enrichment 
Rule dialog box.

New Folder Creates a new folder.

Preview Generates  a preview of the results of the selected 
Enrichment rule.

Properties Opens the New Enrichment Rule/Properties dialog box. 
Enables you to change the description and the activation 
state of the rule.

Rename Folder Renames the folder

Save (Enabled only when a new Enrichment query is created 
or when changes are made to an existing one.) Saves the 
Enrichment rule to the CMDB.

Save As Displays the Save As dialog box, enabling you to define a 
new name and description for a query. This option can be 
used for creating a new Enrichment rule based on an 
existing one.

GUI Element (A-Z) Description
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Editing Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Create and define Enrichment nodes and relationships.

➤ When you select a folder in the Enrichment Rules 
pane, the editing pane is empty.

➤ When you select an Enrichment rule in the 
Enrichment Rules pane, the editing pane displays the 
selected rule, which consists of TQL nodes that are 
defined in the TQL query and the relationships 
between them, and the Enrichment nodes and 
relationships that are created and added to the rule.

Important 
Information

➤ The Enrichment Manager has two modes in which 
you can work: Enrichment mode and TQL mode.

The right-click options that appear when you click a 
node or relationship depends on the which mode in 
which you are working. For details, see the editing 
pane description below.

➤ You can calculate the number of instances that were 
created as a result of an Enrichment rule and remove 
the instances created from an Enrichment rule from 
the CMDB. For details, see “Additions Count” on 
page 717 and “Remove Enrichment Results” on 
page 722.

Included in Tasks “Define an Enrichment Rule – Scenario” on page 318

Useful Links For details on how to create a TQL query, see “Add Nodes 
and Relationships to a TQL Query” on page 348.

GUI Element (A-Z) Description

Indicates an added Enrichment node or 
relationship.

Indicates a node or relationship that has been 
deleted from the CMDB.

Indicates an updated node or relationship.
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TQL and Enrichment 
mode

The Enrichment Manager has two modes in 
which you can work: Enrichment mode and TQL 
mode.

Working in:

➤ TQL mode enables you to define regular 
(non-Enrichment) relationships and nodes and 
add them to the TQL query you defined.

➤ Enrichment mode enables you to define 
Enrichment relationships and nodes and add 
them to the TQL query you defined.

<Context menu> options For details, see “Context Menu Options” on 
page 357.

<Main Menu> For details, see “Main Menu” on page 713.

<Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between 
two nodes.

<Toolbar> For details, see “Toolbar Options” on page 717.

<Tooltips> Hold the cursor over a node or relationship to 
view its tooltip.

The tooltips contain the following information:

➤ Element name. The name of the node.

➤ CI Type. The CIT of the node as defined in the 
CI Type Manager. For details, see “CI Type 
Manager” on page 225.

➤ Definitions of the selected nodes and 
relationships. The attribute conditions, as 
described in “Node/Relationship Properties 
Dialog Box” on page 401.

GUI Element (A-Z) Description
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CI Type Selector

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a hierarchical tree structure of the CI Types 
found in the CMDB. For more details, see “CI Type 
Manager User Interface” on page 236.

Note: The number of instances of each CIT in the CMDB 
is displayed to the right of each CIT.

To create or modify a TQL query, click and drag nodes to 
the Editing pane and define the relationship between 
them. Your changes are saved to the CMDB. For details, 
see “Add Nodes and Relationships to a TQL Query” in 
Model Management.

Important 
Information

The CI Type Selector is part of the following managers: 
View Manager, Enrichment Manager, Query Manager, 
Correlation Manager, Topology Report Manager, and 
Trigger TQL Editor. 

Included in Tasks ➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Define a TQL Query” on page 346

➤ “Create a Pattern View” on page 164

➤ “Define a Report Rule – Scenario” on page 264

GUI Element (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

Click Expand All to expand all subtrees within the CI 
type tree.
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Context Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Information Pane

Click Collapse All to collapse the subtrees within the CI 
type tree.

<Search window> Enter the name or part of a name of a CI type for which 
to search.

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the Show All Instances window, which displays all 
instances of the selected CIT. For details, see “Element 
Instances Dialog Box” in Model Management.

Description Displays the properties, conditions, and cardinality for 
the selected node and relationship.

GUI Element (A-Z) Description
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Important 
Information

The Information pane appears in the lower part of the 
window in the following managers and user interfaces: 
View Manager, Correlation Manager, Query Manager, 
Topology Report Manager, Enrichment Manager, 
Discovery Input TQL Editor, and Discovery Trigger TQL 
Editor.

A small green indicator  appears next to the tabs in 
which a change occurred.

Included in Tasks ➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Define a TQL Query” on page 346

➤ “Create a Pattern View” on page 164

➤ “Define a Report Rule – Scenario” on page 264
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current manager. You can select a tab from the list.

Affected Nodes Displays which node is affected by the changes that occur in 
the selected trigger node. If required, you can click Edit to 
open and modify the Affected Nodes dialog box. For details, 
see “Affected Nodes Dialog Box” on page 206.

Note: This tab appears only in Correlation Manager.

Attributes Displays the attribute conditions defined for the node or the 
relationship. For details, see “Attribute Tab” on page 403.

Cardinality Cardinality defines how many nodes you expect to have at 
the other end of a relationship. For example, in a 
relationship between host and IP, if the cardinality is 1:3, the 
TQL retrieves only those hosts that are connected to 
between one and three IPs. For details, see “Cardinality Tab” 
on page 405.

Details Displays the following information:

➤ CI Type. The CIT of the selected node/relationship.

➤ Visible. A green check indicates that the selected 
node/relationship is visible in the topology map. A red 
mark indicates that it is not visible.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
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Enrichment Rules Displays the Enrichment rule defined for the selected node 
or relationship. If the Enrichment rule is used to update the 
attributes of a CI, click Edit to open the Node/Relationship 
Definition dialog box and edit the rule if required. For 
details, see “Node/Relationship Definition Dialog Box” on 
page 336.

Note: This tab appears only in Enrichment Manager.

Folding Rule Displays the folding rule defined for the selected 
relationship. For details about folding rules, see “Adding 
Folding Rules to Relationships” on page 65.

Note: This tab appears only when a relationship is selected 
in View Manager.

Grouping Displays the different CI groupings for the selected node, as 
defined in the Grouping dialog box.

Note: This tab appears only in View Manager.

Node Definition Displays the attributes to be included in the report for the 
selected node. If required, you can click Edit to open and 
modify the Report Node definition dialog box. For details, 
see “Report Node Definition Dialog Box” on page 294.

Note: This tab appears only in Topology Report Manager.

Qualifiers Displays the qualifier conditions defined for the node or the 
relationship. For details, see “Qualifier Tab” on page 408.

Rule Displays the report folding rule defined for the selected 
relationship. For details about folding rules, see “Editing 
Pane” on page 288.

Note: This tab appears only when a relationship is selected 
in Topology Report Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL results. For details, see 
“Identity Tab” on page 410.

GUI Element (A-Z) Description
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New Enrichment Rule/Enrichment Rule Properties/Save 
As Enrichment Rule Wizard

Description Creates or modifies an Enrichment rule.

To access: 

➤ To create a new Enrichment rule, right-click anywhere 
in the Enrichment Rules pane and click New or click 
the New  button.

➤ To modify an existing Enrichment rule, right-click an 
Enrichment rule in the Enrichment Rules pane and 
select Properties. 

➤ To create a new Enrichment rule based on an existing 
query, right-click an Enrichment rule in the 
Enrichment Rules pane and select Save As.

Included in Tasks “Define an Enrichment Rule – Scenario” on page 318

Important 
Information

➤ When creating a new Enrichment rule, bear in mind 
that the application does not allow you to make any 
changes in the TQL that are necessary for the rule. 
These changes include the following:

➤ Deleting, from the Enrichment TQL, the nodes or 
relationships connected to the Enrichment node, 
causing a node to become unattached to any 
relationship.

➤ You cannot change the cardinality definition to 0 
(not required) of a node or relationship that is used 
in an Enrichment rule. For details on relationship 
cardinality, see “Node/Relationship Properties 
Dialog Box” on page 401.

➤ An Enrichment TQL that serves as the basis for 
Enrichment rules, is subject to certain validation 
restrictions. For details, see “Troubleshooting and 
Limitations” on page 427. If the TQL is not valid, you 
cannot save it.

Useful links “Topology Query Language” on page 341

Wizard Map The New Enrichment Rule /Enrichment Rule 
Properties/Save As Correlation Rule wizard contains:

Rule General Attributes Page > Rule Base TQL Page
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Rule General Attributes Page

Description Enables you to enter a unique name and description for 
the Enrichment rule.

Included in Tasks “Define an Enrichment Rule – Scenario” on page 318

Important 
Information

➤ An Enrichment TQL that serves as the basis for 
Enrichment rules, is subject to certain validation 
restrictions. For details, see “Troubleshooting and 
Limitations” on page 427. If the TQL is not valid, you 
cannot save it.

➤ For important information on the effects of making 
changes to the TQL after creating it, see “New 
Enrichment Rule/Enrichment Rule Properties/Save As 
Enrichment Rule Wizard” on page 332.

➤ By default, this wizard is set to display a Welcome 
page. You can choose not to display this page by 
changing the user preferences. For details, see “User 
Preferences Dialog Box” on page 426.

Useful Links “Topology Query Language” on page 341

Wizard Map The New Enrichment Rule/Enrichment Rule 
Properties/Save As Enrichment Rule Wizard contains:

Rule General Attributes Page > Rule Base TQL Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Description (Optional) Enter a description of the rule.

Enrichment Rule is 
Active

(Optional) Select this option to activate the rule in the 
system as soon as it is saved.

Default: Not selected

Notes: 

➤ If an active Enrichment rule is deactivated (by clearing 
the Enrichment Rule is Active check box), all changes 
that occurred in the CMDB relating to the rule are 
deleted from the system. When you deactivate an 
Enrichment rule, a red X appears next to the 
Enrichment rule in the Enrichment Rules pane.

➤ To reactivate the rule, right-click the rule in the 
Enrichment Rules pane and select Properties. In the 
General Attributes page , select Enrichment Rule is 
Active.

Rule Name Enter a unique name for the Enrichment rule. 

The rule name cannot contain any of the following 
characters: \ / : " < > | % ?

Note: If the Enrichment rule name is either empty, 
contains a name used by another Enrichment rule, or 
uses invalid charcters, the Next and Finish buttons are 
disabled.
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Rule Base TQL Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define the properties of the TQL on which 
the Enrichment rule is based.

Included in Tasks “Define an Enrichment Rule – Scenario” on page 318

Important 
Information

➤ An Enrichment TQL that serves as the basis for 
Enrichment rules, is subject to certain validation 
restrictions. For details, see “Troubleshooting and 
Limitations” on page 427. If the TQL is not valid, you 
cannot save it.

➤ For important information on the effects of making 
changes to the TQL after creating it, see “New 
Enrichment Rule/Enrichment Rule Properties/Save As 
Enrichment Rule Wizard” on page 332.

➤ By default, this wizard is set to display a Completion 
page after clicking Next in this page. You can choose 
not to display the Completion page by changing the 
user preferences. For details, see “User Preferences 
Dialog Box” on page 426.

Useful Links “Topology Query Language” on page 341

Wizard Map The New Enrichment Rule/Enrichment Rule 
Properties/Save As Enrichment Rule Wizard contains:

Rule General Attributes Page > Rule Base TQL Page

GUI Element (A-Z) Description

Base the Enrichment 
rule on a new TQL

Select this check box if you want to base the Enrichment 
rule on a new TQL query. The TQL results are based on 
the attributes defined for the new TQL query.

Base the Enrichment 
rule on an existing 
TQL

Select this check box if you want to base the Enrichment 
rule on an existing TQL query. Select the required 
Enrichment TQL query from the drop-down list.

Base TQL Description (Optional) Enter a description of the TQL query.
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Node/Relationship Definition Dialog Box

Base TQL Name Enter a unique name for the Enrichment TQL query.

If you selected the Base the Enrichment rule on an 
existing TQL option, select the Enrichment TQL query on 
which you want to base the rule.

Base TQL Priority Select a priority level for the new TQL query (Low and 
Medium). This setting determines how often the query is 
rerun automatically by the system to include updated 
information from the CMDB.

Description Displays the attributes of the selected node/relationship. 
The key attributes and the required attributes of the 
selected node appear in bold. 

Use an Enrichment rule to update the value of CI 
attributes in the CMDB, or to add data to attributes that 
currently do not have values. You can use this option, for 
example, for adding a note simultaneously to all CI 
instances.

To access: Right-click a node or relationship when in 
Enrichment mode (select Enrichment from the 
TQL/Enrichment list at the top of the Enrichment 
Manager window) and select Update Relationship/Node.

Important 
Information

You must fill in the value of the key attributes and the 
required attributes of the Enrichment node. The method 
you use to define these values determines the number of 
instances created.

If you enter a dynamic value, you can create numerous 
instances. For example, entering the dynamic value of a 
host_key for the CIT Host or an IP address attribute for 
the CIT IP.

Included in Tasks “Define an Enrichment Rule – Scenario” on page 318

GUI Element (A-Z) Description
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Attributes Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Set Attributes Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Name The attribute name.

Type The field type of the selected attribute.

Value The value as defined in one of the following:

➤ The Value box in the Set Attributes area.

➤ The combination of the values in the By Attribute 
boxes in the Set Attributes area.

➤ The Value column if you selected Simple in the Type 
column in the Node Definition - Advanced Attribute 
dialog box.

➤ The combination of the values in the Value column 
and the column to the right of the Value column if you 
selected By Attribute in the Type column in the Node 
Definition - Advanced Attribute dialog box.

GUI Element (A-Z) Description

(Appears only if you selected an attribute of the field type 
string.) Opens the Node Definition - Advanced Attribute 
dialog box.

Define node and relationship attributes of the type string 
using simple or complex expressions. You can also create 
complex expressions using regular expression format.

Advanced (Appears only if you selected an attribute of the field type 
string.) Displays the attribute value you defined in the 
Node Definition - Advanced Attribute dialog box.
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Node Definition – Advanced Attribute Dialog Box

By Attribute Define an attribute using attributes from other nodes in 
the TQL query.

➤ In the box to the left, select the required node.

➤ In the box to the right, select the node’s required 
attribute.

The attribute definition appears in the Value column in 
the Attributes area.

RegExp Group (Appears only when you select an attribute of the field 
type string.) Enter the group number only if you are 
adding a regular expression using regular expression 
syntax. This is the part of the regular expression pattern 
to focus on when creating the attribute. A set of 
parentheses ( ) constitutes a group.

Regular Expression (Appears only when you select an attribute of the field 
type string.) Add a regular expression using regular 
expression syntax. Enter the regular expression pattern.

Value (in the Set 
Attributes area)

Define a constant value. Enter the required value in the 
Value box or select a value from the Value list.

Note: The value definition appears in the Value column 
in the Attributes area.

Description Define node and relationship attributes of the type String 
using simple or complex expressions. You can also create 
complex expressions using regular expression format.

To access: 

1  Select an attribute of the type string in the Node 
Definition dialog box.

2  Select Advanced and then click the Advanced button.

Included in Tasks “Define an Enrichment Rule – Scenario” on page 318

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Define an attribute value using simple or complex 
expressions. Creates a new entry in the Type column. 
Click the new entry and select either Simple or By 
Attribute. For details, see the description for the Type 
column below.

Delete an attribute value.

Move a selected row up.

Move a selected row down.

Advanced Value (This list is only available if you select By Attribute in the 
Type column.) Click the entry inside the box and select 
the required attribute.

Concatenate Use all the attribute values listed in this dialog box.

RegExp Group (This list is only available if you select By Attribute in the 
Type column.) Click inside the RegExp Group column, 
click the  button, and enter the group number 
in the Value for RegExp Group dialog box that opens. 
This is the part of the regular expression pattern to focus 
on when creating the attribute. A set of parentheses ( ) 
constitutes a group.

Regular Expression (This list is only available if you select By Attribute in the 
Type column.) Click inside the Regular Expression 
column, click the  button, and enter the regular 
expression pattern in the Value for Regular Expression 
dialog box that opens.
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Type Click the entry inside the Type column and select one of 
the following options:

➤ Simple. Define a constant value using a simple 
expression.

➤ By Attribute. Define an attribute using attributes from 
other nodes in the TQL.

Default is: Simple

Use first attribute 
with value

Use the first attribute value listed in this dialog box that is 
not empty.

Value ➤ If you select Simple in the Type column, click inside 
the Value column, click the  button, and 
enter the required value in the Value for Simple dialog 
box.

➤ If you select By Attribute in the Type column, click 
inside the Value column and select the required value 
from the list.

GUI Element (A-Z) Description
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Topology Query Language

This chapter provides information on Topology Query Language (TQL).

This chapter includes:

Concepts

 ➤  Topology Query Language (TQL) Overview on page 342

 ➤  Topology Query Language on page 342

 ➤  The Roles of TQL on page 343

 ➤  Where TQL Queries Are Created on page 343

 ➤  Viewing TQL Query Results on page 344

 ➤  Compound Relationship on page 344

 ➤  Join Relationship on page 345

 ➤  Subgraph Definition on page 346

Tasks

 ➤  Define a TQL Query on page 346

 ➤  Add Nodes and Relationships to a TQL Query on page 348

 ➤  Add Enrichment Nodes and Relationships to an Enrichment TQL Query 
on page 349

 ➤  Define a Compound Relationship — Scenario on page 350

 ➤  Define a Join Relationship — Scenario on page 353

 ➤  Create a Subgraph Definition — Scenario on page 355

Reference

 ➤  Context Menu Options on page 357
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 ➤  Attribute Operator Definitions on page 364

 ➤  TQL Logs on page 366

 ➤  TQL Parameters on page 370

 ➤  Topology Query Language User Interface on page 378

Troubleshooting and Limitations on page 427
Concepts

Topology Query Language (TQL) Overview

Topology Query Language (TQL) is a language and tool for discovering, 
organizing, and managing IT infrastructure data. It enables you to create 
TQL queries that retrieve business service data from the configuration 
management database (CMDB) and displays the data in a visual 
representation that facilitates data monitoring and managing. For details on 
CMDB, see “Configuration Management Database (CMDB)” on page 19.

Topology Query Language

TQL extends the standard SQL language by adding two important 
capabilities:

➤ TQL enables you to draw conceptual relationships between configuration 
items (CIs), which represent their actual interdependencies. Using 
predefined operators, the different types of interconnections (relationships) 
that exist between CIs can be established, and consequently the 
infrastructure design and performance are more accurately represented. This 
representation serves as a basis and a model for the discovery, arrangement, 
query, and management of complex infrastructures.

➤ TQL includes a graphical aspect, consisting of visual symbols and syntax, 
that represents the resources and their interconnections. This visualization 
of an IT infrastructure simplifies the understanding, monitoring, and 
managing of the IT business operations.
342



Chapter 10 • Topology Query Language
The Roles of TQL

TQL plays several roles:

➤ Builds a business service model that defines and delineates the 
interconnection between IT assets that function together as business 
services. The business service model guides the discovery and identification 
of these business services, from the ever-increasing number and complexity 
of infrastructure resources. After the resources that comprise the business 
services are discovered, the business service model structures the way they 
are organized and managed in the CMDB.

➤ Constantly searches the CMDB for changes that occur in the state of 
managed resources. When such changes are detected, the relevant 
subsystems are informed and updated. 

➤ Creates queries that retrieve business service data from the CMDB, and 
displays the data in a visual representation that facilitates data monitoring 
and managing.

Where TQL Queries Are Created

The following managers use TQL:

➤ Correlation Manager. Create a Correlation TQL query to simulate how 
infrastructure changes can impact your system. A Correlation rule is based 
on either a Correlation TQL query created from within the Correlation 
Manager, or on an existing query. By creating Correlation rules based on 
TQL queries, you can determine the true origin of a problem and its business 
impact. For details, see “Correlation Manager” on page 197.

➤ Enrichment Manager. Create an Enrichment rule based on either an 
Enrichment TQL query from within the Enrichment Manager, or on an 
existing query. An Enrichment rule enables you to either enlarge the CMDB, 
delete CI instances from the CMDB, or update the attributes of a CI that 
already exists in the CMDB. For details, see “Enrichment Manager” on 
page 315.

➤ Query Manager. Create TQL queries that can be used in other managers. For 
details, see “Query Manager” on page 301.
343



Chapter 10 • Topology Query Language
➤ Topology Report Manager. Create a report definition based on either a 
Report TQL query from within the Topology Report Manager, or on an 
existing query. You can define exactly which information appears in each 
report, including the order in which nodes are listed and their placement 
relative to other nodes, and how the information within each Report is 
sorted. For details, see “Topology Report Manager” on page 263.

➤ View Manager. Create a pattern view, template, or perspective based on a 
TQL query, or create a template based view using an existing template. For 
details, see “View Manager” on page 149. 

Viewing TQL Query Results

You view the resulting data in a visual representation in the Topology View 
application. The queries define the structure of the resulting topology view. 
The view displays only those CIs and relationships that meet the query 
definition. For more details about Topology View application, see “Topology 
View Application” on page 523.

Compound Relationship

A compound relationship represents a path in the topological graph. You 
use a compound relationship to define the allowed steps in the path 
between the source and the target CIs.

Each row represents one of the allowed steps in the path leading from the 
source CI to the target CI in the topology map.

For an example of a compound definition, see “Define a Compound 
Relationship — Scenario” on page 350. For details on defining compound 
relationships, see “Add/Edit Compound Relationship Dialog Box” on 
page 381.
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Join Relationship

A join relationship is a logical connection, which appears only in the 
topology view containing the TQL query results, and represents the 
relationship between two CIs. It does not exist in the CMDB. A join 
relationship is created by defining an attribute for each node, whose values 
are used for comparison.

The TQL results retrieve all CIs whose attribute values meet the conditions 
defined in the join definition.

For example, you can create a join definition that links all Host CIs 
connected to IP CIs whose Created by attribute values are equal (see the 
example below).

Each join definition represents one condition defined for the join 
relationship.

Note: You can define multiple conditions.

For an example of a join definition, see “Define a Join Relationship — 
Scenario” on page 353. For details on defining join relationships, see 
“Add/Edit Join Relationship Dialog Box” on page 385.
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Subgraph Definition

A subgraph definition enables you to create a graph that represents 
additional TQL query data related to a specific CI. The DDM job searches for 
the results from both the TQL query and the subgraph definitions. The 
query recursively retrieves all the related CIs by a defined depth. For details 
on defining subgraph definitions, see “Subgraph Definition Dialog Box” on 
page 416.

In the graph, you can define the relationship that is connected to a specific 
node. For example, if one of the nodes is a host, you can specify different 
relationships for Windows, router, and IP. You can also define attribute 
conditions for nodes. For details, see “Subgraph Condition Definition 
Dialog Box” on page 414.

The DDM job retrieves data that meets the criteria that is defined in the 
subgraph.

For an example of a subgraph definition, see “Create a Subgraph Definition 
— Scenario” on page 355.

Tasks

Define a TQL Query

This task describes how to create a TQL query in Correlation Manager, 
Query Manager, View Manager, Topology Report Manager, and Enrichment 
Manager.

This task includes the following steps:

➤ “Create a TQL Query” on page 346

➤ “Add Nodes and Relationships to the Query” on page 347

 1 Create a TQL Query
Create a new query by giving the query a unique name in the relevant 
manager. For details about the managers in which you can create a TQL 
query, see “Where TQL Queries Are Created” on page 343. In this task, you 
create a TQL query in the Query Manager. For details, see “New Query/Save 
Query As/Query Properties Dialog Box” on page 303. 
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 2 Add Nodes and Relationships to the Query
Add the TQL nodes and relationships that define the query. The TQL nodes 
represent the CITs, as defined in the CI Type Manager, and the relationships 
represent the connections between them. Relationships are defined one at a 
time for each pair of TQL nodes in the query. For details, see “Add Nodes 
and Relationships to a TQL Query” on page 348. For details on the CI Type 
Manager, see “CI Type Manager” on page 225.

Example of a TQL Query Definition

The direction of the relationship indicates which node is dependent on the 
other. The following example displays two hosts, a Server Port, and a Client 
Port, which are linked to one another via a client/server connection. The 
TQL results must comply with the direction of the arrows.

Note: A TQL query is subject to certain validation restrictions. For details, 
see “Troubleshooting and Limitations” on page 427.
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Add Nodes and Relationships to a TQL Query

This section explains how to add nodes and relationships to a TQL query. It 
is relevant for View Manager, Query Manager, Correlation Manager, 
Enrichment Manager, and Topology Report Manager.

Note: For TQL queries to be valid, they must comply with certain 
restrictions. For details, see “Troubleshooting and Limitations” on page 427.

To add nodes and relationships to a TQL query:

 1 From the tree in the left pane, select the required query or click the New 
button to create one.

 2 From the tree displayed in the CI Type Selector, click and drag one or more 
required TQL nodes on to the editing pane. These are the TQL nodes that 
are included in the query.

 3 To add a relationship between two nodes:

➤ Select the required TQL nodes by holding down CTRL and clicking the 
TQL nodes, right-click and select Add Relationship.

or

➤ Click the Create Relationship icon and draw a line between the required 
nodes.

The Select Relationship Type dialog box opens. Select the required 
relationship type. For details, see “Select Relationship Type Dialog Box” on 
page 413.

 4 Click OK. The selected nodes are linked by the relationship you have 
selected.
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Add Enrichment Nodes and Relationships to an 
Enrichment TQL Query

This section describes how to add Enrichment nodes and relationships to an 
Enrichment TQL query in the Enrichment Manager. For more information 
on Enrichment Manager, see “Enrichment Manager” on page 315.

To add Enrichment nodes and relationships to a TQL query:

 1 From the tree in the Enrichment Rules pane, select the Enrichment rule to 
which you want to add Enrichment nodes and relationships or create a new 
one. For details, see “New Enrichment Rule/Enrichment Rule 
Properties/Save As Enrichment Rule Wizard” on page 332.

 2 From the TQL/Enrichment list at the top of the Enrichment Manager 
window, select Enrichment mode.

 3 From the tree displayed in the CI Type Selector, click and drag the nodes you 
want to function as an Enrichment node on to the editing pane. These are 
the TQL nodes that are included in the query. Added Enrichment nodes are 
displayed by an added indicator.

Note: You can add more than one Enrichment node to a rule.

 4 The next step is to link the Enrichment node to an existing TQL node or 
nodes, to provide the Enrichment node with the needed context for its 
operation.

Following are the Enrichment rule validations:

➤ You must link the new Enrichment node to at least one of the existing 
TQL nodes in the rule.

➤ Enrichment nodes can only be linked to one another with an 
Enrichment relationship.
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➤ If the new Enrichment node must be contained (according to its CIT 
definition) in another node, you must use the Container link relationship 
to connect this Enrichment node to an existing TQL node.

➤ You cannot link an Enrichment node to a TQL node that is not visible.

 5 To add a relationship between two nodes:

➤ Select the required nodes by holding down CTRL and clicking the TQL 
nodes, right-click and select Add Relationship.

or

➤ Click the Create Relationship icon and draw a line between the required 
nodes.

Added Enrichment relationships are displayed by an added indicator. 

The Add Relationship dialog box opens. For details, see “Add/Edit 
Relationship Dialog Box” on page 388.

 6 Click OK. The selected nodes are linked by the relationship you have 
selected.

Define a Compound Relationship — Scenario

This section describes how to define the allowed steps that form a 
compound relationship between a Network and an IP CI.

Note: To reach the required result, you must implement each one of the 
following steps.

To define a compound relationship between a Network CI and an IP CI:

 1 Create a TQL query and drag the following nodes from the CI Type Selector 
onto the editing pane:

➤ Network

➤ IP
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 2 Right-click the Network and IP nodes and select Add Compound 
Relationship to open the Add Compound Relationship dialog box.

 3 Click the Add button to open the Add Triplet dialog box and do the 
following.

➤ From the Source list, select Network.

➤ From the Target list, select Host.

➤ From the Relationship list, select Member.

➤ Select the required Relationship direction.

 4 Click OK to save your changes.

 5 Click the Add button to open the Add Triplet dialog box and do the 
following:

➤ From the Source list, select Host.

➤ From the Target list, select IP.

➤ From the Relationship list, select Contained.

➤ Select the required Relationship direction.

 6 Click OK to save your changes.

The compound definitions now look like this.

 7 Click OK to save your changes.

The TQL query in the editing pane now looks like this:
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 8 Go to the required view in IT Universe to view the results. If you did not 
select the Show full path between source and target CIs option, then the 
results display the names of the relationships that link the CIs as Virtual-
Compound rather than the actual names of the relationships. See the 
illustration below:

You can double-click the Virtual - Compound relationship in IT Universe to 
open the Link Map, which displays the CIs and relationships that comprise 
the allowed steps used to link the Network and IP CIs.

In the example above, the 192.168.136.0 (Network) CI is linked to the 
192.168.142.1 (IP) CI through the labm1mam15 (Host) CI.
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If you did select the Show full path between source and target CIs option, 
then the results in IT Universe display the actual names of the relationships 
that link the CIs and the full path between the source and target CIs. See the 
illustration below:

Define a Join Relationship — Scenario

This section explains how to define a join relationship that links Host CIs to 
IP CIs whose Created by attribute values are equal.

Note: To reach the required result, you must implement each one of the 
following steps.

To define a join relationship that links all IP and Host CIs whose Created by 
attribute values are equal:

 1 Create a TQL query and drag the following nodes from the CI Type Selector 
onto the editing pane:

➤ Host

➤ IP

 2 Select the Host and IP nodes and right-click to open the Add Join 
Relationship dialog box.
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 3 Click the Add button to open the Join Relationship Condition dialog box 
and do the following:

➤ In the Host Attribute box, select Created by.

➤ In the Operator box, select Equal.

➤ In the IP Attribute box, select Created by.

 4 Click OK to save your changes.

The Join Definition area now looks like this.

 5 Click OK to save your changes.

The TQL query in the editing pane now looks like this:

Go to the required view in IT Universe to view the results. Double-click the 
Virtual - Join relationship in IT Universe to open the Link Map (as seen 
below), which displays all the Host CIs that are connected to an IP CI whose 
Created by attribute values are equal.
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Create a Subgraph Definition — Scenario

This section describes how to create a subgraph definition. In this example, 
the TQL query results retrieve all CIs that are connected to a host whose 
host’s display label is <host display label> by either a Container link or a 
Contained relationship.

Note: To reach the required result, you must implement each one of the 
following steps.

To create this sample subgraph definition:

 1 Create a TQL query and drag a Host node from the CI Type Selector onto the 
editing pane.

 2 Right-click the Host node and select Subgraph Definition to open the 
Subgraph Definition dialog box.

 3 Select the default subgraph definition that appears and delete it.

 4 Click the Add  button to open the Add Triplet dialog box and do the 
following:

➤ From the Source list, select IT Universe.

➤ From the Target list, select IT Universe.

➤ From the Relationship list, select Contained.

 5 Click OK to save your changes.

 6 Click the Add  button to open the Add Triplet dialog box and do the 
following:

➤ From the Source list, select IT Universe.

➤ From the Target list, select IT Universe.

➤ From the Relationship list, select Container link.

 7 Click OK to save your changes.
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 8 Click the Add  button to open the Add Triplet dialog box and do the 
following:

➤ From the Source list, select IT Universe.

➤ From the Target list, select IT Universe.

➤ From the Relationship list, select Contains.

 9 Click OK to save your changes.

The Add Triplet dialog box now looks like this.

 10 Click OK in the Subgraph Definition dialog box.

 11 Right-click the Host node and select Node Properties to open the Node 
Properties dialog box.

 12 Click the Attribute tab.

 13 From the Attribute Name list, select Display Label.

 14 From the Operator list, select Equal.

 15 Select Fixed Value.

 16 In the Value box, enter <host display label>.

 17 Click OK to save your changes.

The Attribute tab now looks like this.
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Go to the required view in IT Universe to view the results.

The results show that the labm1amrnd06 (Host) CI is linked to the 
16.59.61.134 (IP) CI by the Contained relationship and to the 
0016353E6EA2 (Interface) CI by the Container link relationship.

Reference

Context Menu Options

This section includes a list of TQL context menu options (listed 
alphabetically):

GUI Element (A–Z) Description

Add Calculated 
Relationship

Enables you to create a calculated relationship.

➤ For details on how to create a calculated relationship, 
see “Triplets Page” on page 251.

➤ For details about Impact Modeling, see Chapter 11, 
“Using Calculated Relationships.”

Add Compound 
Relationship

Enables you to define the connection between two nodes 
using a compound relationship.

For details, see “Add/Edit Compound Relationship Dialog 
Box” on page 381.
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Add Join Relationship Enables you to define join relationships, which is created 
by defining an attribute for each node, whose values are 
used for comparison. 

For details, see “Add/Edit Join Relationship Dialog Box” 
on page 385.

Add Relationship Enables you to create a relationship for your nodes by 
selecting it from a predefined list. Displays the Add 
Relationship dialog box.

For details, see “Add/Edit Relationship Dialog Box” on 
page 388.

Note: In Enrichment Manager, this option adds an 
Enrichment relationship to the rule when working in 
Enrichment mode. Applicable for regular and Enrichment 
nodes. For details, see “Enrichment Manager” on 
page 315. Added relationships are denoted by an added 

 indicator.

GUI Element (A–Z) Description
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Add Rule Enables you to add folding rules to a relationship. Right-
click the relationship for which you want to define a 
folding rule. Select one of the following options to define 
the organizational structure between the two CI types 
connected by the selected relationship:

➤ Parent. Select this option to display Node1 as the 
parent of Node2. That is, double-clicking the Node1 
element on one map level displays a new map level 
with Node2 elements.

➤ Right Sibling. Select this option to display Node1 
elements wherever Node2 elements are displayed. That 
is, both CIs are displayed on the same map level.

➤ Left Sibling. Select this option to display Node2 
elements wherever Node1 elements are displayed. That 
is, both CIs are displayed on the same map level.

➤ Child. Select this option to display Node1 as the child 
of Node2. That is, double-clicking a Node2 element on 
one map level displays a new map level with Node1 
elements.

➤ None. Do not define any folding rules for this 
relationship.

Note: Only relevant for View Manager.

Add to Applications Click to create an application CI and link it to all CIs of 
the type selected. For details, see “Link Nodes to 
Application CI” on page 154.

Note: Only relevant for View Manager.

Clear Available by right-clicking a node or relationship when 
working in Enrichment mode in the Enrichment 
Manager. Clears the node/relationship’s Enrichment rule 
definition. For details, see “Enrichment Manager” on 
page 315.

Appears only if you have updated or deleted a 
node/relationship using an Enrichment rule.

Note: Only relevant for Enrichment Manager.

GUI Element (A–Z) Description
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Clear Contact Node Changes the selected node from a contact node to a 
regular node.

Note: Only relevant for perspectives in View Manager.

Clear Node 
Definition

Deletes the report definition for the selected Report node. 
For details, see “Topology Report Manager” on page 263.

Note: Only relevant for Topology Report Manager.

Copy/Paste Copy/paste an existing TQL node/relationship in the 
same query or into another TQL query.

The copied TQL node/relationship includes all TQL 
definitions.

You can copy and paste relationships provided that the 
TQL nodes to which the relationships are connected are 
also selected. A relationship on its own cannot be copied 
without its connecting TQL nodes.

You can select multiple TQL nodes/relationships as well.

Note: The Paste option is available only after using the 
Copy option to copy an existing TQL node/relationship.

Define Affected Define which node in the TQL query is the trigger 
Correlation node and which nodes are affected by the 
changes that occur in the system. For details, see 
“Affected Nodes Dialog Box” on page 206.

Note: Only relevant for Correlation Manager.

Delete Deletes the selected node/relationship/CI.

Note: This option is not available for calculated 
relationships.

GUI Element (A–Z) Description
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Delete 
Relationship/Node

Available by right-clicking a node or relationship when 
working in Enrichment mode.

Creates a specific Enrichment rule that is designed to 
delete CIs/relationships from the CMDB. Applicable to 
regular nodes and relationships only. You can use this 
option, for example, for removing unnecessary data from 
the CMDB. For details, see “Enrichment Manager” on 
page 315.

Deleted nodes and relationships are denoted by a 
removed  indicator.

Note: Only relevant for Enrichment Manager.

Edit Relationship 
Type

Displays the Edit Relationship Type dialog box. For 
details, see “Add/Edit Relationship Dialog Box” on 
page 388.

Note: This option appears only when the selected 
relationship has descendants.

Node Order Displays the Set Node Order dialog box, enabling you to 
determine the order in which Report node information is 
displayed in the report, that is, the order of the report’s 
columns. For details, see “Set Node Order Dialog Box” on 
page 296.

Note: Only relevant for Topology Report Manager.

Node/Relationship 
Definition

Displays the Grouping dialog box which enables you to 
group CIs in the topology map. For details, see 
“Node/Relationship Grouping Dialog Box” on page 179.

Note: Only relevant for View Manager.

Node/Relationship 
Properties

Displays the Node/Relationship Properties dialog box, 
enabling you to define the attribute conditions for the 
selected TQL node/relationship. For details, see 
“Node/Relationship Properties Dialog Box” on page 401.

Note: This option is not available for calculated 
relationships.

GUI Element (A–Z) Description
361



Chapter 10 • Topology Query Language
Refine Node Type Displays the Refine Node Type dialog box. Enables you to 
change the CI type of the node after you have created it. 
For details, see “Refine Node Type Dialog Box” on 
page 412.

Note: This option only appears if a child of the CI type 
exists.

Remove from 
Applications

Click to remove a business service item from a business 
service view. For details, see “Link Nodes to Application 
CI” on page 154.

Note: Only relevant for View Manager.

Remove Subgraph Only appears if you have defined a subgraph definition. 
For details, see “Subgraph Definition Dialog Box” on 
page 416.

Report Node 
Definition

Displays the Report Node Definition dialog box, enabling 
you to determine the content of the report. For details, 
see “Report Node Definition Dialog Box” on page 294.

Note: Only relevant for Topology Report Manager.

Reset Affected Removes the Define Affected definition applied to that 
node. For details on the Define Affected definition, see 
“Affected Nodes Dialog Box” on page 206.

Note: Only relevant for Correlation Manager.

Reset Inner 
Relationship

Redraws a self-referential relationship in the Topology 
map as a square for ease of viewing.

Note: Only relevant for self-referential relationships 
which are not square.

Set As Contact Node Designates the selected node as a contact node for the 
perspective.

Note: Only relevant for perspectives in View Manager.

GUI Element (A–Z) Description
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Set View Element 
Parameters

Appears only when a parameterized condition is defined 
for the selected CI. 

Displays the Set View Element Parameters dialog box 
where you can edit the parameter of each condition. For 
details, see “Set View Parameters/Set View Element 
Parameters Dialog Box” on page 183.

Note: Only relevant for View Manager and Topology 
Report.

Show Element’s 
instances

Displays the Element Instances dialog box which displays 
all the instances found for each node in a table. For 
details, see “Element Instances Dialog Box” on page 394.

Straighten Straightens the relationship between two nodes. This 
option is only available for relationships that have angles.

Subgraph Definition Displays the Subgraph Definition dialog box, where you 
can create a graph that represents additional TQL query 
data related to a specific node. For details, see “Subgraph 
Definition Dialog Box” on page 416.

TQL Node Wizard Displays the TQL Node Wizard dialog box which enables 
you to build a TQL query. For details, see “TQL Node 
Wizard” on page 418.

Update 
Relationship/Node

Use an Enrichment rule to update the value of CI 
attributes in the CMDB, or to add data to attributes that 
currently do not have values. Opens the Node Definition 
- Attributes dialog box. For details, see 
“Node/Relationship Definition Dialog Box” on page 336. 
This is applicable for both regular and Enrichment nodes. 

Updated nodes are denoted by an updated  indicator.

Note: Only relevant for Enrichment Manager.

GUI Element (A–Z) Description
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Attribute Operator Definitions

This section contains a list of operators used to define attribute conditions 
in various dialog boxes, such as the Subgraph Condition dialog box, the Add 
Relationship dialog box, Correlation Definition dialog box, or the 
Node/Relationship Properties dialog box.

Operator Description

Changed during (Displayed only when you select the Create Time 
attribute.) Displays only the instances that changed 
during the period specified in the Value comparison 
box.

Equal Checks whether the attribute value is equal to the 
value specified in the Value Comparison box.

Equal ignore case Checks whether the attribute value is equal to the 
value specified in the value box regardless of the 
case.

Greater than or equal Checks whether the attribute value is greater than 
or equal to the value specified in the Value 
comparison box.

Greater Checks whether the attribute value is greater than 
the value specified in the Value comparison box.

In Displays only the instances where this attribute 
value equals one of the selected values. For 
example, for CIs that have a Change state that 
equals Plan and New, select the operator In from the 
Operator list and select both Plan and New from 
the Value box.

In list Equals one of the elements that appears in the list. 
For example: 320,4445,3483.

Is null Checks whether the attribute value is null.

Less Checks whether the attribute value is less than the 
value specified in the Value comparison box.
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Note: 

➤ For Not equal or Not like operators, query results do not include data 
from the CI instances that are not assigned a value. For example, a 
system contains three hosts: Host1 is assigned the value A, Host2 is 
assigned the value B, and Host3 is not assigned a value. If you create a 
query to retrieve all hosts that are Not equal to A, the results of your 
query include Host2 only, because Host3 is not assigned a value.

➤ HP Universal CMDB supports both Microsoft SQL Server and Oracle 
Server servers. Microsoft SQL Server is not case sensitive by default 
(unlike Oracle Server which is case sensitive). Consequently, if you are 
using Microsoft SQL Server, the Equal operator retrieves the same query 
results as the Equal ignore case operator. For example, if you select the 
attribute City, the operator Equal, and type NEW YORK in the Value 
comparison box, case differences are ignored and query results include 
NEW YORK, New York and new york. 

Less than or equal Checks whether the attribute value is less than or 
equal to the value specified in the Value comparison 
box.

Like Uses a wildcard (%). Use Like when you are not sure 
of the complete name for which you are searching.

Like ignore case Uses a wildcard (%). Use Like ignore case when you 
are not sure of the complete name for which you 
are searching. The case of the string is ignored.

Not equal Checks whether the attribute value is not equal to 
the value specified in the Value Comparison box.

Unchanged during (Displayed when you select a date type attribute.) 
Displays only the instances that did not change 
during the period specified in the Value comparison 
box.

Operator Description
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TQL Logs

This section contains definitions for TQL parameter log files.

This section includes the following topics:

➤ “Pattern Log” on page 366

➤ “Pattern Statistics Log” on page 367

➤ “Audit Short/Detailed Log (TQL Perspective)” on page 368

➤ “Incremental Statistics Log” on page 368

➤ “Incremental Splitter Log” on page 369

➤ “Incremental Detailed Log” on page 370

Pattern Log
The log name is cmdb.pattern.log.

Log File Description

Purpose Information about the lifecycle of a TQL query that is handled 
and calculated in the CMDB. 

Only TQLs stored in the CMDB are included. Information 
about ad hoc TQLs is not included.

Information 
Level

Not available.

Error Level Not available.

Debug Level Possible actions performed on each TQL query include:

➤ status changes

➤ model changes

➤ query changes

➤ completed calculations
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Pattern Statistics Log
The log name is cmdb.pattern.statistics.log.

Basic 
Troubleshooting

Check if a TQL query has the same status for a long time:

➤ new – the query is in lazy loading

➤ inactive 

➤ calculation – the calculation may have failed but the 
scheduler was not informed

You can also view the number of notifications that a TQL 
received.

Log File Description

Purpose General calculation data for each TQL, updated at predefined 
intervals.

Information 
Level

The following information is given for each TQL:

➤ name

➤ average, minimum, and maximum calculation times

➤ number of calculations

➤ last calculation time

➤ result size

Error Level Not available.

Debug Level Not available.

Basic 
Troubleshooting

➤ Verify that a specific TQL was updated.

➤ Evaluate a TQL’s calculation time.

➤ Evaluate a TQL’s result size. 

Log File Description
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Audit Short/Detailed Log (TQL Perspective)
The log name is cmdb.audit.short.log.

Incremental Statistics Log
The log name is cmdb.incremental.statistics.log. 

Log File Description

Purpose CMDB state changes, CI Type changes, and TQL results.

You can use this log to follow the results of TQL queries.

Information 
Level

Not available.

Error Level Not available.

Debug Level ➤ Final calculation for TQLs is logged.

➤ If the final TQL calculation is unchanged from the previous 
calculation, this is noted.

➤ If the final TQL calculation is changed from the previous 
calculation, results of the CIs and relationships are recorded 
in the detailed log. The number of CIs and relationships are 
recorded in the short log.

Basic 
Troubleshooting

➤ Use this log to verify which notifications are published by 
the TQL subsystem.

➤ Check the section at the end of each result. This section 
includes added, removed, and updated CIs and 
relationships.

➤ Track the CIT changes and see if the query results also 
change. You can thus correlate the CIT changes to the 
results of the query calculations.

Log File Description

Purpose Traces the calculation procedure, full or incremental, of every 
query.

Information 
Level

Not available.
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Incremental Splitter Log
The log name is cmdb.incremental.splitter.log.

Error Level Not available.

Debug Level ➤ Gives the date, time, query name, and whether an 
incremental statistic calculation was performed (yes/no). 

➤ If an incremental statistic calculation was not performed, 
states the reason, the number of subcalculations (relevant 
for incremental calculations only), and the complete 
calculation time.

Basic 
Troubleshooting

Monitors the calculation process.

If a specific query calculation takes a long time, check if it is a 
full or incremental calculation:

➤ If full, check whether a full calculation is necessary.

➤ If incremental, check how many subcalculations have been 
performed.

Log File Description

Purpose Monitors the incremental splitter result made during an 
incremental calculation.

Information 
Level

Not available.

Error Level Not available.

Debug Level Gives the set of node numbers of each query graph created by 
the incremental splitter.

Basic 
Troubleshooting

If the TQL result calculated by the incremental calculator is 
wrong, verify that the splitter result is correct.

Log File Description
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Incremental Detailed Log
The log name is cmdb.incremental.detailed.log.

TQL Parameters

This section describes the TQL parameters needed for configuring the 
CMDB. 

 

Log File Description

Purpose Monitors the incremental calculation process. 

Information 
Level

Not available.

Error Level Not available.

Debug Level Each incremental subcalculation entry includes the following:

➤ the trigger node 

➤ the number of elements classified to the trigger node 

➤ whether the subcalculation step is driven by new elements 
added to the model or by existing elements

➤ the calculated query graph

Basic 
Troubleshooting

Follows the basic steps of an incremental calculation.

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)

tql.threads.pool.size Defines the number 
of threads to limit 
concurrent 
calculation of TQLs. 
This is done to 
prevent high CPU 
consumption.

integer N
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tql.scheduler.timer.t
ime

Defines the interval 
of time to wait 
between wake up 
calls to the TQL 
State Machine 
manager.

long Value is in 
milliseconds. 

N

tql.scheduler.statisti
cs.logupdate.interva
l.time.millisec

The interval 
between updates of 
cmdb.pattern.statistic
s.log.

long Value is in 
milliseconds.

N

tql.resultrepository.t
imer.time

The length of time 
the ad hoc TQL 
results reside in 
memory before the 
results are purged 
from memory.

long Value is in 
milliseconds.

N

tql.resultutils.patter
ntakeover.timeout

10000

tql.resultutils.adhoc
.validate

Defines whether to 
perform pattern 
validation of ad hoc 
TQLs.

Boolean ➤ true. Perform 
pattern 
validation.

➤ false. Do not 
perform 
pattern 
validation.

N

tql.resultutils.chunk
.maxresultsize

The maximum 
number of CIs and 
relationships in a 
TQL result that can 
be retrieved together 
without dividing 
them into chunks 
for separate 
retrievals.

integer 100000 N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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tql.resultutils.chunk
.maxnotificationsiz
e

The maximum 
number of CIs and 
relationships in a 
TQL result that can 
be sent to external 
clients, the 
applications that get 
notification service 
from CMDB. If this 
number is exceeded, 
a message is sent.

integer 50000 N

tql.resultutils.chunk
.keepingperiod.seco
nds

The length of time 
that a chunk of TQL 
results is resident in 
memory until the 
next chunk is 
received in memory.

integer Value is in 
seconds.

N

tql.conditionstatisti
cs.refresh.seconds

The time interval in 
which the total 
number of objects of 
each type in the 
CMDB is updated.

integer Value is in 
seconds.

N

tql.statemachine.fai
l.retries

Number of times to 
recalculate a TQL 
before the status is 
set to Fail.

integer N

tql.statemachine.fai
l.recover.time

Time interval to 
wait between a 
pattern calculation 
failure and the next 
attempt to 
recalculate. 

integer Value is in 
seconds.

N

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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tql.scheduler.statisti
cs.maxcalculation

The maximum 
number of a TQL’s 
recent calculations 
stored in the 
Scheduler statistics.

integer N

tql.group.all.active.
count

Maximum number 
of active TQLs 
permitted per 
customer in the 
appropriate group: 
all, collectors, view, 
topology, report, 
server data, path 
manager, and 
internal 
enrichment.

The name of the 
group is found in 
the name of the 
parameter after 
tql.group.

integer N

tql.group.collectors.
active.count

tql.group.view.activ
e.count

tql.group.topology.a
ctive.count

tql.group.report.acti
ve.count

tql.group.serverdata
.active.count

tql.group.pathmana
ger.active.count

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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tql.group.all.result.s
ize

The maximum 
number of CIs held 
in a TQL result 
before the TQL is 
deactivated.

integer Values are 
assigned 
according to TQL 
group: all, 
collectors, view, 
topology, report, 
server data, path 
manager, and 
internal 
enrichment.

N

tql.group.collectors.
result.size

tql.group.view.resul
t.size

tql.group.topology.r
esult.size

tql.group.report.res
ult.size

tql.group.serverdata
.result.size

tql.group.pathmana
ger.result.size

EXPRESS_PRIORITY.
Min.CalculationTim
eInterval

Minimum length of 
time to wait until a 
full calculation is 
performed for some 
TQL query. 

The results are 
updated after 
calculation. 

long ➤ Value is in 
milliseconds.

➤ Value is defined 
for each TQL 
priority. 

N

HIGH_PRIORITY.Mi
n.CalculationTimeI
nterval

MED_PRIORITY.Mi
n.CalculationTimeI
nterval

LOW_PRIORITY.Mi
n.CalculationTimeI
nterval

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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EXPRESS_PRIORITY.
Max.CalculationTi
meInterval

Maximum length of 
time to wait until a 
full calculation is 
performed for a TQL 
query. 

The results are 
updated after 
calculation. 

long ➤ Value is in 
milliseconds.

➤ Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Ma
x.CalculationTimeI
nterval

MED_PRIORITY.Ma
x.CalculationTimeI
nterval

LOW_PRIORITY.Ma
x.CalculationTimeI
nterval

EXPRESS_PRIORITY.
Min.EventArrivalTi
meInterval

The minimum 
length of time to 
wait after the last 
event arrives before 
starting a full 
calculation. A full 
calculation is not 
started if the elapsed 
time from the last 
event is less than 
this value.

long ➤ Value is in 
milliseconds.

➤ Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Mi
n.EventArrivalTimeI
nterval

MED_PRIORITY.Mi
n.EventArrivalTimeI
nterval

LOW_PRIORITY.Mi
n.EventArrivalTimeI
nterval

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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EXPRESS_PRIORITY.
Max.EventArrivalTi
meInterval

The maximum 
length of time to 
wait after the last 
event arrives before 
starting a full 
calculation. A full 
calculation is started 
if this value is 
reached.

long ➤ Value is in 
milliseconds.

➤ Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Ma
x.EventArrivalTimeI
nterval

MED_PRIORITY.Ma
x.EventArrivalTimeI
nterval

LOW_PRIORITY.Ma
x.EventArrivalTimeI
nterval

EXPRESS_PRIORITY.
Max.EventArrivalTi
meIntervalForImme
diate

The maximum 
length of time to 
wait after the last 
event arrives before 
starting an 
immediate 
calculation. An 
immediate 
calculation is started 
no later than this 
value.

long ➤ Value is in 
milliseconds.

➤ Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Ma
x.EventArrivalTimeI
ntervalForImmediat
e

MED_PRIORITY.Ma
x.EventArrivalTimeI
ntervalForImmediat
e

LOW_PRIORITY.Ma
x.EventArrivalTimeI
ntervalForImmediat
e

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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EXPRESS_PRIORITY.
Min.PendingEvents
Amount

Minimum number 
of events to 
accumulate to start 
a full calculation. A 
full calculation is 
not started if the 
number of pending 
events for some TQL 
is less than this 
value. 

integer Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Mi
n.PendingEventsAm
ount

MED_PRIORITY.Mi
n.PendingEventsAm
ount

LOW_PRIORITY.Mi
n.PendingEventsAm
ount

EXPRESS_PRIORITY.
Max.PendingEvents
Amount

Maximum number 
of events to 
accumulate to start 
a full calculation. 

A full calculation 
starts when the 
number of pending 
events for a TQL 
equals, or is greater 
than, the value 
defined in this 
parameter. 

integer Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Ma
x.PendingEventsAm
ount

MED_PRIORITY.Ma
x.PendingEventsAm
ount

LOW_PRIORITY.Ma
x.PendingEventsAm
ount

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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Topology Query Language User Interface

This section describes:

 ➤  Add/Edit Calculated Relationship Dialog Box on page 379

 ➤  Add/Edit Compound Relationship Dialog Box on page 381

 ➤  Add/Edit Join Relationship Dialog Box on page 385

 ➤  Add/Edit Relationship Dialog Box on page 388

 ➤  Add Triplet Dialog Box on page 390

 ➤  Element Instances Dialog Box on page 394

 ➤  Filter CI Instances Dialog Box on page 397

 ➤  Join Relationship Condition Dialog Box on page 398

 ➤  Layout Settings Dialog Box on page 400

 ➤  Node/Relationship Properties Dialog Box on page 401

 ➤  Refine Node Type Dialog Box on page 412

EXPRESS_PRIORITY.
Max.PendingEvents
AmountForImmedi
ate

Maximum number 
of events to 
accumulate to start 
an immediate 
calculation. 

An immediate 
calculation starts 
when the number of 
pending events for a 
TQL equals, or is 
greater than, the 
value defined in this 
parameter. 

integer Value is defined 
for each TQL 
priority.

N

HIGH_PRIORITY.Ma
x.PendingEventsAm
ountForImmediate

MED_PRIORITY.Ma
x.PendingEventsAm
ountForImmediate

LOW_PRIORITY.Ma
x.PendingEventsAm
ountForImmediate

Parameter Name Parameter 
Description

Type Value Description Change Value? 
(Y/N)
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 ➤  Select Relationship Type Dialog Box on page 413

 ➤  Subgraph Condition Definition Dialog Box on page 414

 ➤  Subgraph Definition Dialog Box on page 416

 ➤  TQL Node Wizard on page 418

 ➤  User Preferences Dialog Box on page 426

Add/Edit Calculated Relationship Dialog Box

Description Enables you to define the connection between two nodes 
using a calculated relationship from the CI Type model.

To access in Topology Report Manager, Enrichment 
Manager, Correlation Manager, Query Manager, and 
View Manager:
➤ Right-click the required node in the editing pane in 

Topology Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, View Manager 
and select Add Calculated Relationship.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the editing pane to display the Add 
Relationship option.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane.

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Add 
Calculated Relationship.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Useful Links ➤ Chapter 11, “Using Calculated Relationships”

➤ “CI Type Relationships” on page 228

GUI Element (A-Z) Description

<List of calculated 
relationships>

Select the calculated relationship that defines the 
connection between two nodes.

Relationship 
Direction

The direction of the relationship that indicates which 
node is dependent on the other.

Relationship Name The name of the calculated relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical nodes or self relationships in the query 
results. A self relationship is a relationship that leads from 
a node to itself.

Note: This list appears only when you select one node or 
two identical nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.
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Add/Edit Compound Relationship Dialog Box

Description Enables you to define the connection between two nodes 
using a compound relationship. 

To access in Topology Report Manager, Enrichment 
Manager, Correlation Manager, Query Manager, and 
View Manager:

Right-click the required node in the editing pane in 
Topology Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, View Manager and 
select Add Compound Relationship.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the editing pane to display the Add 
Relationship option.

To access in Manage Discovery Resources in Discovery 
and Dependency Mapping (DDM):
1  Select a pattern in the Discovery Resources pane. 

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Add 
Compound Relationship.

Important 
Information

You can create as many compound definitions as 
necessary.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Useful Links ➤ “Compound Relationship” on page 344

➤ “Define a Compound Relationship — Scenario” on 
page 350
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Add a compound definition. Opens the Add Triplet dialog 
box. 

Delete the selected compound definition.

Edit the selected compound definition. Opens the Add 
Triplet dialog box.

Max steps The longest path allowed between the two CIs in the 
CMDB to be included in the discovery process.

Default is: 5

Min steps The shortest path allowed between the two CIs in the 
CMDB to be included in the discovery process.

Default is: 1

Relationship The relationship connecting the two nodes. 

Relationship 
Direction

The direction of the relationship that indicates which 
node is dependent on the other.

Relationship Name The name of the compound relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical nodes or self relationships in the query 
results. A self relationship is a relationship that leads from 
a node to itself.

Note: This list appears only when you select one node or 
two identical nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.
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Show full path 
between source and 
target CIs 

If you select this option, then the query results display 
the actual names of the relationships that link the CIs 
and the full path between the source and target CIs.

Source The required source node.

Stop at first 
compound level

Select this option if you want the system to stop looking 
for TQL results once it reaches the first target in the path. 

In the following sample compound link definition, Depth 
is defined as 10 and Stop at first compound level is 
selected.

The TQL results include the Target 1, Target 3, and Target 
4 because they are all at level 1 (the first CI found in the 
path). Target 2 is not included in the TQL results because 
it is at level 2 (the second CI found in the path).

GUI Element (A-Z) Description
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Target The required target node.

Visible Select Visible to include query results relating to a join or 
compound relationship. By default, Visible is selected. 
When Visible is cleared, a box  appears to the left of the 
of the relationship’s name in the editing pane, denoting 
that any query results pertaining to the relationship are 
not displayed in the topology map.

GUI Element (A-Z) Description
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Add/Edit Join Relationship Dialog Box

Description Enables you to define join relationships. 

To access in Topology Report Manager, Enrichment 
Manager, Correlation Manager, Query Manager, and 
View Manager:

Right-click the required nodes in the editing pane in 
Topology Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, View Manager and 
select Add Join Relationship.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the editing pane to display the Add 
Relationship option.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane. 

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Add Join 
Relationship.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Useful Links “Join Relationship” on page 345

“Define a Join Relationship — Scenario” on page 353
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Define a join definition. Opens the Join Relationship 
Condition dialog box.

Delete the selected join definition.

Edit the join definition. Opens the Join Relationship 
Condition dialog box.

<Selected node1> A selected node. The first attribute applies to <end_1>. 

<Selected node2> A selected node. The second attribute applies to <end_2>.

And All join definitions are linked by the And operator.

Operator The operator selected in the Join Relationship Condition 
dialog box. For details about operator definitions, see 
“Attribute Operator Definitions” on page 364.

Relationship 
Direction

The direction of the relationship that indicates which 
node is dependent on the other.

Relationship Name The name of the join relationship.
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Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical nodes or self relationships in the query 
results. A self relationship is a relationship that leads from 
a node to itself.

Note: This list appears only when you select one node or 
two identical nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.

Visible Select Visible to include query results relating to a join or 
compound relationship. By default, Visible is selected. 
When Visible is cleared, an invisible box  appears to 
the left of the of the relationship’s name in the editing 
pane. Any query results pertaining to the relationship are 
not displayed in the topology map.

GUI Element (A-Z) Description
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Add/Edit Relationship Dialog Box

Description Enables you to define the connection between two nodes 
in a query.

To access in Topology Report Manager, Enrichment 
Manager, Correlation Manager, Query Manager, and 
View Manager:
➤ Right-click the required node in the editing pane in 

Topology Report Manager, Enrichment Manager, 
Correlation Manager, Query Manager, View Manager 
and select Add Relationship.

or

➤ Click the Create Relationship  icon and draw a line 
between the required nodes.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the editing pane to display the Add 
Relationship option.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane.

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Add 
Relationship.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Important 
Information

This option does not appear when two selected nodes (or 
a single selected node) do not have a valid relationship 
between them.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<List of relationships 
from which to 
choose>

Select the relationship that defines the connection 
between two nodes.

Relationship 
Direction

The direction of the relationship that indicates which 
node is dependent on the other.

Relationship Name The name of the relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical nodes or self relationships in the query 
results. A self relationship is a relationship that leads from 
a node to itself.

Note: This list appears only when you select one node or 
two identical nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.
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Add Triplet Dialog Box

Description Enables you to define the allowed steps in a path in the 
topology graph leading from the source CI to the target 
CI when creating a subgraph definition, a compound 
relationship, or a calculated relationship.

Select the nodes and relationships to be included in the 
topology graph.

To access:

➤ In the Add Compound Relationship dialog box, click 
the Add  button. For details, see “Add/Edit 
Compound Relationship Dialog Box” on page 381.

➤ In the Subgraph Definition dialog box, click  Add. 
For details, see “Subgraph Definition Dialog Box” on 
page 416.

➤ In CI Type Manager, select Calculated Relationships 
from the drop-down list in the CI Types pane. In the 
main window, select the Triplets page and then click 

 Add.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Useful Links ➤ “Compound Relationship” on page 344

➤ “Define a Compound Relationship — Scenario” on 
page 350

➤ “Subgraph Definition” on page 346
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Define attribute conditions for the source and target 
nodes you selected. Opens the Subgraph Condition 
Definition dialog box. 

The Condition button is enabled only after you select a 
node from the Source or Target lists.

Note: You cannot define attribute conditions for the 
source and target nodes in the CI Type Manager.

Relationship Select an available relationship connecting the two 
nodes. The list of available relationships appears only 
after defining both nodes. 

Relationship 
Direction

Select the required direction. Setting different 
relationship directions can achieve different query 
results. For an example, see “Setting Different 
Relationship Directions for Compound Definitions” on 
page 392.

Note: The Relationship list remains empty until you have 
selected a source and target.

Source Select the required source node.

Target Select the required target node.
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Setting Different Relationship Directions for Compound 
Definitions

You can achieve different TQL results by setting different relationship 
directions. For example, in your business world, as illustrated below, you 
want to create a compound relationship that connects between a node of 
the CIT a and a node of the CIT b. Depth is defined at 5 (for details, see 
“Depth” on page 417). 

In the Add Triplet dialog box, you can create compound definitions to link 
nodes a and b using different relationship directions.

➤ Compound definitions 1 and 2 result in the following query:

Compound 
Definition

Source Target Relationship Relationship 
Direction

#1 node a node c <relationship> source --> target

#2 node c node b <relationship> source --> target

#3 node c node b <relationship> source <-- target
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➤ Compound definitions 1 and 3 result in the following query:

➤ Compound definitions 1, 2, and 3 result in the following query:
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Element Instances Dialog Box

Description Displays all of the CI instances found for the selected TQL 
node in a table.

To access in Topology Report Manager, Enrichment 
Manager, Correlation Manager, Query Manager, and 
View Manager:
In the editing pane, right-click the required node and 
select Show Element’s Instances.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the editing pane to display the Show 
Element’s Instances option.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane.

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Show 
Element’s Instances.

Important 
Information

The columns in the report display the attributes of the 
selected CI type. The attributes displayed vary according 
to the CI type selected.

By default, only columns corresponding to attributes that 
have been defined with the Asset Data, Change 
Monitored, and Comparable attribute qualifiers in the 
CIT Manager are displayed as columns in the dialog box. 
For details, see “Attributes Page” on page 247. 

If required, you can click the Display Hidden Columns 
button to display the attributes that are defined as Visible 
but not Static. For details on Static attributes, see 
“Attributes Page” on page 247.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Specify the CIT you want displayed in the table. The table 
also includes the children of the selected CIT.

Click Show CI Properties to open the Configuration Item 
Properties dialog box for the selected CI.

Click to refresh the list of CI instances.

Filters the CI instances you want to display for the 
selected node. Opens the Filter CI Instances dialog box.

Clears the filter definitions you created in the Filter CI 
Instances dialog box.

Enables you to select the columns to be displayed. For 
details, see, “Select Columns Dialog Box” in Reference 
Information.

Enables you to set the order of the visible columns. For 
details, see, “Sort Column Content Dialog Box” in 
Reference Information.
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Choose the export format for the table data. The available 
options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. In Solaris, 
you can specify the list separator in the application 
that opens the CSV file.

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

Note: This option is displayed in Text mode only.

Select the number of rows to be displayed.

Click to navigate through the results page by page or to 
jump to the first or last page.

<Element Instances> The CI instances found for the selected TQL node.

You can double-click an instance to open the 
Configuration Item Properties dialog box for that CI.

<Element instances 
context (right-click) 
menu>

For details, see “IT Universe Manager Context Menu” on 
page 91.

GUI Element (A–Z) Description
396



Chapter 10 • Topology Query Language
Filter CI Instances Dialog Box

Display Label The name of the CI instance as it appears in the topology 
map.

<Toolbar> For details, see “Toolbar Options” on page 717.

Description Enables you to reduce the number of CI instances to be 
displayed in a list by selecting a condition and a value for 
a specific CI.

A description of the filter condition you defined appears 
above the table columns in the Element Instances dialog 
box. For example, the following illustration shows that a 
filter condition was created to display only CI instances 
whose CI type is Windows.

To access: 

➤ Click the Filter  button in the Element Instances 
dialog box.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Join Relationship Condition Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Attribute Displays all the attributes of the CI type to which the CI 
belongs.

Condition Select the required operator. For details, see “Attribute 
Operator Definitions” on page 364.

Value Select or enter the required value.

Description Enables you to define the connection between two nodes 
using a join relationship. The join definition appears in 
the Join Definition area.

To access: Click the Add  button in the Add Join 
Relationship dialog box.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

<Selected node1> A selected node. The first attribute applies to <end_1>.
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<Selected node2> A selected node. The second attribute applies to <end_2>.

Operator Select one of the following operators: 

➤ Equal. The system checks whether two selected 
attributes are equal.

➤ Not equal. The system checks whether two selected 
attributes are not equal.

➤ Sub string. The system checks whether the value of the 
first attribute is a substring of the value of the second 
attribute.

➤ Sub string ignore case. The system checks whether the 
value of the first attribute is a substring of the value of 
the second attribute regardless of the string’s case.

Important: When using the operator Not equal, ensure 
that both sides of the join relationship have a limited 
result size. It is recommended to define more specific 
conditions so as not to overload the system with large 
results.

GUI Element (A-Z) Description
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Layout Settings Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to determine which attributes are used in the 
calculation of the TQL query when using the UCMDB 
API. For details, see “The HP Universal CMDB Web Service 
API” on page 15 in Reference Information.

To access: Click Advanced layout settings in the 
Node/Relationship Properties dialog box.

Important 
Information

➤ Since this option is only relevant when querying the 
CMDB API, the query results in the user interface is not 
impacted by the attributes you select in this dialog 
box.

➤ Once you have selected the required attributes and 
clicked OK, you cannot clear the selections you have 
made.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Attribute name The name of the attribute.

Calculate Select this check box to include the attribute in the 
query’s calculation.
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Node/Relationship Properties Dialog Box

Description Enables you to define the attribute conditions for the 
selected TQL node/relationship.

To access in Topology Report Manager, Enrichment 
Manager, Correlation Manager, Query Manager, and 
View Manager: 
In the editing pane, right-click the required node and 
select Node/Relationship Properties.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the editing pane to display the Node 
Properties option.

To access in Discovery:
1  To access from the Discovery Resources pane, select a 

pattern. In the Pattern Signature tab, click the  Edit 
Input TQL button to the right of the Input TQL box to 
open the Input TQL Editor. 

2  Right-click the required node/relationship and select 
Node/Relationship Properties.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Advanced layout 
settings

Enables you to determine which attributes are used in the 
calculation of the TQL query when querying the CMDB 
using third-party or custom tools. 

Opens the Layout Settings dialog box.

Element name (Optional) The Element name box contains the name of 
the selected node/relationship. By default, the CIT type is 
assigned as the element’s name. You can rename a TQL 
node in the Element name box giving it a unique label. 
This can be helpful when there is more than one node of 
the same CIT type in the TQL query.

Include subtypes Select to display both the selected CI and its children in 
the topology map.

Visible Select Visible to display the selected TQL node in the 
editing pane. When this option is cleared, an invisible 
box  appears to the right of the selected TQL node in 
the editing pane.

Any query results pertaining to that TQL node are not 
displayed in the topology map. This can be useful when 
certain relationships or TQL nodes are required to build 
the query but are not needed in the results. For example, 
Windows are connected to the network by defining 
specific IPs, but in any query results you may want to 
view the IP elements only and not the Windows 
elements.
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Attribute Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create an expression defining conditions 
that restrict the number of nodes that appear in the 
query:

➤ Add an attribute condition to a node or relationship.

➤ Filter the query results.

To access: 

➤ Click the Attribute tab in the Node/Relationship 
Properties dialog box.

or

➤ Click Next in the New TQL Relationship Page in the 
TQL Node Wizard.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Add the attribute condition you have defined.

Delete an attribute definition.

Move a selected row up.

Move a selected row down.

View the condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.
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Attribute name Choose an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances dialog box.

Fixed value Select one of the following options:

Fixed value. You cannot change the value of the 
parameter.

Parameterized value. Enables you to change the value of 
the parameter.

➤ When a parameterized value is selected in View 
Manager, an option called Set View Element 
Parameters is included in the right-click menu. For 
details on how to change the value when using the 
TQL, see “Layout Settings Dialog Box” on page 400.

Note: If you select this option, you can enter a value 
here that is saved in the view. If you do not enter a 
value here, you are forced to enter one before saving 
the view. 

➤ When a parameterized value is selected in Topology 
Report Manager, a Set parameters values option is 
displayed at the top right of a generated Topology 
report, enabling you to edit the predefined parameters 
of node conditions in a Topology report. For details, 
see “Topology Report” on page 591.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three hosts: Host1 is 
assigned the value A, Host2 is assigned the value B and 
Host3 is not assigned a value. You create a query to 
retrieve all hosts that are equal to A and select NOT; the 
results of your query only include Host2 because Host3 is 
not assigned a value.

GUI Element (A-Z) Description
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Cardinality Tab

Operator Select the required operator. For details, see “Attribute 
Operator Definitions” on page 364.

Update Update an attribute condition that has been modified.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

Description Define a relationship cardinality, which enables you to 
define how many CI instances you expect to have at the 
end of a relationship in your query result. 

Select the required relationship to which the selected 
node is attached. Then define the lower and upper limits 
for including the node at the other end of the 
relationship in the query results.

You can define relationship conditions that enable the 
relationship’s connecting node to be included in the TQL 
query results by creating an expression defining that 
condition. For an example, see “Example of a 
Relationship Condition” on page 407.

To access: Click the Cardinality tab in the 
Node/Relationship Properties dialog box.

Important 
Information

This tab appears only when a node is selected.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Add the cardinality definition you have defined.

Delete a cardinality definition from the Cardinality area.

Move a selected row up.

Move a selected row down.

View the cardinality condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

Max Enter the value that defines the upper limits for including 
the node at the other end of the relationship in the query 
results. 

Note: You can use an asterisk (*) in the Max box to 
represent an infinite value.

Min Enter the value that defines the lower limits for including 
the node at the other end of the relationship in the query 
results.

For example, if <end_1> is IP and <end_2> is Windows, 
entering 1 in the Min box and asterisk (*) in the Max box 
instructs the system to retrieve only those IPs that are 
connected to at least one Windows operating system. 
(The asterisk indicates an infinite value.) Entering 3 in 
the Min box and asterisk (*) in the Max box instructs the 
system to retrieve only those Windows operating systems 
that are connected to at least three IPs.
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Example of a Relationship Condition

The example of relationship conditions is based on the following TQL 
query:

 

In the Relationship Cardinality dialog box, the following relationship 
conditions are defined for the TQL:

➤ Member – Min: 1, Max: *

➤ Contained – Min: 2, Max: 4

Node Select the required relationship to which the selected 
node is attached. The list contains all the relationships 
that are linked to the selected node.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three hosts: Host1 is 
assigned the value A, Host2 is assigned the value B and 
Host3 is not assigned a value. You create a query to 
retrieve all hosts that are equal to A and select NOT; the 
results of your query only include Host2 because Host3 is 
not assigned a value.

Update Update a cardinality definition that has been modified.

GUI Element (A-Z) Description
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Using the OR operator, the definitions appear in the Cardinality section, as 
follows:

➤ [member (Network, Host)] OR [contained (Host, IP)] means that the host must 
either have between two and four IPs OR be a member of the network.

Using the AND operator, the definitions appear in the Cardinality section, as 
follows:

➤ [member (Network, Host)] AND [contained (Host, IP)] means that the host must 
have between two and four IPs AND also be a member of the network.

Qualifier Tab

Description Enables you to define qualifier conditions for the selected 
node or relationship. For example, you can use a qualifier 
to define a CIT as abstract, meaning you cannot create 
instances from it.

To access: Click the Qualifier tab in the 
Node/Relationship Properties dialog box.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Important 
Information

Important: By default, multiple selection links the 
conditions with the OR operator.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

ABSTRACT_CLASS You cannot create instances of this CIT.

BLE_LINK_CLASS. Relevant to HP Business Availability Center only.

CONTAINER This qualifier is assigned to relationships that signify a 
containment relationship, such as Member, Container 
link, Contains, or Contained.

HIDDEN_CLASS Instances of this CIT do not appear anywhere in the 
application.

ITU_HIDDEN_CLASS Instances of this CIT do not appear in the topology 
map application.

MAJOR_APP CI types that are assigned this qualifier appear in the 
Major Application Type Breakdown overview report. 
For details, see “Major Application Type Breakdown 
Report” on page 632.

MODELING_ENABLED Enables a CIT to act as model in Modeling Studio. For 
details, see “Business CI Models” on page 106.

NETWORK_DEVICES A qualifier common to all the CI types that represent a 
network device. It can be used for TQL queries related 
to network devices and serves as a replacement for CI 
types in a query.

Negate Qualifiers If this check box is selected, then multiple selection 
links the conditions with the AND operator.

PM_SUSPECT Relevant to HP Business Availability Center only.

ProtocolDialog For internal use only.

ProtocolFields For internal use only.

READ_ONLY_CLASS This CIT cannot be edited.

TRACK_LINK_CHANGES Changes that occur in the specified relationship 
appear in Change reports. For details, see “Change 
Report” on page 585.
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Identity Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to filter the TQL results according to the 
element ID of the instances found for the selected TQL 
node. 

Move the required element from the Optional identities 
pane on the left to the Selected identities pane on the 
right to define what you want included in the TQL results 
using the left and right arrows.

To access: Click the Identity tab in the Node Properties 
dialog box.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Important 
Information

This tab appears only when a node is selected.

GUI Element (A-Z) Description

Filter the CI instances you want to display for the selected 
node. Opens the Filter CI Instances dialog box.

Clear the filter definitions you created in the Filter CI 
Instances dialog box.

Hide or display specific columns. For details, see “Select 
Columns Dialog Box” in Reference Information.

Update the table.

Click to navigate through the results page by page or to 
jump to the first or last page.
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Optional Identities Pane 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Selected Identities Pane

Optional identities 
pane 

Displays all the instances found for the selected TQL 
node. For details, see “Optional Identities Pane” on 
page 411.

Selected identites 
pane

Displays the elements that are used to define what should 
be included in the TQL results. For details, see “Selected 
Identities Pane” on page 411.

Set Rows per Page Determine the number of CI instances that appear on a 
page.

Description Displays all the instances found for the selected TQL 
node in a table.

To access: Click the Identity tab in the Node Properties 
dialog box.

GUI Element (A-Z) Description

CI Type The CI type.

Display label The label that is displayed for the node’s instance.

Description Displays the elements that are used to define what should 
be included in the TQL results.

To access: Click the Identity tab in the Node Properties 
dialog box.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Refine Node Type Dialog Box

GUI Element (A-Z) Description

CI Type The CI type.

Display label The label that is displayed for the node’s instance.

Description Enables you to change the CI type of the TQL node after 
you have created a TQL query.

To access: Right-click the required node and select Refine 
Node Type.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the editing pane to display the Refine 
Node Type option.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Important 
Information

You can change the CI type to a type from one of the CI 
type’s children, if one exists. If one does not exist, this 
option does not appear.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Select Relationship Type Dialog Box

GUI Element (A-Z) Description

List of CI types from 
which to choose

Select the required CI type.

Description Enables you to select the type of TQL relationship to be 
created.

To access: In the editing pane of IT Universe, Query 
Manager, View Manager, Correlation Manager, 
Enrichment Manager, and in the Topology Report 
Manager, click the Create Relationship  button in the 
toolbar and draw a line between two nodes. The Select 
Relationship Type dialog box opens automatically. 

Important 
Information

Select one of the following relationship types:

➤ Regular Relationship. For details, see “Add/Edit 
Relationship Dialog Box” on page 388.

➤ Join Relationship. For details, see “Add/Edit Join 
Relationship Dialog Box” on page 385.

➤ Compound Relationship. For details, see “Add/Edit 
Compound Relationship Dialog Box” on page 381.

➤ Calculated Relationship. For details, see “Add/Edit 
Calculated Relationship Dialog Box” on page 379.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.
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Subgraph Condition Definition Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create conditions that restrict the number 
of nodes that appear in the query.

Contains the following tabs:

➤ Conditions. Enables you to define attribute conditions 
for nodes and relationships. See a description of the 
elements in the Conditions tab in the table below.

➤ Qualifiers. Enables you to define qualifier conditions 
for the selected node or relationship. For details, see 
“Qualifier Tab” on page 408.

To access: Click Condition  in the Add Triplet dialog 
box.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

GUI Element (A-Z) Description

Add the subgraph condition definition.

Delete the subgraph condition definition.

Move a selected row up.

Move a selected row down.

View the subgraph condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.
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Attribute name Choose an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

CIT Contains the CIT selected from the Source and Target 
lists.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, let us assume that your system contains three 
hosts. Host1 is assigned the value A, Host2 is assigned the 
value B and Host3 is not assigned a value. If you create a 
query in which you want to retrieve all hosts that are 
equal to A and you select NOT, the results of your query 
only include Host2 because Host3 is not assigned a value.

Operator Select the required operator. For details, see “Attribute 
Operator Definitions” on page 364.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

GUI Element (A-Z) Description
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Subgraph Definition Dialog Box

Description Enables you to create a graph that represents additional 
TQL query data related to a specific CI.

To access in Topology Report Manager, Enrichment 
Manager, Correlation Manager, Query Manager, and 
View Manager:
In the editing pane, right-click the required node and 
select Subgraph Definition.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the editing pane to display the 
Subgraph Definition option.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane. 

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select Subgraph 
Definition.

Important 
Information

The following icon is displayed next to the node for 
which you define a subgraph:

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.

Useful Links “Subgraph Definition” on page 346

“Create a Subgraph Definition — Scenario” on page 355
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Add a subgraph definition. Opens the Add Triplet dialog 
box.

Delete a subgraph definition.

Edit a subgraph definition. Opens the Edit Triplet dialog 
box.

Depth A number that represents the longest path (that is, the 
maximum connecting nodes) allowed between two CIs in 
the CMDB that should be included in the DDM process.

Default: 5

Element condition 
exists

A green asterisk appears next to either the source, 
relationship, or target in the subgraph definition if an 
attribute condition has been defined for one of them in 
the Subgraph Condition Definition dialog box. For 
details, see “Subgraph Condition Definition Dialog Box” 
on page 414.

Relationship The relationship selected in the Add Triplet dialog box 
connecting the source to the target node.

Relationship 
Direction

The direction of the relationship selected in the Add 
Triplet dialog box, indicating which node is dependent 
on the other.

Source The required source node selected in the Add Triplet 
dialog box.

Target The required target node selected in the Add Triplet 
dialog box.
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TQL Node Wizard

Description Enables you to build a TQL query. 

To access in Topology Report Manager, Enrichment 
Manager, Correlation Manager, Query Manager, and 
View Manager:
In the editing pane, right-click the required node and 
select TQL Node Wizard.

Note: If you are using Enrichment Manager, select TQL 
mode at the top of the editing pane.

To access in Job Configuration in Discovery:
1  Select a job in the Discovery Modules pane. 

2  Select a Trigger TQL in the Properties pane. Click the 
Open the TQL Editor  button to open the Trigger 
TQL Editor.

3  Right-click the required node and select TQL Node 
Wizard.

To access in Manage Discovery Resources in Discovery:
1  Select a pattern in the Discovery Resources pane. 

2  In the Pattern Signature tab, click the  Edit Input 
TQL button to the right of the Input TQL box to open 
the Input TQL Editor.

3  Right-click the required node and select TQL Node 
Wizard.

Important 
Information

If the TQL query is empty, drag the required TQL nodes 
on to the editing pane from the tree displayed in the CI 
Type Selector.

Included in Tasks ➤ “Define a Report Rule – Scenario” on page 264

➤ “Define a Correlation Rule – Workflow” on page 199

➤ “Define an Enrichment Rule – Scenario” on page 318

➤ “Create a TQL Query” on page 303

➤ “Create a Pattern View” on page 164

➤ “Implement a Pattern” in Discovery and Dependency 
Mapping Guide.
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New TQL Node Page

Useful Links “Topology Query Language” on page 342

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > TQL 
Node Properties Page > Element Instances Page

Description Enables you to add a node to the TQL query.

Important 
Information

If the TQL query is empty, drag the required TQL node on 
to the editing pane from the tree displayed in the 
Configuration Item Types pane.

For general information on the TQL Node Wizard, see 
“TQL Node Wizard” on page 418.

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > 
TQL Node Properties Page > Element Instances Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<node> is required Define the relationship cardinality. For details, see 
“Cardinality Tab” on page 405.

➤ Select the <node> is required check box for each node 
to include a minimum of one instance of the node at 
the other end of the relationship in the query results. 
Selecting the check box gives the relationship a 
cardinality value of 1*.

➤ Clear the <node> is required check box to give the 
relationship a cardinality value of 0*.

<TQL Node hierarchy 
tree>

Select the required node. The node you select appears in 
the Element name box.

This list only includes the nodes of the CIT type that have 
valid relationships to the selected (source) node. 

To the right of each node, the number of CI instances 
that exist in the CMDB for that CI type is displayed. The 
number of instances is only updated after you close the 
TQL Node Wizard and open it again.

Note: The first node in the hierarchy tree is selected by 
default.

Element name (Optional) Contains the name of the selected node. By 
default, the CIT type is assigned as the element’s name.

You can rename a TQL node in the Element name box 
giving it a unique label. This can be helpful when there is 
more than one node of the same CIT type in the TQL 
query.

Show only CITs with 
instances

Select this check box to display only the CITs of which 
there are instances in the CMDB.

Note: The Show only CITs with instances check box is 
selected by default.
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New TQL Relationship Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to add a relationship to a TQL query.

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > 
TQL Node Properties Page > Element Instances Page

GUI Element (A-Z) Description

<TQL Relationship 
hierarchy tree>

Select the required relationship. The node you select 
appears in the Relationship Type box.

Direction Select the required relationship direction. The direction 
indicates which node is dependent on the other.

Relationship 
direction

Select the required relationship direction. The direction 
indicates which node is dependent on the other.

Relationship Type A valid relationship that defines the connection between 
the selected nodes. The box displays the relationship you 
selected in the relationship hierarchy tree.

Show only 
relationships with 
instances

Display only the relationships of which there are 
instances in the CMDB.
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TQL Node Properties Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create an expression that restricts the 
number of nodes that appear in the query by adding an 
attribute condition to a node or relationship.

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > TQL 
Node Properties Page > Element Instances Page

GUI Element (A-Z) Description

Add the attribute definition.

Delete an attribute condition.

Move a selected row up.

Move a selected row down.

View the condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Choose an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.
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Fixed value Select one of the following options:

Fixed value. You cannot change the value of the 
parameter.

Parameterized value. Enables you to change the value of 
the parameter.

➤ When a parameterized value is selected in View 
Manager, an option called Set View Element 
Parameters is included in the right-click menu. For 
details on how to change the value when using the 
TQL, see “Set View Parameters/Set View Element 
Parameters Dialog Box” on page 183.

Note: If you select this option, you can enter a value 
here that is saved in the view. If you do not enter a 
value here, you are forced to enter one before saving 
the view. 

➤ When a parameterized value is selected in Topology 
Report Manager, a Set parameters values option is 
displayed in a generated Topology report, enabling you 
to edit the predefined parameters of node conditions 
in a Topology report. For details, see “Topology 
Report” on page 591.

Include subtypes Display both the selected CI and its children in the 
topology map.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three hosts: Host1 is 
assigned the value A, Host2 is assigned the value B and 
Host3 is not assigned a value. You create a query to 
retrieve all hosts that are equal to A and select NOT; the 
results of your query only include Host2 because Host3 is 
not assigned a value.

Operator Select the required operator. For details, see “Attribute 
Operator Definitions” on page 364.

GUI Element (A-Z) Description
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Update Update an attribute condition that has been modified.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

Visible Select Visible to display the selected TQL node in the 
editing pane. When Visible is cleared, an invisible box  
appears to the right of the selected TQL node in the 
editing pane.

Any query results pertaining to that TQL node are not 
displayed in the topology map. This can be useful when 
certain relationships or TQL nodes are required to build 
the query but are not needed in the results. For example, 
Windows are connected to the network by defining 
specific IPs, but in any query results you may want to 
view the IP elements only and not the Windows 
elements.

GUI Element (A-Z) Description
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Element Instances Page

Description Displays all the instances found for the selected TQL node 
in a table.

Important 
Information

The columns displayed in the report vary according to 
the CI type selected. 

By default, only columns corresponding to attributes that 
have been defined with the Asset Data, Change 
Monitored, and Comparable attribute qualifiers in the 
CIT Manager are displayed as columns in the dialog box. 
For details, see “Attributes Page” on page 247. 

If required, you can click the Display Hidden Columns 
button to display the attributes that are defined as Visible 
but not Static. For details on Static attributes, see 
“Attributes Page” on page 247.

Note: For information on the elements included in the 
Element Instances page, see “Element Instances Dialog 
Box” on page 394.

Wizard Map The TQL Node Wizard contains:

New TQL Node Page > New TQL Relationship Page > TQL 
Node Properties Page > Element Instances Page
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User Preferences Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to reset system preferences.

To access: Select Edit > User Preferences.

Important 
Information

All the preferences you select (such as whether to display 
certain wizard pages or warning message preferences) are 
stored in the system. This dialog box enables you to reset 
those preferences.

GUI Element (A-Z) Description

<Left pane> Select the preferences page to edit. The following options 
are available:

➤ Wizard Preferences

➤ Optional Messages Preferences

➤ Discovery Preferences

Preferences list The list of warning messages and their user-selected 
preferences.

Reset Page Click to reset the selected preference to its default value.

Reset All Click to reset all the preferences to their default values.
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Troubleshooting and Limitations

For TQL queries to be valid, they must comply with certain restrictions.

This section includes the following topics:

➤ “Understanding Validation Restrictions” on page 427

➤ “Correlation TQL Validation” on page 429

➤ “Enrichment TQL Validation” on page 430

Understanding Validation Restrictions
For Correlation, Enrichment, and DDM TQL types to be valid, they must 
comply with the following restrictions:

➤ Self Relationships. A TQL must not contain self relationships, that is, a 
relationship must not lead from a node to itself, as the following example 
illustrates:
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➤ Cyclic Graph. The TQL structure cannot be a closed circle, as shown in the 
following example:

➤ Separate Nodes and Groups. All the TQL nodes must be linked to one 
another, that is, the TQL cannot contain separate nodes or groups, as the 
following example illustrates:

Note: This restriction also applies to Report TQLs.
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Correlation TQL Validation
A Correlation TQL must also comply with the following restrictions:

➤ Number of nodes. A Correlation TQL must consist of at least two nodes.

➤ Trigger and affected nodes must be connected. There must be a path of 
relationships from the triggered node to the affected nodes.

➤ Selecting nodes to function as Correlation triggers. When selecting nodes 
to function as Correlation triggers, the nodes must comply with the 
following restrictions:

➤ You can select more than one node as a trigger. However, you cannot 
define a node as affected and as a trigger.

➤ If a node has a relationship whose minimum limit is 0 (meaning that one 
of its ends does not necessarily have a node linked to it), the node that is 
linked to its other end cannot be a root cause node (because it may or 
may not exist in the TQL). For details about minimum limits, see 
“Cardinality Tab” on page 405. For example, IT Universe cannot be either 
a root cause or affected node because it is connected to the host with a 
Min limit of 0. 

Note: A node that is not visible cannot be a root cause or an affected node.
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➤ The connection between trigger and affected nodes. The trigger node and 
affected nodes you define must be connected by a path of relationships 
from the triggered node to the affected nodes.

Enrichment TQL Validation
Enrichment TQL queries must comply with the following restriction:

➤ Required elements. You cannot perform Enrichment on a non-required 
node, that is, a node that does not necessarily appear in the TQL results.

Example 1. In this example, the TQL results can be either A and B or A and 
C. Therefore, you cannot add an Enrichment node to nodes B or C because 
they are not required elements. You can add an Enrichment node to node A 
because it always appears in the TQL results. For details on how to add 
Enrichment nodes and relationships, see “Add Enrichment Nodes and 
Relationships to an Enrichment TQL Query” on page 349.
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Example 2. In this example, both A and B are required elements that always 
appear in the TQL results. Only C is not a required element because it has a 
cardinality of 0. Therefore, you cannot add an Enrichment node to it.
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Using Calculated Relationships

This chapter provides information on calculated relationships.

This chapter includes:

Concepts

 ➤  Calculated Relationships Overview on page 433

 ➤  Calculated Relationships on page 434

 ➤  Calculated Relationship Types on page 435
Concepts

Calculated Relationships Overview

You can use calculated relationships to create TQL queries just like any other 
relationship in the CI Type model. This enables you to base Enrichment 
rules, Correlation rules, Report rules, and views on calculated relationships. 

Calculated relationships affect the results of all TQLs that use that calculated 
relationship since calculated relationships are part of the class model.
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Calculated Relationships

Calculated relationships are defined by one or more triplets. For details, see 
“Triplets Page” on page 251. Each triplet is defined by the following 
components:

➤ One source CI type

➤ One target CI type

➤ A physical relationship that links the two CI types

➤ The required direction. The direction can be identical to or opposite from 
the direction of the relationship in the class model. 

Since calculated relationships are defined by physical relationships from 
within the class model, their lifetime is determined by the lifetime of the 
physical relationships. When the physical relationship in the class model is 
removed, the corresponding calculated relationship is removed from all 
view results as well.

Note: If you create a new CI type or relationship in the CI Type Manager, 
you need to define the required triplets. For example, Change report 
displays changes based on calculated relationships. To include the changes 
for the new CI type in the Change report, you need to define the 
appropriate triplet.

Example of a Triplet Definition
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Calculated Relationship Types

There are two types of out-of-the-box calculated relationships. Each one 
represents a different type of relation.

➤ Impacted by (Directly)

➤ Impacted By (Potentially)

The example below illustrates the difference between the Impacted By 
(Directly) and Impacted By (Potentially) relationships.
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➤ If Host4 experiences downtime, it impacts only the Poker application. 

➤ If the Database CI experiences downtime, it impacts both the Poker and 
Bridge applications. 

➤ If there is a planned downtime for Poker:

➤ The four hosts are also in downtime because they are contained within 
the Poker application. 

➤ The Database CI continues to be active. 

Although this illustration maps a Contains relationship to an Impacted By 
(Directly) relationship and a Depends relationship to an Impacted By 
(Potentially) relationship, you can use calculated relationships to replace a 
number of relationships. This enables you to reduce the number of 
relationships you need to include when creating TQLs.

For details on defining the connection between two nodes using a 
calculated relationship, see “Add/Edit Calculated Relationship Dialog Box” 
on page 379.

You can also define new calculated relationships to suit your business needs. 
For details, see “Triplets Page” on page 251.
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Direct Links to an Application Page

This chapter provides information on how to create a URL that either opens 
a specific HP Universal CMDB page directly in your browser, or directly 
embeds a UCMDB applet into external applications.

This chapter includes:

Concepts

 ➤  Direct Links Overview on page 437

Tasks

 ➤  Work with Direct Links — Scenario on page 439

Reference

 ➤  Direct Links User Interface on page 439
Concepts

Direct Links Overview

Direct Links enable you to create a URL that:

➤ Opens a specific HP Universal CMDB view, or CI, directly in HP Universal 
CMDB. This enables users to retrieve information from HP Universal 
CMDB without being located in the HP Universal CMDB context. 

Note: To open a specific view or CI directly in HP Universal CMDB, use 
the Open in context link option. For details, see “Select Command Page” 
on page 441.
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➤ Enables integration with HP Universal CMDB:

➤ If you create a URL using the Embedded links option, the URL takes 
you first to the HP Universal CMDB login page. After you enter your 
login name and password, the target page opens in your browser.

Note: To open the target page in your browser, use the Embedded 
links option. For details, see “Select Command Page” on page 441.

➤ (Intended for integration developers only) You can directly embed a 
UCMDB applet into external applications. 

For details on how to embed UCMDB applets directly into an external 
application using direct links, see “Embedding UCMDB Applets Using Direct 
Links” in Solutions and Integrations.

You can create a URL in Topology View (select Applications > Topology 
View) and all the TQL editors in Admin > Modeling.

For details on the user interface for the Direct Links option, see “Direct Links 
User Interface” on page 439.

When you create a URL, you can:

➤ Send the URL to an email recipient

➤ Copy the URL to the clipboard

➤ Test the URL to ensure that the target application page can be found

The user to whom you are sending the URL must have an account with 
sufficient privileges to open the target page. You must apply the appropriate 
viewing and editing permissions to the users and user groups that want to 
access the target view. You set permissions in Admin > Settings > Users and 
Roles. For details, see “Users and Roles User Interface” on page 641.

Tasks
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Work with Direct Links — Scenario

This scenario describes how to use Direct Links to email the URL of a specific 
CI to another person.

Jane Harrison is a senior engineer in the ABC Software company. She has 
encountered a problematic CI in a view she has created. She wants to inform 
Henry Jones, who is working with the same view through HP ServiceCenter, 
about the problematic CI. Since the view Jane has created contains many 
hundreds of CIs, she decides to email Henry the URL of the CI so that he 
does not have to spend a lot of time searching for that specific CI.

In IT Universe, Jane selects Direct Links Wizard from the Edit menu. In the 
Select Command page of the Direct Links Wizard, she selects the Show View 
option and clicks Next. 

In the Direct Link Parameters — Show View page, she selects the view she 
created, the problematic CI, and IT Universe as the mode in which Henry 
opens the CI. When the URL is created, she emails Henry the link to the 
problematic CI.

For details on the Direct Links Wizard, see “Direct Links Wizard” on 
page 441.

Reference

Direct Links User Interface

This section describes:

 ➤  Direct Link Dialog Box on page 440

 ➤  Direct Links Wizard on page 441

 ➤  Select CIs Dialog Box on page 455
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Direct Link Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description The URL that is created by the Direct Links wizard to 
either access a specified application page in HP Universal 
CMDB or embed a UCMDB applet into an external 
application. 

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard. 

Note: You can also create a URL in Topology View (select 
Applications > Topology View).

GUI Element (A-Z) Description

Copy URL Copies the URL to the clipboard.

Description Describes the mode used in the Select Command page to 
create the URL.

Link URL The URL that was created by the Direct Links Wizard to 
access the specified HP Universal CMDB function.

Mail URL Opens an email containing the URL of the link.

Test URL Checks the URL to ensure that the specified application 
page can be found.
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Direct Links Wizard

Select Command Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Creates a URL that guides another user to a specific target 
view or CI in HP Universal CMDB, or embeds a UCMDB 
applet into an external application.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard. 

Note: You can also create a URL in Topology View (select 
Applications > Topology View).

Included in Tasks “Work with Direct Links — Scenario” on page 439

Description Enables you to select the required Direct Link commands.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command.

Important 
Information

For general information about the Direct Links Wizard, 
see “Direct Links Wizard” on page 441.

GUI Element (A-Z) Description

<Left pane> A graphic illustration of the selected command.

CI type selector Enables you create a URL that embeds the CI type selector 
into external applications. For details, see the Direct 
Link Parameters — Show CI Type Selector page.

Note: Appears when you select the Embedded links 
option.

Description A description of the selected command.

Embedded links Creates a URL that enables you to embed a UCMDB 
applet into external applications.
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Open in context links Creates a URL that guides another user to a specified 
application page without having to be in the 
HP Universal CMDB context. 

Show change report Enables you to create a URL that embeds a report 
displaying changes made to a specific CI into an external 
application. For details, see the Direct Link Parameters — 
Show Change Report page.

Note: Available when you select the Embedded links 
option.

Show change report 
on view

Enables you to create a URL that embeds a report 
displaying changes made to a specific view into an 
external application. For details, see the Direct Link 
Parameters — Show Change Report on View page.

Note: Available when you select the Embedded links 
option.

Show CI 
Neighborhood

Enables you to create a URL that embeds a topology map 
displaying a specific CI and the CIs that are linked to it by 
a distance of no more than one relationship, into an 
external application. For details, see Direct Link 
Parameters — Show CI Neighborhood page.

Note: Available when you select the Embedded links 
option.

Show CI properties Enables you to create a URL that displays a CI’s 
properties. For details, see the Direct Link Parameters — 
Show CI Properties page.

Note: Available when you select the Embedded links 
option.

Show related CIs Opens a topology map displaying the selected CI and its 
immediate neighbors within the selected view. For 
details, see Direct Link Parameters — Show Related CIs 
page.

Note: Available when you select the Open in context 
option.

GUI Element (A-Z) Description
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Direct Link Parameters — CI Type Selector Page

Show Topology 
Report

Enables you to create a URL that embeds a Topology 
Report into an external application. For details, see 
Direct Link Parameters — Show Topology Report page.

Note: Available when you select the Embedded links 
option.

Show view Displays the selected view and optionally preselect a 
node in it. For details, see Direct Link Parameters — Show 
Related View page.

Note: Available when you select the Open in context 
option.

Start impact map Enables you to create a URL that embeds an impact map 
into an external application. For details, see the Direct 
Link Parameters — Show Impact Map page.

Note: Available when you select the Embedded links 
option.

Start in mode Opens HP Universal CMDB in the selected mode. For 
details, see the Direct Link Parameters — Start in Mode 
page. 

Note: Available when you select the Open in context links 
option.

Description Enables you to create a URL to a hierarchical tree or list of 
selected CI types, which you can embedded into an 
external application.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Embedded 
links > CI type selector.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

Useful Links “CI Type Manager” on page 225

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

CI type selector 
mode

View the selected CI types in either a hierarchical tree or 
list.

Invisible CITs (tree 
only)

Select the CI types you do not want to appear in the tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types you want to appear in the tree.

➤ Click  to delete the selected CI types. 

Root CI Type (tree 
only)

Select the CI type you want to use as the root CI type in a 
hierarchical tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI type you want to use as the root CI type 
in the tree. 

➤ Click  to delete the selected CI type. The default is 
IT Universe.

Selection mode Allow single or multiple selection of CI types.

Unselectable CITs 
(tree only)

Select the CI types which cannot be selected in the tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types which cannot be selected in the 
tree.

➤ Click  to delete the selected CI types. 

Visible CITs (list only) Select the CI types which you want to appear in the CI 
type list.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types which you want to appear in the CI 
type list.

➤ Click  to delete the selected CI types. 

Note: If you choose to view the CITs in a list, then you 
are required to select at least one CI type.
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Direct Link Parameters — Show Change Report Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a URL to a specific Change report 
that displays the changes made to a specific CI and its 
children.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Embedded 
links > Show change report.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

Useful Links ➤ “Change Report” on page 585

➤ “Working in Reports” in Reference Information

GUI Element (A-Z) Description

Date from: Configure a start date and time for the report.

Date until: Configure an end date and time for the report.

Source CI object ID Enables you to create a URL to a specific Change report 
that displays the changes made to a specific CI and its 
children.

➤ Click  to select the source CI and retrieve its object 
ID. Opens the Select Source CI dialog box. For details, 
see “View Explorer” on page 676.

➤ Click  to delete the value in the Source CI object ID 
box. 

Time range: Select a time range for which you want to view the 
report. For more information on defining a time period 
using the Time Range options, see “Generating Reports” 
in Reference Information.
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Direct Link Parameters — Show Change Report on 
View Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a URL to a specific Change report 
that displays the changes made to a specific view. 

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Embedded 
links > Show change report on view.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

Useful Links ➤ “Change Report” on page 585

➤ “Working in Reports” in Reference Information

GUI Element (A-Z) Description

Date from: Configure a start date and time for the report.

Date until: Configure an end date and time for the report.

Selected view ➤ Click  to select the required view. Opens the Select 
View dialog box.

➤ Click  to delete the value in the Selected View box. 

Time range: Select a time range for which you want to view the 
report. For more information on defining a time period 
using the Time Range options, see “Generating Reports” 
in Reference Information.
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Direct Link Parameters — Show CI Neighborhood Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to embed into an external application, a 
topology map that displays a specific CI, and all the CIs 
that are linked to it by a distance of no more than one 
relationship.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Embedded 
links > Show CI Neighborhood.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

GUI Element (A-Z) Description

Restrict results to CI 
types

Restrict the results of the topology map to related CIs of 
one or more CI types.

➤ Click  to select the required CI types. Opens the CI 
Type Selector dialog box.

➤ Click  to delete the value in the Restrict results to 
CI types box. 

Restrict results to 
view

Restrict the results of the topology map to related CIs 
from a specific view.

➤ Click  to select the required view. Opens the Select 
View dialog box.

➤ Click  to delete the selected view in the Restrict 
results to view box.

Source CI Select the CI whose related CIs you want to display in an 
embedded topology map.

➤ Click  to select the required CI and retrieve its 
object ID. Opens the Select Source CI dialog box. For 
details, see “View Explorer” on page 676.

➤ Click  to delete the value in the Source CI box. 
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Direct Link Parameters — Show CI Properties Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view basic information for an existing CI. 

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Embedded 
links > Show CI Properties.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

Useful Links “Configuration Item Properties Dialog Box” on page 74

GUI Element (A-Z) Description

Source CI object ID Select the required CI.

➤ Click  to select the source CI and retrieve its object 
ID. Opens the Select Source CI dialog box. For details, 
see “View Explorer” on page 676.

➤ Click  to delete the value in the Source CI object ID 
box. 



Chapter 12 • Direct Links to an Application Page

449

Direct Link Parameters — Show Impact Map Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to run a Correlation rule defined in 
Correlation Manager.

The URL you create enables you to embed a topology 
map showing a simulation of all the CIs that are affected 
by the selected trigger CI for the selected severity and 
state.

For details, see “Run Correlation Dialog Box” on 
page 536.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Embedded 
links > Show impact map.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

Useful Links “Topology View Application” on page 523

GUI Element (A-Z) Description

State and Trigger 
Severity

➤ Click  to select the required severity and state. 
Opens the Correlation State and Trigger Severity dialog 
box. For details, see “Run Correlation Dialog Box” on 
page 536.

➤ Click  to delete the selected severity and state. 

Trigger CIs Select the CIs that represent the simulated changes you 
want to make to the system. Opens the Select CIs dialog 
box.
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Direct Link Parameters — Show Instances Grid Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Direct Link Parameters — Show Related CIs Page

Description Display all of the CI instances found in the CMDB for 
selected CI type, and its children.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Embedded 
links > Show instances grid.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

Useful Links “Element Instances Dialog Box” on page 394

GUI Element (A-Z) Description

CI type Select the required CI type.

➤ Click  to select the required CI type. Opens the CI 
Type Selector dialog box.

➤ Click  to delete the CI type. 

Description Enables you to create a URL to a topology map displaying 
the related CIs of the selected (source) CI. The topology 
map opens in either Topology view or IT Universe.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Open in 
context links > Show related CIs.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Direct Link Parameters — Show Topology Report Page

GUI Element (A-Z) Description

Initial mode Displays the related CIs in either Topology Map or 
IT Universe.

Source CI object ID The object ID of the source CI.

Select the (source) CI whose related CIs you want to 
display in a topology map.

➤ Click  to select the source CI and retrieve its object 
ID. Opens the Select Source CI dialog box. For details, 
see “View Explorer” on page 676.

➤ Click  to delete the value in the Source CI object ID 
box. 

Description Enables you to create a URL to a specific Topology report. 

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Embedded 
links >Show topology report.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

Useful Links ➤ “Topology Report” on page 591

➤ “Working in Reports” in Reference Information
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Direct Link Parameters — Show View Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Report name Select the required Topology report.

➤ Click  to select the required Topology report. 
Opens the Reports Tree dialog box.

➤ Click  to delete the value that appears in the 
Report name box. 

Description Enables you to create a URL to a specific view and 
optionally select a specific node in that view. When the 
view opens, the CI you chose is selected in the view.

Note: The view opens in either Topology view or 
IT Universe.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Open in 
context links > Show view.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

GUI Element (A-Z) Description

<Left pane> A graphic illustration of the selected option.

Initial mode Displays the view in either Topology Map or IT Universe.
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Direct Link Parameters — Show View Topology Page

Selected View The target view to be opened by the URL.

➤ Click  to select the target view to be opened by the 
URL. Opens the Select View dialog box.

➤ Click  to delete the selected view in the Selected 
view box.

Select CI from view 
result

(Optional) Click to select a CI and retrieve its object ID. 
When the view opens, the CI you chose is selected in the 
view.

➤ Click  to choose the CI you want selected in the 
target view and retrieve its object ID. Opens the Select 
Source CI dialog box. For details, see “View Explorer” 
on page 676.

➤ Click  to delete the object ID for the selected CI in 
the Select CI from view result box.

View mode The view options are:

➤ View Topology. Displays an entire layer within a view.

➤ Related in View. Displays the selected CI and its 
immediate neighbors within the current view.

➤ Related in DB. Displays the selected CI and its 
immediate neighbors in the CMDB.

Description Enables you to display the topology map of the selected 
view and embed it in an external application.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Embedded 
links > Show view topology.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Direct Link Parameters — Start in Mode Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Finish Page

GUI Element (A-Z) Description

Selected View ➤ Click  to select the required view to be opened by 
the URL. Opens the Select View dialog box.

➤ Click  to delete the selected view in the Selected 
view box.

Description Starts the UCMDB application in the required mode.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select Command > Open in 
context links >Start in mode.

Important 
Information

➤ For general information about the Direct Links 
Wizard, see “Direct Links Wizard” on page 441.

➤ Click Finish to close the wizard and create a URL. 
Opens the Direct Links dialog box.

GUI Element (A-Z) Description

<Left pane> A graphic illustration of the selected mode.

Initial mode Starts the UCMDB application in the selected mode.

Description This is the final page of the Direct Links wizard. Click 
Finish to close the wizard and create a URL. Opens the 
Direct Links dialog box.

Important 
Information

For general information about the Direct Links Wizard, 
see “Direct Links Wizard” on page 441.
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Select CIs Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the required CIs. For details on the 
CI Selector, see “View Explorer” on page 676.

To access: Select Admin > Modeling > <TQL editor> > Edit 
> Direct Links Wizard > Select command > Embedded 
links > Show impact map. Then click the Edit button  
in the Trigger CIs box.

GUI Element (A-Z) Description

Moves the selected CI in the CI Selector pane to the 
Trigger CIs pane.

Moves the selected CI in the Trigger CIs pane to the CI 
Selector pane.

Moves all the CIs in the Trigger CIs pane to the CI 
Selector pane.

CI Selector pane Enables you to choose the CIs you want to use as the 
trigger in an impact map.

➤ Select the Browse Views tab to search for and display a 
view, and browse through the view to locate a 
particular CI.

➤ Select the Search CIs tab to search for and display a 
view, and browse through the view to locate a 
particular CI. 

For details on how to use the CI Selector pane, see “View 
Explorer” on page 676.

Trigger CIs pane The CIs that are used as the triggers in an impact map.
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Infrastructure Settings Manager

This chapter provides information on the Infrastructure Settings Manager. 

This chapter includes:

Concepts

 ➤  Infrastructure Settings Manager Overview on page 459

Reference

 ➤  Infrastructure Settings Manager User Interface on page 460
Concepts

Infrastructure Settings Manager Overview

HP Universal CMDB enables you to define the value of many settings that 
determine how HP Universal CMDB and its applications run.

Important: Modifying certain settings can adversely affect the performance 
of HP Universal CMDB. It is highly recommended not to modify any 
settings without first consulting HP Software Support or your HP Services 
representative.
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In the Infrastructure Settings Manager, you can select different contexts 
from which to view and edit settings. These contexts are split into two 
groups: 

➤ Applications

This list includes those contexts that determine how the various 
applications running within HP Universal CMDB behave. 

➤ Foundations

This list includes those contexts that determine how the administration 
tools of HP Universal CMDB run. 

Descriptions of the individual settings appear in the Description column of 
the table on the Infrastructure Settings page. 

Reference

Infrastructure Settings Manager User Interface

This section describes:

 ➤  Infrastructure Settings Manager Window on page 460

 ➤  Edit Setting Dialog Box on page 461

Infrastructure Settings Manager Window

Description Enables you to view and edit infrastructure settings.

To access: Select Admin > Settings > Infrastructure 
Settings Manager.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Edit Setting Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click the Edit Setting button to open the Edit Settings 
dialog box which enables you to edit an infrastructure 
setting.

All Displays all the infrastructure settings.

Applications Displays the infrastructure settings connected with the 
Applications.

Description A description of the infrastructure setting.

Foundations Displays the infrastructure settings connected with the 
Administration tools.

Name The name of the infrastructure setting.

Value The value of the infrastructure setting.

Description Enables you to change the value of an infrastructure 
setting.

To access: In Infrastructure Settings Manager, click the 
Edit Setting button  next to the infrastructure setting 
to be edited.

GUI Element (A-Z) Description

Description A description of the infrastructure setting.

Name The name of the infrastructure setting.

Note Other information about the selected infrastructure 
setting.
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Restore Default Click to restore the default value of the infrastructure 
setting.

Value The value of the infrastructure setting.

GUI Element (A-Z) Description
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Package Manager

This chapter provides information on Package Manager.

This chapter includes:

Concepts

 ➤  Package Administration Overview on page 464

 ➤  Package Zip File Contents and Format on page 465

 ➤  Packages for Federated CMDB Adapters on page 466

Tasks

 ➤  Create a Custom Package on page 467

 ➤  Deploy a Package on page 468

 ➤  Export a Package on page 468

Reference

 ➤  Package Resources on page 469

 ➤  Using the JMX Console to Perform Package Manager Tasks on page 471

 ➤  Package Manager User Interface on page 475

Troubleshooting and Limitations on page 490
Concepts
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Package Administration Overview

A package is a subset of resources grouped together by a defined criteria. For 
a list of the predefined resource types, see “Resource Types” on page 481. 

Package Manager fulfills several functions:

➤ Enables the discovery of specific IT infrastructure assets. For example, 
HP Universal CMDB deploys the SQL_Server package to discover Microsoft 
SQL servers.

➤ Enables you to define the CI Type model through the CI types that are 
included in the packages. For example, some of the CI types included in the 
package Host_Resources_Basic are Disk, CPU,Process, and Print Queue.

➤ Enables you to move groups of resources from one system to another. For 
example, from a test to a production environment.

There are two types of packages:

➤ Factory package. Contains resources that are deployed with the installation 
and are used to initialize HP Universal CMDB.

By default, factory packages are located in: <HP Universal CMDB root 
folder>\UCMDBServer\root\lib\factory_packages.

Note: Some of the factory packages that are deployed with the installation 
are not visible in the list of packages that appear in Package Manager. To 
display the hidden packages, right-click anywhere in the Package Manager 
Window and select Show Hidden Packages.

➤ Custom package. A package that is user created. You may want to create a 
custom package if the factory packages do not contain the resources needed 
for the tool you are developing, or if you want to export resources from 
system to system. For details, see “Create Custom Package/Edit Package 
Wizard” on page 477.
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Important: If you create custom packages for the resources or tools you 
develop, do not place them in the <HP Universal CMDB root 
folder>\UCMDBServer\root\lib\factory_packages folder. This folder is 
only for factory packages.

Export and deployment of packages from system to system is performed 
through the Package Manager interface.

You can:

➤ Export some or all of a package’s resources to your local directory. For 
details, see “Export a Package” on page 468.

➤ Deploy some or all of a package’s resources to the CMDB from your local 
directory. For details, see “Deploy a Package” on page 468.

Package Zip File Contents and Format

A package’s resources are stored in the CMDB. To export a package from 
system to system, you use the Package Manager interface (for details, see 
“Package Manager Window” on page 486). Package Manager creates a zip 
file containing the resources to enable the export of the resources.

When you export resources from the Package Manager to your local 
directory, the resource definitions are stored in various formats, for example, 
XML format. 

In the sample Network.zip below, the router.xml file contains a Router CIT 
definition and the Switch.xml file contains a Switch CIT definition.
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.

Packages for Federated CMDB Adapters

You deploy Federated CMDB adapters by creating a package and placing 
them in the appropriate folder. For details, see “Deploy the Adapter” in the 
Integrations PDF. 

Tasks
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Create a Custom Package

When you create a new package, you give the package a unique name and 
description, and then select the resources you want included in the package. 
For details, see “Create Custom Package/Edit Package Wizard” on page 477.

Example of Resources Selected to Be Included in a Package

The summary page in the Create Custom Package wizard displays the 
resources selected to be included in the package, as shown in the illustration 
below:

The package contains resources from the following resource groups: 

➤ Relationships

➤ Valid Links

➤ Configuration Item Types
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Deploy a Package

You can deploy some or all of a package’s resources to the CMDB from your 
local directory. For details, see “Package Manager Window” on page 486.

Example of Deploying Only Specific Resources in a Package

You want to deploy only some of the resources contained in the package 
called ticket2.zip. Click the  button. In the Deploy Specific Resources 
dialog box, browse to the package’s location and select the resources from 
the package you want to deploy. See the following illustration:

Export a Package

You can export some or all of a package’s resources to your local directory. 
For details, see “Package Manager Window” on page 486.

Example of Exporting Only Specific Resources in a Package

You want to export only some of the resources contained in a package called 
ticket2.zip to your local directory. Click the  button. In the Export 
Package dialog box, select the Export Resources option and select the 
resources you want to export. See the following illustration:

Reference
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Package Resources

This section contains a list of the resources a package can contain. For a list 
of the available resource types and their descriptions, see “Resource Types” 
on page 481.

➤ acl. The definition of a role such as Administrator or Guest. For details, see 
“Users and Roles” on page 639.

➤ adapter. Contains a description and the capabilities of the deployed 
federated adapter.

➤ adapterCode. Contains compiled classes (normally a jar), based-on *.jar 
files, and configuration files needed for federated adapters. Place these files 
in the adapterCode\<adapter ID> folder in the zip package. For details, see 
“Deploy the Adapter” in Discovery and Dependency Mapping Guide.

➤ calculatedLinks subsystem. Contains the calculated relationships and their 
triplets as defined in the CI Type Manager.

➤ categories. Contains the State definitions used by Correlation Manager. For 
details on States, see “State Manager” on page 507. For details on 
Correlation Manager, see “Correlation Manager” on page 197.

➤ class. CI type descriptions, such as host, file, switch, and so on. For details, 
see “CI Type Manager” on page 225.

➤ correlation. Correlation rule definitions. For details, see “Correlation 
Manager” on page 197.

➤ datamodel. Used to import CI instances into the system. If the CI does not 
exist in the CMDB, an instance of the CI is created. If a CI type already exists 
in the CMDB, the values of the CI from the package resource overwrites the 
values of the CI in the CMDB.

➤ datamodelcreateonly. Used to import CI instances into the system. If the CI 
does not exist in the CMDB, an instance of the CI is created. If a CI type 
already exists in the CMDB, the values of the CI from the package resource 
does not overwrite the values of the CI in the CMDB.

➤ datamodelgenerateids. Used to import CI instances into the system for CITs 
that require the ID to be calculated dynamically upon deployment (such as 
CITs with no key attributes).
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➤ discoveryConfigFiles. Configuration files include properties and parameters 
that are needed to discover components on the system. For details, see 
“Manage Discovery Resources” in Discovery and Dependency Mapping Guide.

➤ discoveryJobs. A Discovery and Dependency Mapping (DDM) job includes 
configuration data, scheduling information, and TQL assignments needed 
to activate discovery of components. For details, see “Run Discovery” in 
Discovery and Dependency Mapping Guide.

➤ discoveryModules. A DDM module includes all the jobs needed to discover a 
specific component in the system. For details, see “Run Discovery” in 
Discovery and Dependency Mapping Guide.

➤ discoveryPatterns. DDM patterns define what scripts need to be run and in 
which order, declare the input and output CI Types and parameters to be 
configurable on the DDM jobs related to them. For details, see “Manage 
Discovery Resources” in Discovery and Dependency Mapping Guide.

➤ discoveryResources. External resources include all external resources that are 
needed in DDM, for example, a Visual Basic file, a credentials file, and so on. 
For details, see “Manage Discovery Resources” in Discovery and Dependency 
Mapping Guide.

➤ discoveryScripts. DDM scripts enable navigating to, and accessing, 
components that must be discovered. For details, see “Manage Discovery 
Resources” in Discovery and Dependency Mapping Guide.

➤ discoveryWizard. Used to define the Discovery Wizard dialog box contents. 
For details, see “Run Discovery” in Discovery and Dependency Mapping Guide.

➤ enrichment. Enrichment rule definitions. For details, see “Enrichment 
Manager” on page 315.

➤ modelnotification. Contains filter definitions for CMDB model 
notifications. The data model notification system gives notification of 
changes that occurred in the CMDB. For example, items in the CMDB that 
have been removed, updated, or added.

➤ report. Report rule definitions, as described in “Topology Report Manager” 
on page 263.

➤ schedulerJobs. Tasks that have been defined to run in the Scheduler. For 
details, see “Scheduler” on page 493.

➤ tql. TQL query definitions. For details, see “Query Manager” on page 301.
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➤ typedef. Predefined Enumeration definitions that relate to attributes of type 
Enumeration, such as severity levels, admin states, and so on. For details, see 
“System Type Manager” on page 228.

➤ users. The definition of a user and the user’s role. For details, see “Security 
Manager User Interface” on page 654.

➤ validlinks. All predefined, valid connections (relationships) between CITs. 

➤ view. View Manager definitions. For details, see “View Manager” on 
page 149.

Using the JMX Console to Perform Package Manager 
Tasks

This section describes the Package Manager tasks you can perform using the 
JMX console.

Note: It is recommended that you use the Package Manager to perform these 
tasks instead of the JMX console. View Package Deployment History cannot 
be performed by the Package Manager.

This section includes the following tasks:

➤ “Deploy a Package” on page 472

➤ “View Package Deployment History” on page 472

➤ “Undeploy a Package” on page 473

➤ “Display Currently Deployed Packages” on page 474

➤ “Export Packages” on page 474
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 1 Deploy a Package
Follow these steps to deploy a package using the JMX console.

 a Launch your Web browser and enter the following address: 
http://<server_name>:8080/jmx-console, where <server_name> is the 
name of the machine on which HP Universal CMDB is installed.

 b Under MAM, click service=MAM Packaging Services to open the JMX 
MBEAN View page. 

 c Locate java.lang.String deployPackages.

 d In the ParamValue box for the parameter customerId, enter the 
<customer id>.

 e In the ParamValue box for the parameter dir, enter the name of the folder 
that contains the package’s zip file. Ensure that you include the full path 
to the folder.

Note: To deploy the package from the factory_packages directory, leave 
this box empty.

 f In the ParamValue box for the parameter packagesNames, enter the 
name of the packages. 

The rules for entering a package name are as follows:

➤ Wildcard characters (*) are not supported.

➤ The package name is case sensitive.

➤ The package name must have a .zip extension.

 g Select True to override DDM job configurations changed in the DDM user 
interface. For details, see the Discovery and Dependency Mapping Guide.

 h Click Invoke to deploy the package.

 2 View Package Deployment History
Each time you deploy packages, a report is created displaying the 
deployment status of those packages. Use the JMX console to view the 
deployment status report.
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 a Launch the Web browser and navigate to: 
http://<server_name>:8080/jmx-console, where <server_name> is the 
name of the machine on which HP Universal CMDB is installed.

 b Under MAM, click service=MAM Packaging Services to open the JMX 
MBEAN View page.

 c Locate java.lang.String displayResourcesDeploymentHistory.

 d In the ParamValue box for the parameter customerId, enter the 
<customer id>.

 e In the ParamValue box for the parameter reportNum, enter the number 
of the report you want to view.

 f Click Invoke to view the deployment status report of the packages.

 3 Undeploy a Package
Follow these steps to undeploy a package using the JMX console.

 a Launch the Web browser and navigate to: 
http://<server_name>:8080/jmx-console, where <server_name> is the 
name of the machine on which HP Universal CMDB is installed.

 b Under MAM, click service=MAM Packaging Services to open the JMX 
MBEAN View page.

 c Locate java.lang.String undeployPackages.

 d In the ParamValue box for the parameter customerId, enter the 
<customer id>.

 e In the ParamValue box for the parameter packagesNames, enter the 
name of the package you want to remove.

The rules for entering a package name are as follows:

➤ Wildcard characters (*) are not supported.

➤ The package name is case sensitive. 

➤ The package name must have a .zip extension.

 f Click Invoke to undeploy the package.
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 4 Display Currently Deployed Packages
Follow these steps to display currently deployed packages using the JMX 
console.

 a Launch the Web browser and navigate to: 
http://<server_name>:8080/jmx-console, where <server_name> is the 
name of the machine on which HP Universal CMDB is installed.

 b Under MAM, click service=MAM Packaging Services to open the JMX 
MBEAN View page.

 c Locate java.lang.String displayDeployedPackages.

 d In the ParamValue box for the parameter customerId, enter the 
<customer id>.

 e In the ParamValue box for the parameter packagesNames, specify the 
names of the packages you want to display.

The rules for entering a package name are as follows:

➤ Wildcard characters (*) are not supported.

➤ The package name is case sensitive.

➤ The package name must have a .zip extension.

 f Click Invoke to display the packages that are currently deployed.

 5 Export Packages
Follow these steps to export resources from the CMDB to the server on 
which HP Universal CMDB is installed using the JMX console.

 a Launch the Web browser and navigate to: 
http://<server_name>:8080/jmx-console, where <server_name> is the 
name of the machine on which HP Universal CMDB is installed.

 b Under MAM, click service=MAM Packaging Services to open the JMX 
MBEAN View page.

 c Locate java.lang.String exportPackages.

 d In the ParamValue box for the parameter customerId, enter the 
<customer id>.
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 e In the ParamValue box for the parameter packagesName, enter the name 
of the package you want to export.

The rules for entering a package name are as follows:

➤ Wildcard characters (*) are not supported.

➤ The package name is case sensitive. 

➤ The package name must have a .zip extension.

 f In the ParamValue box for the parameter outputDir, enter the name of 
the folder on the HP Universal CMDB server to which you want to export 
the package’s zip file. Ensure that you include the full path to the folder.

 g In the ParamValue box for the parameter userOnly, select one of the 
following:

➤ True. Export only the custom packages.

➤ False. Export both custom and factory packages.

 h Click Invoke to export the package.

Package Manager User Interface

This section describes:

 ➤  Choose Resources to Export Dialog Box on page 476

 ➤  Create Custom Package/Edit Package Wizard on page 477

 ➤  Export Package Dialog Box on page 483

 ➤  Filter Dialog Box on page 484

 ➤  Find Dialog Box on page 485

 ➤  Package Manager Window on page 486

 ➤  Undeploy Package Resource Wizard on page 488
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Choose Resources to Export Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Select the resources you want to export to your local 
directory.

To access: Select Export resources in the Export Package 
dialog box.

GUI Element (A-Z) Description

<List of resources > Displays the list of resources contained in the package. 
Select the resources you want to export to your local 
directory.
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Create Custom Package/Edit Package Wizard

Package Properties Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a package using existing resources 
or edit an existing package.

To access: Click the Add  button in the Package 
Manager window to create a new package or select a 
package in the Package Manager window and click the 
Edit  button to edit an existing package.

Included in Tasks “Create a Custom Package” on page 467

Wizard Map The Create Custom Package Wizard contains:

Package Properties Page > Resource Selection Page > 
Selection Summary Page

Description Define the properties of the package.

Wizard Map The Create Custom Package/Edit Package Wizard 
contains:

Package Properties Page > Resource Selection Page > 
Selection Summary Page

GUI Element (A-Z) Description

Package Category A free text box for any notes you want to associate with 
the package.

Package Description A description of the package.

Package Name The name of the package.
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Resource Selection Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to add the required resources to the package. 
Select the required resources from the various resource 
types.

Note: You can make multiple selections from each 
resource type.

Wizard Map The Create Custom Package/Edit Package Wizard 
contains:

Package Properties Page > Resource Selection Page > 
Selection Summary Page

GUI Element (A-Z) Description

Appears in the left pane. Indicates that a resource has 
been added to the package.

Appears in the left pane. Indicates that no resource has 
been added to the package.
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<Resource types in 
the left pane>

Contains the resource types from which you can choose 
the required resources to add to the package.

For details of a list of the available resource types and 
their descriptions, see “Resource Types” on page 481.

Note: A green dot appears on the resource type icon 
when one or more of its resources are selected to be 
included in the package.

GUI Element (A-Z) Description
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<Resources in the 
right pane>

Select the resources you want to add to the package. You 
can select multiple resources.

Notes: 

➤ A green check appears to the right of a Configuration 
Item Types, Relationships, or Calculated Relationships 
when one or more of its children in the resource tree 
are included in the package.

➤ A folder’s check box has a  when only some of its 
resources are included in the package. (This does not 
apply to Configuration Item Types, Relationships, or 
Calculated Relationships.)

➤ A folder’s check box is selected when all its resources 
are included in the package. (This does not apply to 
Configuration Item Types, Relationships, or Calculated 
Relationships.)

Important information:

If you want to add a calculated relationship to the 
package, you can choose to select either the required 
calculated relationship together with one or more of its 
triplets, or the required triplets without selecting the 
calculated relationship itself. 

➤ If you choose to select only specified triplets and not 
the calculated relationship, the triplets are added only 
if you already have an existing calculated relationship 
in the system.

➤ If you select a calculated relationship together with 
one or more of its triplets, then the property 
definitions of the calculated relationship you are 
adding, are included in the package. If you already 
have a calculated relationship in the system, then the 
property definitions of the existing calculated 
relationship are updated with the properties of the 
calculated relationship you are adding to the package. 

For details on calculated relationships and triplets, see 
“Using Calculated Relationships” on page 433 and 
“Triplets Page” on page 251.

GUI Element (A-Z) Description
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Resource Types

This section contains a list of the available resource types and their 
descriptions. For a list of the resources a package can contain, see “Package 
Resources” on page 469.

➤ Calculated Relationships. Contains the calculated relationships and their 
triplets as defined in the CI Type Manager.

➤ Configuration Item Types. The CITs defined in the CI Type Manager. For 
details, see “CI Types Overview” on page 226. 

➤ Correlations. The Correlation rules defined in the Correlation Manager. For 
details, see “Correlation Manager” on page 197.

➤ Discovery Configuration Files. Configuration files include properties and 
parameters that are needed to discover components on the system. For 
details, see “Resource Files” in the Discovery and Dependency Mapping Guide.

➤ Discovery External Resource. Includes resources not used by the DDM Probe 
directly, but rather indirectly by the DDM scripts. It can contain binary 
executable files or DLLs, XML configuration files, or any other essential 
resource needed for the discovery to function properly. For details, see 
“Manage Discovery Resources” in the Discovery and Dependency Mapping 
Guide.

➤ Discovery Jobs. A DDM job includes configuration data, scheduling 
information, and TQL assignments needed to activate discovery of 
components. For details, see “Run Discovery” in the Discovery and 
Dependency Mapping Guide.

➤ Discovery Jython Script. DDM Jython Scripts are Jython scripts used by the 
discovery process to discover and map the various network entities.

➤ Discovery Modules. A DDM module includes all the jobs needed to discover 
a specific component on the system. For details, see “Discovery Modules 
Pane” in the Discovery and Dependency Mapping Guide. 

➤ Discovery Wizard Resource. Used to define the Discovery Wizard dialog box 
contents. For details, see “Basic Mode Window” in the Discovery and 
Dependency Mapping Guide.
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➤ Discovery Patterns. DDM patterns define what scripts need to be run and in 
which order, declare the input and output CI Types and the parameters to be 
configurable on the DDM jobs related to them. For details, see “Manage 
Discovery Resources” in the Discovery and Dependency Mapping Guide.

➤ Enrichments. The Enrichment rules defined in the Enrichment Manager. For 
details, see “Enrichment Manager” on page 315.

➤ Job Scheduler. Tasks that have been defined to run in the Scheduler. For 
details, see “Scheduler” on page 493. 

➤ Relationships. The relationships defined in the CI Type Manager. For details, 
see “CI Type Relationships” on page 228.

➤ Reports. Report rules definitions, as described in “Topology Report 
Manager” on page 263.

➤ State Categories. The states defined in the State Manager. For details, see 
“State Manager” on page 507.

➤ TQLs. The TQL queries defined in the Query Manager. For details, see 
“Query Manager” on page 301.

➤ Type Definitions. Predefined Enumeration definitions that relate to 
attributes of enumeration type, such as severity levels, admin states, and so 
on. For details, see “System Type Manager” on page 228.

➤ Users. The definition of a user and the user’s role. For details, see “Security 
Manager User Interface” on page 654.

➤ Valid Links. All possible predefined valid connections (relationships) 
between the CITs that are defined in the CIT folder.

➤ Views. The views defined in the View Manager. For details, see “View 
Manager” on page 149.
482



Chapter 14 • Package Manager
Selection Summary Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Export Package Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view the resources to be included in the 
package.

Wizard Map The Create Custom Package/Edit Package Wizard 
contains:

Package Properties Page > Resource Selection Page > 
Selection Summary Page

GUI Element (A-Z) Description

<Selected resources> Displays the resources that were selected to be part of the 
package.

Description Exports the selected package’s resources to your local 
directory. 

To access: Click the Export Package to Local Directory 
button  in the Package Manager window.

Important 
Information

You can choose to export some or all the resources in the 
package.

GUI Element (A-Z) Description

Export to directory Select the directory to which you want to export the 
resources. 

Export resources Export only some of the package’s resources to your local 
directory. Opens the Choose Resources to Export dialog 
box.
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Filter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Export whole 
package

Export all the resources in the package to your local 
directory.

File name The name of the package. 

Note: The package name cannot be edited.

Description Enables you to display only specific packages in the 
Package Manage window.

A description of the filter condition you defined appears 
above the table columns in the Package Manager window. 
For example, the following illustration shows that a filter 
condition was created to display a package called 
Network.

To access: Click the Filter  button in the Package 
Manager window.

GUI Element (A-Z) Description

<Click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

<Right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

Condition Click inside the box and select the required operator. For 
details, see “Attribute Operator Definitions” on page 364.

GUI Element (A-Z) Description
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Find Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Display Name Filter the task list according to one of the following:

➤ Package name

➤ Package Category

➤ Package Description

For details, see “Package Manager Window” on page 486.

Value Click inside the box to open the Edit box. Enter the 
required value.

Description Find a package that contains a specified resource. For 
details, see “Resource Types” on page 481.

To access: Click the Find  button in the Package 
Manager window. 

GUI Element (A-Z) Description

Case sensitive Distinguish between uppercase and lowercase characters. 
When you select Case Sensitive, search results find only 
those instances in which the capitalization matches the 
text you typed in the Resource name box.

Resource name Enter a word or phrase contained in the resource for 
which you are looking.

Search Results The search results. Displays the names of the resources 
containing the text entered in the Resource name box.

Topic The subsysytem containing the resource you want the 
package to contain. For details, see “Resource Types” on 
page 481.

GUI Element (A-Z) Description
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Package Manager Window

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Package Manager enables you to:

Create a package out of existing resources or edit an 
existing one to suit your IT management needs.

To access: Select Admin > Settings > Package Manager.

GUI Element (A-Z) Description

Enables you to create a package out of existing resources. 
Opens the Create Custom Package Wizard.

Enables you to edit an existing package. Opens the Edit 
Package Wizard. 

Deletes a package from the Package Manager while the 
resources from the package remain in the system. The 
package that is deleted is removed from the list of 
packages in the Package Manager window.

View the resources included in the selected package. 
Opens the View package resources window.

Deletes the resources from the system and removes them 
from the selected package. Opens the Undeploy Package 
Resource Wizard.

Deploys all of a package’s resources to the CMDB from 
your local directory. Opens the Deploy Packages to Server 
dialog box. Browse to the required package. The name of 
the package is added to the list of the packages in the 
Package Manager.

Note: When deployment is finished and it is not 
successful, a Deploy Package window is displayed 
indicating which resources within the package are not 
successfully deployed.
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Deploys specific resources to the CMDB from your local 
directory. Opens the Deploy Specific Resources dialog 
box. Browse to the required package and select the 
resources you want to deploy.

Note: When deployment is finished and it is not 
successful, a Deploy Package window is displayed 
indicating which resources within the package are not 
successfully deployed.

Exports some or all of the package’s resources to your 
local directory. Opens the Export Package dialog box. 

Finds a package that contains a specified resource. Opens 
the Find dialog box.

Generate a report displaying a list of the packages that are 
deployed in the system.

Notes: 

➤ For information about limitations on the size of 
reports produced in .pdf format, see “Troubleshooting 
and Limitations” in Reference Information. 

➤ For details on how to work with reports, see “Working 
in Reports - Overview” in Reference Information.

Update the contents of the table.

Opens the Filter dialog box. You use the Filter dialog box 
to show only the packages you want displayed in the 
Package Manager window.

Clear the filter definitions you created in the Filter dialog 
box. This is enabled only if filter definitions were created.

Click the Customize Columns button to open the Select 
Columns dialog box and change the display order of the 
columns, hide a column, or display a hidden column.

For details on the Select Columns dialog box, see “Select 
Columns Dialog Box” in Reference Information.

Represents a factory package.

GUI Element (A-Z) Description
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Undeploy Package Resource Wizard

Represents a hidden package.

Represents a custom package.

Category The free text you want to associate with the package, as 
displayed in the Package Properties page of the Create 
Custom Package Wizard.

Description The description of the package, as displayed in the 
Package Properties page of the Create Custom Package 
Wizard.

Package Name The name of the package.

Readme Click to read a description of the package, as well as other 
relevant information.

Description Deletes the resources from the system and removes them 
from the selected package.

To access: Click the Undeploy resources  button in the 
Package Manager window.

Important 
Information

When you undeploy a package, the resources are removed 
from the system, and from the other packages that 
contain that resource. You can restore the resources only 
when a package containing those resources is deployed.

Wizard Map The Undeploy Package Resource Wizard contains:

Remove Resources Page > Selection Summary Page

GUI Element (A-Z) Description
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Remove Resources Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Selection Summary Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Select the resources you want to delete.

Important 
Information

If you delete all the resources from the package, the 
package is automatically deleted and removed from the 
list of packages in the Package Manager window.

Wizard Map The Undeploy Package Resource Wizard contains:

Remove Resources Page > Selection Summary Page

GUI Element (A-Z) Description

<List of resources 
contained in the 
selected package>

Displays the resources contained in the selected package.

Description Enables you to view the resources you selected to be 
deleted.

Important 
Information

When undeployment is finished and it is not successful, 
an Undeploy Package window is displayed indicating 
which resources within the package are not successfully 
undeployed.

Wizard Map The Undeploy Package Resource Wizard contains:

Remove Resources Page > Selection Summary Page

GUI Element (A-Z) Description

<List of deleted 
resources>

Displays the resources that were selected to be deleted 
from the package.
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Troubleshooting and Limitations

This section describes some of the troubleshooting issues that might arise 
when deploying and undeploying packages.

This section includes the following topics:

➤ “Gold Master Reports Cannot be Deployed by Package Manager” on 
page 490

➤ “Datamodel Resources Cannot Be Undeployed” on page 490

➤ “Additional Information on Package Deployment Failure” on page 490

➤ “Package Creation and Deployment in a Non-English Locale” on page 491

Gold Master Reports Cannot be Deployed by Package 
Manager
If you export a package’s resources from Package Manager that includes a 
Gold Master report definition, and then export those resources again to 
another system, the Gold Master report definition is not deployed.

Datamodel Resources Cannot Be Undeployed
For a list of the package resources, see “Package Resources” on page 469.

Additional Information on Package Deployment Failure
If package deployment fails, you can check the following Package Manager 
log files for additional information on why the deployment failure occurred.

➤ The mam.packaging.log file is located in:<HP Universal CMDB root 
directory>\UCMDBServer\j2f\log\mam.

➤ The cmdb.classmodel.log file is located in:<HP Universal CMDB root 
directory>\UCMDBServer\j2f\log\cmdb.

➤ The mam.log file is located in:<HP Universal CMDB root 
directory>\UCMDBServer\j2f\log\mam.

➤ The cmdb.log file is located in:<HP Universal CMDB root 
directory>\UCMDBServer\j2f\log\cmdb.
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Note: If a log\mam or a log\cmdb folder does not exist, look for the log 
files under log\EJBContainer.

Package Creation and Deployment in a Non-English Locale
This section describes the limitations when working in a non-English locale.

➤ You cannot deploy a package if the server locale is different than the client 
locale and the package name contains non-English characters.

➤ You cannot create a package that contains resources (for example, views and 
TQLs) having non-English characters in their names, if the server locale is 
different from the client locale.
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Scheduler

This chapter provides information on Scheduler.

This chapter includes:

Concepts

 ➤  Scheduler Overview on page 493

Tasks

 ➤  Define Tasks that Are Activated on a Periodic Basis on page 494

Reference

 ➤  Cron Expressions on page 495

 ➤  Scheduler User Interface on page 496
Concepts

Scheduler Overview

You can define tasks to run periodically. For example, you can define a 
schedule for taking snapshots of a specific view on a daily basis.

Tasks
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Define Tasks that Are Activated on a Periodic Basis

This task describes how to run jobs on a periodic basis.

This section includes the following tasks:

➤ “Create a Job Definition” on page 494

➤ “Choose an Action” on page 494

➤ “Schedule a Task” on page 494

 1 Create a Job Definition
Define a job definition. Add actions to the job you created and define how 
often they run. The Job Definition dialog box displays the tasks that are 
defined. For details, see “Job Definitions Dialog Box” on page 499.

Example of a Job Definition

The illustration below shows that two Enrichment rules are set to run — one 
at a set interval and one on a daily basis.

 2 Choose an Action
Select the actions that you want the Scheduler to run. For details, see 
“Action Definition Dialog Box” on page 497.

 3 Schedule a Task
Set the schedule for activating a task in the Scheduler pane. For details, see 
“Job Definitions Dialog Box” on page 499.
494



Chapter 15 • Scheduler
Example of a Scheduled Task

The illustration below shows that the Scheduler is set to take a snapshot of 
the View called Host Resources every day at 1:00 AM.

Reference

Cron Expressions

A Cron Expression is a string composed of six or seven fields separated by 
white space. Six of the fields are mandatory, and one is optional.

The following table contains the fields used in a Cron Expression.

Field Name Allowed Values Allowed Special Characters

Seconds 0-59 , - * /

Minutes 0-59 , - * /

Hours 0-23 , - * /

Day of month 1-31 , - * ? / L W C

Month 1-12 or JAN-DEC , - * /
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The following table contains examples of how to use Cron expressions.

For more details about Cron expressions, go to 
http://quartz.sourceforge.net/javadoc/org/quartz/CronTrigger.html.

Scheduler User Interface

This section describes:

 ➤  Action Definition Dialog Box on page 497

 ➤  Filter Dialog Box on page 498

 ➤  Job Definitions Dialog Box on page 499

 ➤  Job Scheduler Window on page 503

Day of week 1-7 or SUN-SAT , - * ? / L C #

Year (optional) empty, 1970-2099 , - * /

Cron Expression Meaning

0 0 12 * * ? The task runs every Wednesday at 12:00 PM.

0 15 10 ? * * The task runs at 10:15 AM every day.

0 15 10 * * ? 2005 The task runs at 10:15 AM every day during the 
year 2005.

0 0/5 14 * * ? The task runs every 5 minutes starting at 2 PM and 
ending at 2:55 PM, every day.

0 15 10 15 * ? The task runs at 10:15 AM on the 15th day of 
every month.

0 15 10 ? * 6L The task runs at 10:15 AM on the last Friday of 
every month.

0 15 10 ? * 6#3 The task run at 10:15 AM on the third Friday of 
every month. 

Field Name Allowed Values Allowed Special Characters
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 ➤  Select Days Dialog Box on page 504

 ➤  Select Hours Dialog Box on page 505

Action Definition Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select a required action in a list of actions 
that can be run by the Scheduler.

To access: Click the Add  button in the Actions pane 
in the Job Definitions dialog box.

Important 
Information

After selecting the required action, click Next to display a 
list of actions. The list of action details depends on which 
action you choose.

For example, if you select Run TQL, a list of the existing 
TQL queries appears. Select the required TQL query 
names. You can make multiple selections.

Included in Tasks “Define Tasks that Are Activated on a Periodic Basis” on 
page 494

GUI Element (A-Z) Description

<Click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

<Right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

Actions For a list of actions that can be run by the Scheduler, see 
“Scheduler Actions” on page 498.
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Scheduler Actions

This section contains a list of actions that can be run by the Scheduler.

➤ Rerun Discovery on View. Runs a discovery on the CIs in a selected view. 
This enables you to configure a general discovery for the entire 
infrastructure on a less frequent basis, such as once a week, while updating 
the CIs in important views more frequently, for example, on a daily basis.

➤ Run an Enrichment rule. Activates the selected Enrichment rule according to 
its set schedule. Click Next to display a list of the available Enrichment rules 
and select the required ones. For details, see “Enrichment Manager” on 
page 315. 

➤ Run a Replication job. You can set a schedule for running a replication job. A 
replication job contains all the information needed to federate data from an 
external data source. You can use this option only if a suitable data source 
has been defined. Click Next to display a list of replication jobs and select 
the required ones. For details, see “Replication Jobs Tab” on page 126.

➤ Run a TQL. Run the selected TQL query according to its set schedule. Click 
Next to display a list of the available TQL queries and select the required 
ones. For details, see “Query Manager” on page 301. 

➤ Run a view. Recalculate the selected view according to its set schedule. Click 
Next to display a list of the available views and select the required ones. For 
details, see “View Manager” on page 149. 

➤ Save a snapshot. Save a snapshot of the selected view according to its set 
schedule. Click Next to display a list of the saved snapshots and select the 
required ones. For details, see “Compare Snapshots” on page 557. 

Filter Dialog Box

Description Displays only specific tasks in the Job Scheduler window.

To access: Click the Filter  button in the Job Scheduler 
window.

Included in Tasks “Define Tasks that Are Activated on a Periodic Basis” on 
page 494
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Job Definitions Dialog Box

GUI Element (A-Z) Description

<click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

<right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

Condition Click inside the box and select the required operator. For 
details, see “Attribute Operator Definitions” on page 364.

Display Name Filters the task list according to one of the following:

➤ Active

➤ Job Definition

➤ Last Run Time

➤ Name

➤ Next Run Time

➤ Schedule

For details, see the Job Scheduler window.

Value Click inside the box and either enter or select the 
required value.

Description Enables you to add actions to the job you created and 
define how often they run.

To access: 

➤ Click the Add  button in the Job Scheduler window.

➤ Click the Add button in the Schedule tab in the 
Replication Jobs window.

Included in Tasks “Choose an Action” on page 494

“Schedule a Task” on page 494
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Actions Pane
 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Job Definition (Optional) A description for this job.

Name The name of the job. 

Description Enables you to add the required actions to the task you 
created.

Included in Tasks “Choose an Action” on page 494

GUI Element (A-Z) Description

Adds an action to the task. Opens the Action Definition 
dialog box.

Edits an existing action.

Deletes an action.

Moves a selected row up.

Moves a selected row down.

Action Definition Displays the action details you selected in the Action 
Definition dialog box for the action added.

Name Displays the name of the action that was added to the 
task.
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Scheduler Pane
 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to set the schedule for activating a task.

Included in Tasks “Schedule a Task” on page 494

Useful Links “Cron Expressions” on page 495

GUI Element (A-Z) Description

Opens a calendar. Select the required date and time.

Automatically set the time zone to the correct one for the 
server.

Click to validate the Cron expression you entered.

Cron Use a Cron expression to schedule a job. For a description 
of the fields used in Cron expressions and examples of 
how to use them, see “Cron Expressions” on page 495.

Cron Expression Enter a Cron expression in the proper format. For a 
description of the fields used in Cron expressions and 
examples of how to use them, see “Cron Expressions” on 
page 495.

Daily Runs a task on a daily basis.

Days of month (Appears when you choose Monthly) Click the button  
to the right of the Days of month box to choose the day 
of the month on which you want to run the action.

Opens the Select Days dialog box.

Days of the week 
(Sunday - Saturday)

(Appears when you choose Weekly). Select the day or 
days on which you want the action to run.
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End by (Does not appear when you select Once) Choose the date 
and time when you want the action to stop running by 
selecting the End by check box and then clicking the 
Open Calendar  button to the right.

Note: This step is optional. If you do not want to specify 
an ending date, leave the End by check box unselected.

Interval Activates the action at a set time interval.

Invocation Hour Choose the time to activate the action. Click the button 
 to the right of the Invocation Hour box to open the 

Select hours dialog box. For details, see the Select Hours 
dialog box.

Note: You can enter the time manually in the Invocation 
hour box once you have chosen a time using the Select 
hours dialog box. You can assign more than one time. 
Each time is separated by a comma.

The manually entered action times are not restricted to 
the hour and half hour only; they can be assigned any 
hour and minute combination. Use the 24:00 format.

For example:

11:15 AM is 11:15

11:15 PM is 23:15

Note: This box is only available when you want to 
schedule a task to run on a daily, weekly, or monthly 
basis.

Invocation Time (Appears when you choose Once) Choose the date and 
time you want the action to begin running by clicking 
the Open Calendar  button to the right.

Monthly Runs a task on a monthly basis. 

Months of the year 
(January - December)

(Appears when you choose Monthly). Select the month or 
months in which you want the action to run.

Once Activates the task only once.

GUI Element (A-Z) Description
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Job Scheduler Window

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Repeat every (Appears only when you select Interval) Type a value for 
the interval between successive runs and then choose the 
required unit of time measurement (seconds, minutes, 
hours, or days).

Start at (Does not appear when you select Once) Choose the date 
and time when you want the action to begin running by 
selecting the Start at check box and then clicking the 
Open Calendar  button to the right.

Note: This step is optional. If you do not want to specify a 
beginning time, leave the Start at check box unselected.

Time Zone Set the required time zone.

Weekly Runs a task on a weekly basis.

Description Enables you to define tasks that are activated on a 
periodic basis. For example, you can define a task that 
generates a Topology report on a daily basis at 3:00 PM.

To access: Click Admin > Settings > Scheduler.

Included in Tasks “Define Tasks that Are Activated on a Periodic Basis” on 
page 494

GUI Element (A-Z) Description

Creates and schedules a task. Opens the Job definitions 
dialog box.

Edits a task. Opens the Job definitions dialog box.

Deletes a task.

GUI Element (A-Z) Description
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Select Days Dialog Box

Opens the Filter dialog box. You use the Filter dialog box 
to show only the scheduled jobs you want displayed in 
the Job Scheduler window.

Clears the filter definitions you created in the Filter dialog 
box.

Changes the display order of the columns, hide a column, 
or displays a hidden column. Opens the Columns dialog 
box. For details, see “Select Columns Dialog Box” in 
Reference Information.

<Click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

<Right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

Active Select the check box to activate the scheduled job.

Job Definition A description of the scheduled job as defined in the 
Definitions box in the Job definitions dialog box.

Last Run Time The last time the job was run.

Name The name of the scheduled job.

Next Run Time The next time the job is scheduled to run.

Schedule How often the job is scheduled to run. For details, see the 
“Scheduler Pane” on page 501.

Description Enables you to choose the day on which to activate the 
action.

To access: Click Monthly in the Job definitions dialog 
box, and then click the  button to the right of the Days 
of month box.

Included in Tasks “Define Tasks that Are Activated on a Periodic Basis” on 
page 494

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Select Hours Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<List of days from 1-
31>

Choose the required days by selecting the required check 
boxes. You can select multiple days.

The selected days appear in the Days of month box. For 
details, see Scheduler pane in the Job Definitions dialog 
box.

Description Enables you to choose the time at which to activate the 
action.

To access: Click Daily, Weekly, or Monthly, and then click 
the button  to the right of the Invocation hour box in 
the Job definitions dialog box.

Included in Tasks “Define Tasks that Are Activated on a Periodic Basis” on 
page 494

GUI Element (A-Z) Description

List of times by the 
hour and half hour

Choose all the required times by selecting the required 
check box. You can select multiple times.

The selected hours appear in the Invocation hour box. For 
details, see “Invocation Hour” on page 502.
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State Manager

This chapter provides information on State Manager.

This chapter includes:

Concepts

 ➤  State Manager Overview on page 507

Tasks

 ➤  Define an Attribute State on page 508

Reference

 ➤  State Manager User Interface on page 508
Concepts

State Manager Overview

A state is based on an Enumeration definition. An Enumeration definition is 
is a severity list, which is designed to be used in defining states.

State Manager contains two default states — Change and Operation. Each 
one is based on its own severity list. States are necessary for retrieving 
Correlation results in Topology View Application. For details, see “Topology 
View Application” on page 523. 

To retrieve Correlation results, you must create a Correlation rule in 
Correlation Manager. A Correlation rule is based on a state that exists in 
State Manager. For details, see “Correlation Manager” on page 197. 
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You can use a default state, or if required, create one based on a severity list 
(Enumeration definition) that is more relevant to your needs. For details on 
creating Enumeration definitions, see “Create/Update List/Enumeration 
Definition Dialog Box” on page 259.

Note: It is not recommended to define states without first consulting HP 
Software Support.

Tasks

Define an Attribute State

Enter a unique name and description for the state. Then select an 
Enumeration definition that can be used to define an attribute type. The 
Type Definition list displays the Enumeration definitions that are defined in 
System Type Manager. For details, see “System Type Manager Dialog Box” on 
page 262.

You can also click the New Enumeration button to create a new 
Enumeration definition. For details, see “State Manager Dialog Box” on 
page 509.

Alternatively, you can create an Enumeration definition in System Type 
Manager. The Enumeration definition you create in System Type Manager 
appears in State Manager.

Reference

State Manager User Interface

This section describes:

 ➤  State Manager Dialog Box on page 509
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State Manager Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a state based on a severity list 
(Enumeration definition).

To access: Admin  > Settings > State Manager. 

Important 
Information

➤ The Change and Operation states are default states 
that cannot be edited.

➤ It is recommended to consult with HP Software 
Support before defining a state.

Included in Tasks “Define an Attribute State” on page 508

Useful Links “Enumeration Definition – Workflow” on page 234

GUI Element (A-Z) Description

Add an attribute state.

Delete an attribute state.

Creates an Enumeration definition. Opens the Create 
Enumeration Definition dialog box.

For details, see “Create/Update List/Enumeration 
Definition Dialog Box” on page 259.

The Enumeration definition you have created appears in 
the System Type Manager dialog box, where you can edit 
it if required (for details, see “System Type Manager” on 
page 228).

Description (Optional) Click in the row and enter a description of the 
state.
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Name Click in the row and enter a unique name for the state.

Type Definition Click in the box to display a list of the Enumeration 
definitions that can be used to define an attribute type. 
Select the required Enumeration definition or create one 
that is more relevant to your needs.

Note: The Type Definition list only displays the 
Enumeration definitions (and not List definitions) that 
are defined in the System Type Manager.

GUI Element (A-Z) Description
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Report Schedule Manager

This chapter provides information on the Report Schedule Manager. 

This chapter includes:

Concepts

 ➤  Report Schedule Manager — Overview on page 511

Reference

 ➤  Report Schedule Manager User Interface on page 512
Concepts

Report Schedule Manager — Overview

A user with Administrator permissions can edit, delete, resume, or pause 
scheduled reports in the Report Schedule Manager. You schedule Favorite 
Filters in the Report Manager to enable specific recipients to automatically 
receive the specified report, through email, at regularly defined intervals. 
For details, see “Create a Schedule” on page 604.

Reference
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512

Report Schedule Manager User Interface

This section describes:

 ➤  Report Schedule Manager Main Page on page 512

Report Schedule Manager Main Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to manage schedules configured on favorite 
filters in the Report Manager.

To access: Select Admin > Settings > Report Schedule 
Manager

Important 
Information

You cannot create a new schedule from the Report 
Schedule Manager main page. For details on creating 
schedules, see “Create a Schedule” on page 604.

Included in Tasks “Create a Schedule” on page 604.

GUI Element (A–Z) Description

Click to open the Edit Schedule for the <Report Name> 
dialog box and edit the selected schedule. For details, see 
“Create New Schedule Dialog Box” on page 613.

Note: This dialog box enables you only to edit an 
existing schedule - you create a new schedule from the 
Report Manager interface. For details, see “Create a 
Schedule” on page 604.

Click to delete the selected schedule. 

Click to resume the selected schedule.

Click to pause the selected schedule.
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513

Click to refresh the Report Schedule Manager page.

Click to reset the width of the columns to the default 
setting. 

Click to select columns to be visible in the table. For 
details, see “Working with Tables” in Reference 
Information.

Generation Time The time (in the indicated time zone) that the schedule is 
to be generated. 

Recipients The individuals configured in the Report Manager to 
receive the report or report item at scheduled intervals. 
For details on configuring Schedules, see “Create New 
Schedule Dialog Box” on page 613.

Recurrence The recurrence pattern for the selected schedule.

Report Name The name of the report for which the schedule is 
configured.

Report Type The type of report for which the schedule is configured.

Status The status of the schedule. Possible values are:

➤ Active

➤ Paused

GUI Element (A–Z) Description
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Recipients Manager

This chapter provides information on Recipients Manager.

This chapter includes:

Concepts

 ➤  Recipients Manager Overview on page 515

Tasks

 ➤  Define an Email Recipient on page 515

Reference

 ➤  Recipients Manager User Interface on page 516
Concepts

Recipients Manager Overview

The Recipients Manager enables you to define the recipients who can 
automatically receive scheduled reports, through email, at regular intervals, 
from Report Manager. For details, see “Report Manager” on page 597.

Tasks

Define an Email Recipient

When you create a new email recipient, you click the Add button in the 
Recipients Manager window and enter the recipients name and email 
address. For details, see “Recipient Dialog Box” on page 516.

Reference
515



Chapter 18 • Recipients Manager
Recipients Manager User Interface

This section describes:

 ➤  Recipient Dialog Box on page 516

 ➤  Recipients Manager Window on page 517

Recipient Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a new email recipient or edit the 
properties of an existing one.

To access:

➤ To create a new email recipient, click the Add button 
in the Recipient Manager window.

Note: You can also acess this dialog box through the 
Reports Manager. For details, see “Report Manager 
Main Page” on page 608.

➤ To edit the properties of an existing recipient, select 
the required recipient in the Recipient Manager 
window and click the  button.

Important 
Information

Multiple emails can be defined using a semicolon (;) 
delimiter, or as separate entries.

Included in Tasks “Define an Email Recipient” on page 515

GUI Element (A-Z) Description

Email Address The email address of the email recipient.

Name The name of the email recipient.
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Recipients Manager Window

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create new email recipients or edit the 
properties of existing email recipients.

To access: Click Admin > Settings > Recipients Manager.

Included in Tasks “Define an Email Recipient” on page 515

Important 
Information

Only the recipients whose email addresses are defined 
here, can automatically receive scheduled reports through 
email from Report Manager.

Useful links “Report Manager” on page 597

GUI Element (A-Z) Description

Click the button beside the recipient whose properties 
you want to modify. The Recipient dialog box opens. 

Delete the selected recipient.

Add Click the Add button to define a new email recipient.

Email Address The email address of the email recipient. 

Name The name of the email recipient.
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Federated CMDB

Information on Federated CMDB has moved to the new Integrations book.

For details, see “Federated CMDB Window” in Integrations.
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Topology View Application

This chapter provides information on the Topology View application.

This chapter includes:

Concepts

 ➤  Topology View Overview on page 524

Tasks

 ➤  Retrieve Correlation Results – Scenario on page 524

 ➤  Take a Snapshot of a View on page 533

 ➤  Print and Save a Topology Map to File on page 534

Reference

 ➤  Topology View Application User Interface on page 534
Concepts
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Topology View Overview

Topology View displays the CIs of the currently selected view in graphical 
format. Topology View includes the same functionality as IT Universe 
Manager, however their context menu options differ. For information on 
the Topology Map, see “Working with Topology Map” on page 689.

The following tasks represent the basic functionality of the Topology View 
application:

➤ Get Correlation results. Topology View enables you to run the Correlation 
rules you defined for that view to simulate how certain defined changes 
impact your system, and to discover the root causes of the changes. For 
more information about Correlation rules, see “Correlation Manager 
Overview” on page 197. You can run the Correlation rule you defined in the 
Correlation Manager. For details, see “Retrieve Correlation Results – 
Scenario” on page 524.

➤ Take a snapshot of a view. HP Universal CMDB enables you to display the 
status of a view in one snapshot by comparison with its status taken at a 
different time. For details on how to take snapshots, see “Take a Snapshot of 
a View” on page 533.

Tasks

Retrieve Correlation Results – Scenario

Correlation Manager enables you to create a Correlation rule that allows you 
to simulate the impact certain infrastructure changes have on your system. 
The results of the Correlation rule are displayed in the Topology View 
application. The Correlation results in this task describes how a change in 
CPU usage affects the Host node to which it is connected.

Note: To retrieve the required Correlation results, you must follow the steps 
in this task.
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This task includes the following steps:

➤ “Create an Enumeration Definition” on page 525

➤ “Define a State” on page 526

➤ “Define a Correlation TQL Query” on page 527

➤ “Define a Correlation Rule” on page 528

➤ “Create a TQL of the Type View in Query Manager” on page 530

➤ “Create a View in View Manager” on page 530

➤ “Get Correlation Results” on page 530

 1 Create an Enumeration Definition
To retrieve Correlation results, you must create a Correlation rule in the 
Correlation Manager. A Correlation rule is based on a state that exists in the 
State Manager (for details, see “State Manager” on page 507). 

Note: This step is optional. You can use the default Enumeration definitions 
that appear in the System Type Manager.

A state is based on an Enumeration definition. Enumerations are designed to 
be used as severity value lists by states. You can either base a state on an 
existing Enumeration definition in the State Manager or, if required, create 
one by clicking the New Enumeration button. For details on creating 
Enumeration definitions, see “Create/Update List/Enumeration Definition 
Dialog Box” on page 259.

Note: Alternatively, you can create an Enumeration definition in the System 
Type Manager. For details, see “System Type Manager” on page 228. The 
Enumeration definition you create appears in the State Manager.
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Example of an Enumeration Definition

Select Admin > Settings > State Manager to open the State Manager. In the 
bottom-right corner, click the New Enumeration button to open the Create 
Enumeration Definition dialog box.

The following Enumeration definition creates a severity list that represents 
CPU usage of 10%, 20%, and 50%.

 2 Define a State
When you create a Correlation Rule, you select the state on which the 
Correlation condition is based. The State Manager contains two default 
states — Change and Operation. Each one is based on its own severity list. 
You can use a default state, or if required, create one based on a severity list 
(Enumeration definition) that is more relevant to your needs.

Note: This step is optional. You can use the default State that appear in the 
State Manager.
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To define a new state, select Admin > Settings > State Manager to open the 
State Manager. For details on defining a new state, see “State Manager Dialog 
Box” on page 509.

Example of a New State Definition

A new state called cpu_usage is defined in the State Manager. Its Type 
Definition is based on the Enumeration definition called cpu_usage defined 
in the previous task.

 3 Define a Correlation TQL Query 
To define a Correlation TQL query, you need to create a Correlation rule and 
then add then add the TQL nodes and relationships that define the query.

To create a Correlation TQL query, select Admin > Modeling > Correlation 
Manager. For details about how to add nodes and relationships to a query, 
see “Add Nodes and Relationships to a TQL Query” on page 348.
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Example of a Correlation TQL Query

In this Correlation TQL query, a CPU and a Host node are linked by a 
Container Link relationship.

 4 Define a Correlation Rule
When you define a Correlation rule, you must specify the required causal 
relationship between the nodes. Define one node as the trigger, or the node 
that represents the changes you want to make to the system, and another 
node as the one that is affected. 

Right-click the node you want to define as the trigger node and select Define 
Affected to open the Affected Nodes dialog box. In the Affected Nodes 
dialog box, select the node you want the trigger node to affect. Then click 
the Add button to open the Correlation Definition dialog box to set 
conditions for defining affected nodes. For details about how to define a 
Correlation rule, see “Correlation Definition Dialog Box” on page 207. 

Example of a Correlation Rule

The Conditions area in the Correlation Definition dialog box defines the 
conditions under which the simulated change in the system is triggered. 
The Affected Severity area defines the severity of the Correlation impact on 
the affected node.
528



Chapter 20 • Topology View Application
The Correlation rule in this example states that when the CPU usage of the 
Host node to which the CPU node is connected does not equal 10%, the 
Host node is automatically assigned the 50% load status, which in this case, 
is the color red according to the severity list.

In the resulting TQL query, an upward arrow appears next to the node 
defined as the trigger node and a downward arrow appears next to the node 
defined as the affected node.
529



Chapter 20 • Topology View Application
 5 Create a TQL of the Type View in Query Manager
The Correlation TQL query created in the Correlation Manager appears in 
Query Manager as the type Correlation.

In Query Manager (select Admin > Modeling > Query Manager), right-click 
the query in the TQLs pane and save it as the type View. For details, see 
“Query Manager Window” on page 306.

 6 Create a View in View Manager
Create a view in View Manager (select Admin > Modeling > View Manager) 
based on the TQL query of the type View you created in Query Manager in 
the previous task. For details, see “New View/View Properties/Save As View 
Wizard” on page 174.

 7 Get Correlation Results
Select Application > Topology View and select the required view in View 
Explorer. To get Correlation results, you need to run the Correlation rule on 
a CI instance in the topology map that is a trigger. Right-click a trigger CI 
and select Run Correlation to open the Run Correlation dialog box. For 
details on how to run a Correlation rule, see “Run Correlation Dialog Box” 
on page 536.

Important: In the State box, you must select the state you used to define the 
Correlation rule in the Correlation Definition dialog box. In the Triggers 
Severity box, you must choose a severity that is other than what you 
selected in the Value Comparison box in the Correlation Definition dialog 
box. For details, see “Correlation Definition Dialog Box” on page 207.
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Example for Getting Correlation Results

A TQL Correlation query is created containing a CPU and Host node 
connected by a Container Link relationship. The CPU node is defined as the 
trigger node and the Host node is defined as the affected node.

The following Correlation rule is defined for the query.

In Topology View, select the required view, right-click a CPU CI, and select 
Run Correlation to open the Run Correlation dialog box. In the State box, 
select cpu_usage, as this was the state on which the Correlation rule was 
based. The trigger severity selected is other than the one assigned to the 
trigger node in the Value Comparison box.
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To see results, click one of the following:

➤ Show in Views. This assigns a status to all the CIs in the view. Only the Host 
CI connected to the CPU CI (whose severity was changed), becomes affected 
and turns red because CPU usage of the Host node no longer equals 10%. 
According to the Correlation rule, the Host node is automatically assigned 
the 50% load status, which in this case, is the color red according to the 
severity list. If the other CIs were not affected, so they remain green (10% 
load according to the Enumeration definition).

The trigger CPU CI turns light olive because 20% load was assigned the color 
light olive in the Enumeration definition.

➤ Show Map. A map appears in a separate window containing only the trigger 
CPU CI and the Host CI it affected. The relationship connecting the two CIs 
contains the name of the Correlation rule defined in the Correlation 
Manager. 
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Note: Optionally, you can create a URL that enables you to embed the map. 
For details, see “Direct Link Parameters — Show Impact Map Page” on 
page 449.

➤ Generate Map. Generates an Impact Analysis report that displays a list of 
CIs that are impacted in the system as a result of the simulated changes. For 
details, see “Run Correlation Dialog Box” on page 536.

Take a Snapshot of a View

You can take a snapshot of a view in Topology View application, save it, and 
then compare snapshots of the same view taken at different times using 
Compare Snapshots in Application > Compliance > Compare Snapshots. For 
details on how to take a snapshot of a view, see “Save Snapshot Dialog Box” 
on page 539. For details on how to view actual differences in the compared 
views, see “Compare Snapshots Window” on page 560.
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Print and Save a Topology Map to File

You can print the content of any topology map and then save it to file. 
Before printing, it is recommended to define your print settings and arrange 
the contents of the topology map according to your requirements. For 
details on how to define print settings, see “Print Setup Dialog Box” on 
page 715. For details on how to preview the content of the topology map 
before printing, see “Print Preview Dialog Box” on page 715. For details on 
how to print the content of a topology map, see “Print Dialog Box” on 
page 714. For details on how to save a topology map to file, see “Run 
Correlation Dialog Box” on page 536.

Reference

Topology View Application User Interface

This section describes:

 ➤  Correlation Rules Window on page 535

 ➤  Run Correlation Dialog Box on page 536

 ➤  Save Snapshot Dialog Box on page 539

 ➤  Topology View Window on page 540
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Correlation Rules Window

The Correlation Rules window includes the following elements (listed 
alphabetically):

Description Opens a window that displays the statuses of the trigger 
CI as well as all statuses of the CIs that are affected by it. 
The relationships in the map represent the Correlation 
rules. The name of the relationship is the name of the 
Correlation rule you defined in the Correlation Manager.

To access: In the Run Correlation Dialog box, click Show 
Map.

Important 
Information

➤ You can only see Correlation results if you defined a 
Correlation rule for that view in Correlation Manager. 
For details, see “Correlation Manager” on page 197.

➤ To view information about specific CIs that are 
triggered or affected by the Correlation rule, 
double-click the relationship connecting the CIs. A 
map is displayed.

Included in Tasks “Retrieve Correlation Results – Scenario” on page 524

GUI Element (A-Z) Description

<Relationship> The relationships represent the Correlation rule you 
defined in the Correlation Manager. For details, see 
“Correlation Definition Dialog Box” on page 207.

<The statuses and 
the colors that 
represent each one>

The statuses that appear and the colors that represent 
each status are the ones that are defined in the severity 
list for that state in the System Type Manager. For details, 
see “Create/Update List/Enumeration Definition Dialog 
Box” on page 259.
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Run Correlation Dialog Box

Description Enables you to run the Correlation rule you defined in 
Correlation Manager for that view.

You can:

➤ Display in a new window all the CIs that are affected 
by the trigger CI. The relationships in the map 
represent the Correlation rules. The name of the 
relationship is the name of the Correlation rule you 
defined in the Correlation Manager. For details, see 
“Show Map” on page 538.

➤ Simulate how the statuses of the affected CIs are 
impacted. For details, see “Show in Views” on 
page 537.

➤ Generate a report that displays a list of CIs that are 
impacted in the system as a result of the simulated 
changes. For details, see “Generate Report” on 
page 537.

To access: Select Application > Topology View. Right-click 
a trigger node in the Topology Map and select Run 
Correlation.

Important 
Information

This dialog only appears if a Correlation rule is defined 
for that view. For details, see “Correlation Manager” on 
page 197.

Included in Tasks “Retrieve Correlation Results – Scenario” on page 524
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The Run Correlation dialog box includes the following elements (listed 
alphabetically):

GUI Element (A-Z) Description

Generate Report Generates an Impact Analysis report, which displays 
information that is divided as follows:

➤ Impacted CIs by CIT. All the impacted CIs (the CIs that 
are impacted in the system as a result of the simulated 
changes), sorted by CIT.

➤ Impacted CIs by Application. All the impacted CIs that 
belong to a specific business service. For details, see 
“Link Nodes to Application CI” on page 154.

➤ Trigger CIs. The CIs that represent the changes you 
want to make to the system.

Notes:

➤ For information about limitations on the size of 
reports produced in .pdf format, see “Troubleshooting 
and Limitations” in Reference Information. (If the 
default values do not suit your needs, and must be 
modified, contact Customer Support.) 

➤ For details on how to work with reports, see “Working 
in Reports - Overview” in Reference Information.

Show in Views Simulates how the statuses of the affected CIs are 
impacted for the selected state. The Topology Map 
displays the statuses of the trigger CIs as well as all 
statuses of the CIs that are affected by it.

The Topology Map also displays the Correlation 
indicators:

➤ A trigger CI is marked by this  indicator.

➤ A CI that is both an affected and a trigger CI is marked 
by this  indicator.

➤ An affected CI is marked by this  indicator.

Note: The statuses that appear here and the colors that 
represent each status are defined in the severity list for 
that state in the System Type Manager. For details, see 
“Create/Update List/Enumeration Definition Dialog Box” 
on page 259.
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Show Map Enables you to select a Correlation rule, and then display 
in a new window, a simulation of all the CIs that are 
affected by the trigger CI for the selected state. If only one 
Correlation rule is defined for this CI, the Correlation 
Rules window is displayed directly. For more details, see 
“Correlation Rules Window” on page 535. 

The relationships in the map represent the Correlation 
rules and the name of the relationship is the name of the 
Correlation rule you defined in the Correlation Manager.

Note: Show Map enables you to view the results of 
multiple triggers.

State Select the required State. For details about States, see 
“State Manager” on page 507.

Trigger’s Severity Select the required severity. 

Note: The severity list was defined for the state in the 
System Type Manager. For details, see “System Type 
Manager” on page 228.

For example, you can create a Correlation rule in the 
Correlation Manager (see the “Correlation Definition 
Dialog Box” on page 207), that defines the severity of the 
trigger node as other than No Change. If you select a 
severity other than No Change, for example, Plan, the 
condition is met and the simulated changes in the system 
are triggered.

GUI Element (A-Z) Description
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Save Snapshot Dialog Box

The Save Snapshot dialog box includes the following elements (listed 
alphabetically):

Description Enables you to take a snapshot of a view and save it.

To access: Go to Application > Topology View and click 
the Save Snapshot button  in View Explorer.

Important 
Information

You can compare snapshots of the same view taken at 
different times using Compare Snapshots in Application 
> Compliance > Compare Snapshots. For details, see 
“Compare Snapshots Window” on page 560.

Included in Tasks “Take a Snapshot of a View” on page 533

GUI Element (A-Z) Description

Description A description of the snapshot (optional).

Note A note about the snapshot (optional).

View Name The name of the view as it appears in View Explorer. This 
field cannot be edited.
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Topology View Window

Description Displays the CIs of the currently selected view in 
graphical format and enables you to run the Correlation 
rule you defined in the Correlation Manager.

To access: Select Application > Topology View.

Important 
Information

The Topology View window contains the following 
panes:

➤ View Explorer (CI Selector). Displays the CIs of a 
selected view. You can select the view from a 
drop–down list. For details, see “View Explorer” on 
page 676.

➤ Topology Map. Displays the CIs of a selected view in 
Map mode or text mode. For details, see “IT Universe 
Manager Window” on page 86.

➤ Advanced Pane. Displays properties and history for the 
selected CI. For details, see “Advanced Pane” on 
page 93.

Note: The Topology View window shares the same 
functionality as the IT Universe Manager topology map. 
The Topology View application includes some additional 
context menu options and toolbar options. For details on 
the IT Universe Manager topology map, see “Topology 
Map” on page 87.

Included in Tasks “Retrieve Correlation Results – Scenario” on page 524

“Take a Snapshot of a View” on page 533

Useful Links “Save Snapshot Dialog Box” on page 539

“Set View Parameters/Set View Element Parameters Dialog 
Box” on page 183
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Context Menu

The Topology View window includes the following elements (listed 
alphabetically) available by right-clicking a CI in the View Explorer pane or 
the Topology Map:

GUI Element (A-Z) Description

<IT Universe 
Manager context 
menu options>

The context menu options from IT Universe Manager are 
also available in the Topology View application. For 
details, see “IT Universe Manager Window” on page 86.

Run Correlation Enables you to run the Correlation rule you defined in 
the Correlation Manager. Displays the Run Correlation 
dialog box. For details, see “Correlation Manager” on 
page 197.

Note: You can only see Correlation results if you defined 
a Correlation rule for that view in Correlation Manager. 

Show Impact Enables you to select a CI, which is defined by a 
Correlation rule as a root cause CI, and to display all the 
CIs that are affected by it, and their statuses, in a separate 
window.

This option appears only after the following has 
occurred:

➤ You defined a Correlation rule for the selected view in 
the Correlation Manager (for details, see “Correlation 
Manager” on page 197).

➤ You clicked Show in Views in the Run Correlation 
dialog box. 

➤ Correlation results appear in the Topology Map.

For example, suppose a Correlation rule is defined for an 
IP CI, which specifies that the rule affects hosts, ports, 
and client-servers that are linked to the IP.

By using the Show Impact option, you can display all CIs 
that are affected by the IP CI.
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Show Root Cause This option enables you to retrieve root cause 
information for CIs that are affected by a chain of 
Correlation rules. The output of Show Root Cause 
displays a logical map that describes a chain of 
trigger/affected CITs that affect the CI.

The root cause CI is displayed in a separate window. If 
only one Correlation rule is defined for this CI, the 
Correlation window is directly displayed.

This option appears only after the following has 
occurred:

➤ You defined a Correlation rule for the selected view in 
the Correlation Manager (for details see, “Correlation 
Manager” on page 197).

➤ You clicked Show in Views in the Run Correlation 
dialog box. 

➤ Correlation results appear in the Topology Map.

A window, as illustrated below, is displayed containing 
the root cause CI and all the other CITs in the Correlation 
rule chain.

Use the Show Root Cause option on the A CI to view, in 
one step, that the source of the failure is the agents CI. 
The CI that the arrow points to is the affected CI.

To view the information about specific CIs that are 
triggered or affected by the Correlation rule, double-click 
the relationship connecting the CIs. A map is displayed.

GUI Element (A-Z) Description
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CI Lifecycle

This chapter provides information on the CI Lifecycle application.

This chapter includes:

Concepts

 ➤  CI Lifecycle Overview on page 544

Tasks

 ➤  Generate CI Lifecycle Data and Filter the Results on page 544

Reference

 ➤  CI Lifecycle User Interface on page 545
Concepts
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CI Lifecycle Overview

The CI Lifecycle application enables you to view a list of CIs and 
relationships that are candidates for deletion by the aging mechanism. 
When the aging mechanism is enabled for a CI or relationship, it becomes 
marked for deletion if it is not accessed for a specified period of time (by 
default, 14 days). The CI or relationship is actually deleted after a fixed 
period of time since it was last accessed (by default, 28 days). You can set the 
time period before a CI becomes a candidate for deletion or before it is 
actually deleted for each CIT in the CIT Manager. For details regarding the 
aging mechanism, see “Removing Out of Date CIs Using the Aging 
Mechanism” on page 61.  

Note: The aging mechanism is disabled by default.

The CI Lifecycle results include the Display Label, CI Type, Last Access Time, 
Actual Delete Time and Updated By information for each CI. For 
relationships, CI Lifecycle also displays the CIs at the two ends of the 
relationship. Once you have generated CI Lifecycle data, you can select the 
columns to be displayed and filter the results by any of the columns. You 
can also select specific CIs or relationships and postpone their deletion or 
mark them as deletion-proof. For details, see “CI Lifecycle Window” on 
page 547.

Tasks

Generate CI Lifecycle Data and Filter the Results

This task describes the steps to follow to generate CI lifecycle data and filter 
the results.

This task includes the following steps:

➤ “Generate CI Lifecycle Data” on page 545

➤ “Filter the CI Lifecycle Results” on page 545
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 1 Generate CI Lifecycle Data
To generate CI Lifecycle results, select either the CI tab or the relationship 
tab. Select the time period in which to search, using the drop-down 
calendars in the From and To fields, and click Generate. If no results are 
generated, try extending the time period further into the future. For details, 
see “CI Lifecycle Window” on page 547.

 2 Filter the CI Lifecycle Results
To filter the CI Lifecycle data, click the Filter button to open the Filter dialog 
box. For each column by which you want to filter, select a condition from 
the drop-down list and fill in the value column, either by entering a value, 
selecting from a drop-down list, or using the calendar. Click OK to apply 
your filter. 

To clear the filter and restore the original results, click the Clear button. For 
details, see “Filter Dialog Box” on page 550.

Reference

CI Lifecycle User Interface

This section describes:

 ➤  CI Lifecycle Report on page 546

 ➤  CI Lifecycle Window on page 547

 ➤  Filter Dialog Box on page 550
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CI Lifecycle Report

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to present filtered CI Lifecycle results in 
report format and print or export them.

To access: Click Report Export from the CI Lifecycle 
window.

Important 
Information

The CI Lifecycle report is generated for the period 
selected in the CI Lifecycle window. From the CI 
Lifecycle report dialog box, you can adjust the period 
and regenerate the results within the dialog box.

For details on working with reports, see Working in 
Reports in Reference Information.

GUI Element (A-Z) Description

Actual Delete Time The date and time when the CI or relationship is deleted.

Configuration Item 
Type

The type of CI or relationship.

End1 The node at one end of the relationship (only relevant for 
relationships).

End2 The node at the second end of the relationship (only 
relevant for relationships).

From Indicates the beginning of the period for the generation 
of the report. Click on the link to open a calendar which 
enables you to change the date and time.

Generate Click Generate to generate the data for the selected 
period.

Label The name of the CI or relationship as it appears in the 
Topology Map.

Last Access Time The last time the CI or relationship was accessed, whether 
it was updated or just discovered by the DDM process.
546



Chapter 21 • CI Lifecycle
CI Lifecycle Window

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

To Indicates the end of the period for the generation of the 
report. Click the link to open a calendar that enables you 
to change the date and time.

View Sets the time period of the report from the beginning 
time. Select a time period from the drop-down list.

Updated By The administrator or process that updated the CI or 
relationship.

Description Enables you to filter CIs and relationships which are 
candidates for deletion.

To access: Select Application > CI Lifecycle.

Included in Tasks “Generate CI Lifecycle Data and Filter the Results” on 
page 544

GUI Element (A-Z) Description

Click Postpone Deletion to delay the deletion of a CI. It 
disappears from the list of candidates for deletion.

Click Mark as Deletion Proof to prevent a CI or 
relationship from being deleted. It disappears from the 
list of candidates for deletion.

Click Delete to delete a selected CI or relationship.

Click Select/Clear All to select or clear all rows of data on 
the current page.

Click Refresh to update the data displayed.

GUI Element (A-Z) Description
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Click Filter to open the Filter dialog box, which enables 
you to customize the filter. For details, see “Filter Dialog 
Box” on page 550.

Click Clear to clear the filter and display the full results.

Click Customize Columns to open the Select Columns 
dialog box, which enables you to change the display 
order of the columns, hide a column, or display a hidden 
column. For details, see “Select Columns Dialog Box” in 
Reference Information.

Click to navigate through the results page by page or to 
jump to the first or last page.

<Right-click a column 
header>

For details, see “Customizing Columns” in Reference 
Information.

Actual Delete Time The date and time when the CI or relationship is deleted.

CIs tab Select to see lifecycle results for CIs.

CI Type The type of the CI or relationship.

Display Label The name of the CI or relationship as it appears in the 
Topology Map.

End1 The node at one end of the relationship (only relevant 
for relationships).

End2 The node at the second end of the relationship (only 
relevant for relationships).

From Use the drop-down calendar to select the beginning date 
and time for the CI Lifecycle report.

Generate Click Generate to generate the data for the selected 
period.

Last Access Time The last time that the CI or relationship was accessed, 
whether it was updated or just discovered by the DDM 
process.

Relationships tab Select to see lifecycle results for relationships.

GUI Element (A-Z) Description
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The following options are available by right-clicking a CI or relationship in 
the results table (listed alphabetically):

Report Export Click Report Export to open the CI Lifecycle Report 
dialog box, which presents the data in the format of a 
report.

Select Click the box in the Select column for a CI to select a CI 
or relationship before performing an operation on it 
(such as Delete or Postpone Deletion).

Set Rows per Page Select the number of rows per page from the drop-down 
list.

To Use the drop-down calendar to select the end date and 
time for the CI Lifecycle report.

Updated By The administrator or process that updated the CI or 
relationship.

Menu Item Description

CI/Relationship 
History

Opens the CI/Relationship History dialog box. For details, 
see “CI/Relationship History Dialog Box” on page 72.

Properties Displays the Properties page for the selected CI. For 
details, see “Configuration Item Properties Dialog Box” 
on page 74.

GUI Element (A-Z) Description
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Filter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to customize the filter.

To access: Click Filter from the CI Lifecycle screen.

Included in Tasks “Generate CI Lifecycle Data and Filter the Results” on 
page 544

GUI Element (A-Z) Description

Condition Click in the Condition column and select one of the 
options from the drop-down list.

Display Name The attribute columns displayed for the CIs or 
relationships.

Value Click in the Value column to set a value for the selected 
attribute. Depending on the attribute selected, you can 
select a value from a drop-down list, select a date and 
time from the calendar, or click the ellipsis button  
to open an editing dialog box where you can enter a 
value.

When the conditions Like or Like ignore case are selected 
in the Condition column, you can use a wildcard (%) 
before and after the string you are searching for.

Note: You must select a condition for a given attribute 
before entering a value.
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Gold Master Report

This chapter provides information on Gold Master reports.

This chapter includes:

Concepts

 ➤  Gold Master Report Overview on page 551

Reference

 ➤  Gold Master Report User Interface on page 551
Concepts

Gold Master Report Overview

A Gold Master report compares the configuration of a Gold Master CI to 
other CIs of the same CI type, or a descendant of the CI type. The report 
contains the results of the Gold Master report definition defined in 
Topology Report Manager. For details, see “Gold Master Report Pane” on 
page 279.

Reference

Gold Master Report User Interface

This section describes:

 ➤  Gold Master Report Page on page 552
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Gold Master Report Page

Left Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Specifies which of the selected CIs are configured 
differently from the Gold Master CI.

To access: Select Applications > Compliance > Gold 
Master.

Important 
Information

➤ Verify that popups are not blocked in your browser.

➤ For details on how to work with reports, see “Working 
in Reports” in Reference Information.

Description Select the required Gold Master report definition you 
want to generate.

GUI Element (A-Z) Description

Definitions tab Displays a hierarchical tree structure of the Gold Master 
reports defined in Topology Report Manager. For details, 
see “Gold Master Report Pane” on page 279.
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Results tab The Gold Master report you select in the Definitions pane 
is automatically selected in the Results pane.

If you have defined a task in the Scheduler that generates 
and saves a Gold Master report on a periodic basis, you 
can produce a Gold Master report that was generated at a 
specific time or a by a specific user. For details on how to 
schedule a task, see “Scheduler” on page 493.

From the:

➤ Report list, select the required Gold Master report.

➤ Date list, select the required time.

➤ User list, select the required user.

Note: For details on how to customize columns and 
divide a table of data or a list of reports into pages, see 
“Working in Reports” in Reference Information.

GUI Element (A-Z) Description
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Right Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Compares the attribute values of the CIs in the Gold 
Master CI subgraph to the attribute values of the CIs in 
the subgraph of the Compared CI in the CMDB.

Note: Only attributes that have been assigned the 
Comparable qualifier in the CIT Manager (for details, see 
“CI Type Manager” on page 225), can be compared.

Each section of the report contains a table comparing the 
attribute values of the Gold Master CIs to the attribute 
values of the Compared CI of the same CIT. 

Note: The Gold Master report only displays a CI attribute 
comparison if the values are different.

If a section is empty, it means that all attribute values of 
the Gold Master CIs and the Compared CIs for that CIT 
are identical. In such a case, the attributes in the next 
layer in the subgraph are compared, and the next one, 
and so on. 

Once the compared CIs in a layer are found to have 
different attributes, the Gold Master report does not 
continue to compare the layers in the subgraph for 
differences.

For a sample of a Gold Master report, see “Sample Gold 
Master Report” on page 555.

Important 
Information

For details on how to work with reports, see “Working in 
Reports” in Reference Information.

GUI Element (A-Z) Description

# in Compared CI The number of CIs for that element type (CIT) the 
Compared CI subgraph contains.

# in Gold Master The number of CIs for that element type (CIT) the Gold 
Master CI subgraph contains.

Attributes The CI attribute.
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Sample Gold Master Report

The sample Gold Master report shows the following:

➤ The Gold Master CI labm1ccm14 is being compared to the Compared CI 
labm1mam13.

➤ Windows attribute values in the Gold Master subgraph are being compared 
with the Windows attribute values in the Compared CI subgraph.

➤ There is one Windows CI in the Gold Master subgraph and one Windows CI 
in the Compared CI subgraph.

Compared CI The display name of the Compared CI.

Element Type The CIT of the CI.

Label The display label of the Gold Master CI.

Report Date The time and date the report was generated.

Value in Compared 
CI

The value of the attribute in the Compared CI.

Value in Gold Master 
CI

The value of the attribute in the Gold Master CI.

GUI Element (A-Z) Description
555



Chapter 22 • Gold Master Report
556



23
Compare Snapshots

This chapter provides information on Compare Snapshots.

This chapter includes:

Concepts

 ➤  Snapshot Comparison Overview on page 557

Tasks

 ➤  Snapshot Comparison on page 558

Reference

 ➤  Compare Snapshots User Interface on page 559
Concepts

Snapshot Comparison Overview

Compare Snapshots displays the status of a view in one snapshot by 
comparison with its status taken at a different time. You can compare a 
current snapshot to a previous snapshot or two snapshots both taken in the 
past. For details, see “Compare Snapshots Window” on page 560.

Tasks
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Snapshot Comparison

This task describes how to take a snapshot of a view, and then compare two 
snapshots of a specific view taken at different times.

This section includes the following tasks:

➤ “Take a Snapshot of a View” on page 558

➤ “Save Snapshots on a Periodic Basis” on page 558

➤ “Compare Snapshots” on page 558

 1 Take a Snapshot of a View
Select Applications > Topology View. In View Explorer, right-click the 
required view and select Save Snapshot to take a snapshot of a view and 
save it. For details, see “Save Snapshot Dialog Box” on page 539.

 2 Save Snapshots on a Periodic Basis
Optionally, you can schedule snapshots to be taken of a certain view at 
specific times by defining a task. For details, see “Job Scheduler Window” on 
page 503.

 3 Compare Snapshots
Compare the snapshots of a view taken at different times. Select Applications > 
Compliance > Compare Snapshots to open the Compare Snapshots dialog box. For 
details on how to compare snapshots taken at different times, see “Compare 
Snapshots Window” on page 560.
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Example of Snapshots of a View Taken at Different Times

In the following example, the Deleted Item icon next to the CI new in the 
right pane, indicates that the CI has been deleted in the newer view.

Reference

Compare Snapshots User Interface

This section describes:

 ➤  Compare Snapshots Window on page 560

 ➤  Find CI by Label Dialog Box on page 565

 ➤  Snapshots of <View> Dialog Box on page 566
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Compare Snapshots Window

Description Enables you to compare two snapshots of a specific view 
taken at different times. This feature enables you to 
visualize the differences between the views by comparing 
the statuses of the view at the times the snapshots were 
taken.

You can compare a current snapshot to a previous 
snapshot or two snapshots both taken in the past.

To access: 

➤ Select Applications > Compliance > Compare 
Snapshots.

or

➤ Click View Snapshot in a Change report if a snapshot 
was taken of that view. For details, see “View 
Snapshot” on page 587. Only views with changes that 
reflect the differences between two snapshots, one 
taken before the From date and another snapshot 
taken before the To date in Change Report (for details, 
see “Change Report” on page 585), appear in the 
report.

Important 
Information

➤ You can also define a schedule that takes snapshots of 
a specific view and saves them on a periodic basis. For 
details, see “Scheduler” on page 493.

➤ Snapshots of views that are marked as Track Changes 
(for details, see “Track Changes” on page 178), are 
created on a daily basis.

Included in Tasks “Snapshot Comparison” on page 558
560



Chapter 23 • Compare Snapshots
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Expand the entire hierarchical tree structure of the CIs 
you selected.

Collapse the hierarchical tree structure of the CIs you 
selected.

Search for a CI within the selected view whose label 
contains the searched text. Opens the Find CI by label 
dialog box.

Find the next occurrence of an item marked as changed.

Find the previous occurrence of an item marked as 
changed.

Show the difference between two configuration files. 
Compare what the configuration file looked like at the 
time each snapshot was taken.

Click Select Snapshots to compare and select a view that 
contains a CI of the CIT configfile. Select a CI of the CIT 
Configuration File. A window opens displaying the 
differences in the configuration files, which are marked 
in blue.

Select a view that contains a CI of the CIT Configuration 
File and click Select Snapshots to compare. Select two 
snapshots and click Compare. Select a CI of the CIT 
Configuration File. 

Note: This button is only enabled if you selected a CI of 
the CIT Configuration File from the tree.

Display the selected CI’s attributes. For details, see 
“Configuration Item Properties Dialog Box” on page 74.

Note: The Properties functionality is sometimes displayed 
in a window and not in a tab.
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The Contains an Updated Item icon indicates that either 
a new child CI was created for a CI or an existing child CI 
was updated or deleted.

For example, the 16.59.56.0 CI in the figure below has a 
Contains an Updated Item icon due to the child CIs that 
were added to it.

The Deleted Item icon indicates that a CI has been 
deleted from the view. For example, the figure below 
shows that the CI 10.168.128.1 has been deleted from the 
view.

GUI Element (A-Z) Description
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The New Item icon indicates that a new CI has been 
added to the view. The example below shows that a Host 
and two IP CIs were added to the 16.59.56.0 Network CI.

The Updated Item icon indicates that the attribute value 
of a CI has changed. For more information, see the 
Example of an Attribute Value of a CI that Has Changed 
on page 564.

<At top of panes> The Compare Snapshots window is divided into two 
panes. Each side displays an hierarchical tree structure of 
all the CIs in the Topology Map for that snapshot version. 
The left side always represents the newer of the two 
versions. When you select a CI on one side, the 
corresponding CI on the other side is automatically 
selected (provided the Synchronize Selection check box is 
selected).

CIT The name of the CIT to which the CI belongs as defined 
in the CI Type Manager, as described in “CI Type 
Manager” on page 225.

Name The name of the CI as defined in the CI’s label.

Properties pane Displays the attributes of the selected CI.

The Properties pane contains the following fields:

➤ Property. Displays the attributes for the selected CI.

➤ Value. Displays the attribute value for the currently 
selected CI.

GUI Element (A-Z) Description
563



Chapter 23 • Compare Snapshots
Example of an Attribute Value of a CI that Has Changed

The Updated Item icon indicates that the attribute value of a CI has 
changed. For example, the figure below shows that the CI 
labn2am09.devlab.ad has the Updated Item icon because it was updated 
with a new Host DNS Name value (see the Property and Value columns in 
the bottom panes underneath the tree structure).

Select Snapshots to 
compare

Select the two snapshots you want to compare. Opens the 
Snapshots of <view> dialog box. 

Select View Name Displays the name of the view whose snapshots you want 
to compare.

Note: Only views for which snapshots have been taken 
are available.

Synchronize 
Selection

Enables you to select a CI on one side and have its 
corresponding CI automatically selected on the other 
side.

The default for the Synchronize Selection check box is 
selected. Clearing this check box allows you to select two 
different CIs from each of the two trees. This allows you 
to compare two different CIs and see their different 
properties.

GUI Element (A-Z) Description
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Find CI by Label Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Search for a CI within the selected view whose label 
contains the searched text. You can specify a whole word 
or part of it. If a match is found, it selects the CI in the 
hierarchical tree structure in the Compare Snapshots 
window.

To access: Click the Find  button in the Compare 
Snapshots window. 

Included in Tasks “Snapshot Comparison” on page 558

GUI Element (A-Z) Description

Backward Do a backward search.

Case Sensitive Distinguish between uppercase and lowercase characters. 
When you select Case Sensitive, search results only find 
those instances in which the capitalization matches the 
text you typed in the Text to find box.

Forward Do a forward search.

Text to find Enter the text of the CI you want to find. You can specify 
a whole word or part of it.
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Snapshots of <View> Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description This dialog box contains a list of all the different 
snapshots taken of the selected view.

To access: Click Select Snapshots to compare in Compare 
Snapshots window.

Important 
Information

This dialog box opens only if you have taken snapshots 
of the view in the “Save Snapshot Dialog Box” on 
page 539. 

Included in Tasks “Snapshot Comparison” on page 558

GUI Element (A-Z) Description

Description The description you wrote for the snapshot in “Save 
Snapshot Dialog Box” on page 539.

Note The note you wrote for the view in “Save Snapshot Dialog 
Box” on page 539.

Owner The name of the user who took the snapshot.

Size The number of CIs that were in the view when the 
snapshot was taken.

Time The time at which the snapshot was saved.
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Compare CIs

This chapter provides information on Compare CIs.

This chapter includes:

Concepts

 ➤  CI Comparison Overview on page 567

Tasks

 ➤  CI Comparison on page 568

Reference

 ➤  Compare CIs User Interface on page 569
Concepts

CI Comparison Overview

Compare CIs enables you to compare the hierarchies of two compound CIs. 
A compound CI is a CI that is linked to another CI by a Container link 
relationship.

You can display the compared CIs and their child CIs that appear in a 
selected view or in the CMDB. 

Change indicators in the Compare CIs window denote:

➤ A CI in one pane does not match any corresponding CI in the other pane.

➤ A CI has a match but one of its children does not have a match.
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You can only see differences in the attributes of the CI whose values have 
been defined as Comparable in the CI Type Manager. For information, see 
“Add/Edit Attribute Dialog Box” on page 237. For example, a comparison 
might show a difference in the operating system or disk capacity. For details 
on how to compare CIs, see “Compare CIs Window” on page 570.

Tasks

CI Comparison

This task explains how to compare the hierarchies of two compound CIs, 
view a CI’s configuration file, and show the difference between two 
configuration files.

This section includes the following tasks:

➤ “Select the Required CIs” on page 568

➤ “View a CI’s Configuration File” on page 569

➤ “Show the Difference Between Two Configuration Files” on page 569

 1 Select the Required CIs
Select the two CIs you want to compare. The hierarchies of the two 
compound CIs are compared in the Compare CIs window. You can choose 
to compare two CIs that appear in a selected view or in the CMDB. For 
details, see “Select CI Dialog Box” on page 573.
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Example of Nonmatching CIs

The following example displays the No Matching CI icon next to the CIs doc 
and doc1 because the CI on one side does not match the corresponding CI 
on the other side. The reason they do not match is the difference in 
document size. The value for Document Size for the doc CI on the left side is 
10 while the Document Size for the doc CI on the right side is 20. 

This example also illustrates that the Document group CI has a Has a Non-
Matching Child icon because they have different child CIs.

 2 View a CI’s Configuration File
Select a CI of the CIT Configuration File and view the configuration file. For 
details, see “Compare CIs Window” on page 570.

 3 Show the Difference Between Two Configuration Files
Select two CIs of the CIT Configuration File and view the difference between 
the two configuration files. For details, see “Compare CIs Window” on 
page 570.

Reference

Compare CIs User Interface

This section describes:

 ➤  Compare CIs Window on page 570

 ➤  Find CI by Label Dialog Box on page 572
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 ➤  Select CI Dialog Box on page 573

Compare CIs Window

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Compare the hierarchies of two compound CIs. A 
compound CI is a CI that is linked to another CI by a 
Container link relationship.

The Compare CIs window is divided into two panes. Each 
side displays a hierarchical tree structure of the CIs you 
selected. When you select a CI on one side, the 
corresponding CI on the other side is automatically 
selected, provided the Synchronize Selection check box is 
selected. 

To access: Select Applications > Compliance > Compare 
CIs.

Important 
Information

You can compare only two CIs of the same CIT or one of 
the CIT’s descendants in the hierarchy.

Included in Tasks “CI Comparison” on page 568

GUI Element (A-Z) Description

Expand the entire hierarchical tree structure of the CIs 
you selected.

Collapse the hierarchical tree structure of the CIs you 
selected.

Search for a CI within the selected view whose label 
contains the searched text. Opens the Find CI by label 
dialog box.

Find the next occurrence of an item marked as changed. 
For information on the change indicators, see “No 
Matching CI” on page 571 and “Has a Non-Matching 
Child” on page 571.
570



Chapter 24 • Compare CIs
Find the previous occurrence of an item marked as 
changed. For information on the change indicators, see 
“No Matching CI” on page 571 and “Has a Non-Matching 
Child” on page 571.

Show the difference between the content of the two 
configuration files. Configuration files use the .xml, .txt 
or .ini extensions.

Select a CI of the CIT Configuration File in both panes 
and click the Show Differences button. A window opens 
displaying the differences in the configuration files, 
which are marked in blue.

View the content of a Configuration File CI. Select a CI of 
the Configuration File CI and click the Open button.

Note: This button is only enabled if you selected a CI of 
the CIT Configuration File from the tree.

Display the selected CI’s properties. For details, see 
“Configuration Item Properties Dialog Box” on page 74.

No Matching CI Indicates that a CI in one pane does not match any 
corresponding CI in the other pane.

Has a Non-
Matching Child

Indicates that the child of the CI does not have a 
matching child in the other pane.

<At top of panes> Displays the CIs you selected in the Select CI dialog box.

<Left and right 
panes>

Displays a tree of the compared CIs and their child CIs 
that appear in the selected view or in the CMDB, 
depending on whether you selected the View or the 
CMDB options.

CIT The CIT (as defined in the CI Type Manager) of the 
selected CI at the top of the pane. For details, on CI Type 
Manager, see “CI Type Manager” on page 225. 

CMDB Display the selected CIs and their child CIs that appear in 
the entire CMDB.

Name The name of the selected CI as defined in the CI’s label.

GUI Element (A-Z) Description
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Find CI by Label Dialog Box

Property Displays the attribute name for the selected CI, which 
was marked as Comparable in the CI Type Manager. For 
details, see “Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard” on 
page 245.

Select Select the two CIs you want to compare. Opens the Select 
CI dialog box. The CI you select from the Select option 
on the left is displayed in the left pane and the CI you 
select from the Select option on the right is displayed in 
the right pane.

Synchronize 
Selection

Enables you to select a CI on one side and have its 
corresponding CI automatically selected on the other 
side.

The default for the Synchronize Selection check box is 
selected. Clearing this check box allows you to select two 
different CIs from each of the two trees. This enables you 
to compare two different CIs and see their different 
properties.

Value Displays the attribute value for the currently selected CI.

View Display the selected CIs and their child CIs that appear in 
a specific view.

Description Search for a CI within the selected view whose label 
contains the searched text. You can specify a whole word 
or part of it. If a match is found, it selects the CI in the 
hierarchical tree structure in the Compare CIs window.

To access: Click the Find  button in the Compare CIs 
window. 

Included in Tasks “CI Comparison” on page 568

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Select CI Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Backward Do a backward search.

Case Sensitive Distinguish between uppercase and lowercase characters. 
When you select Case Sensitive, the search results only 
include those instances in which the capitalization 
matches the text you typed in the Text to find box.

Forward Do a forward search.

Text to find Enter the text of the CI you want to find. You can specify 
a whole word or part of it.

Description Select the required CI for comparison from the 
hierarchical tree or search for a CI for comparison.

To access: Click Select CI in the Compare CIs window.

GUI Element (A-Z) Description

Browse tab Select the required CI for comparison from a hierarchical 
tree. For details, see “Browse Tab” on page 574 below.

Search tab Search for a CI for comparison. For details, see “Search 
Tab” on page 574.
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Browse Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Search Tab

Description Search for and display a view, and browse through the 
view to locate a particular CI.

To access: Click Select CI to open the Select CI dialog box 
and click the Select CI tab.

GUI Element (A-Z) Description

Refresh the list of CIs (if new CIs have been added to a 
view).

Refresh the View list (if views have been newly defined).

Click to open the Select View dialog box. Select the view 
from which you want to select a CI.

Enables you to move to the next or previous result of the 
search for the string entered in the Find box.

<Hierarchical CI tree> Displays the CIs from the selected view. 

Find Enter a CI name or a portion of a CI name in the Find box 
to locate a CI in the CI tree.

View Select the required view from the list.

Description Search for a CI either in the entire CMDB. You can also 
filter the list of CIs that is displayed.

To access: Click Select CI to open the Select CI dialog box 
and click the Search tab.
574



Chapter 24 • Compare CIs
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click this to view the search results. The search results are 
displayed at the bottom of the Search tab.

Filter the list of CIs that is displayed. Click the Select CITs 
to search in button to open the hierarchical tree structure 
of the CI Type model. Select the required CIT.

CI Type Search for a CI of a specified CI type. Click the  button 
to the right to open the hierarchical tree structure of the 
CI Type model. 

Search for Enter the name of the CI (or part of the name) you want 
to find.
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Asset Report

This chapter provides information on Asset reports.

This chapter includes:

Concepts

 ➤  Asset Report Overview on page 577

Reference

 ➤  Asset Report User Interface on page 577
Concepts

Asset Report Overview

Asset reports display a list of all the CIs in a specified view, their attribute 
values, as well as their child CI’s in the CMDB. You use Asset reports to view 
and analyze the contents of the view and focus on the data which is of 
interest to you. For example, an Asset report can display a list of all the 
servers that are part of a specific application contained in the view.

Reference

Asset Report User Interface

This section describes:

 ➤  Asset Report Page on page 578
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Asset Report Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description An Asset report displays a list of all the CIs in a selected 
view and their attribute values, as well as their child CIs 
and their attribute values in the CMDB.

The report contains only the attributes whose Asset Data 
check box was selected in the Attributes tab in the CI 
Type Manager. For more details, see “Add/Edit Attribute 
Dialog Box” on page 237.

You can generate a list from a specific view or from the 
CMDB.

When you generate an Asset report from a specific view, 
the report retains the same hierarchical structure as the 
relevant view in the Topology Map.

To access: Select Applications > Reports > Asset Report.

Important 
Information

➤ Make sure that popups are not blocked in your 
browser.

➤ For details on how to work with reports, see “Working 
in Reports - Overview” in Reference Information.

➤ For information about limitations on the size of 
reports produced in .pdf format, see “Publishing a 
Report” in Reference Information. 

GUI Element (A-Z) Description

CMDB Include information from the selected view as well as 
information about the child CIs and their attribute values 
in the CMDB.

By choosing this option, the report includes CIs that are 
connected by the Container link relationship to the CIs in 
selected view. For example, the report would include the 
CPU and memory of a server that is contained in the 
view.
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Selected view Select the required view.

Views Includes only information about the CIs and their 
attributes contained in this view.

GUI Element (A-Z) Description
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Host Dependency Report

This chapter provides information on Host Dependency reports.

This chapter includes:

Concepts

 ➤  Host Dependency Report Overview on page 581

Reference

 ➤  Host Dependency Report User Interface on page 582
Concepts

Host Dependency Report Overview

Host Dependency reports are based on TQL queries created in the 
Enrichment Manager, which use the relationship of the type Dependency. 
Dependency reports list all the relationships of the type Dependency that 
connect between servers in the selected view, or between the servers in the 
CMDB and the servers within the selected view.

The report includes relationships that:

➤ Exist between databases and clients

➤ Exist between clients and servers

➤ Are created as a result of an MQ connection
Reference
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Host Dependency Report User Interface

This section describes:

 ➤  Host Dependency Report Page on page 582

Host Dependency Report Page

The Host Dependency report page includes the following elements (listed 
alphabetically):

Description Enables you to generate a list of all the relationships of 
the type Dependency that connect between servers in the 
selected view, or between the servers in the CMDB and 
the servers within the selected view.

To access: Select Applications > Reports > Host 
Dependency.

Important 
Information

➤ You can create new TQLs in Enrichment Manager 
using the Dependency relationship to describe the 
connection between hosts. Every new Dependency 
relationship that is used appears in the Dependency 
report.

➤ Make sure that popups are not blocked in your 
browser.

➤ For details on how to work with reports, see “Working 
in Reports” in Reference Information.

GUI Element (A-Z) Description

CMDB Display all the servers in the CMDB that are dependent 
on the servers in the selected view.

Selected view Select the required view.

Views Display all the dependencies between the servers in the 
selected view.
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The following elements are included in the generated Host Dependency 
report (unlabeled GUI elements are shown in angle brackets):

GUI Element (A-Z) Description

Clients The list of clients that are linked to the servers.

Counter The number of clients to which the server is connected.

Host The servers in the selected view.

Relationship The display label of the relationship in the Topology 
Map.
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Change Report

This chapter provides information on Change reports.

This chapter includes:

Concepts

 ➤  Change Report Overview on page 585

Reference

 ➤  Change Report User Interface on page 585
Concepts

Change Report Overview

Change reports enable you to view and analyze the actual changes made to 
a specific CI and its children, or to a specific view. This can help with 
possible troubleshooting issues related to this CI. For example, seeing the 
changes that occurred to a CI might enable you to conclude that these 
changes are the cause of the problem. By the same token, the source of the 
troubleshooting issue could be related to expected changes which failed to 
occur.

Reference

Change Report User Interface

This section describes:

 ➤  Change Report Page on page 586

 ➤  CI History Report Page on page 590
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Change Report Page

Description Displays information about the changes made to the CIs 
whose properties are marked as either Change Monitored or 
Comparable. For details, see “Add/Edit Attribute Dialog Box” 
on page 237.

To access: Select Applications > Reports > Change Report.

The report displays:

➤ Changes that occurred in a selected CI and all its children, 
which are linked, by default, by an impact_link. The CIs 
in the generated report are retrieved according to the 
Infrastructure Settings Manager settings. Go to Admin > 
Settings > Infrastructure Settings Manager > Applications 
> MamWeb. For details, see “Infrastructure Settings 
Manager” on page 459. 

➤ Select Change Report relationship name to retrieve CIs 
that are linked by the selected calculated relationship. 
In the Value box, enter the name of the relationship as 
it appears in the Name box (not the Display Name box) 
in the Details page of the selected relationship in the CI 
Type Manager. For details, see “Details Page” on 
page 246.

➤ Select Change Report relationship qualifier to retrieve 
CIs that are defined with a qualifier. In the Value box, 
enter the name of the required qualifer. For 
information about qualifiers, see “Qualifiers Page” on 
page 249.

➤ Changes that occurred in all CIs in the selected view. In 
addition, this page displays any CIs that were added or 
deleted during the defined time frame according to 
snapshots taken of that view.

➤ CIs with a Container link relationship that were added to 
or removed from a CI.

➤ CIs whose relationship was defined with a 
TRACK_LINK_CHANGES qualifier, that were added to or 
removed from a CI. For information about qualifiers, see 
“Qualifiers Page” on page 249.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reference Information.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

The generated report includes the following elements (listed alphabetically):

GUI Element (A-Z) Description

Select CI/View Select the required CI or view. Opens the Select CI/View 
dialog box. For details, see “Working with View Explorer” 
on page 669.

Use results on CMDB The report displays the changes that occurred to the CI 
and its children in the entire CMDB.

Note: This option is available only if you selected a CI 
and not a view.

Use results on View The report displays the changes that occurred to the CI 
and its children in the selected view.

Note: This option is available only if you selected a CI 
and not a view.

GUI Element (A-Z) Description

View Snapshot Opens the Compare Snapshots dialog box. Enables you to 
perform a snapshot comparison. For details about 
snapshots, see “Compare Snapshots” on page 557.

Note: This option is displayed only if, for the relevant 
view context, a snapshot was saved before the From date 
and another snapshot was saved before the To date, and 
there was a difference between them.

View Statistics The statistics include the following:

➤ The number of CIs that were added to the view

➤ The number of CIs that were removed from the view

➤ The number of relationships that were added to the 
view

➤ The number of relationships that were removed from 
the view
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The Change Report page includes the following areas:

➤ “CI Changes Area” on page 588

➤ “Relationship Changes Area” on page 589

CI Changes Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<View other pages> To view other pages, use the left and right arrows. The 
number between the left and right arrows indicate which 
pages are currently being displayed. For example, 1 - 2 of 3 
means that the 1st and 2nd pages out of 3 are being 
displayed.

Change Date & Time The date and time at which the change occurred.

Changer The name of the user that manually modified the CI’s 
property, or the name of the Discovery and Dependency 
Mapping (DDM) Probe that automatically discovered a 
change made to the CI’s property.

CI Attribute The name of the CI attribute that was changed.

CI Label The label of the path from the root to the CI.

Note: A backslash (\) in a CI name indicates a parent-
child relationship with the format: 
<parent_CI>\<child_CI>. For example, the entry 
16.59.63.0\Windows provides change information for the 
Windows CI which is the child of the 16.59.63.0 CI.

Note: Click to view the change history of a specific CI. 
For details, see “CI History Report Page” on page 590.

CIT Name The name of the CIT (internal).

New Value The new value of the CI attribute.

Old Value The previous value of the CI attribute (before the change).

Type The type of change that occurred.
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Relationship Changes Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets)::

GUI Element (A-Z) Description

Change Date The date and time at which the update was performed.

Changer The name of the user that manually modified the CI’s 
property, or the name of the DDM probe that 
automatically discovered a change made to the CI’s 
property.

Container Label The label of the path from the root to the container CI.

A backslash (\) in a CI name indicates a parent-child 
relationship with the format: <parent_CI>\<child_CI>. 
For example, the entry 16.59.63.0\Windows provides 
change information for the Windows CI which is the child 
of the dancer.hp.com CI.

Note: Double-click an item to view the change history of 
the container CI. For details, see “CI History Report Page” 
on page 590.

Event type You can have one of the following values:

➤ Add related CI. A contained CI was added to the 
container CI using a Container link relationship.

➤ Remove related CI. A contained CI that was linked to a 
container CI using a Container link was removed.

Related label The label of the path from the root to the contained CI.

Note: Double-click an item to view the change history of 
the related CI. For details, see “CI History Report Page” on 
page 590.
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CI History Report Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view all the changes in the properties of a 
specific CI or for CIs linked by a Container link 
relationship, from the time they were created.

To access: 

➤ In the CI Changes area, click one of the links in the CI 
label column for the required CI.

or

➤ In the Relationship Changes area, click one of the links 
in the Container label or Related label columns for the 
required CI.

Important 
Information

Make sure that popups are not blocked in your browser.

GUI Element (A-Z) Description

Change Date The date and time when the update was performed.

Changer The name of the user that manually modified the CI’s 
property, or the name of the DDM probe that 
automatically discovered a change made to the CI’s 
attribute.

CI Attribute The name of the CI attribute that was updated.

New Value The new value of the CI attribute.
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Topology Report

This chapter provides information on Topology reports.

This chapter includes:

Concepts

 ➤  Topology Report Overview on page 591

Tasks

 ➤  Generate and Send a Topology Report at Defined Intervals on page 592

Reference

 ➤  Topology Report User Interface on page 593
Concepts

Topology Report Overview

A Topology report is based on a specific Report TQL query, defined in 
Topology Report Manager. It gives you information about the selected Report 
nodes in the TQL on which it is based.

Topology Report Manager enables you to customize the way the report is 
displayed. The information that appears in the report, including the order in 
which Report nodes are listed and their placement relative to other Report 
nodes, and how the information within each Report node is sorted, is 
defined in Topology Report Manager. For details, see “Topology Report 
Manager” on page 263.

You can generate a report and save it. The results of the generated report are 
saved in the History Results tab in the Topology Report page. For details, see 
“Topology Report Page” on page 594.
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You can optionally schedule the Topology report to run on a periodic basis, 
For details, see “Generate and Send a Topology Report at Defined Intervals” 
on page 592.

Tasks

Generate and Send a Topology Report at Defined 
Intervals

This section explains how to schedule a Topology report to be generated and 
sent to specific recipients, through email, at regularly defined intervals. The 
results of the scheduled reports are displayed in the History Results tab in the 
Topology Report page. 

This task includes the following steps:

➤ “Configure a Favorite Filter” on page 592

➤ “Edit the Favorite Filter in Report Manager” on page 592

➤ “Send a Report at Specific Intervals” on page 593

 1 Configure a Favorite Filter
Configure a Favorite Filter for the required Topology report. The filter is 
uploaded to the Report Manager. For details, see “Save Filter to Favorites 
Dialog Box” in Reference Information.

 2 Edit the Favorite Filter in Report Manager
Edit the Favorite Filter in Report Manager to enable you to create a schedule 
to send the Favorite Filter to specified individuals at specific intervals. 

In Report Manager, select the required Favorite Filter and then click the Edit 
 button to open the Favorite Filters wizard. In the Filter Setting page, 

select the Save to History DB option. For details, see “Favorite Filters 
Wizard” on page 605.
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 3 Send a Report at Specific Intervals
In Report Manager, create a schedule to send the Favorite Filter to specified 
individuals at specific intervals. The results of the scheduled reports are 
saved in the History Results tab in the Topology Report page.

For details on how to create a schedule, see “Create New Schedule Dialog 
Box” on page 613.

For details about the History Results tab, see “Topology Report Page” on 
page 594.

Reference

Topology Report User Interface

This section describes:

 ➤  Set Parameter Values Dialog Box on page 593

 ➤  Topology Report Page on page 594

Set Parameter Values Dialog Box

Description Enables you to edit the predefined parameterized values 
of node conditions defined for the selected Report 
definition in Topology Report Manager.

The dialog box displays all the conditions for the selected 
report definition. For each element, every condition 
appears on a separate line.

To access: Click the Set parameter values link in the 
Topology Report page.

Important 
Information

The Set parameter values link appears only if you defined 
a node condition using parameterized values in the 
Attribute tab in the Node Condition dialog box in 
Topology Report Manager. For details, see “Attribute 
Tab” on page 403.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Topology Report Page

The Topology Report page includes the following panes:

➤ “Left pane” on page 595

➤ “Right pane” on page 596

GUI Element (A-Z) Description

<Attribute> The attribute used for the attribute condition definition.

<Operator> The operator used for the attribute condition definition.

Element name The node for which the condition was defined using 
parameterized values.

Value The required value.

Description A Topology report is based on a specific Report TQL query 
defined in Topology Report Manager. Each report is 
customized to display specific information, as defined in 
the relevant Report TQL. For details, see “Topology 
Report Manager” on page 263.

To access: Select Applications > Reports > Topology 
Report.

Important 
Information

➤ For details on how to work with reports, see “Working 
in Reports” in Reference Information.

➤ For information about limitations on the size of 
reports produced in .pdf format, see “Publishing a 
Report” in Reference Information. 

Included in Tasks “Generate and Send a Topology Report at Defined 
Intervals” on page 592
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Left pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Select the required Topology report definition you want 
to generate.

GUI Element (A-Z) Description

Definitions tab Displays the hierarchical tree structure of the Topology 
reports defined in Topology Report Manager. For details, 
see “Topology Report Manager” on page 263.

History Results tab Displays the history of the Topology reports that were 
generated and saved using the Save to History DB option. 
This enables you to produce a Topology report that was 
generated at a specific time or a by a specific user.

The Topology report you select in the Definitions tab is 
automatically selected in the History Results tab.

From the:

➤ Report list, select the required Topology report.

➤ Date list, select the required time.

➤ User list, select the required user.

Note: For details on how to customize columns and 
divide a table of data or a list of reports into pages, see 
“Working in Reports” in Reference Information.
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Right pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Contains the information that was defined in Topology 
Report Manager to be included in the report. This 
includes which Report nodes should appear in the report, 
the parameter defined for each Report node, and the 
function you want to use to calculate the results on the 
report’s columns. For details, see “Topology Report 
Manager” on page 263.

Important 
Information

For details on how to work with reports, see “Working in 
Reports” in Reference Information.

GUI Element (A-Z) Description

Save to History DB Enables you to generate and save a Topology report. The 
report results are stored in the History Results tab.

Set parameter values (Optional) A link that opens the Set parameters values 
dialog box. Enables you to edit the predefined values of 
node conditions.

Note: This link appears only if you defined a node 
condition using parameterized values in the Attribute tab 
in the Node Condition dialog box in Topology Report 
Manager. For details, see“Attribute Tab” on page 403.

Set view-specific 
report

(Optional) Enables you to generate a report of the 
selected Report TQL query based on a certain view rather 
than the entire CMDB. Select the view on which you 
want to base the report.

Note: Click Clear to run the report based on the entire 
CMDB.
596



597

29
Report Manager

This chapter includes the main concepts, tasks, and reference information 
for the Report Manager.

This chapter includes:

Concepts

 ➤  Report Manager Overview on page 598

 ➤  Favorite Filters on page 598

 ➤  Report Schedules on page 599

Tasks

 ➤  Work With the Report Manager — Workflow on page 600

 ➤  Work With the Report Manager — Scenario on page 601

 ➤  Create a Schedule on page 604

Reference

 ➤  Report Manager User Interface on page 605
Concepts
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Report Manager Overview

The Report Manager is a central location where you can manage selected 
report objects from throughout HP Universal CMDB. The Report Manager 
enables you to create and manage the following:

Favorite Filters

Favorite Filters enable you to save a report filter and reuse it for future 
generating of the report. The filter you create can be used only for the same 
report for which it was created. Filters include the time range, location, 
views, CIs, and resource definitions configured for the report. For details on 
creating a Favorite Filter, see “Favorite Filters Wizard” on page 605.

You can also create a Favorite Filter from the specified report page. For 
details on the user interface for performing this task, see “Save Filter to 
Favorites Dialog Box” on page 81. 

Report or Report 
Object

Description

Favorite Filters Used to regenerate a report with predefined filters. For 
details, see “Favorite Filters” on page 598.

Schedules Schedule a report object to be sent to specified 
individuals at set times. For details, see “Report 
Schedules” on page 599.

Annotations A snapshot of selected reports and highlight important 
areas of the report by drawing shapes, lines, and adding 
text to the snapshot. For details, see “Report Annotation” 
on page 60.

Note: Annotations are created outside the Report 
Manager, in the specific report in which you are working.

Email Send report objects to selected individuals using email. 
For details, see “Email Dialog Box” on page 611.
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Report Schedules

You configure schedules to enable specified recipients to automatically 
receive reports, through email, at regularly defined intervals.

You can schedule Favorite Filters defined in the Report Manager, or reports 
saved from the specific report page.

For details on configuring report schedules, see “Create a Schedule” on 
page 604.

By default, the value that appears in the From field in the email containing 
the scheduled report is UCMDB_Manager@<HP Universal CMDB server 
name>. You can modify the value by selecting Admin > Settings > 
Infrastructure Settings Manager and the Scheduled Reports context in the 
Foundations tab. Modify the value E-mail sender or Scheduled Reports e-
mail sender address (to include an email address in the From field). For 
details on modifying values, see “Infrastructure Settings Manager” on 
page 459.

To correctly view scheduled reports received in Microsoft Outlook 2003, in 
Tools > Options > Security > Zone Settings, select Internet; click Custom 
Level and specify the following settings in the Security Settings dialog box: 

➤ Download signed ActiveX control = Prompt

➤ Run ActiveX controls and plug-ins = Enable

➤ Script ActiveX controls marked safe for scripting = Enable

➤ In the Reset to list, select Medium

Administrators can manage configured report schedules using the Report 
Schedule Manager tab, located at Admin > Settings > Report Schedule 
Manager. For details on managing report schedules using the Report 
Schedule Manager tab, see “Report Schedule Manager” on page 511.

Tasks
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Work With the Report Manager — Workflow

This task describes how to create, manage, and distribute reports using the 
Report Manager.

For a scenario of this task, see “Work With the Report Manager — Scenario” 
on page 601.

This task includes the following steps:

➤ “Create a Favorite Filter” on page 600

➤ “View a Report” on page 600

➤ “Email a Report” on page 600

 1 Create a Favorite Filter
You can create a filter for reports, save it, and apply it to the specified report. 
For details on creating a Favorite Filter, see “Favorite Filters Wizard” on 
page 605.

 2 View a Report
You can view a favorite filter or annotation by selecting the report object in 
the Report Manager table and clicking the View Report button on the Report 
Manager Main Page.

 3 Email a Report
You can send a Favorite Filter to selected users using email. For details, see 
“Email Dialog Box” on page 611.

For details on how to create a schedule for a report object to be sent to 
specified individuals at set times, see “Create a Schedule” on page 604.
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Work With the Report Manager — Scenario

This scenario describes how to create, manage, and distribute  report objects 
using Report Manager. 

For a task of this scenario, see “Work With the Report Manager — 
Workflow” on page 600.

This scenario includes the following steps:

➤ “Creating a Favorite Filter” on page 601

➤ “Emailing a Report” on page 602

➤ “Viewing a Report Saved to the Report Manager” on page 602

 1 Creating a Favorite Filter
John Smith is the CEO for ABC Software Company. He wants to see the data 
output of the Change report for a specific CI for the past month. He clicks 
the New Favorite Filter button. In the Favorite Filters Wizard, he configures 
a Favorite Filter by selecting the report he wants to view, and configures the 
Time Range bar to generate or view the report displaying all the changes 
that occurred for that CI, Resource, View during the defined time range.
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The report generated by the Favorite Filter appears as follows:

 2 Emailing a Report
John wants to send a Change report to an associate to show him the data 
that has been collected. He selects the Change report in the Report Manager 
and clicks the Send Email Now button to choose a recipient from the Email 
dialog box and send the report using email.

 3 Viewing a Report Saved to the Report Manager
One of John’s associates has saved an annotated report to the Report 
Manager, and John wants to view the areas in the report that have been 
highlighted by the annotations. He selects the annotation in the Report 
Manager and clicks the View Report button to view the report’s annotations. 
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The resulting Report Manager page appears as follows: 

The annotated report appears, with annotations indicated by black and pink 
boxes, as follows:
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Create a Schedule

This task describes how to schedule a favorite filter from the Report Manager 
main page.

This task includes the following steps:

➤ “Prerequisites” on page 604

➤ “Create a Schedule” on page 604

➤ “Results” on page 604

 1 Prerequisites
Ensure that you have at least one Favorite Filter in the Report Manager. For 
details on configuring Favorite Filters, see “Work With the Report Manager 
— Workflow” on page 600.

 2 Create a Schedule

 a Click the Create new schedule for selected reports button.

 b Enter the requested information in the Create New Schedule dialog box. 
For details on creating a new schedule in the Create New Schedule Dialog 
Box, see “Create New Schedule Dialog Box” on page 613.

 3 Results
The configured schedule’s status is indicated in the Scheduling column of 
the Report Manager. 

Click the link in the Scheduling column to open the Schedule Management 
dialog box and manage the configured schedules. For details on the 
Schedule Management dialog box, see “Schedule Management Dialog Box” 
on page 614.

Reference
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Report Manager User Interface

This section describes:

 ➤  Favorite Filters Wizard on page 605

 ➤  Report Manager Main Page on page 608

Favorite Filters Wizard

Filter Properties Page

Description Enables you to create a predefined filter with which you 
can regenerate the specified report.

To access: Click the New Favorite Filter button  in 
the Report Manager.

Included in Tasks “Generate Reports” on page 61

Wizard Map The Favorite Filters Wizard contains:

Filter Properties Page > Filter Setting Page > Report 
Preview Page

Description Enables you to choose the report for which you want to 
assign a Favorite Filter, and to configure the name, 
description, and access level of the filter. 

To access: Click the New Favorite Filter button  in 
the Report Manager.

Important 
Information

General information about the wizard is available at 
“Favorite Filters Wizard” on page 605.

Wizard Map Filter Properties Page > Filter Setting Page > Report 
Preview Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Filter Setting Page

The following elements are included:

GUI Element (A–Z) Description

Filter description Optionally, enter a description for the filter. 

Filter name Enter a descriptive name for the filter.

Save filter as Choose the access level for the favorite filter:

➤ Private. The filter is available only to the user who 
configured it, or to an administrator.

➤ Public. The filter is available to any user with 
appropriate permissions. 

Select report Click to select from the list of reports from which you 
can assign a Favorite Filter.

Description Enables you to configure parameters for the filter.

To access: Click the New Favorite Filter button  in 
the Report Manager.

Important 
Information

General information about the wizard is available at 
“Favorite Filters Wizard” on page 605.

Wizard Map Filter Properties Page > Filter Setting Page > Report 
Preview Page

GUI Element (A–Z) Description

<Filters> The active filters displayed on the Filter Setting page 
depend on the report you have chosen. The various filter 
options are described in the documentation for the 
specific report you are viewing. 

Time Range Choose the date and time frame for the filter. For details, 
see “Time Range Bar” on page 82.
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Select CI/View Dialog Box

Set View-specific Report Dialog Box

Save to History DB Option

Selected View Dialog Box

Description Select the required CI or view. Opens the Select CI/View 
dialog box. For details, see “Working with View Explorer” 
in Model Management.

To access: Click the CI/View link.

Important 
Information

The CI/View link is available only in the Change report.

Description Enables you to generate a report of the selected Report 
TQL query based on a specific view rather than the entire 
CMDB.

To access: Select the Favorite Filter of a Topology report 
and click the Edit button . In the Filter Settings page, 
click the Set View-Specific Report link.

Important 
Information

The Set View-specific Report link is available only in 
Topology reports.

Description Enables you to create a schedule to send the Favorite 
Filter to specified individuals at specific intervals.

To access: Select the Favorite Filter of a Topology report 
and click the Edit button . In the Filter Settings page, 
select the Save to History DB option.

Important 
Information

The Set View-specific Report link is available only in 
Topology reports.

Description Select the required view. Opens the Selected View dialog 
box. 

To access: Click the Selected View link.

Important 
Information

The Selected View link is available only in Asset, Host 
Dependency, or Change reports.
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Report Preview Page

Report Manager Main Page

Description Displays a snapshot of the generated report, based on the 
parameters configured for the filter.

To access: Click the New Favorite Filter button  in 
the Report Manager.

Important 
Information

➤ The Report Preview Page only displays the report and 
does not enable any functionality on the report 
snapshot.

➤ General information about the wizard is available at 
“Favorite Filters Wizard” on page 605.

Wizard Map Filter Properties Page > Filter Setting Page > Report 
Preview Page

Description Enables you to manage the contents of the Report 
Manager and perform a variety of actions, including: 

➤ View, edit, and clone existing components. 

➤ Configure Favorite Filters.

➤ Email Favorite Filters.

➤ Create a schedule for selected reports to run.

To access: Select Application > Reports > Report 
Manager.

Important 
Information

You can filter the contents of the Report Manager by 
entering or selecting values in the cells under each 
column heading.

Useful Links “Annotation Tool Window” on page 65
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The following elements are included:

GUI Element (A–Z) Description

Click to view the selected annotated report or Favorite 
Filter. 

Divides a table of data into pages. You move from page to 
page by clicking the relevant button:

➤ To view more items, click the Next page or Last page 
buttons.

➤ To view previous items in the list, click the Previous 
page or First page buttons.

Click to create a filter to be applied to reports. For details, 
see “Favorite Filters Wizard” on page 605.

Click to edit the selected Favorite Filter. 

Note: When selecting a Favorite Filter, clicking this 
button opens the Favorite Filter wizard. 

Click to create a copy of the report or report object. 
When copying a Favorite Filter, you can then edit 
parameters in the wizard of the Favorite Filter.

Note: Any schedules configured for a specific Favorite 
Filter are not cloned when selecting this option. 

Click to delete the report object.

Note: Deleting a Favorite Filter causes all schedules 
configured for the Favorite Filter to also be deleted. 

Click to email the selected report object. For details, see 
“Email Dialog Box” on page 611.

Click to create a schedule to send the  report object to 
specified individuals at specific intervals. For details, see 
“Create New Schedule Dialog Box” on page 613. 

Click to open the Schedule Management dialog box and 
manage schedules configured for the selected  report 
object. For details, see “Schedule Management Dialog 
Box” on page 614.
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Click to delete all schedules from the Favorite Filter.

Click to resume all schedules for the Favorite Filter.

Click to pause all schedules for the Favorite Filter. 

Click to refresh the Report Manager page.

Click to reset the width of the columns to the default 
setting. 

Click to select columns to be visible in the table. For 
details, see “Working with Tables” in Reference 
Information.

Description The description of the report object. The value of this 
field is entered as entered during configuration of the 
report object.  

Details Displays the name of the report (value of the Report 
Name field) with which the Filter is associated.

Name The name of the Favorite Filter or annotated report.

Owner The user who created the report object.

Privilege The privilege level of the report or report object. The 
available values are:

➤ Private. The report or report object is available only to 
the user who configured it, or an administrator.

➤ Public. The report or report object is available to 
administrators or any user with appropriate 
permissions.

GUI Element (A–Z) Description
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Email Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Scheduling Indicates if schedules are configured for the selected 
report or filter, and displays a link to the list of schedules 
(if they exist). 

Click the indicated schedules link to open the Schedules 
Management dialog box and manage schedules for the 
selected item. For details on the user interface, see 
“Schedule Management Dialog Box” on page 614.  

Type The type of report object displayed. 

Description Enables you to send the selected report object using 
email.

To access: Click the Email button  on the Report 
Manager Main Page. 

GUI Element (A-Z) Description

Attachment type Select the type of report attachment to be used. The 
available attachment types are: 

➤ Embedded. The favorite filter or annotated report is 
embedded into the body of the email.

➤ Attached. The favorite filter or annotated report is sent 
as an external attachment with the email. 

➤ Zipped. The favorite filter or annotated report is sent 
as a .zip file attachment. 

Format Select the format of the report. 

GUI Element (A–Z) Description
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Recipients Area

The following elements are included:

Recipients Section of the Email dialog box that enables you to select 
recipients to receive the email. For details, see “Recipients 
Area” on page 612.

Select language Select the language of the report attachment. The server 
from which the schedule is being sent must support the 
selected language for the report to display properly.

GUI Element (A–Z) Description

Click to move recipients to the Selected Recipients pane. 
You must select recipients in the Available Email 
Recipients pane before clicking this button. 

Click to de-select recipients by highlighting and move 
them to the Available Email Recipients pane. You must 
highlight recipients in the Selected Recipients pane 
before clicking this button.

Available Email 
Recipients

The list of configured recipients who are currently not 
selected to receive email on the report object. 

New Recipient Click to add a new recipient to receive email of the report 
object. For details, see “Recipient Dialog Box” on 
page 516.

Selected Recipients The list of configured recipients who are currently 
selected to receive email on the report object.

GUI Element (A-Z) Description
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Create New Schedule Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to schedule a report object to be sent to 
specified individuals at specific intervals. 

To access: 

➤ Click the Create new schedule for selected reports 
button  on the Report Manager main page.

➤ Click the New button  in the Schedules 
Management dialog box, accessible by clicking the 
listed schedules in the Scheduling column.

Note: This dialog box is also accessible by navigating to 
Admin > Settings > Report Schedule Manager, and 
clicking the Edit Selected Schedule  button. For 
details on the Report Schedule Manager, see “Report 
Schedule Manager” on page 511.

Included in Tasks “Create a Schedule” on page 604

Useful Links “Report Schedules” on page 599

GUI Element (A–Z) Description

Range of recurrence Configure the start and end time of the schedule, as 
follows: 

➤ Start. Click to configure the date for the schedule to 
start. 

➤ No end date. Select for the schedule to run 
indefinitely.

➤ End by. Click to configure the date for the schedule to 
end. 

Recipients Configure recipients to receive the report at the 
scheduled time. For details on configuring recipients, see 
“Recipients Area” on page 612.

Recur every day on Select the days of the week on which the report is to run.
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Schedule Management Dialog Box

Recurrence Pattern Enables you to select how often the report object is to be 
sent.

You also select the following configurations:

➤ How often the report is to run. Choose from:

➤ Daily 

➤ Weekly

➤ Monthly

➤ Quarterly

➤ Days of the week the report is to run, if you chose 
Daily or Weekly. 

➤ The first or last day of every month or quarter, if you 
chose Monthly or Quarterly.

➤ The specific day of the month or quarter, if you chose 
Monthly or Quarterly.

Report generation 
time 

Set the time for the report generation to begin, and the 
time zone in which the generation should take place.

Select language Select a language for the schedule to be sent. 

Note: The server from which the schedule is being sent 
must support the selected language for the report to 
display properly.

Time Zone Select a time zone according to whose time the schedule 
is to be sent.

Description Enables you to manage configured schedules. 

To access: 

➤ Click the link in the Scheduling column next to the 
relevant item on the Report Manager Main Page. 

➤ Click the Manage schedules list button  on the 
Report Manager Main Page.

Useful Links “Create New Schedule Dialog Box” on page 613

GUI Element (A–Z) Description
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The following elements are included:

GUI Element (A–Z) Description

Click to create a new schedule for the selected report 
object. For details on creating schedules, see “Create New 
Schedule Dialog Box” on page 613. 

Click to resume the selected schedule according to its 
configured running time.

Click to pause the selected schedule. 

Click to delete the selected schedule. 

Note: Deleting the schedule does not delete the report 
object.

Generation Time The time (in the indicated time zone) that the schedule is 
to be generated. 

Recipients The recipients configured to receive the selected 
schedule.

Recurrence The recurrence pattern for the selected schedule.

Status The current status of the schedule, displayed with an 
icon indicating one of the following statuses:

➤ Active. 

➤ Paused. 

Note: If an error status is indicated, see the scheduler log 
located in: 

<HP Universal CMDB root 
directory>UCMDBServer\j2f\log\EJBContainer\schedul
er\scheduler.log
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30
Overview Reports

This chapter provides information on Overview reports, located in 
Applications > Overview Reports.

This chapter includes:

Concepts

 ➤  Overview Reports Overview on page 617

Reference

 ➤  Overview Reports User Interface on page 618
Concepts

Overview Reports Overview

Overview reports consist of charts and tables that help you track and 
analyze the health of your monitored environment.

Overview reports enable you to view and assess performance data collected 
by HP Universal CMDB and stored in the CMDB. When generating reports, 
you can specify various report settings, such as time range or location, as 
well as drill down to see further information.

Note: You must have Adobe Flash Player version 8.0 or later installed on 
your machine to view Overview reports. For details, see “Viewing Reports 
with Adobe Flash Player” in Reference Information.

Reference
617
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Overview Reports User Interface

This section describes:

 ➤  Changed Applications Report on page 619

 ➤  Changed Views Report on page 621

 ➤  CMDB Utilization Report on page 623

 ➤  Database Breakdown Report on page 624

 ➤  Delete Candidates Overview Report on page 626

 ➤  Generic Breakdown Report on page 628

 ➤  Host OS Breakdown Report on page 631

 ➤  Major Application Type Breakdown Report on page 632

 ➤  Network Device Breakdown Report on page 634

 ➤  Number of Changes Report on page 635
618
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Changed Applications Report

Description This report displays a bar graph showing the number of 
detected changes in applications within a defined period.

Each bar represents a different application type. The 
colors in each bar represent the different types of changes 
that occurred in the application. Each color in the legend 
at the right of the bar graph represents a different type of 
change. The CI type of each application is displayed 
under the bar.

You can display the number of each type of change that 
occurred by moving the cursor over the related color. The 
tooltip that appears displays the relevant number of 
changes that occurred.

Click the relevant color in the bar to drill down to see a 
Show CI Instances report displaying the application 
instances that represent the changes.

To access: Select Applications > Overview Reports > 
Changed Applications.
619
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Important 
Information

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details,see “Viewing Reports with Adobe Flash 
Player” in Reference Information.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reference 
Information.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reference Information.
620
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Changed Views Report

Description This report displays a bar graph showing the number of 
changes that occurred in a specific view within a defined 
period.

Note: Only views with changes that reflect the differences 
between two snapshots, one taken before the From date 
and another snapshot taken before the To date in Change 
Report appear in the report.

Each bar represents a different view. The bar graph 
displays up to ten views with the largest number of 
changes. The view name is displayed under the bar. The 
legend at the right side of the bar graph shows which 
color represents the type of change that occurred. You 
can display the number of each type of change by 
moving the cursor over the relevant color. The tooltip 
that appears displays the name of the view and the 
number of changes that occurred.

To access: Select Applications > Overview Reports > 
Changed Views.
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Important 
Information

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details,see “Viewing Reports with Adobe Flash 
Player” in Reference Information.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reference 
Information.

Useful Links ➤ For details on how to work with reports, see “Working 
in Reports” in Reference Information.

➤ For details on Change reports, see “Change Report” on 
page 585.
622



Chapter 30 • Overview Reports
CMDB Utilization Report

Description This report displays general CMDB statistics.

For example, the statistics can contain the number of 
Correlation rules created, how many CIs there are in the 
CMDB, or how many snapshots have been taken.

To access: Select Applications > Overview Reports > 
CMDB Utilization.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reference Information.
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Database Breakdown Report

Description This report displays a pie chart showing the breakdown of 
database types and versions. You can view all databases 
deployed in the system or databases at a certain location.

To view the available databases at a specific location, 
select the required country, state, and city in which the 
hosts that the databases are connected to are located.

To verify the database types, use the legend below the pie 
chart.

Click a segment to view a specific database type sorted by 
version.

You can display the number of each database version by 
moving the cursor over the related color. The tooltip that 
appears displays the relevant number.

Click a pie slice to drill down to see a Show CI Instances 
report for each database version.

To access: Select Applications > Overview Reports > 
Database Breakdown.
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Important 
Information

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details,see “Viewing Reports with Adobe Flash 
Player” in Reference Information.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” on page 84 in 
Reference Information.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reference Information.
625
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Delete Candidates Overview Report

Description This report displays a bar graph showing the CITs and 
relationships that were deleted within a defined period, 
and the ones that are about to be deleted.

Each bar represents the CIT of a CI or a relationship. The 
legend at the right side of the bar graph shows which 
color represents the CIs and relationships that were 
deleted and which color represents those that are about 
to be deleted. The CI type of each CI or relationship is 
displayed under the bar.

You can display the number of CIs and relationships that 
were deleted and the ones that are about to be deleted by 
moving the cursor over the related color in the bar. The 
tooltip that appears displays the relevant number.

Click a bar to drill down to see a Show CI Instances report 
displaying the CITs and relationships that were deleted.

To access: Select Applications > Overview Reports > 
Delete Candidates Overview.
626
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Important 
Information

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details,see “Viewing Reports with Adobe Flash 
Player” in Reference Information.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reference 
Information.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reference Information.
627
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Generic Breakdown Report
628
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Description This report displays a pie chart showing the breakdown of 
CI types by:

➤ The CITs grouped under the selected CI type in the CI 
type tree

➤ A CI type attribute

For details, see “CI Type Manager” on page 225.

To view the breakdown by CI types:
1  Select the required CI type in the Choose Initial CI Type 

box.

2  Select CI Type in the Break Down by box.

To view the breakdown by CI type attributes:
1  Select the required CI type in the Choose Initial CI Type 

box.

2  Select the required CI type attribute in the Break Down 
by box.

Notes: 

➤ The Break down by box that is marked in blue is the 
current breakdown of the report.

➤ The current drilldown selection is marked below the 
breakdown’s filter.

You can display the number of each CI type or attribute 
by moving the cursor over the related color. The tooltip 
that appears displays the relevant number. To verify the 
CI types and attributes, use the legend below the pie 
chart.

Click a pie segment to drill down to see a Show CI 
Instances report. 

Note: In the Show CI Instances report, click the link in 
the Display Label column to see the related CIs in a 
topology map.

You can generate a report that has up to four different 
levels. If the pie chart has more than one level, use the 
links of the breadcrumbs at the top of the report to 
navigate through the various levels.

To access: Select Applications > Overview Reports > 
Generic Breakdown.
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Important 
Information

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details,see “Viewing Reports with Adobe Flash 
Player” in Reference Information.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” on page 84 in 
Reference Information.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reference Information.
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Host OS Breakdown Report

Description This report displays a breakdown of operating systems. 
You can view all deployed operating systems or you can 
view data for operating systems at a certain location or 
running on a certain subnet.

You can display the number of operating systems of each 
type by moving the cursor over the related color. The 
tooltip that appears displays the relevant number.

Click a pie slice to drill down to see a Show CI Instances 
report for each operating system.

To access: Select Applications > Overview Reports > Host 
OS Breakdown.

Important 
Information

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details,see “Viewing Reports with Adobe Flash 
Player” in Reference Information.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reference 
Information..

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reference Information.
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Major Application Type Breakdown Report

Description This report displays a breakdown of major applications 
and their versions. Major applications are CITs that have 
been assigned the MAJOR_APP class qualifier. For details, 
see “Qualifiers Page” on page 249.

You can view data for all applications deployed in the 
system, or only those at a specific location. Choose the 
country, state, and city for which you want to view 
application breakdown data, or select All to show the 
entire application breakdown.

Use the legend below the pie chart to verify an 
application and the cersions. 

Click a segment to view a specific application sorted by 
version.

Click a pie segment to drill down to see a Show CI 
Instances report for each application version.

To access: Select Applications > Overview Reports > 
Application Breakdown.
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Important 
Information

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details,see “Viewing Reports with Adobe Flash 
Player” in Reference Information.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reference 
Information.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reference Information.
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Network Device Breakdown Report

Description Displays a breakdown of network devices. Only the 
network devices that meet the following conditions 
appear in the report:

➤ The CIT of the network device has been assigned the 
qualifier NETWORK_DEVICES. For details, see 
“Qualifiers Page” on page 249.

➤ The network device is connected to an IP CI.

➤ The network device is defined with the following 
attribute condition: Host is complete = True. For 
details, see “Attribute Tab” on page 403.

You can view all network devices deployed in the system 
or at a certain location. Choose the country, state, and 
city for which you want to view network device 
breakdown data, or select All to show the entire network 
device breakdown.

Each color in the pie chart represents a different network 
device. The legend underneath shows which network 
device each color represents. You can display the name 
and number of each network device by moving the cursor 
over the related color. The tooltip that appears displays 
the relevant information.

Click a segment to view a specific network device sorted 
by manufacturer.

Click a segment to generate a Show CI Instances report, 
displaying the details of the CI instances of that network 
device for that manufacturer. 

To access: Select Applications > Overview Reports > 
Network Device Breakdown.
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Number of Changes Report

Important 
Information

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details,see “Viewing Reports with Adobe Flash 
Player” in Reference Information.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” on page 84 in 
Reference Information.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reference Information.

Description This report displays a bar graph showing the number of 
detected changes in a CIT within a defined period.

Click the bar to view the breakdown of the types of 
changes that occurred for the CIT and its child CITs. 

To access: Select Applications > Overview Reports > 
Number of Changes.
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Sample Change Type Breakdown Report

This example displays the breakdown of the types of changes that occurred 
for a CIT and its children.

Each bar represents a different CI type. The CI type is displayed under the 
bar. Each color in the legend at the right of the bar graph represents a 
different type of change. You can display the number of each type of change 
by moving the cursor over the related color. The tooltip that appears 
displays the relevant number of changes that occurred.

Important 
Information

➤ You must have Adobe Flash Player version 8.0 or later 
installed on your machine to view Overview reports. 
For details,see “Viewing Reports with Adobe Flash 
Player” in Reference Information.

➤ For information about limitations on formatting 
reports, see “Formatting a Report” in Reference 
Information.

Useful Links For details on how to work with reports, see “Working in 
Reports” in Reference Information.
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Users and Roles

This chapter provides information on Users and Roles.

This chapter includes:

Concepts

 ➤  Users and Roles Overview on page 639

Tasks

 ➤  Set Up Users on page 640

Reference

 ➤  Users and Roles User Interface on page 641

Troubleshooting and Limitations on page 648
Concepts

Users and Roles Overview

When you create a user or role, you define which actions the user or role can 
perform. Roles enable you to assign permissions to users according to their 
responsibilities in the organization. For example, you could create a role 
that enables its users to create TQL queries, or you could create a role that 
enables its users to create views in View Manager but not to edit existing 
TQL queries.

You can assign administrator or guest access rights to these users or roles, 
and if necessary, specify additional permissions in the Security Manager, for 
example, which views a user can display. For details, see “Security Manager” 
on page 653.
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Note: Users and Roles is available only to those logged in with admin or 
administrator access rights.

Tasks

Set Up Users

Use the following procedures to set up users in your system:

 1 Define Roles
A role is a group of users to whom you assign the same access rights. For 
details, see “Users and Roles Overview” on page 639 and “Roles Tab” on 
page 645.

 2 Assign Access Rights to the Roles
You assign permissions for roles to access HP Universal CMDB. For details, 
see “Set Up Security” on page 654 and “Security Manager Window” on 
page 656.

Note: From a best practices point of view, it is preferable to assign access 
rights to roles only, and to associate users with a role that has the 
appropriate access rights. 

For details on assigning access rights to Web service users, see “Roles Tab” on 
page 645.

Example – Create a Role Hierarchy

One team maintains the Oracle databases in your organization and another 
maintains the Microsoft SQL Server databases. The team leader needs to be 
familiar with both databases. You can create a role hierarchy:
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 a Create two roles, dba_oracle and dba_mssql, and give the first role access 
rights to the Oracle view and the second role access rights to the SQL 
Server view. For details, see “Security Manager Window” on page 656 and 
“View Manager Window” on page 184.

 b Create another role, dba, and give it rights to both the Oracle and SQL 
Server views.

 3 Define Users
For details on defining a user, see “Users Tab” on page 646. When defining 
users, you associate a user with one or more roles. For details, see “Users and 
Roles Overview” on page 639.

 4 Define a Profile for a User
You can set preferences, such as time zone and locale, for a specific user. For 
details, see “User Profile” on page 649.

Reference

Users and Roles User Interface

This section describes:

 ➤  Add New User Wizard on page 641

 ➤  New/Edit Role Dialog Box on page 644

 ➤  Roles Tab on page 645

 ➤  Users Tab on page 646

Add New User Wizard

Description Enables you to create a user.

To access: Admin > Settings > Users and Roles > Users tab. 
Click the Add New User  button.

Important 
Information

It is recommended to define roles prior to defining new 
users. For details, see “Roles Tab” on page 645.
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User Name and Password Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

User Details Page

Included in Tasks “Define Users” on page 641

Wizard Map The Add New User wizard contains:

User Name and Password Page > User Details Page > Role 
List Page

Description Enables you to assign a name and password for the user.

Included in Tasks “Define Users” on page 641

Wizard Map The Add New User Wizard contains:

User Name and Password Page > User Details Page > 
Role List Page

GUI Element (A-Z) Description

Confirm Password Type in the password you entered in the Password box.

Old Password Type in your old password.

Note: This box appears only when you edit an existing 
user.

Password Type in a password.

User Name Type a unique user name.

Description Enables you to add the details of the user.

Included in Tasks “Define Users” on page 641

Wizard Map The Add New User Wizard contains:

User Name and Password Page > User Details Page > Role 
List Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Role List Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Update recipient Enables you to add the name and email address of the 
selected user to the Recipients Manager, or update the 
existing email address of a recipient currenty listed in the 
Recipients Manager. For details, see “Recipients Manager” 
on page 515.

Description  Associate a user with one or more roles.

Included in Tasks “Define Users” on page 641

Important 
Information

If you do not select a role, you must assign permissions in 
the Security Manager to enable access rights for the user. 
For details, see “Security Manager Window” on page 656.

Useful Links “Roles Tab” on page 645

Wizard Map The Add New User Wizard contains:

User Name and Password Page > User Details Page > Role 
List Page

GUI Element (A-Z) Description

<List of roles> Contains the list of default and custom roles. For details, 
see “Security Manager Window” on page 656.
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New/Edit Role Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables administrators to create and manage roles, and 
assign permissions to each role to perform specific actions. 
For example, a role named dba could have permissions to 
view all database views and to create new views.

To access: Click the New Role  or Edit button in the Roles 
tab.

Included in Tasks “Set Up Users” on page 640

GUI Element (A-Z) Description

<Roles> Contains the list of roles that appear in the Role list in the 
Roles tab.

Select the roles whose permissions you want to assign to the 
new role.

Note: If you do not select a role from the Role List, you must 
assign permissions in the Security Manager, to enable access 
rights for the role. For details, see “Security Manager 
Window” on page 656.

Description Enter a description of the role you are defining.

Name Enter a unique name for the role.
644



Chapter 31 • Users and Roles
Roles Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create, edit, and delete roles.

For example, you can create a role that enables its users to 
create TQL queries, or you can create a role that enables its 
users to create views in the View Manager but not to edit 
existing TQL queries.

To access: Admin > Settings > Users and Roles > Roles tab

Included in Tasks “Set Up Users” on page 640

GUI Element (A-Z) Description

Click to add a new role. Opens the New Role dialog box.

Click to remove a selected role. You can make multiple 
selections.

Save the changes you have made.
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Users Tab

Click to edit an existing role. Opens the Edit Role dialog box.

<List of roles> Contains the list of default and custom roles.

The default roles are:

➤ Admin. Users with this role have unlimited access to all 
functions.

➤ Guests. Users with this role have permissions to display 
views in the Topology View.

➤ Web service roles. Users who are working with the 
HP Universal CMDB API or the Discovery and 
Dependency Mapping API to write data to the UCMDB 
must be given permissions to the UCMDB. 

The following roles enable the API writer to work with the 
CMDB:

➤ CmdbOpenApiClassModel. A user with this role can 
perform operations on CITs.

➤ CmdbOpenApiImpact.A user with this role can 
perform impact operations on the CMDB.

➤ CmdbOpenApiQuery. A user with this role can send 
queries to the CMDB and receive replies.

➤ CmdbOpenApiUpdate. A user with this role can update 
the CMDB with changes.

For details on writing APIs, see “The HP Universal CMDB 
Web Service API” in Solutions and Integrations.

Description Enables you to define a user or edit an existing one.

To access: Admin > Settings > Users and Roles > Users tab

Useful Links ➤ For details on the complete procedure for creating users 
and assigning roles and access permissions, see “Set Up 
Users” on page 640.

➤ For details on the Roles tab, see, “Roles Tab” on page 645.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Enables you to create a user. Opens the Add New User 
wizard.

Select a user and click to remove the user name. You can 
make multiple selections.

Save the changes you have made.

Refresh to update the data content that may have been 
modified by other users.

Enables you to add the name and email address of the 
selected user to the Recipients Manager. 

You can make multiple selections. The button updates 
several recipients at one time. For details, see “Recipients 
Manager” on page 515.

<List of users> Contains the list of default and custom users.

➤ . Represents users that have Administrator access 
rights.

➤ . Represents users that do not have Administrator 
access rights.

The default users are:

➤ Administrator. Users and roles with Administrator access 
rights have unrestricted access to all functions. 
Administrators can edit the access rights of the default 
users and roles.

➤ admin. Users and roles with admin access rights have the 
same access rights as Administrators.

➤ guest. Users and roles with guest access rights have 
permissions to display views in the Topology View.

Details tab Edit the user details as required. For details, see “User Details 
Page” on page 642.

Full Name The first and last name of the user as defined in the Details 
tab. For details, see “User Details Page” on page 642.
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Troubleshooting and Limitations

You cannot create a new user if the name of the new user contains more 
than 16 Japanese characters. For details, see “Users Tab” on page 646.

Roles tab Associate a user with different roles. For details, see “Role 
List Page” on page 643.

Profile tab Edit the preferences, such as time zone and locale, for a 
specific user. For details, see “User Profile” on page 649.

User Name The name of the user.

GUI Element (A-Z) Description
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User Profile

This chapter provides information on User Profile.

This chapter includes:

Concepts

 ➤  User Profile Overview on page 649

Tasks

 ➤  Define User Preferences on page 650

Concepts

 ➤  User Profile User Interface on page 650
Concepts

User Profile Overview

You can configure the preferences of the currently logged in user, such as the 
time zone, or the editor to use when editing configuration files. For details, 
see “User Profile Dialog Box” on page 650.

Note: Administrators can configure profiles for all users using the Users page 
in Users and Roles. For details, see the “Users Tab” on page 646.

Tasks
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Define User Preferences

Configure preferences for the currently logged in user. For details, see “User 
Profile Dialog Box” on page 650.

Concepts

User Profile User Interface

This section describes:

 ➤  User Profile Dialog Box on page 650

User Profile Dialog Box

Description Enables you to set preferences for the currently logged in 
user.

To access: 

➤ For admin users: Select a user and click the Profile button 
in the Users page in Users and Roles. For details, see 
“Users Tab” on page 646.

➤ For non-admin users: Admin > Settings > User Profile.

Important 
Information

Non-admin users can change their own password here.

Included in Tasks “Define User Preferences” on page 650
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to browse to the executable file of the file editor you 
want to use when editing configuration files.

Change Password Click to open the Change Password dialog box. Enter the old 
and new passwords and click OK.

Label 
Transparency

➤ Yes. If you drag one CI on top of another CI so that the 
text of one label overlaps the text of the other label, the 
text of both labels remains visible.

➤ No. The default. If you drag one CI on top of another CI 
so that the text of one label overlaps the text of the other 
label, the text of only one of the labels remains visible.

Max number of 
characters in a line

Enter the maximum size (in characters) of item labels. In the 
following example, a maximum number of 15 characters is 
defined: 

Max number of 
lines

Enter the maximum number of lines for an item label. 
When the label is longer than the number of allocated 
characters, text flows to the next line. In the following 
example, a maximum number of 10 characters and three 
lines is defined: 

Time zone Select the appropriate time zone, according to the user's 
location.  
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Security Manager

This chapter provides information on Security Manager.

This chapter includes:

Concepts

 ➤  Security Manager Overview on page 653

Tasks

 ➤  Set Up Security on page 654

 ➤  Assign Access Rights on page 654

Reference

 ➤  Security Manager User Interface on page 654
Concepts

Security Manager Overview

You assign role access rights to TQL queries, views, domain instances, 
configuration item types, and customize options. Once the roles are 
assigned access rights, you create users and associate them with a role or 
roles, thus assigning the access rights to the users.

You must also assign access rights to the appropriate manager (Correlation 
Manager, CI Type Manager, Query Manager, and so on). For example, to give 
a role permissions for a view, give the role access rights to the View Manager. 
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When users launch HP Universal CMDB, the actions for which you gave 
them permissions are available. For example, if a user is not assigned 
permissions to create a new role, the Users and Roles option in the Settings 
tab is not available. If a user is not assigned permissions to view a certain 
manager, the manager does not appear in HP Universal CMDB.

Tasks

Set Up Security

Choose the roles (recommended) or users for which you are assigning 
permissions. For details, see “Role and User Selector Dialog Box” on 
page 655.

Assign Access Rights

Enable permissions for a resource. For details, see “Security Manager 
Window” on page 656.

Reference

Security Manager User Interface

This section describes:

 ➤  Role and User Selector Dialog Box on page 655

 ➤  Security Manager Window on page 656
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Role and User Selector Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to choose the roles or users for which you are 
assigning access rights.

To access: Click the Add button  in the Roles/Users pane.

Important 
Information

The roles and users that appear are defined in Users and 
Roles.

For details, see “Users and Roles” on page 639.

Included in Tasks “Set Up Security” on page 654

GUI Element (A-Z) Description

Move the role or user to the Selected Roles and Users pane. 

Move the role or user back to the Defined Roles and Users 
pane.

Move all the roles and user to the Selected Roles and Users 
pane.

Move all the roles and users back to the Defined Roles and 
Users pane. 

Defined Roles and 
Users pane

Contains the list of the roles and users that are defined in 
Users and Roles.

Description A description of the role or user.

Name The name of the role or user.

Selected Roles and 
Users pane

The roles or users for which you are assigning permissions 
for the selected resource.

Type  Represents a user.

 Represents a role.
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Security Manager Window

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

 

Description Enables you to assign access rights to view, create, update, 
remove, or perform actions.

To access: Select Admin > Settings > Security Manager.

Important 
Information

➤ When assigning permissions, you must also assign access 
rights to the appropriate manager. For example, to give a 
role permissions for a view, give the role access rights to 
the View Manager. 

➤ Do not give regular users access to the Admin > Settings > 
Users and Roles menu option. This is because an 
administrator can override any user’s password from this 
menu option. Users can change their own passwords 
through the Change Password option. For details, see 
“User Profile” on page 649.

➤ It is recommended to assign access rights to roles only, 
and to associate users with a role that has the appropriate 
access rights.

➤ You cannot select an item at the folder level.

➤ If you make a selection at the root level, the user or role 
receives access rights to all items contained in the root.

➤ Child resources inherit the permissions assigned to their 
parents or the nearest ancestor to which permissions are 
assigned. For example, if you assign permissions to host, 
its children (atwswitch, concentrator, and so on) inherit 
the permissions assigned to host.

Included in Tasks “Assign Access Rights” on page 654

GUI Element (A-Z) Description

CI Types tab Give permissions to users to perform a specific operation 
on the selected CI types.

Domain tab Give permissions to users to edit the DDM domain 
credentials and the range of network addresses for the 
DDM probe.
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TQLs tab Give permissions to users to view, update, or delete the 
selected TQLs.

Views tab Give permissions to users to view, update, or delete the 
selected views.

GUI Element (A-Z) Description
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Customize tab Give permissions to users to view, update or perform 
specific operations in the CMDB Admin and Application 
menus.

CMDB Admin

➤ Modeling. Give permissions to access IT Universe, 
View, Correlation, CI Type, Reports, Query, and 
Enrichment managers.

➤ Discovery:

➤ View. View the configuration of the DDM jobs in the 
Run Discovery tab, for example, which DDM job is 
active, and information and statistics about all 
active jobs and errors discovered during a run.

➤ Execute. (Requires View permissions) Activate DDM 
jobs, run the Discovery wizards, define a schedule 
for a DDM job, override DDM pattern behavior, and 
edit Discovery TQLs.

➤ Update. (Requires Execute permissions) Grants full 
permissions for all DDM operations, including 
updating and creating new DDM patterns, scripts, 
and configuration files.

Settings

Give permissions to users to view or perform operations 
in the selected application.

Application

➤ Topology View. Give permissions to users to access 
Topology View Application.

➤ CI Lifecycle. Give permissions to users to access CI 
Lifecycle.

➤ Compliancy. Give permissions to users to compare CIs, 
compare snapshots, and generate a Gold Master report.

➤ Reports. Generate Host Dependency, Change, System, 
Asset, and Overview reports.

➤ Overview reports. Generate Overview reports.

GUI Element (A-Z) Description
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Resources Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

 

Roles/Users Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

 

Permissions Pane

Description Contains the resource tree for the selected tab.

GUI Element (A-Z) Description

<Resources for the 
selected tab>

Select the resource to which you want to assign access 
rights.

Description Displays the users or roles for which you want to assign 
permissions for the selected resource.

GUI Element (A-Z) Description

Choose users or roles to which you want to assign 
permissions for the selected resource.

Remove the selected user or role for the selected resource.

Remove all the users and roles for the selected resource.

Description Enables you to apply permissions to roles and users for 
specific resources and instances of those resources that 
are defined in the system.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

 

GUI Element (A-Z) Description

Permissions To enable permissions for a resource, you must first select 
the role or user to which you are assigning access rights. 
Then select the check box next the action that you want 
the user or role to perform.

➤ View. The role or user can view the resource, but 
cannot make changes.

➤ Create. The role or user can define new resources. 

➤ Update. The role or user can update an existing 
resource.

➤ Remove. The role or user can delete a resource from the 
CMDB.

➤ Execute. The role or user can perform actions, for 
example, running a script.

Note: Only those permissions that are relevant to the 
selected resource are enabled.
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LDAP Manager

This chapter provides information on LDAP Manager.

This chapter includes:

Concepts

 ➤  LDAP Manager Overview on page 661

Tasks

 ➤  Synchronize User Groups With LDAP on page 662

Reference

 ➤  LDAP Manager User Interface on page 664
Concepts

LDAP Manager Overview

The LDAP server can be used as a user repository for mapping user groups on 
the LDAP server to user groups in HP Universal CMDB. You can perform 
updates to users and groups in HP Universal CMDB via the LDAP server. 

Synchronizing groups is done via the LDAP Manager in the Settings tab. The 
LDAP Manager only appears in the Settings tab if:

➤ The LDAP setting in HP Universal CMDB Infrastructure settings is 
configured to Enabled. For details, see “Infrastructure Settings Manager 
Overview” on page 459.

➤ The user has the required permissions. For details, see “Users and Roles 
Overview” on page 639.
661



Chapter 34 • LDAP Manager
For details on synchronizing LDAP groups with HP Universal CMDB groups, 
see “Synchronize User Groups With LDAP” on page 662.

Tasks

Synchronize User Groups With LDAP

This task describes how to synchronize LDAP user groups with HP Universal 
CMDB user groups:

This task includes the following steps:

➤ “Configure Infrastructure Settings to Set an LDAP Synchronization Strategy” 
on page 662

➤ “Create HP Universal CMDB Groups” on page 663

➤ “Map LDAP Groups to HP Universal CMDB Groups” on page 663

 1 Configure Infrastructure Settings to Set an LDAP 
Synchronization Strategy
To set up an LDAP authentication synchronization, you must first modify 
the settings in the Infrastructure Settings Manager. Any changes you make 
remain in effect for all future Web sessions.

 a Select Admin > Settings > Infrastructure Settings Manager and select 
Foundations > LDAP Configuration.

 b In the LDAP server URL setting, enter the url of the LDAP server in the 
following format: 

ldap://<ldapHost>[:<port>]/[<baseDN>][??scope

 c In the Remote users repository mode setting, select Enabled.

 d In the Groups base DN setting, enter the distinguished name of the 
general group.

 e In the Root groups base DN setting, enter the distinguished name of the 
root group.

 f Locate the Enable User Synchronization setting and verify that the value 
is set to True.
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 g Log out of UCMDB and log in again. LDAP Manager appears under the 
Settings tab.

For details on Infrastructure Settings Manager, see “Infrastructure Settings 
Manager Overview” on page 459.

 2 Create HP Universal CMDB Groups
You can create local HP Universal CMDB groups that can be assigned to the 
remote LDAP server. 

 3 Map LDAP Groups to HP Universal CMDB Groups
You map user groups on the LDAP server with groups in HP Universal 
CMDB to synchronization LDAP groups and HP Universal CMDB groups 
and enable management of your HP Universal CMDB groups via the LDAP 
server, as follows:

 a Select Admin > Settings > LDAP Manager.

 b In the Corporate Directory Remote Repository pane, select a remote 
group and click Assign Groups. 

The HP Universal CMDB groups synchronized with the selected LDAP group 
are displayed in the Corporate Directory Local Repository for Remote 
Group: <group name> pane. 

Existing synchronization of all LDAP groups is displayed in the Local 
Groups to Remote Group Mapping pane.

Important: When defining mappings, make sure to map at least one LDAP 
group to an Admin group in the CMDB before logging out. If this is not 
done, you may not have any remaining group with administration 
permissions.

Reference
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LDAP Manager User Interface

This section describes:

 ➤  LDAP Manager on page 664

LDAP Manager

Corporate Directory Remote Repository Pane

Description Enables you to map groups configured in HP Universal 
CMDB to groups configured on the LDAP server. 

To access: Select Admin > Settings > LDAP Manager.

Important 
Information

The LDAP Manager consists of the following panes:

➤ Corporate Directory Remote Repository Pane. For 
details, see “Corporate Directory Remote Repository 
Pane” on page 664.

➤ Corporate Directory Local Repository for Remote 
Group: <group name> Pane. For details, see 
“Corporate Directory Local Repository for Remote 
Group: <group name> Pane” on page 665.

➤ Local Groups to Remote Group Mappings. Displays a 
table of the LDAP groups and the HP Universal CMDB 
groups to which they are assigned. The LDAP groups 
are displayed in the Remote Group Name column, and 
the HP Universal CMDB Groups are listed in the Local 
Group Name column. 

Description Enables you to assign HP Universal CMDB groups to 
LDAP groups, and to list the users in the LDAP groups. 

Important 
Information

➤ To synchronize LDAP groups with HP Universal 
CMDB groups, click Assign Groups to open the Select 
Local Groups for Remote Group dialog box. 

➤ To view the list of users associated with the respective 
LDAP groups, click List Users.

You can also select either of these options by right 
clicking on the group. 
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Corporate Directory Local Repository for Remote Group: 
<group name> Pane

Description Displays the HP Universal CMDB mapped to the LDAP 
group selected in the Corporate Directory Pane, and 
enables you to remove the mapped HP Universal CMDB 
groups. 

Important 
Information

➤ To remove groups, select the group you want to 
remove and click Remove Groups. 

➤ You can remove multiple groups at once by holding 
the CTRL button while selecting groups.
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Working with View Explorer

This chapter provides information on View Explorer.

Note: In IT Universe Manager, the Topology View Application, and the 
Modeling Studio, View Explorer is called CI Selector.

This chapter includes:

Concepts

 ➤  View Explorer Overview on page 670

Tasks

 ➤  Display a View in Browse Mode on page 670

 ➤  Search for CIs in Search Mode on page 671

 ➤  Modify View Explorer Display Options on page 674

Reference

 ➤  View Explorer User Interface on page 675

Troubleshooting and Limitations on page 685
Concepts
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View Explorer Overview

View Explorer presents the elements of the IT universe model in 
HP Universal CMDB through the medium of views. HP Universal CMDB 
displays View Explorer in the left pane of IT Universe Manager.

When you select a view in View Explorer, the configuration items (CIs) 
contained in the view are displayed in a hierarchical tree format according 
to the relationships defined between the CIs. A view may be empty if no CIs 
were found matching the TQL query. For details on views, see “View 
Formats” on page 150.

You can use View Explorer to select views and to locate CIs. You can select a 
view and browse through the list of CIs, or you can search for a CI if you do 
not know in which view the CI is included. 

For information on the components of View Explorer, see “View Explorer 
User Interface” on page 675.

Tasks

Display a View in Browse Mode

When View Explorer is set to Browse mode, you can display the contents of 
a selected view. For details on the View Explorer user interface in Browse 
mode, see “Browse Mode” on page 677.

This task includes the following steps:

➤ “Prerequisites” on page 670

➤ “Select a View to Display” on page 671

 1 Prerequisites
In the View Explorer pane, select Browse mode. (In IT Universe Manager or 
Topology View, select View Browser.)
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 2 Select a View to Display
Click the ellipsis button to open the Select view dialog box and select the 
view you want to display. The name of the selected view is shown in the 
View box. The CIs in the view appear in the CI tree in the lower part of the 
View Explorer pane. The view remains selected when you move to other 
applications in HP Universal CMDB.

Search for CIs in Search Mode

The View Explorer search tool enables you to find the CI you need, so that 
you can shift the focus, in the application in which you are working, to that 
CI. You can set up searches based on any combination of the filter criteria 
described in the task. For details on the View Explorer search tool user 
interface, see “Search Mode” on page 681.

This task includes the following steps:

➤ “Prerequisites” on page 671

➤ “Search by CI Name” on page 671

➤ “Filter the Scope of the Search” on page 672

➤ “Search by Related Configuration Item” on page 672

➤ “Search by Configuration Item Type” on page 673

➤ “Run the Search and Sort the Results” on page 673

 1 Prerequisites
In the View Explorer pane, select Search mode. (In IT Universe Manager or 
Topology View, select CMDB Search.)

 2 Search by CI Name
To search for CIs by name, enter a string in the Search for box, representing 
the name of the CI, or part of the name. The search returns all CIs that 
contain the entered string somewhere in the name (within the boundaries 
of the other search criteria that you define).
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When using this search option, note the following:

➤ The search by CI name option is not case sensitive.

➤ You can use the wildcard character asterisk (*) as follows:

➤ If you enter serv, all CIs containing the string serv are returned.

➤ If you enter serv*, only CIs with names beginning with serv are returned.

Note: The wildcard character asterisk is not relevant in search mode in 
IT Universe Manager or Topology View.

 3 Filter the Scope of the Search
All searches in View Explorer must specify the locations in which to search 
(this option is not available in IT Universe Manager):

➤ The current view only. This option includes the view currently selected in 
Browse mode.

➤ All views. This option searches in the most recently accessed views. It does 
not include any views that are unavailable in the current application. For 
information on unavailable views, see “Unavailable Views and CIs” on 
page 685.

➤ The entire CMDB. This option enables you to find CIs that are not included 
in any view, or that are part of a view that is unavailable in IT Universe 
Manager. This option is only available if you are working in Change Report.

Note: In IT Universe Manager, the search is always run on the entire CMDB.

 4 Search by Related Configuration Item
You can search for CIs using the Related to box (this option is not available 
in IT Universe Manager or Topology View). This search returns CIs that have 
defined relationships to the CI specified in the Related to box. 
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Click the ellipsis button to open the Select Configuration Item dialog box 
and select the required CI. You cannot manually enter a CI in the Related to 
box. 

Note: The results list includes only those relationships that exist in the 
CMDB and are included in a view.

After defining a CI in the Related to box, HP Universal CMDB remembers 
your selection until you move to a different application, or until you define 
a different value. The selection is shown as inactive; you activate it again for 
a search by selecting the check box.

 5 Search by Configuration Item Type
You can search for CIs using the CI type box. This search returns CIs that are 
of the type specified in the CI type box.

Click the ellipsis button to open the Select Configuration Item Type dialog 
box and select the required CI type. You cannot manually enter a CIT in the 
CI type box. 

After defining a CI in the CI type box, HP Universal CMDB remembers your 
selection until you move to a different application, or until you define a 
different value.

 6 Run the Search and Sort the Results
Run the search. The results are listed in the lower part of the View Explorer 
pane, showing the CI name and the name of the view that the CI appears in, 
for each entry. In IT Universe Manager and Topology View, the results 
display the CI name and the CI type. You can sort the search results by 
clicking the appropriate heading.
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Modify View Explorer Display Options

You can modify the display options for View Explorer. These options are 
configured in the Infrastructure Settings Manager. 

Important: Modifying certain settings in the Infrastructure Settings Manager 
can adversely affect the performance of HP Universal CMDB. Do not modify 
settings without first consulting HP Software Support or your 
HP Professional Services representative. 

This task includes the following steps:

➤ “Prerequisites” on page 674

➤ “Modify Selected Settings” on page 674

 1 Prerequisites
Access the Infrastructure Settings Manager by selecting Admin > Settings > 
Infrastructure Settings Manager. Select the Foundations context and choose 
View Explorer from the list.

 2 Modify Selected Settings
The following settings can be modified:

➤ Immediate Children Count. Number of children immediately displayed 
when expanding their parent’s node in View Explorer.

➤ Maximal Children Count. Maximum number of children displayed under 
their parent’s node in View Explorer.

➤ Maximal search results size. Maximum number of CMDB instances that can 
be returned in one search operation.

➤ Recently Used Views List size. Maximal number of recently used views to 
store per user.
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Note: Some of the settings are not relevant in IT Universe Manager and 
Topology View.

Reference

View Explorer User Interface

This section describes:

 ➤  CI Instances Dialog Box on page 675

 ➤  View Explorer on page 676

CI Instances Dialog Box

Description Enables you to view the CIs in your search results in a 
separate window.

To access: In the CI Selector in IT Universe Manager, in 
CMDB Search mode, click Show CIs in table.

Important 
Information

The CI Instances dialog box displays the results of your 
CMDB search in tabular form. You can select the columns 
you want to appear in the table. The functionality of the 
CI Instances dialog box is the same as that for the 
Element Instances dialog box, which is available in the 
other managers. For details, see “Element Instances 
Dialog Box” on page 394.
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View Explorer

Description Enables you to select views and to locate CIs.

To access: Appears in the left pane of the IT Universe 
Manager window, Topology View, and Modeling Studio.

Important 
Information

View Explorer consists of two functional formats: Browse 
mode and Search mode.

➤ In Browse mode you can search for and display a view, 
and browse through the view to locate a particular CI. 
You can also perform operations for the CI from a 
context menu. In IT Universe Manager, you access 
this mode by selecting View Browser from the drop-
down window.

➤ In Search mode you can search for one or more CIs in 
the views or the CMDB, search for all occurrences of a 
CI, or filter the list of CIs that is displayed. In 
IT Universe Manager, you access this mode by 
selecting CMDB Search from the drop-down window.

Included in Tasks “Display a View in Browse Mode” on page 670

“Search for CIs in Search Mode” on page 671
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Browse Mode

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to refresh the CI tree of the view.

In IT Universe Manager and Topology View, the 
following options are available:

➤ Refresh the data content of the hierarchical tree 
structure that may have been modified by other users.

➤ Rebuild the view by performing a full recalculation.

Note: The recalculation may take a long time.

Click Add selected CIs to model/view to add the 
selected CIs to the current model or view.

Note: This button only appears in the Modeling Studio.

Click Add as related CI to add the selected CI to the 
model as a related CI.

Note: This button is only active in the Model Editor of 
the Modeling Studio.

Click Open selected model in a new tab to open the 
selected model in the Model Editor.

Note: This button is only active when a model is 
selected in the Modeling Studio.

Click Generate view for selected model to open the 
Creating New View dialog box which enables you to 
build a view based on the selected model.

Note: This button is only active when a model is 
selected in the Modeling Studio.

Click Show View Definition to go directly to View 
Manager or the Modeling Studio for the current view.

Note: This button only appears in IT Universe Manager.
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Click Show Discovery and Changes Summary to 
rediscover all the CIs in a selected view by manually 
starting the DDM jobs that originally discovered them. 
For details, see “Discovery and Changes Summary 
Dialog Box” on page 79.

Note: This button only appears in IT Universe Manager.

Click Generate Direct Link to View to create a direct link 
to the view using the Direct Links wizard.

Note: This button only appears in IT Universe Manager 
and Topology View.

Choose the export format for the table data. The 
available options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-
separated values (CSV) text file that can be displayed 
in a spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that 
the comma is defined as the List Separator value. In 
Solaris, you can specify the list separator in the 
application that opens the CSV file.

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

GUI Element (A-Z) Description
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Opens the Save Snapshot dialog box, which enables you 
to save a snapshot of the view. For details, see “Save 
Snapshot Dialog Box” on page 539.

Note: This button only appears in IT Universe Manager 
and Topology View.

Click Asset Report to open the Asset report for the 
selected view. For details, see “Asset Report Overview” 
on page 577.

Note: This button only appears in IT Universe Manager 
and Topology View.

In IT Universe Manager and Topology View, this icon 
represents the Set View Parameters button. The Set 
View Parameters button is only active if at least one 
node in the selected view has a parameterized node 
condition. Displays the Set View Parameters dialog box 
where you can edit the parameter of each condition. For 
details, see “Set View Parameters/Set View Element 
Parameters Dialog Box” on page 183.

In the Modeling Studio, this icon represents Open 
Selected View in Editor area. Click Open Selected View 
in Editor area to open the current view in a separate tab 
in the View Editor.

Click the Menu option button to display a 
context-sensitive menu containing the options you can 
perform on a selected CI. You can also display the menu 
by right-clicking a CI.

Note: This button does not appear in IT Universe 
Manager, Topology View, or the Modeling Studio.

Click the Close/Open button to hide or display the View 
Explorer pane.

Note: This button does not appear in IT Universe 
Manager, Topology View, or the Modeling Studio.

GUI Element (A-Z) Description
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Click the Select view from the folder tree button to the 
right of the View box, to open the Select View dialog 
box. You can browse through the folder tree to locate 
the view you want to display.

Enables you to move to the next or previous result of the 
search for the string entered in the Find

Note: This feature only appears in IT Universe Manager, 
Topology View, and the Modeling Studio.

<CIs> The CIs contained in the currently selected view.

<Tooltip> Hold the cursor over a CI to display a tooltip with the 
relevant CI type.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the CI tree. The search only works 
for layers that have previously been. expanded. CIs in 
sublayers that have not been expanded in the tree are 
not included in the search.

Note: This feature only appears in IT Universe Manager, 
Topology View, and the Modeling Studio.

View The View box displays the currently selected view. To 
select a view to display, click the down arrow on the 
right side of the View box; this displays an abridged list 
of views, containing the most recently accessed views. 
Click the arrow at the bottom of the list to scroll 
through the entire list. (In IT Universe Manager, the 
recently accessed views appear at the top of the drop-
down, above the dividing line. The complete list of 
views appears below the line.)

Alternatively, place the cursor in the list and begin 
typing the view name. HP Universal CMDB completes 
the view name, if the first few letters that you type 
match an existing entry. If the names of several views 
begin with those letters, all matching views are 
displayed in the list.

GUI Element (A-Z) Description
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Search Mode

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click Show CIs in Table to open a separate window with 
a table of the CIs in the search results.

Note: This button only appears in IT Universe Manager 
and Topology View.

Click Add selected CIs to model/view to add the 
selected CIs to the current model or view.

Note: This button only appears in the Modeling Studio.

Click Add as related CI to add the selected CI to the 
model as a related CI.

Note: This button is only active in the Model Editor of 
the Modeling Studio.

Click Open selected model in a new tab to open the 
selected model in the Model Editor.

Note: This button is only active when a model is 
selected in the Modeling Studio.

Click Generate View for Selected Model to open the 
Creating New View dialog box which enables you to 
build a view based on the selected model.

Note: This button is only active when a model is 
selected in the Modeling Studio.
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Choose the export format for the table data. The 
available options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-
separated values (CSV) text file that can be displayed 
in a spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that 
the comma is defined as the List Separator value. In 
Solaris, you can specify the list separator in the 
application that opens the CSV file.

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

In the Related to window, click to open the Select 
Configuration Item dialog box, where you select the 
required CI.

In the CI type window, click to open the Select 
Configuration Item Type dialog box, where you select 
the required CIT to search for.

Note: This is not relevant in IT Universe Manager, 
Topology View, or the Modeling Studio.

Enables you to move to the next or previous result of the 
search for the string entered in the Find field.

Note: This feature only appears in IT Universe Manager, 
Topology View, and the Modeling Studio.

GUI Element (A-Z) Description
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<Search results> After you run the search, the results are listed in the 
lower part of the View Explorer pane. The results are 
shown in two columns:

➤ Name. Contains the name of the CI.

➤ View. Contains the name of the view in which the CI 
appears.

(In IT Universe Manager, the search results columns 
shown are Name and CI Type.)

If the CI or view name is abbreviated, hold the pointer 
over the entry to see the full name. You can sort the 
search results by clicking the appropriate heading.

CI type To search for CIs related to a specified CI type, click the 
ellipsis button to select a CI from the Select 
Configuration Item Type dialog box and select the CI 
Type check box (the check box is not relevant in 
IT Universe Manager).

In IT Universe Manager, you can search incrementally 
by typing the first few letters of the required CI type.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the search results.

Note: This feature only appears in IT Universe Manager, 
Topology View, and the Modeling Studio.

Name filter box Enter a CI name or part of a name in the filter box under 
the Name column of the results and press Enter to filter 
the results by name.

Note: This is not relevant in IT Universe Manager, 
Topology View, or the Modeling Studio.

Related to To search for CIs of a specified CI, select the Related to 
check box and click the ellipsis button to select a CI 
from the Select Configuration Item dialog box.

Note: This is not relevant in IT Universe Manager, 
Topology View, or the Modeling Studio.

GUI Element (A-Z) Description
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Context Menu Options

Search Click to run the search. The search results are displayed 
in the lower part of the View Explorer pane. 

Search for In the Search for box, enter the name of the CI (or part 
of the name). For more information, see “Filter the 
Scope of the Search” on page 672.

Search in Specify the scope of your search. You can limit your 
search to the current view, search in the most recently 
accessed views (by selecting All views), or search the 
entire CMDB. The default option is Current view. Select 
the required option.

For more information, see “Filter the Scope of the 
Search” on page 672.

Note: This is not relevant in IT Universe Manager, 
Topology View, or the Modeling Studio.

Search results count The Search results count below the Find box displays the 
total number of CIs found in the search.

Note: This feature only appears in IT Universe Manager, 
Topology View, and the Modeling Studio.

View filter box Enter a view name or part of a name in the filter box 
under the View column of the results and press Enter to 
filter the results by view.

Note: This is not relevant in IT Universe Manager, 
Topology View, or the Modeling Studio.

Menu Item Description

<IT Universe Manager 
context menu 
options>

The regular context menu for the topology map in 
IT Universe Manager is also available from the View 
Explorer pane. For details on the menu options, see 
“IT Universe Manager Context Menu” on page 91.

Add Adds the selected CI to the current model or view.

Note: This feature only appears in the Modeling Studio.

GUI Element (A-Z) Description
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Troubleshooting and Limitations

Unavailable Views and CIs
The View list in View Explorer may not display all views in the CMDB, or it 
may not display the contents of a view, for any of the following reasons:

➤ The View list includes only the views for which you have the necessary 
permissions. To set permissions, select Admin > Settings > Users and Roles. 
For more information, see “Users and Roles User Interface” on page 641.

➤ Views that are currently inactive appear in red in the View list, but they 
cannot be selected. In IT Universe Manager, inactive views appear in faded 
text.

➤ Out-of-the-box views for which you do not have a license may appear in the 
View list, but these views do not contain CIs. For information on the out-of-
the-box views, see “Predefined Folders and Views” on page 152.

Add as related CI Adds the selected CI as a related CI to the current model.

Note: This feature only appears in the Modeling Studio.

Generate View from 
Model

Select to create a view based on the current model. The 
Creating New View dialog box opens which enables you 
to select a perspective to apply.

Note: This feature only appears in the Modeling Studio.

Get Related CIs Select to view a related CIs map for the selected CI. For 
details, see “IT Universe Manager Context Menu” on 
page 91.

Note: This feature only appears in the Modeling Studio.

Open Selected Model Opens the selected model in the Model Editor.

Note: This feature only appears in the Modeling Studio.

Properties Opens the Properties page for the selected CI. For details, 
see “Configuration Item Properties Dialog Box” on 
page 74.

Menu Item Description
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Note: After deleting one or more nodes from a TQL, it can take time for 
changes to be updated to the view; meanwhile, the removed CIs appear in 
the view. If you select one of these CIs before it is updated, an error message 
is displayed. Click the Refresh button to update the view.
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Working with Topology Map

This chapter provides information on Topology Map.

This chapter includes:

Concepts

 ➤  Topology Map Overview on page 689

 ➤  Handling Large Views on page 690

Reference

 ➤  Topology Map User Interface on page 690
Concepts

Topology Map Overview

The Topology Map provides a graphical display of a view. All the CIs in a 
given layer of the view are represented by icons and the connecting lines 
represent relationships. You can select a CI in the Topology Map or in View 
Explorer in the left pane. You can also drill down in View Explorer to display 
different layers of the view in the Topology Map.

If an icon appears with a downward arrow in the Topology Map, there is an 
additional CI layer beneath it, created by a parent or child folding rule.

The toolbar and Main Menu above the Topology Map enable you to zoom 
in, change the layout of the Topology Map, and print the Topology Map. 
Additional functionality is available from the context menu by right-
clicking a CI in the Topology Map or in View Explorer.
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Handling Large Views

The Topology Map cannot display a view with more than 900 CIs in a single 
layer. When you select a view which contains a layer with more than this 
number of CIs, the Topology Map appears empty. 

To handle large views, use one of the following methods:

➤ Reduce the TQL query results by redefining the view in View Manager. For 
details, see “Refine Node Type Dialog Box” on page 412.

➤ Define different folding rules or Group By rules for the view to redistribute 
the CIs among the view’s layers. For details on defining folding rules, see 
“Add Folding Rules to Relationships” on page 165.

➤ Reset the maximum number of CIs allowed in the configuration parameters. 
Select the Foundations context in Infrastructure Settings Manager. Select the 
Max Object Count GUI for TS parameter under UCMDB common – Viewing 
Settings. However, be aware that increasing the maximum number of CIs 
per layer may significantly slow down the redrawing of the Topology Map.

For details regarding Infrastructure Settings Manager, see “Infrastructure 
Settings Manager User Interface” on page 460.

Reference

Topology Map User Interface

This section describes:

 ➤  Export Map to Image Dialog Box on page 691

 ➤  Layout Properties Dialog Box on page 692

 ➤  Main Menu on page 713

 ➤  Print Dialog Box on page 714

 ➤  Print Preview Dialog Box on page 715

 ➤  Print Setup Dialog Box on page 715

 ➤  Toolbar Options on page 717
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Export Map to Image Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to save a topology map to a file.

To access: From a topology map, select Operations > 
Export Map to Image.

Included in Tasks “Print and Save a Topology Map to File” on page 534

GUI Element (A–Z) Description

Move the indicator left or right to set the required quality 
of the printed map on the scale. 100 means that the 
quality is excellent.

Actual Size Save the view so that the node sizes are at maximum.

Current Zoom Level Save the view as you see it on the topology map. For 
example, if you have used the Interactive Zoom mode to 
decrease the view magnification, the nodes also appear 
smaller in the saved view. For details, see “Interactive 
Zoom” on page 720.

Custom Specify the size of the view you want to save in the Width 
and Height boxes.

Draw Grid Draw a grid in the graph.

File Name Specify the required file name and location (or click 
Browse to search for the file and location).

Fit in Canvas Expand or shrink the view so that it fits in the window.

Image Quality (0-
100)

Enter a value to set the required quality of the printed 
map on the scale. 100 means that the quality is excellent.

Selected Objects 
Only

Saves only the nodes/CIs and their relationships that you 
selected in the map.

Type Select the required file format.

Visible Window Only Saves only the part of the graph that appears in the 
window.
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Layout Properties Dialog Box

Circular Tab

Description Enables you to customize the layout of a specific layer in 
a view, to achieve the clearest presentation possible and 
to better understand and monitor the managed data.

You define the layout of a view’s layers by assigning 
logical positions for the nodes and relationships that 
appear in a layer. You customize the layer layouts by 
modifying the default values.

Note: You set layout definitions for a specific layer only. 
The definitions cannot be saved for a different layer or a 
different view.

To access: Select Layout > Layout Properties.

Important 
Information

Parameter values are in pixels.

Description Enables you to group a graph’s nodes into groups or 
clusters based on the grouping options you select. It is 
particularly suited for visualizing ring and star network 
topologies, and for link analysis. 

The Circular tab has the following areas:

➤ Clustering area. Specifies the ratio between the average 
cluster size and the number of clusters as well as the 
minimum and maximum number of clusters in a layer.

➤ Cluster Layout Style area. Displays clusters either in a 
symmetric or circular layout style.

➤ Layout Quality area. Adjusts the quality of the layout 
produced to fit your application’s needs. The quality 
reflects the number of steps or the method used to 
produce the layout. For example, high quality is 
sharper but takes more time to set the layout.

➤ Spacing area. Sets the spacing around each node 
within the same cluster and between clusters.

To access: Click the Circular tab in the Layout Properties 
dialog box.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Circular Displays clusters in a circular layout style.

Cluster Spacing Sets the spacing between clusters.

Default value: 50

This illustration shows smaller cluster spacing.

This illustration shows larger cluster spacing.

Cluster Size 
Multiplier

Specifies the ratio between the average cluster size and 
the number of clusters. The size of a cluster is defined as 
the sum of the weights of all nodes in the cluster. You can 
assign a weight value to each node.

Draft Sets the layout to draft quality.

Default Sets the layout to default quality.

Max Number of 
Clusters

The maximum number of clusters in a layer.

Min Number Of 
Clusters

The minimum number of clusters in a layer.
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Node Spacing Sets the spacing around each node within the same 
cluster. The larger the spacing, the more nodes there are 
on the cluster boundary. 

Default value: 10

This illustration shows smaller node spacing.

This illustration shows larger node spacing.

Proof Sets the layout to proof quality.

Symmetric Displays clusters in a symmetric layout style.

GUI Element (A–Z) Description
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Disconnected Tab 

Description Enables you to define general layout parameters for 
disconnected nodes and connected components. 

➤ A disconnected node is a node that is not connected to 
any other node.

➤ A disconnected component is a component that is not 
connected to any other component. It contains a set of 
nodes that can be connected to each other.

This illustrates a connected component with five nodes:

This illustrates a connected component with two nodes:

This illustrates four disconnected components, each 
made up of a single, disconnected node:

The Disconnected tab has the following areas:

➤ Aspect Ratio area. This setting affects the placement of 
components with respect to each other only, and not 
the layout of each individual component. The setting 
has no effect if the graph is connected.

➤ Components area. The spacing between the 
components in a disconnected graph consists of both 
a constant value and a proportional value based on the 
sizes of the components.

➤ Disconnected Nodes. The spacing between the nodes 
in a disconnected graph consists of both a constant 
value and a proportional value based on the sizes of 
the nodes.

To access: Click the Disconnected tab in the Layout 
Properties dialog box. 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Automatic The layout is performed automatically.

Custom Sets a specific aspect ratio.

Default value: 1.0

Constant Spacing Set constant spacing (horizontal and vertical) around 
each disconnected component. 

Default value: 20

Detect Components Select this option to view the disconnected components. 
You can specify that all components be laid out together 
or individually, regardless of the other components. If 
the grouping for components is selected, each 
component is laid out, and the resulting components are 
packed together.

Detect Disconnected 
Nodes

Select this option to view the disconnected nodes. You 
can specify that disconnected nodes be grouped into one 
component or laid out individually.

Proportional Spacing Set spacing (horizontal and vertical) that is proportional 
to the size of the component around each disconnected 
component. 

Default value: 0.05
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Hierarchical Tab

Description Shows the precedence relationships that can represent 
organizational or information management system 
dependencies, as well as process models, software call 
graphs, and work flows. The hierarchical layout 
emphasizes dependencies by placing the nodes at 
different levels.

The Hierarchical tab has the following areas:

➤ Backward Edges area. Specifies how backward 
relationships are displayed in the hierarchical layout. 

➤ Horizontal Spacing area. Enables you to set the 
minimum horizontal distance between two 
neighboring nodes at each level.

➤ Layout Quality area. Enables you to adjust the quality 
of the layout produced to fit your application’s needs. 
The quality reflects the number of steps or the method 
used to produce the layout. For example, high quality 
is sharper but takes more time to set the layout.

➤ Level Alignment area. Enables you to set the way 
nodes are vertically aligned.

➤ Orientation. Enables you to set the orientation of the 
hierarchy.

➤ Orthogonal Routing area. Enables you to set the type 
of relationship between CIs. This option is useful 
when layers have nodes with a very large number of 
connecting relationships.

➤ Polyline Routing area. Routes edges as one or more 
straight line segments with arbitrary angles. Polyline 
routed edges are prevented from overlapping by 
adding extra segments.

➤ Vertical Spacing area. Enables you to set the minimum 
vertical distance between two neighboring nodes on 
different levels.

To access: Click the Hierarchical tab in the Layout 
Properties dialog box. 

Important 
Information

Orthogonal Routing is currently not supported.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Bottom This illustration shows that the bottom of the nodes at 
the same level of the hierarchy are aligned.

Bottom To Top The children are located below the parent (in the 
example, Alignment = Center).

Center This illustration shows that the center of the nodes at the 
same level of the hierarchy are aligned.

Default Sets the layout to default quality.
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Draft Sets the layout to draft quality.

Left To Right The children are located to the left of the parent (in the 
example, Alignment = Center).

Minimum Backward 
Edges

Sets the number of number of backward relationships 
displayed in a layer to a minimum.

Optimize For 
Feedback Flow

Sets the number of number of backward relationships 
displayed in a layer to a maximum. This mode is more 
appropriate for flow charts.

Orthogonal For orthogonal lines between nodes/CIs.

GUI Element (A–Z) Description
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Polyline For straight lines between nodes/CIs.

Proof Sets the layout to proof quality.

Right To Left The children are located to the right of the parent (in the 
example, Alignment = Center).

GUI Element (A–Z) Description
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Spacing Between 
Edges (in the 
Horizontal Spacing 
area)

This setting is available only when you select Routing > 
Orthogonal. It sets a horizontal space between edges in 
the graph.

Default value: 12

This illustration shows smaller edge spacing.

This illustration shows larger edge spacing.

GUI Element (A–Z) Description
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Spacing Between 
Bends

This setting is available only when you select Routing > 
Polyline. Polyline routing routes edges (connecting lines) 
as one or more straight line segments with arbitrary 
angles. Path nodes are added automatically to prevent 
the edges (connecting lines) from overlapping.

Default Value: 12

Spacing Between 
Edges (in the Vertical 
Spacing area)

This setting is available only when you select Routing > 
Orthogonal. It sets a vertical space between edges in the 
graph.

Default value: 12

Spacing Between 
Nodes (in the 
Vertical Spacing 
area)

Sets a vertical space around each node in the level. 

Default value: 28

GUI Element (A–Z) Description
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Spacing Between 
Nodes (in the 
Horizontal Spacing 
area)

Sets a space around each node horizontally in the layer. 
Default value: 20

This illustration shows smaller node spacing.

This illustration shows larger node spacing.

GUI Element (A–Z) Description
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Top This illustration shows that the top of the nodes at the 
same level of the hierarchy are aligned.

Top To Bottom The children are located above the parent (in the 
example, Alignment = Center).

GUI Element (A–Z) Description
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Orthogonal Tab

Undirected Layout Edge direction is not used to build the levels of the 
hierarchical drawing.

Variable Level 
Spacing

Variable level spacing adjusts the spacing between pairs 
of neighboring levels according to the density of edges 
between the levels. 

If the drawing’s edges are orthogonally routed, this 
ensures the desired vertical spacing between horizontal 
edges (in a top-to-bottom or bottom-to-top layout) 
routed between levels. 

If the routing is polyline, variable level spacing makes it 
easier to distinguish among edges in very dense 
drawings.

Description Enables you to set orthogonal layout route relationships 
horizontally and vertically. This results in relationships 
bending at 90-degree angles only.

The Orthogonal tab has the following areas:

➤ Aspect Ratio area. Enables you to set the layout’s 
proportions. This only affects the placement of 
components with respect to each other, not the layout 
of each individual component. The layout’s 
proportions have no effect if the graph is connected.

➤ Horizontal Spacing area. Enables you to set the 
minimum horizontal distance between nodes.

➤ Layout Quality area. Enables you to adjust the quality 
of the layout produced to fit your application’s needs. 
The quality reflects the number of steps or the method 
used to produce the layout. For example, high quality 
is sharper but takes more time to set the layout.

➤ Vertical Spacing area. Enables you to set the minimum 
vertical distance between nodes.

To access: Click the Orthogonal tab in the Layout 
Properties dialog box.

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

The Fix Node Sizes option is currently not supported.

GUI Element (A–Z) Description

Automatic The layout is performed automatically.

Custom Specify the aspect ratio.

Default value: 1.0

Default Set the layout to default quality.

Draft Set the layout to draft quality.

Disabled Disables the aspect ratio.

Proof Set the layout to proof quality.

Spacing Between 
Edges (in the 
Horizontal Spacing 
area)

Set a space between elements in the layer.

Default value: 12

Spacing Between 
Nodes (in the 
Horizontal Spacing 
area)

Set a space around each node in the layer.

Default value: 20

Spacing Between 
Edges (in the Vertical 
Spacing area)

 Set a space between elements in the layer.

Default value: 12

Spacing Between 
Nodes (in the 
Vertical Spacing 
area)

Sets a space around each node in the layer.

Default value: 20
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Routing Tab

Description Enables you to produce drawings that leave nodes 
essentially where they are, and reroute the lines 
orthogonally.

The Routing tab has the following areas:

➤ Horizontal Spacing area. Enables you to set the 
horizontal space around each node.

➤ Vertical Spacing area. Enables you to set the vertical 
space around each node.

To access: Click the Routing tab in the Layout Properties 
dialog box.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Fix Node Positions Maintain the position of all the nodes in the display. 
Clear this option for the layout to move the nodes if it is 
necessary to improve the layout. The movement is 
minimal, avoids overlaps, and minimizes bend points.

Fix Node Sizes Maintain the size of a node. Clear this option if you want 
the layout to increase the size of a node if it is necessary 
to maintain the specified relationship spacing when 
more than one relationship is attached to the same node 
side.
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Spacing Between 
Edges (in the 
Horizontal Spacing 
area)

Sets the horizontal space between any two neighboring 
parallel lines. Line spacing can also affect the size of a 
node to which many lines are attached, unless the node 
is set to remain fixed at its current size. The settings for 
line spacing are constant values.

Default value: 12

The following illustrates smaller line spacing:

The following illustrates larger line spacing:

Spacing Between 
Edges (in the Vertical 
Spacing area)

Set the vertical space between any two neighboring 
parallel lines. Spacing between lines can also affect the 
size of a node to which many edges are attached, unless 
the node is set to remain fixed at its current size. The 
settings for edge spacing are constant values. 

Default value: 12

GUI Element (A–Z) Description
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Spacing Between 
Nodes (in the 
Horizontal Spacing 
area)

Sets the horizontal space around each node in the layer.

Default value: 20

The following illustrates smaller node spacing:

The following illustrates larger node spacing:

Spacing Between 
Nodes (in the 
Vertical Spacing 
area)

Set the vertical space around each node in the layer. 

Default value: 20

GUI Element (A–Z) Description
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Symmetric Tab

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a clear representation of complex networks. The 
symmetric layout emphasizes the symmetries that may 
occur in a graph.

This tab consists of the following areas:

➤ Layout Quality area. Adjusts the quality of the layout 
produced to fit your application’s needs. The quality 
reflects the number of steps or the method used to 
produce the layout. For example, high quality is 
sharper but takes more time to set the layout.

➤ Spacing Options area. Enables you to adjust the 
spacing around each node in the layer.

To access: Click the Symmetric tab in the Layout 
Properties dialog box.

GUI Element (A–Z) Description

Default Set the layout to default quality.

Draft Set the layout to draft quality.
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Node Spacing Allows you to set constant horizontal and vertical 
spacing around each node in the layer. The value you 
specify is a guideline for the layout, so that it is possible 
that the spacing for a particular pair of nodes might be 
different from the one you specified. The larger the node 
spacing, the farther apart the nodes are spaced in the 
final layout.

Default value: 10

The following figure illustrates smaller and larger 
spacing.

Proof Set the layout to proof quality.

GUI Element (A–Z) Description
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Main Menu

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Contains the options for working with the topology map.

Important 
Information

The specific options contained within the Main Menu 
drop-downs are detailed in “Toolbar Options” on 
page 717.

GUI Element (A–Z) Description

Edit Contains selection options for the topology map.

Layout Contains options for changing the layout of the topology 
map.

Map Item Contains the topology map context menu options for the 
current manager.

Operations Contains options for printing or exporting the topology 
map.

Resources Contains the left pane context menu options for the 
current manager.

Note: In IT Universe Manager, this drop-down is called 
Configuration Items and in CI Type Manager it is called 
CI Types.

View Enables you to hide or display the different panes of the 
topology map.
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Print Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to print the contents of the topology map. 

To access: Select Operations > Print.

Important 
Information

The results of printing a topology map is similar to a 
screen capture. Therefore, before printing, it is 
recommended to:

➤ Define your print settings and arrange the contents of 
the topology map according to your requirements. For 
details, see “Print Setup Dialog Box” on page 715.

➤ Arrange the contents of the topology map for print. 
You can use the Layout option and Layout Properties. 
For details about the layout options, see “Layout” on 
page 721. For details about layout properties, see 
“Layout Properties Dialog Box” on page 692.

Included in Tasks “Print and Save a Topology Map to File” on page 534

GUI Element (A–Z) Description

Number of copies Enter the number of copies you want to print.

Properties Define document properties as required.
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Print Preview Dialog Box

The Print Preview dialog box includes the following menu options (listed 
alphabetically):

Print Setup Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to preview the content of the topology map 
before printing.

To access: Select Operations > Print Preview.

Included in Tasks “Print and Save a Topology Map to File” on page 534

Menu Item Description

Fit in Canvas Fit the complete view in the window.

Print Print the map. For details, see “Print Dialog Box” on 
page 714.

Print Setup Define the print settings for the map. For details, see 
“Print Setup Dialog Box” on page 715.

Zoom Focus on specific details of the map. For details, see 
“Interactive Zoom” on page 720.

Description Enables you to define the print settings for a topology 
map.

To access: Select Operations > Print Setup.

Included in Tasks “Print and Save a Topology Map to File” on page 534

GUI Element (A–Z) Description

Actual Size Print the view as it really is.

Color Set the text color.
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Font Set the required font.

Page Setup Set the printer settings.

Pages Divide the map into rows and columns and print each 
section separately. Enter the number of columns and rows 
in the Page Columns and Page Rows boxes.

Print Background Print the background behind the view.

Print Border Print the map with a border. Click Color to select the 
required border color.

Print Caption Enter the caption in the text area and click Font to select 
the required custom font.

Print Crop Marks Print the crop marks.

Print Current 
Selection

Print the selected nodes and their relationships.

Print Current 
Window

Print the part of the view that appears in the window.

Position Select the position of the caption from the Position list.

Print Entire Drawing Print the complete view.

Print Page Numbers Print the page numbers.

Zoom Level Print the view at the current zoom level.

GUI Element (A–Z) Description
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Toolbar Options

The following table contains a description of each Topology Map toolbar 
option, organized alphabetically.

Button Option Name Use This Option to...

Add 
Background 
Image

Add a background image to a view. For details, see “Add 
Background Image Dialog Box” on page 71.

To access: Select Layout > Add Background Image.

Note: This option is only active in IT Universe Manager and 
Topology View application.

Additions 
Count

Calculate the number of instances that are created as a result of 
an Enrichment Rule. The number of TQL node instances and 
relationships that are created appear next to the Enrichment 
nodes/relationships, as seen in the figure below.

Note: This option appears in the toolbar in Enrichment 
Manager only.

Calculate TQL 
Result Count

Calculate the number of instances found for each TQL 
node/relationship.

Candidates 
for Deletion

Identify the CIs in the current view which are candidates for 
deletion with the following icon  .

Note: This option appears in the toolbar in the Topology View 
application only.
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Change Label 
Length

Enter the maximum number of characters that the labels should 
contain.

To access: Select Layout > Change label length.

Change 
Timeframe

Open the Change Timeframe dialog box, which enables you to 
set the period for the display of added or changed CI indicators.

Note: This option appears in the toolbar in Topology View 
application only.

CI Types Tree Toggle between hiding and displaying the CI Type Selector at 
the right of the screen.

To access: Select View > CI Types Tree.

Clear 
Correlation

Clear the Topology View of the statuses of the trigger and 
affected CIs for the state Change. CI statuses appear only after 
using the Run Correlation dialog box to run an Impact Analysis 
report on a set of existing Correlation rules. For details, see “Run 
Correlation Dialog Box” on page 536. For details on Correlation 
rules, see “Correlation Manager User Interface” on page 205.

Note: This option appears in the toolbar in the Topology Map in 
the Topology View application only.

Create 
Relationship

In most managers, create a relationship between two existing 
TQL nodes. For details, see “Add Nodes and Relationships to a 
TQL Query” on page 348.

In IT Universe Manager, create a relationship between existing 
CIs. For details, see “Attaching Existing CIs” on page 64. 

Delete 
Selected 
Item(s)

Delete a CI from IT Universe Manager, a node from View 
Manager, a TQL node from Query Manager, Correlation 
Manager, Report Manager, or Enrichment Manager. 

Direct Links 
Wizard

Open the Direct Links wizard, which enables you to create a 
direct link to a specific CI or view. For details, see “Direct Links 
User Interface” on page 439.

Drag Map Drag the view.

To access: Open the drop-down menu in the Mode box or select 
View > Drag Map.

Button Option Name Use This Option to...
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Drill Down 
One Layer

Move down one level in the topology map. This option is 
enabled only if there is an additional CI layer below it, created 
by a parent or child folding rule as defined in View Manager. For 
details on folding rules, see “Adding Folding Rules to 
Relationships” on page 65. 

Note: This option appears only in IT Universe Manager and 
Topology View application.

Entities Tree Toggle between hiding and displaying the manager specific 
entities tree at the left of the screen.

To access: Select View > Entities Tree.

Export Map 
to Image

Save the topology map to a file. For details, see “Export Map to 
Image Dialog Box” on page 691.

To access: Select Operations > Export Map to Image.

Filter DB 
Results

Open a dialog box which displays the number of related CIs by 
type. Select the CI type you want to appear in the Topology Map 
results.

Note: This option appears only in IT Universe Manager and the 
Topology View application.

Fit to 
Window

Fit the complete map in the window.

Generate 
Related CIs 
Report

Display the Get Related CIs Report for the selected CI. For 
details, see “Get Related CIs Report” on page 80.

Note: This option appears only in IT Universe Manager and 
Topology View application.

Go Up One 
Layer

Move up one level in the topology map. This option is enabled 
only if there is an additional CI layer above it, created by a 
parent or child folding rule as defined in View Manager. For 
details on folding rules, see “Adding Folding Rules to 
Relationships” on page 65. 

Note: This option appears only in IT Universe Manager and the 
Topology View application.

Button Option Name Use This Option to...
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Hide All 
Inheritance 
From Map

Toggle between showing and hiding Inheritance_f relationships 
and their connecting node.

To access: Select Layout > Hide All Inheritance From Map.

Note: This option is only active in the toolbar in CI Type 
Manager.

Hide All Node 
Labels

Toggle between showing or hiding the CI/CIT/node/pattern 
labels.

To access: Select Layout > Hide All Node Labels.

Hide All 
Relationship 
Labels

Toggle between showing or hiding the relationship labels.

To access: Select Layout > Hide All Relationship Labels.

Hide All 
Relationships

Toggle between showing and hiding the relationships in the 
displayed map.

To access: Select Layout > Hide All Relationships.

Hide 
Panes/Restor
e Panes

Toggle between the regular display and a full-screen display of 
the topology map.

Information 
Pane

Toggle between hiding and displaying the Information Pane at 
the bottom center of the screen.

To access: Select View > Information Pane.

Interactive 
Zoom

➤ Decrease the view magnification by clicking and pushing the 
pointer upwards.

➤ Magnify the view by clicking and pulling the pointer 
downwards.

To access: Open the drop-down menu in the Mode box or select 
View > Interactive Zoom.

 Layout 
Properties

Define the view’s layer layout, by assigning positions for the 
nodes and relationships of the view. For details, see “Layout 
Properties Dialog Box” on page 692. 

To access: Select Layout > Layout Properties.

Button Option Name Use This Option to...
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Layout Select the layout display from the list. The options are:

➤ Hierarchical. Enables you to display the precedence relations 
in the topology map.

➤ Symmetric. Enables you to display clear representations of 
complex networks.

➤ Circular. Groups a graph’s nodes into groups or clusters.

➤ Manual. Enables you to display the changes you have made 
manually to the topology map. 

➤ Orthogonal. Enables you to display views of outstanding 
clarity that are achieved by employing only horizontal and 
vertical edge routing.

Note: Select Layout > Save Layout to save the selected layout.

For further details about each of the options, see “Layout 
Properties Dialog Box” on page 692. 

Map 
overview

Open a small window with a copy of the topology map. This is 
useful in large views when zooming in.

To access: Select Layout > Map Overview.

Navigation Take the pointer to the next connected CI/CIT/TQL node in a 
clockwise direction.

➤ Left-click to move in a clockwise direction.

➤ Right-click to point to the next CI/CIT/node/pattern in a 
clockwise direction. 

To access: Open the drop-down menu in the Mode box or select 
View > Navigation.

Note: You can use this option only on CI/CIT/nodes/patterns 
that are connected by relationships.

New CI Define a new unrelated CI. For details, see “Working with CIs” 
on page 58.

Note: This option appears in the toolbar in IT Universe Manager 
only.

New Related 
CI

Define a new related CI. For details, see “Working with CIs” on 
page 58.

Note: This option appears in the toolbar in IT Universe Manager 
only.

Button Option Name Use This Option to...
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Place in 
Center

Place the selected CI/node/CIT/pattern in the center of the map.

To access: Select Layout > Place in Center.

Print Print the contents of the topology map. For details, see “Print 
Dialog Box” on page 714.

To access: Select Operations > Print...

Print Preview Preview the contents of the map before printing.

To access: Select Operations > Print Preview.

Print Setup Define print settings for printing the topology map. For details, 
see “Print Setup Dialog Box” on page 715.

To access: Select Operations > Print Setup...

Remove 
Enrichment 
Results

Remove the instances created from an Enrichment rule from the 
CMDB.

Note: This option appears in the toolbar in Enrichment 
Manager only.

Save Layout Save changes to the layout. To retrieve the layout you have 
saved, select Manual Layout. 

To access: Select Layout > Save Layout.

Note: This option appears in the toolbar in IT Universe Manager 
and Topology View application only.

Select Select a CI/CIT/TQL node or multiple CIs/CITs/TQL nodes.

To access: Open the drop-down menu in the Mode box or select 
View > Select.

Select All Select all the CIs and relationships in a selected layer.

To access: Select Edit > Select All.

Select All 
Nodes

Select all the nodes in a selected layer.

To access: Select Edit > Select All Nodes.

Select 
Columns

Enables you to select the columns to be displayed. For details, 
see, “Select Columns Dialog Box” in Reference Information.

Note: This option is displayed in Text mode of IT Universe 
Manager only.

Button Option Name Use This Option to...
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Set Number 
of Hops

Open a dialog box which enables you to set the degree of 
separation of the related CIs to appear in the Related in DB 
selection.

Note: This option appears in the toolbar in IT Universe Manager 
and Topology View application only.

Show 
Changes in 
Map

Display an indicator next to each CI that was added or changed 
within the selected period as follows:

➤  Indicator for an added CI

➤  Indicator for a changed CI

You can toggle between hiding and displaying the indicators by 
clicking the button. When the indicators are displayed, you can 
double-click on the indicator to open the CI History dialog box, 
which displays the history for the CI over the selected period.

For details on selecting the period, see “Change Timeframe” on 
page 718.

Note: This option appears in the toolbar in Topology View 
application only. 

Show 
Schedule Info

Display the scheduling information for the selected job. For 
details, see “Discovery Scheduler Dialog Box” in Discovery and 
Dependency Mapping Guide.

Note: This option appears in the toolbar in the Dependency 
Map tab of DDM. For details, see “Dependency Map Tab” in 
Discovery and Dependency Mapping Guide.

Sort Order Enables you to set the order of the visible columns. For details, 
see, “Sort Column Content Dialog Box” in Reference Information.

Note: This option is displayed in Text mode of IT Universe 
Manager and the Topology View application only.

Straighten Straightens any selected relationship between two nodes that 
has angles. 

To access: Select Layout > Straighten.

Button Option Name Use This Option to...
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User 
Preferences

Opens the User Preferences dialog box which enables you to 
reset warning message preferences. For details, see “User 
Preferences Dialog Box” on page 426.

To access: Select Edit > User Preferences.

Zoom Zoom in on a specific section of the topology map by clicking 
and drawing a selection rectangle around the part to magnify. 
The area you select is displayed at the highest percentage that 
fits in the topology map.

To access: Open the drop-down menu in the Mode box or select 
View > Zoom.

Button Option Name Use This Option to...
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